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Interface Elements for Windows

This documentation provides information on individual User Interface Elements such as grids, navigation panes,
data editors, etc. Each element can provide context menus, allow numerous mouse operations and support a
number of keyboard shortcuts.

To obtain information about these features, browse through the table of contents to locate the element you are
interested in.

Charting

Docking

Editors

Expression Editor

Filter Editor

Grid

Layout Manager

Map

Navigation Bars

PDF Viewer

Pivot Table

Print Preview

Report Designer

Ribbon

Rich Text Editor

Scheduler

Snap Reporting Engine

Spreadsheet

Toolbars and Menus

Tree List

Vertical Grid
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Charting

This section describes the capabilities provided by Charts.

 

Topics in this section:

Chart Wizard

Highlighting and Selection Chart Elements

Zoom a Chart

Scroll a Chart

Rotate a Chart
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Chart Wizard

Use the chart wizard dialog to quickly and easily create a new chart, or modify an existing one.

The Chart Wizard contains the following pages.

Construction group

Chart Type Page

Appearance Page

Series Page

Data Page

Presentation group

Chart Page

Diagram Page

Panes Page

Axes Page
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Series Views Page

Point Labels Page

Chart Titles Page

Legend Page

Annotations Page

To navigate through the Chart Wizard's pages, use the navigation bar or the  and 
buttons.

To complete the chart, use the  button, or the  button, to cancel all changes.

Use the "Display a wizard every time a new chart is added" option to specify whether or not a chart wizard should
appear when you add a new chart to the windows form.
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Chart Type Page

Tasks

Choose a chart type.

Page Elements

Chart type selector
Contains icons representing chart types. Click an icon to choose the appropriate chart type.

Chart type filter
Filters chart types available in the Chart type selector. The following chart filters are available:

All Chart Types.

Bar Series (Bar, Stacked Bar, 100% Stacked Bar, Side-By-Side Stacked Bar, 100% Side-By-Side Stacked
Bar, 3D Bar, 3D Stacked Bar, 3D 100% Stacked Bar, 3D Side-By-Side Stacked Bar, 3D 100% Side-By-Side
Stacked Bar and Manhattan Bar).

Point and Line Series (Point, Bubble, Line, Stacked Line, 100% Stacked Line, Step Line, Spline, Scatter
Line, Swift Plot, 3D Line, 3D Stacked Line, 3D 100% Stacked Line, 3D Step Line and 3D Spline).

Pie Series (Pie, Doughnut, 3D Pie and 3D Doughnut).

Funnel Series (Funnel and 3D Funnel).
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Area Series (Area, Stacked Area, 100% Stacked Area, Step Area, Spline Area, Spline Area Stacked, 100%
Stacked Spline Area, 3D Area, 3D Stacked Area, 3D 100% Stacked Area, 3D Step Area, 3D Spline Area, 3D
Spline Stacked Area and 3D 100% Stacked Spline Area).

Range Series (Range Bar, Side-By-Side Range Bar, Range Area, 3D Range Area).

Radar and Polar Series (Radar Point, Radar Line, Radar Area, Polar Point, Polar Line and Polar Area).

Advanced Series (Stock, Candle Stick, Gantt, Side-By-Side Gantt).
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Appearance Page

Tasks

Choose a palette to color a series.

Choose the style specifying the chart's appearance.

Page Elements

Chart preview area
Previews a chart's layout.

Palette Editor
Specifies a palette to color a series.
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Style Editor
Specifies the style determining the chart's appearance, depending on the selected palette.
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Series Page

Tasks

Create or remove a series of points.

Define the series name, visibility and view type.

Customize additional series options and legend point options.

Enable and customize the Top N Values feature.

Page Elements

Series List
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This list displays all available series. You can click list entries to access properties of the corresponding series. To
switch between series, use the   and   buttons.

Series management buttons
Use the Add, Copy and Remove buttons to manage the series collection.

Options tabs
The following tabs are available on this page:

General
Choose whether the selected series should be visible, define its name, and select a view type.

Series Options
Specifies argument and value scale types, the point sort order, visibility in the legend, whether the legend
is checked, and legend text.

Top N Options
Specifies whether the Top N Values feature is enabled, and allows you to control this feature's options.

Legend Text Pattern
Specifies the format of values displayed in the chart legend.
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Data Page

Tasks

Provide data for a chart;

Bind a chart or individual series to a data source;

Customize an argument and a value scale type;

Customize the view type of auto-generated series;

Apply data filtering and sorting;

Adjust the Pivot Chart settings.

Page Elements

You can provide data for a chart using the following tabs.

Points tab

Series Binding tab

Auto-created Series tab

Points Tab

Use it to manually enter data points for series.
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Note that valid Argument and Value entries must correspond to the Argument scale type and the Value scale
type selected for the appropriate series on the Series Page. Otherwise, an error message will be invoked.

Series Binding Tab

Use it to provide specific data binding options for each series.

The following illustration demonstrates how it works.
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Auto-created Series Tab

Use it to specify data columns used to generate series, as well as the series view type and other options like
sorting, filtering and name template.

The following illustration demonstrates how it works.
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For familiar data sources (such as Pivot Grid), you can choose to automatically adjust the binding and layout
settings of your Chart.

And when you set a Pivot Grid as a Chart's data source, the Pivot Grid Data Source tab becomes available.

On this tab you can adjust various Pivot Chart options.
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Chart Page

Tasks

Define a chart's background color and background image.

Page Elements

Chart preview area
Previews a chart's layout.

Options tabs
The following tabs are available on this page.

Appearance
Specifies a chart's background color, fill style and background image.
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Border
Specifies a border's color, thickness and visibility.

Padding
Specifies the diagram's inner indents.

Empty Chart Text
Specifies the message displayed in the chart when there's no data to display.

Small Chart Text
Specifies the message displayed in the chart, when the chart size is too small to fit the diagram.
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Diagram Page

Tasks

Rotate a diagram;

Define a diagram's padding;

Add or remove secondary axes;

Add or remove panes;

Define panes' layout direction;

Enable or disable a diagram's scrolling and zooming.

Page Elements

Chart preview area
Previews a chart's layout.
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Options tabs
The following tabs are available on this page.

General
Choose whether a diagram should be rotated, set its padding values, and (if it contains several panes)
define the panes' layout direction.

Elements
Add or remove secondary axes and panes.

Scroll & Zoom
Enable or disable a diagram's scrolling and zooming, and specify the scrolling and zooming options.



Charting 30

© 2014 DevExpress Inc. 30

Panes Page

Tasks

Customize panes properties.

Page Elements

Chart preview area
Previews a chart's layout.

Pane selector
Specifies a pane to be customized.

Options tabs
The following tabs are available on this page.

General
Determines whether the selected pane should be visible, specifies its name, size mode and size value.
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Appearance
Specifies a pane's background color and fill style, and its background image.

Border
Determines whether a pane's border should be visible, and defines its color.

Shadow
Determines whether a pane's shadow should be visible, and defines its color and size.

Scroll & Zoom
Enable or disable a pane's scrolling and zooming for specific axes.

Scroll Bars
If scrolling and/or zooming is enabled for an axis, adjust the scroll bars visibility, position and appearance.
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Axes Page

Tasks

Customize axes properties;

Customize the appearance of axis labels;

Add a constant line and a strip to an axis;

Enable automatic and manual scale breaks.

Page Elements

Chart preview area
Previews a chart's layout.
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Note that you can select an axis to be modified on the chart preview area directly.

Axis selector
Specifies an axis to be customized.

Options tabs
The following tabs are available on this page.

General
Specifies visibility, position, range and format properties.

Appearance
Defines color, thickness and interlacing options.

Elements
Customizes title, tickmarks and grid line properties.

Labels
Specifies position and text for automatically created labels, or allows custom labels to be defined.

Strips
Allows you to create strips, define their visibility, name, limits, appearance, etc.

Constant Lines
Allows you to create constant lines, define their visibility, name, value, legend text, appearance, title, etc.

Scale Breaks
Allows you to enable automatic and / or create custom scale breaks, and define their appearance.
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Series Views Page

Tasks

Customize the view-type-specific properties of series;

Customize the appearance and border settings of series;

Add or remove financial indicators (Fibonacci indicators, trendlines and regression lines).

Page Elements

Chart preview area
Previews a chart's layout.
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Note that you can select a series to be modified directly in the chart preview area.

Series selector
Specifies a series to be customized.

Options tabs
The following tabs are available on this page.

General
Specifies a series bar's width, distance, color, transparency, etc.

Appearance
Specifies a series color, transparency and fill style. Additionally, determines whether series points should
be painted individually.

Border
Determines whether a series border should be visible, and defines its color and thickness.

Shadow
Specifies whether a series' shadow should be visible, determines its color and size.

Indicators
Allows you to add or remove indicators of a required kind (Regression Line, Trend Line, Fibonacci Arcs,
Fibonacci Fans, Fibonacci Retracement and many others).



Charting 36

© 2014 DevExpress Inc. 36

Point Labels Page

Tasks

Resolve overlapping of point labels;

Customize the appearance of point labels.

Page Elements

Chart preview area
Previews a chart's layout.

Note that you can select point labels to be modified directly in the chart preview area.
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Series selector
Specifies a series to be customized.

Options tabs
The following tabs are available on this page.

General
Specifies whether labels should be visible and shown for zero values, determines their text and resolves
overlapping settings.

Point Options
Specifies point view, pattern and value format.

Line
Determines whether label lines should be visible, and specifies their appearance.

Appearance
Specifies the background color and fill style of labels.

Border
Determines whether label borders should be visible, and defines their color and thickness.

Shadow
Specifies whether a label's shadow should be visible, and defines its color and size.
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Chart Titles Page

Tasks

Create chart titles;

Enable the word-wrapping for lengthy chart titles;

Customize the appearance and position of chart titles.

Page Elements

Chart preview area
Previews a chart's layout.

Note that you can select chart titles to be modified in the chart preview area directly.
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Titles management section
Allows you to add or remove titles from the titles list, and choose a title to be customized.

Options tabs
The following tabs are available on this page.

Text
Sets a text for the selected chart title. Note that the basic HTML formatting is supported for chart titles.

General
Specifies a title's visibility, alignment and font options, and determines whether the word-wrapping is
enabled for a title.
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Legend Page

Tasks

Customize chart legend's properties.

Page Elements

Chart preview area
Previews a chart's layout.

Note that you can select the legend directly on the chart preview area.
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Options tabs
The following tabs are available on this page.

General
Specifies legend visibility, direction, alignment, spacing, limits and margins.

Appearance
Specifies legend background color and background image.

Marker
Specifies visibility and dimensions of legend markers.

Text
Specifies legend text antialiasing, color and font.

Border
Specifies visibility, color and thickness of legend borders.

Shadow
Specifies visibility, color and size of the legend shadow.



Charting 42

© 2014 DevExpress Inc. 42

Annotations Page

Tasks

Create and customize image and text annotations.

Page Elements

Chart preview area
Previews a chart's layout.
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Annotation selector
Specifies an annotation to be created and/or customized.

Note that you can select an annotation directly on the chart preview area.

Options tabs
The following tabs are available on this page.

General
Specify an annotation's name, adjust its visibility, z-order and layout.

Anchor Point
Choose an element to anchor to (chart, pane, or series point), and adjust the corresponding options.

Shape Position
Choose an annotation's shape position type (free or relative), and adjust the corresponding options.

Content
Depending on an annotation's type (text or image), specify its content.

Padding
Specify an annotation's inner indents.

Appearance
Adjust an annotation's background color, fill style, shape and connector options.

Border
Specify visibility, color and thickness of an annotation's borders.

Shadow
Specifies visibility, color and size of an annotation's shadow.
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Highlighting and Selection Chart Elements

If you are working with 2D charts, you can highlight and select different chart elements via the mouse or using
different gestures on your touchscreen device.

Highlighting

Any chart element that can be selected supports highlighting.

An end user can highlight a chart's area using either the drag gesture on your touchscreen device or via the
mouse pointer by hovering over a particular chart element, as shown in the image below.

Note

Chart element highlighting and selection is available only for 2D Chart Types.

Selection

To select a particular chart element, an end user should tap it on a device supporting touchscreen or click this
element using the left mouse button. The following image demonstrates how a constant line and a single series
are painted if selected by an end user with the mouse pointer.



Charting 45

© 2014 DevExpress Inc. 45

Selectable Elements

Chart elements which can be highlighted or selected are shown in the following illustration.
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Zoom a Chart

If you are working with 2D XY-charts (Bar, Line, Point, etc.) or 3D charts, you can zoom in or out of a chart. This
allows you to see some of the chart's data in greater detail, or get a more general picture of your data.

Note that zooming is unavailable for 2D Pie, 2D Doughnut, Radar, and Polar charts.

Zoom In a Chart

To zoom in a chart, do one of the following.

Hold down SHIFT and click.

After you press SHIFT, the mouse pointer is changed to . Then, move the mouse pointer to the chart
region to be zoomed into, and click (while holding SHIFT). The magnification factor is 300%.

Press SHIFT and select a region on a diagram.

After you press SHIFT, the mouse pointer is changed to . Then, select a zoomed region by dragging the
mouse pointer.

After releasing the left mouse button, a chart is zoomed into the bounds of the selected region on a
diagram.

Note

This feature is available for 2D charts only.

if you press SHIFT and can't zoom in anymore (the mouse pointer is changed to ), then a chart is
already zoomed in by 100 times (10000%). This is the maximum possible zoom factor allowed.

Use CTRL+PLUS SIGN.

In this case, the magnification factor is 120%.

Use the spread gestures on a touchscreen device.

An end-user can zoom in a chart's diagram performing spread gestures on any device supporting
touchscreen.

Use the mouse wheel.

In this case, the magnification factor is 120%.

Zoom Out of a Chart

To zoom out of a chart, do one of the following.

Hold down ALT and click.

After you press ALT, the mouse pointer is changed to . Then, move the mouse pointer to the region to
be zoomed out, and click (while holding ALT). The magnification factor is 300%.
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Use CTRL+MINUS SIGN.

In this case, the magnification factor is 120%.

Use the pinch gestures on a touchscreen device.

A chart's diagram can be zoomed out by performing pinch gestures on any device supporting touchscreen.

Use the mouse wheel.

In this case, the magnification factor is 120%.

Undo Zooming

Press CTRL+Z to return to the state before the first zoom operation in a series.
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Scroll a Chart

You can scroll a chart if either the axis visible range is reduced or a chart is already zoomed in (its zoom factor is
more than 100%). Since the entire chart is not visible at one time, it's possible to scroll a chart.

Scroll a 2D Chart

To scroll a 2D chart, do one of the following:

Hold down the left mouse button, and drag it.

After you hold down the left mouse button, the mouse pointer is changed from  to . Then drag the
mouse pointer to scroll the diagram.

Use scrollbars.

An end-user is able to click a scrollbar arrow, click the scrollbar near the thumb, or drag the thumb and
move it.

In this instance, a chart's diagram is scrolled in the same way as controls in used Windows applications.

Use flick gestures on a touchscreen device.

An end-user can scroll a diagram using flick gestures on a touchscreen device.

Use CTRL+ARROW combinations.

When an end-user presses CTRL + LEFT, a chart's diagram is moved to the left.
When an end-user presses CTRL + UP, a chart's diagram is moved to the top.
When an end-user presses CTRL + RIGHT, a chart's diagram is moved to the right.
When an end-user presses CTRL + DOWN, a chart's diagram is moved to the bottom.

Scroll a 3D Chart

An end-user can perform chart scrolling doing one of the following:

Hold down the mouse wheel button on a chart and drag it.

After you hold down the mouse wheel, the mouse pointer is changed from  to . Then drag the
mouse pointer to scroll a chart's diagram.

Use CTRL+ARROW combinations.

Use flick gestures on a touchscreen device.
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An end-user can scroll a diagram using flick gestures.
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Rotate a Chart

If you are working with 3D charts, you can rotate a chart's diagram. This may be required if a chart displays
multiple series or data points, and it's required to change the current rotation angle to view the chart data in
detail.

To rotate a chart control, do one of the following:

Hold down the left mouse button on the diagram and drag the mouse pointer.

After holding down the left mouse button, the mouse pointer is changed from  to . Then, drag the
mouse pointer to rotate the chart.

Use rotation gestures on a touchscreen device.

Touch a 3D chart's area with two fingers and move them in a clockwise or counterclockwise direction.
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Docking

In the Docking section, you will learn about the main runtime capabilities of the DocumentManager and
DockManager, which can be combined to create traditional docking UI applications (see the image below).

The main elements of the DocumentManager and DockManager components are Documents and Dock panels,
respectively. These objects are containers that display content and provide docking functionality you can drag
Documents and Dock Panels into a tab group, dock them to different application dock zones, make them floating
or auto-hidden, etc.

This section consists of the following topics.

Dock Panels

Documents
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Dock Panels

This topic describes the most common runtime operations for dock panels.

Docking Hints

Dock panels can be docked, floating or auto-hidden. To dock or undock a panel, simply click its header and drag
the panel. As you drag the panel over an application form, docking hints appear (see the figure below). Use these
hints to dock the panel to the desired position.

Docking hints are semi-transparent square elements that allow you to dock a panel to a form's edges, or to an
existing container as a tab, or between other docking elements. These hints are displayed separately or grouped
in a docking guide (e.g., in the form's central area). Finally, a docking zone is a semi-transparent preview of
exactly where your panel will be docked. This zone is displayed when you drag a panel into a docking hint, but
before you drop it.

Buttons

Dock panels have multiple state change buttons in their top right corner.

Close - closes the current panel.

Maximize/Restore - maximizes the panel to full-screen size, or restores it back to its original size.
Available only for floating panels.

Auto-hide/Dock - hides the panel, leaving only its header visible, or restores an auto-hidden panel back
to the docked state. Depending on the application settings, hidden panels are displayed either on mouse
hover or on click only. Available only for docked panels.

Pin - places the panel in the first tab position. Available only for panels docked as tabbed documents.

Context Menu



Docking 53

© 2014 DevExpress Inc. 53

Most docking operations are available from the panel's context menu, displayed on right-click. The figure below
illustrates the context menu for a docked panel.

For dock panels docked as tabbed documents, the context menu displays multiple additional items, which allow
you to pin the panel or start a new horizontal or vertical group within the docked area (see the image below).

Interoperability with Documents and Other Dock Panels

When dragging a dock panel, you can dock it to other dock panels. This will create a dock panel container that
presents both panels as tabs. Note that in addition to docking panels via docking hints, you can also drag them to
the tab header area. This allows you to instantly rearrange panels within the container (see the animation
below).
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Dock panels can be docked to both the dock panel docking areas (the form's edges) as well as to the tabbed
View. Documents, however, can only be docked within the tabbed View, and not to the docking areas.

Mouse Operations and Hotkeys

Double-click a docked panel's caption - undocks the panel and makes it floating. This does not work with
auto-hide panels.

Ctrl+Double-click a floating panel's caption - docks the floating panel to its previous docking position.

Esc while dragging a panel - cancels the dock operation and drops the panel at the current position.

Ctrl+Tab or Crtl+Shift+Tab - shows the Document Selector. See the Dock Panels topic to learn more
about the Document Selector.
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Documents

Document objects resemble dock panels and serve the very same goal - to host content within floating or tabbed
MDI windows. You can click a documents caption, and drag this document to dock or undock it in the same manner
as dock panels. However, there are certain differences between documents and dock panels.

View

While dock panels can be docked to any forms edge, documents can only be docked in a special area called a
tabbed View. When you drag a document, docking hints will tell you where this area is. The image below
illustrates a tabbed View within a tabbed MDI application.

Dock panels can also be docked into this area, but documents cannot be docked to auto-hide containers and form
edges.

Floating Document Container

As you can see from the image above, documents can be nested into a floating document container. If this feature
is enabled, it allows you to organize all of your floating documents in a single floating container (and avoid a
cluttered UI with multiple floating windows). If you want to dock your floating documents once again, simply drag
this container in the same manner in which you drag documents. Docking a floating container into a tabbed View
will dock all of the container's documents into this View. You can also rearrange within or drag individual
documents out of this container.

Tabbed Groups

Documents within a tabbed View can be docked to vertical or horizontal document groups. To do so, use the side



Docking 56

© 2014 DevExpress Inc. 56

docking hint when dragging a document, or right-click the document header and select the New Tab Group item in
the invoked context menu (see the figure below).

Document groups are divided by splitters. You can drag the splitter to resize the groups, as shown in the figure
below.

Document groups can display Next and Previous buttons, which allow you to scroll through tab headers when
there is not enough free space within the group to display all of the headers.
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Document groups within a View can either be arranged horizontally (side-by-side), or vertically (one above
another), but not in both directions simultaneously. If only one tabbed group exists, the View does not yet have
an orientation setting. After you start a new horizontal tab group, for example, the View becomes vertically
oriented, which means that all subsequent tab groups can only be arranged vertically. You can reverse the current
View orientation by right-clicking any tab group header and selecting the Arrange Tab Groups Vertically
(Horizontally) context menu item.

Navigation

To navigate through documents (and dock panels, if any exist), you can use the Document Selector, invoked via
the CTRL+Tab keyboard hotkey. This tool displays a small preview of each focused document (dock panel) and its
short description. You can see the Document Selector in the next image.

To quickly navigate through documents, you can also use the button in the group's top right corner.
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Finally, you can right-click a document group's header and select the Windows... item to display the Windows
dialog, which lists all currently opened documents and their paths (see the image below).

Mouse Operations and Keyboard Shortcuts

Double-click a docked document's caption - undock the document and make it floating.
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Ctrl+Double-click a floating document's caption - docks the floating document to its previous docking
position.

Ctrl+Tab or Ctrl+Shift+Tab - shows the Document Selector.
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Editors

This section describes the capabilities provided by the editor controls:

 

Topics in this section:

Working with Dropdown Editors

Editing Values, Selecting Text and Using the Clipboard

Editor Context Menu
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Working with Dropdown Editors

Open Editor's Dropdown

Do one of the following:

Focus the editor and press ALT+DOWN ARROW or F4.

Click the editor's dropdown button:

Close Editor's Dropdown

For all editors providing a dropdown, you can close the dropdown by pressing ALT+DOWN ARROW, ESC or F4.

If the calculator is displayed in the dropdown, it can be closed via CTRL+ENTER.

Dropdowns displaying lists of items can be closed by clicking an item with the mouse, or by selecting an item with
the keyboard and pressing ENTER.
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Editing Values, Selecting Text and Using the Clipboard

Select and Deselect Editor's Contents

To select all text within an editor, you can invoke the Editor Context Menu and choose Select All. To select a part
of the edit value, click on a position where the selection should start, drag the pointer to the end position and
then release the mouse button.

Additionally, the following keyboard shortcuts allow you to manage selections.

Shortcut Description

CTRL+A or F2 Select all within an editor.

SHIFT+ARROW Extends or shrinks the selection by one character.

CTRL+SHIFT+ARROW Extends or shrinks the selection by one word.

Clipboard Operations

Clipboard operations are supported for editors that support caret moving.

To copy selected text into the clipboard, do the following.

Press CTRL+C or CTRL+INSERT.

Open the Editor Context Menu and select Copy.

To paste text from the clipboard, do the following.

Press CTRL+V or SHIFT+INSERT.

Open the Editor Context Menu and select Paste.

To cut some text from an editor into the clipboard, do the following.

Press CTRL+X or SHIFT+DELETE.

Open the Editor Context Menu and select Cut.

Delete Selected Text

To delete the selected text within an editor, do one of the following:

Press DELETE or BACKSPACE.

Open the Editor Context Menu and select Delete.

Undo

To undo the last text editing operation, do one of the following:

Press CTRL+Z.

Open the Editor Context Menu and select Undo.

Note

After you've undone an operation, you can return to the previous edit value by executing the Undo command
once again.

Change Date/Time Values
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You can edit these values without opening the dropdown calendar. Position the caret at the portion of a date/time
value that needs to be changed. To increment the value, press UP ARROW. To decrement the value, press DOWN
ARROW. Or, use the mouse wheel.

Change Numeric Values

To increment a value, press UP ARROW. To decrement the value, press DOWN ARROW. Or, use the mouse wheel.

Change Values of Editors That Display Items in the Dropdown

To select the previous value, press UP ARROW. To select the next value, press DOWN ARROW. Or use the mouse
wheel.

To learn how to open and close dropdown windows, see Working with Dropdown Editors.

Edit Images

To copy, cut, paste, load and save images in image editors, right click the image and select the required command
via the context menu:
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Editor Context Menu

Text editors support a context menu providing common commands. To open the menu, right-click an editor.
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Expression Editor

Expression Editor

The Expression Editor allows you to edit various Boolean or regular expressions in controls:

In this editor, you can type an expression manually, or select functions, operators and operands using the editor's
controls.

An expression is a string that, when parsed and processed, evaluates some value. Expressions consist of column/
field names, constants, operators and functions. Column/field names must be wrapped with brackets. The
following are examples of regular expressions:

"[Quantity] *  [Un itPrice] *  (1  - [BonusAm ount])"
"[Firs tNam e] + ' ' + [Las tNam e]"

Boolean expressions:

"[Country] == 'USA'"
"[OrderDate] > #8/16/1994# AND [Quantity] > 20"

The Expression Editor supports numerous standard functions, allowing you to easily perform different string, date-
time, logical and math operations over data. You can access the available functions by selecting the Functions
category.
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See Also
Expression Operators, Functions and Constants
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Expression Operators, Functions and Constants

WinForms Controls > Expression Editor > Expression Operators, Functions and Constants

This topic lists operators and functions supported by the Expression Editor. It also provides information on how
constants can be specified in expressions.

Operators

Operator Description Example

+ Adds the value of one numeric
expression to another, or
concatenates two strings.

[FirstName] + ' ' + [LastName]
[UnitPrice] + 4

- Finds the difference between two
numbers.

[Price1] - [Price2]

* Multiplies the value of two
expressions.

[Quantity] * [UnitPrice] * (1 -
[BonusAmount])

/ Divides the first operand by the
second.

[Quantity] / 2

% Returns the remainder (modulus)
obtained by dividing one numeric
expression into another.

[Quantity] % 3

| Compares each bit of its first
operand to the corresponding bit
of its second operand. If either bit
is 1, the corresponding result bit is
set to 1. Otherwise, the
corresponding result bit is set to 0.

[Flag1] | [Flag2]

& Performs a bitwise logical AND
operation between two integer
values.

[Flag] & 10

^ Performs a logical exclusion on two
Boolean expressions, or a bitwise
exclusion on two numeric
expressions.

[Flag1] ^ [Flag2]

== Returns true if both operands have
the same value; otherwise, it
returns false.

[Quantity] == 10

!= Returns true if the operands do not
have the same value; otherwise, it
returns false.

[Country] != 'France'

< Less than operator. Used to
compare expressions.

[UnitPrice] < 20

<= Less than or equal to operator.
Used to compare expressions.

[UnitPrice] <= 20

>= Greater than or equal to operator.
Used to compare expressions.

[UnitPrice] > 30

> Greater than operator. Used to
compare expressions.

[UnitPrice] >= 30

In (,,,) Tests for the existence of a [Country] In ('USA', 'UK', 'Italy')
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property in an object.

Like Compares a string against a
pattern. If the value of the string
matches the pattern, result is true.
If the string does not match the
pattern, result is false. If both
string and pattern are empty
strings, the result is true.

[Name] Like 'An%'

Between (,) Specifies a range to test. Returns
true if a value is greater than or
equal to the first operand and less
than or equal to the second
operand.

[Quantity] Between (10, 20)

And Performs a logical conjunction on
two expressions.

[InStock] And ([ExtendedPrice]>
100)

Or Performs a logical disjunction on
two Boolean expressions.

[Country]=='USA' Or [Country]
=='UK'

Not Performs logical negation on an
expression.

Not [InStock]

Functions

Date-time Functions

Function Description Example

AddDays(DateTime, DaysCount) Returns a date-time value that is
the specified number of days away
from the specified DateTime.

AddDays([OrderDate], 30)

AddHours(DateTime, HoursCount) Returns a date-time value that is
the specified number of hours
away from the specified DateTime.

AddHours([StartTime], 2)

AddMilliSeconds(DateTime,
MilliSecondsCount)

Returns a date-time value that is
the specified number of
milliseconds away from the
specified DateTime.

AddMilliSeconds(([StartTime],
5000))

AddMinutes(DateTime,
MinutesCount)

Returns a date-time value that is
the specified number of minutes
away from the specified DateTime.

AddMinutes([StartTime], 30)

AddMonths(DateTime,
MonthsCount)

Returns a date-time value that is
the specified number of months
away from the specified DateTime.

AddMonths([OrderDate], 1)

AddSeconds(DateTime,
SecondsCount)

Returns a date-time value that is
the specified number of seconds
away from the specified DateTime.

AddSeconds([StartTime], 60)

AddTicks(DateTime, TicksCount) Returns a date-time value that is
the specified number of ticks away
from the specified DateTime.

AddTicks([StartTime], 5000)

AddTimeSpan(DateTime, TimeSpan) Returns a date-time value that is
away from the specified DateTime
for the given TimeSpan.

AddTimeSpan([StartTime],
[Duration])
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AddYears(DateTime, YearsCount) Returns a date-time value that is
the specified number of years
away from the specieid DateTime.

AddYears([EndDate], -1)

GetDate(DateTime) Extracts a date from the defined
DateTime.

GetDate([OrderDateTime])

GetDay(DateTime) Extracts a day from the defined
DateTime.

GetDay([OrderDate])

GetDayOfWeek(DateTime) Extracts a day of the week from
the defined DateTime.

GetDayOfWeek([OrderDate])

GetDayOfYear(DateTime) Extracts a day of the year from the
defined DateTime.

GetDayOfYear([OrderDate])

GetHour(DateTime) Extracts an hour from the defined
DateTime.

GetHour([StartTime])

GetMilliSecond(DateTime) Extracts milliseconds from the
defined DateTime.

GetMilliSecond([StartTime])

GetMinute(DateTime) Extracts minutes from the defined
DateTime.

GetMinute([StartTime])

GetMonth(DateTime) Extracts a month from the defined
DateTime.

GetMonth([StartTime])

GetSecond(DateTime) Extracts seconds from the defined
DateTime.

GetSecond([StartTime])

GetTimeOfDay(DateTime) Extracts the time of the day from
the defined DateTime, in ticks.

GetTimeOfDay([StartTime])

GetYear(DateTime) Extracts a year from the defined
DateTime.

GetYear([StartTime])

Now() Returns the current system date
and time.

AddDays(Now(), 5)

Today() Returns the current date.
Regardless of the actual time, this
function returns midnight of the
current date.

AddMonths(Today(), 1)

UtcNow() Returns the current system date
and time, expressed as
Coordinated Universal Time (UTC).

AddDays(UtcNow(), 7)

Logical Functions

Function Description Example

Iif(Expression, TruePart, FalsePart) Returns either TruePart or
FalsePart, depending on the
evaluation of the Boolean
Expression.

Iif([Quantity]>=10, 10, 0 )

IsNull(Value) Returns True if the specified Value
is NULL.

IsNull([OrderDate])

IsNull(Value1, Value2) Returns Value1 if it is not set to
NULL; otherwise, Value2 is
returned.

IsNull([ShipDate], [RequiredDate])



Expression Editor 70

© 2014 DevExpress Inc. 70

IsNullOrEmpty(String) Returns True if the specified String
object is NULL or an empty string;
otherwise, False is returned.

IsNullOrEmpty([ProductName])

Math Functions

Function Description Example

Abs(Value) Returns the absolute, positive
value of the given numeric
expression.

Abs(1 - [Discount])

Acos(Value) Returns the arccosine of a number
(the angle, in radians, whose
cosine is the given float
expression).

Acos([Value])

Asin(Value) Returns the arcsine of a number
(the angle, in radians, whose sine
is the given float expression).

Asin([Value])

Atn(Value) Returns the arctangent of a
number (the angle, in radians,
whose tangent is the given float
expression).

Atn([Value])

Atn2(Value1, Value2) Returns the angle whose tangent
is the quotient of two specified
numbers, in radians.

Atn2([Value1], [Value2])

BigMul(Value1, Value2) Returns an Int64 containing the full
product of two specified 32-bit
numbers.

BigMul([Amount], [Quantity])

Ceiling(Value) Returns the smallest integer that is
greater than or equal to the given
numeric expression.

Ceiling([Value])

Cos(Value) Returns the cosine of the angle
defined in radians.

Cos([Value])

Cosh(Value) Returns the hyperbolic cosine of
the angle defined in radians.

Cosh([Value])

Exp(Value) Returns the exponential value of
the given float expression.

Exp([Value])

Floor(Value) Returns the largest integer less
than or equal to the given numeric
expression.

Floor([Value])

Log(Value) Returns the natural logarithm of a
specified number.

Log([Value])

Log(Value, Base) Returns the logarithm of a specified
number in a specified Base.

Log([Value], 2)

Log10(Value) Returns the base 10 logarithm of a
specified number.

Log10([Value])

Power(Value, Power) Returns a specified number raised
to a specified power.

Power([Value], 3)

Rnd() Returns a random number that is
less than 1, but greater than or

Rnd()*100
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equal to zero.

Round(Value) Rounds the given value to the
nearest integer.

Round([Value])

Sign(Value) Returns the positive (+1), zero (0),
or negative (-1) sign of the given
expression.

Sign([Value])

Sin(Value) Returns the sine of the angle,
defined in radians.

Sin([Value])

Sinh(Value) Returns the hyperbolic sine of the
angle defined in radians.

Sinh([Value])

Sqr(Value) Returns the square root of a given
number.

Sqr([Value])

Tan(Value) Returns the tangent of the angle
defined in radians.

Tan([Value])

Tanh(Value) Returns the hyperbolic tangent of
the angle defined in radians.

Tanh([Value])

String Functions

Function Description Example

Ascii(String) Returns the ASCII code value of
the leftmost character in a
character expression.

Ascii('a')

Char(Number) Converts an integerASCIICode to a
character.

Char(65) + Char(51)

CharIndex(String1, String2) Returns the starting position of
String1 within String2, beginning
from the zero character position to
the end of a string.

CharIndex('e', 'devexpress')

CharIndex(String1, String2,
StartLocation)

Returns the starting position of
String1 within String2, beginning
from the StartLocation character
position to the end of a string.

CharIndex('e', 'devexpress', 2)

Concat(String1, ... , StringN) Returns a string value containing
the concatenation of the current
string with any additional strings.

Concat('A', ')', [ProductName])

Insert(String1, StartPosition,
String2)

Inserts String2 into String1 at the
position specified by StartPositon

Insert([Name], 0, 'ABC-')

Len(Value) Returns an integer containing
either the number of characters in
a string or the nominal number of
bytes required to store a variable.

Len([Description])

Lower(String) Returns String in lowercase. Lower([ProductName])

PadLeft(String, Length) Left-aligns characters in the
defined string, padding its left side
with white space characters up to
a specified total length.

PadLeft(String, Length, Char) Left-aligns characters in the PadLeft([Name], 30, '<')
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defined string, padding its left side
with the specified Char up to a
specified total length.

PadRight(String, Length) Right-aligns characters in the
defined string, padding its left side
with white space characters up to
a specified total length.

PadRight([Name], 30)

PadRight(String, Length, Char) Right-aligns characters in the
defined string, padding its left side
with the specified Char up to a
specified total length.

PadRight([Name], 30, '>')

Remove(String, StartPosition,
Length)

Deletes a specified number of
characters from this instance,
beginning at a specified position.

Remove([Name], 0, 3)

Replace(String, SubString2,
String3)

Returns a copy of String1, in which
SubString2 has been replaced with
String3.

Replace([Name], 'The ', ''

Reverse(String) Reverses the order of elements
within String.

Reverse([Name])

Substring(String, StartPosition,
Length)

Retrieves a substring from String.
The substring starts at
StartPosition and has the specified
Length..

Substring([Description], 2, 3)

Substring(String, StartPosition) Retrieves a substring from String.
The substring starts at
StartPosition.

Substring([Description], 2)

ToStr(Value) Returns a string representation of
an object.

ToStr([ID])

Trim(String) Removes all leading and trailing
SPACE characters from String.

Trim([ProductName])

Upper(String) Returns String in uppercase. Upper([ProductName])

Constants

Constant Description Description

String constants String constants must be wrapped
in apostrophes.
If a string contains an apostrophe,
the apostrophe must be doubled.

[Country] == 'France'
[Name] == 'O''Neil'

Date-time constants Date-time constants must be
wrapped in '#'.

[OrderDate] >= #1/1/2009#

True Represents the Boolean True
value.

[InStock] == True

False Represents the Boolean False
value.

[InStock] == False

? Represents a null reference, one
that does not refer to any object.

[Region] != ?
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See Also
Expression Editor
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Filter Editor

This section describes the capabilities provided by the Filter Editor, which allows users to visually build filters:

 

Topics in this section:

Filter Data via the Filter Editor

Examples of Using the Filter Editor
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Filter Data via the Filter Editor

Filter Editor

The Filter Editor is used to edit filter criteria. To create and customize filter criteria, use the  and  buttons
embedded into the control and context menus supported by the editor's elements:

Remarks

A filter condition group is a set of conditions combined by the same logical operator. The following filter expression
contains two groups combined by the logical OR operator: "([Product] = 'Chang' And [Quantity] > 20) Or ([Product]
In ('Tofu', 'Konbu') And [Quantity] < 100)". In the Filter Editor it's represented as follows:

For step-by-step examples of creating filter criteria, see Examples of Using the Filter Editor.

Add Conditions

To add a condition to a logical group, do one of the following:

Focus any condition within the group or the group's logical operator and then press INSERT or ADD on the
keyboard.

Click the  button for the group.

Click the group's logical operator and select Add Condition.

To add a condition or a group of conditions that have been copied to the clipboard, press CTRL+V or
SHIFT+INSERT. The new condition will be added to the focused group.
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Delete Conditions

To delete a condition, do one of the following:

Focus the condition and press DELETE or SUBTRACT.

Click the  button.

To delete a group of conditions, do one of the following:

Focus the group's logical operator and press DELETE or SUBTRACT

Click the group's logical operator and select Remove Group.

To delete all conditions, do one of the following:

Focus the topmost logical operator and press DELETE or SUBTRACT.

Click the topmost logical operator and select Clear All.

To cut a condition/group of conditions to the clipboard, focus this condition or the group's logical operator and
press CTRL+X or SHIFT+DELETE.

Clipboard Operations

To copy a condition or a group of conditions to the clipboard, focus this condition or the group's logical operator
and press CTRL+C or CTRL+INSERT.

To cut a condition or a group of conditions to the clipboard, focus this condition or the group's logical operator and
press CTRL+X or SHIFT+DELETE.

To paste a condition or a group of conditions from the clipboard to the focused group, press CTRL+V or
SHIFT+INSERT.

Change a Column in a Filter Condition

To change a condition's column, invoke the column list by doing one of the following:

Click the current column.

Focus the current column via the keyboard and press SPACE or ALT+DOWN ARROW.

Then, choose the required column from the list that will be invoked

Change an Operator in a Filter Condition

To change a condition's operator, invoke the operator list by doing one of the following:

Click the condition's current operator.

Focus the current operator via the keyboard and press SPACE or ALT+DOWN ARROW

Then, choose the required operator from the list that will be invoked

Edit a Condition's Value

To edit a condition's value, click the operand value and type text.

To activate the operand value's edit box without changing the value, click the value or focus the operand value via
the keyboard and press F2, SPACE, ENTER or ALT+DOWN

To close the active edit box, press ENTER.

To discard changes to the value and close the active edit box, press ESC.

Navigation

To focus a specific filter condition or a group's operator within the Filter Editor, do one of the following:

Click the target element.
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Use arrow keys to move focus via the keyboard.

See Also
Examples of Using the Filter Editor
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Examples of Using the Filter Editor

The Filter Editor allows you to filter data (display those records that meet specific requirements), by visually
constructing filter criteria in a straightforward graphical form.

The following sections demonstrate how to construct filter criteria using the Filter Editor.

How to Construct a Simple Filter Condition

Basically, filter conditions specify what data to select from a data source and display in a data-bound control. A
typical simple filter condition consists of three parts: the column/field name, operator and a value(s). For instance,
'[Discount] >= 0.05' is a simple filter condition, where '[Discount]' is a field name, '>=' is an operator and '0.05' is a
value. This condition when applied to a data-aware control will display records that have values in the Discount
column greater than or equal to 0.05. Here is how to create this condition via the Filter Editor (it's assumed that
the underlying data source contains the Discount column, otherwise, this column will not be accessible in the Filter
Editor's column list):

1.Invoke the Filter Editor.

To invoke the Filter Editor in a grid control, right-click any grid column's header and select the Filter
Editor option.

To learn how to invoke the Filter Editor for other controls, see corresponding sections in this
documentation.

2.The Filter Editor will pop up.

When invoking the Filter Editor for a grid control, if no filtering has yet been applied, the Filter Editor will
contain a new filter condition referring to the clicked column. If, for example, the Filter Editor has been
opened by right-clicking a Product Name column, it will look like the image below:

3.Select a column.

Now, to filter against the Discount column, click the condition's link displaying a column name ('Product
Name'). This will display the list of available columns. Select the Discount column in this list:
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4.Select a comparison operator.

To select the '>=' comparison operator, click the condition's operator link ('Equals') to display the list of
supported comparison operators and select the required operator:

The comparison operator list displays only those operators that are supported by the current column's
data type. For instance, the Discount column is of the numeric type, and the operator list doesn't display
the 'Begins with' operator and other operators that are related to strings.

5.Enter a value.

Now, click the value box and enter a comparison value ('0.05'):



Filter Editor 80

© 2014 DevExpress Inc. 80

6.Save changes.

Click OK or Apply, to filter data using the created filter condition. The grid will show the filter panel
displaying the current filter criteria:

The filter panel will contain the 'Edit Filter' button, which also allows you to invoke the Filter Editor.

How to Construct Filter Criteria with Multiple Conditions Joined by One Logical Operator

Filter criteria typically consist of two or more simple filter conditions combined by logical operators (AND, OR, NOT
AND, NOT OR). The following example shows how to construct filter criteria in the Filter Editor that consist of
multiple conditions combined by one logical operator. The "[ProductName] = 'Tofu' AND [Discount] >= 0.1 AND
[Quantity] > 99" filter expression contains three simple filter conditions combined by the AND operator. To
construct it, do the following:

1.Invoke the Filter Editor. When the Filter Editor is invoked for a grid control, the Filter Editor may display
an unfinished new filter condition:

2.Set the condition's operator to Equals and operand value to 'Tofu' (as described in the previous
section):

3.To add one more condition, press the  button next to the group's AND operator:
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This will create a new condition under the current one:

4.For the second condition, set the column to 'Discount', operator to '>=' and operand value to '0.1':

5.To add a third condition to the same group, click the  button again. Set the condition's column to
'Quantity', operator to '>' and operand value to '99'. Below is the result:

6.Click OK or Apply, to apply the created filter criteria.

How to Construct Filter Criteria Involving Different Logical Operators

Some filter criteria contain multiple logical (Boolean) operators combining simple filter conditions. For instance, you
want to see items whose price is under 10, and at the same time, the available quantity is also less than 10. At
the same time, you may also want to see those items whose price is over 10, while the available quantity is also
greater than 10.

The resulting condition will look like this:

(Price is less than 10 AND Quantity is less than 10) OR (Price is greater than 10 AND
Quantity is greater than 10)

This is how you can do this:

1.Invoke the Filter Editor.

2.Clear existing filter conditions (if any) by clicking the  button:
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3.Change the root logical operator to OR. To do this, click the current AND operator and select OR:

4.Add a new filter condition group by clicking the OR operator and selecting Add Group.

5.For the created condition, set the column to 'UnitPrice', operator to '<' and operand value to '10':

6.Click the  button to add a new condition to the current group:
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7.For the new condition, set the column to 'Quantity', operator to '<' and operand value to '10':

8.Add a new filter condition group. To do this, click the root OR operator and select Add Group.

9.For the condition within the created group, set the column to 'UnitPrice', operator to '>' and operand
value to '10':

10.Click the  button to add a new condition to the new group:
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11.For the new condition, set the column to 'Quantity', operator to '>' and operand value to '10':

12.Click OK or Apply, to apply the created filter criteria.

See Also
Filter Data via the Filter Editor
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Grid

This section describes the capabilities provided by the Grid control, which represents data in a tabular or card
form, supports data editing, sorting, grouping, filtering, summary calculation and many other features:

 

Data Editing

Edit Grid Cells

Add and Delete Grid Records

 

Data Presentation

Sort Grid Rows

Group Grid Rows

Filter Grid Data

Show Summaries (Totals) in Grids

 

Layout Customization

Expand and Collapse Rows and Cards in Grids

Hide and Display Grid Columns, Bands and Card Fields

Rearrange Grid Columns, Bands and Card Fields

Resize Cards in Grids

Resize Grid Columns, Bands and Card Fields

 

Selection and Navigation

Locate Grid Records

Navigate Through Grid Records

Select Grid Rows and Cards
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Data Editing

Add and Delete Grid Records

Add Records

Click the Append button within the Navigator control:

Delete Records

Click the Delete button within the Navigator control:
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Edit Grid Cells

Activate Cell Editor

Do one of the following:

Click a cell.

Focus a cell (for instance, via the keyboard), and press ENTER or F2.

Focus a cell and press any alpha-numeric key. The editor will be invoked and its contents will be replaced
with the pressed character.

Focus a cell and click the Navigator control's Edit button:

If a cell editor provides a dropdown, you can activate the editor and open its dropdown by pressing ALT+DOWN
ARROW or F4.

Select and Deselect Cell Text

Press F2 or CTRL+A.

Close Cell Editor and Accept Changes Made

Do one of the following:

Press ENTER.

Click the End Edit button within the Navigator control:

Click any other grid cell.

Focus any other control.

Discard Changes

To discard changes made in a cell press ESC.

To discard changes made in all cells in a row/card, do one of the following:.

Press ESC twice.

Click the Cancel Edit button within the Navigator control:

Open Cell Editor's Dropdown

Do one of the following:

Press ALT+DOWN ARROW or F4.

Click the editor's dropdown button:

Close Cell Editor's Dropdown
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For all editors providing a dropdown, you can close the dropdown by pressing ALT+DOWN ARROW.

If the calculator is displayed in the dropdown, it can be closed via CTRL+ENTER.

Dropdowns displaying lists of items can be closed by clicking an item with the mouse, or by selecting an item with
the keyboard and pressing ENTER.

Change Values

Change Date/Time Values

You can edit these cell values without opening the dropdown calendar. Position the caret at the portion of a date/
time value that needs to be changed. To increment the value, press CTRL+UP ARROW. To decrement the value,
press CTRL+DOWN ARROW.

Change Numeric Values

To increment the value, press CTRL+UP ARROW. To decrement the value, press CTRL+DOWN ARROW.

Change Values of Cells That Provide Dropdown Items

To select the previous value, press CTRL+UP ARROW. To select the next value, press CTRL+DOWN ARROW.

Note: this feature is not applicable to all editors.

Edit Images

To copy, cut, paste, load and save images in image editors, right click the image and select the required command
via the context menu:
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Data Presentation

Sort Grid Rows

Sort Data in Grid Views

To sort records by a column's values and replace existing sort conditions that are applied to the current or other
columns, click the target column's header, until an Up or Down Arrow icon is displayed within the header. The Up
and Down Arrows indicate ascending and descending sort orders respectively.

To sort records by a column's values while preserving existing sort conditions, do one of the following:

Click a column header while holding the SHIFT key down, until an Up or Down Arrow icon is displayed
within the header.

Right-click a column header and select Sort Ascending or Sort Descending from the context menu that
appears:

To remove sorting by a column, click a column header while holding the CTRL key down. You can also select Clear
Sorting from the column header context menu.

Sort Data in Card Views

To sort records by a card field's values and replace existing sort conditions that are applied to the current or other
fields:

1.Click the Customize button:
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2.In the Customization window that opens, click the Sort button that corresponds to the target card field:

To sort records by a card field's values while preserving existing sort conditions:

1.Click the Customize button.

2.In the Customization window that opens, click the Sort button that corresponds to the target card field,
while holding the SHIFT key down.

To remove sorting by a card field:

1.Click the Customize button.

2.In the Customization window that opens, click the Sort button that corresponds to the target card field,
while holding the CTRL key down.

Sort Data in Layout Views

To sort records by a card field's values and replace existing sort conditions that are applied to the current or other
fields, do the following:

1.Hover over the target card field within any card. The sort ( ) and filter buttons will appear.

2.Click the sort button until its image changes to a black arrow (  or ). These images indicate
ascending and descending sort orders respectively.

To sort records by a card field's values while preserving existing sort conditions:
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1.Hover over the target card field within any card. The sort and filter buttons will appear.

2.Hold the SHIFT key down and click the sort button until its image changes to a black arrow (  or ).

To remove sorting by a card field:

1.Hover over the target card field within any card. The sort and filter buttons will appear.

2.Hold the CTRL key down and click the sort button until its image changes to a gray arrow ( ).
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Group Grid Rows

Group Data

To group by a specific column, do one of the following:

Drag a column header from the column header panel to the group panel:

Right-click a column header and select Group By This Column from the context menu:

Ungroup Data

To ungroup data by a grouping column, do one of the following:

Drag a column header from the group panel to the column header panel:
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Right-click a grouping column's header and select UnGroup from the context menu:

To remove grouping by all columns, right click the group panel and select Clear Grouping from the context menu:

Change Group Order

To change group order, move a grouping column header to another position within the group panel:
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See Also
Expand and Collapse Rows and Cards in Grids
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Filter Grid Data

Invoke the Filter Dropdown List

In Grid Views, hover over the column header. Click the filter button ( ) within the column header that
appears.

In Card Views, click the Customize button and then click the Filter button corresponding to the target
column.

In Layout Views, hover over the target card field within any card. Click the filter button ( ) that appears.

Create a Simple Filter Condition

To select records that contain a specific value in a specific column/card field, do the following:

1.Invoke the filter dropdown list containing available filter values.

By default, if filtering is applied, the filter dropdown will only display the values which match the current
filter criteria. If the SHIFT key is pressed while opening the filter dropdown, all values will be listed (not
only those that match the current filter criteria).

2.Select the required filter value in the filter dropdown list:
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The filter dropdown list will be immediately closed, and the control will display the records which contain
the specified value in the specified column/card field.

If the filter dropdown list provides check boxes to the left of filter values, multiple values can be selected
(checked) simultaneously:

In this mode, click OK to close the filter dropdown list and apply the filter.

You can sequentially filter data against multiple columns using the method described above.

Use Microsoft Excel Style Custom Filter Dialog

To construct filter criteria involving up to two conditions, do the following:

Invoke the filter dropdown list (see above) and click Custom. This will invoke the Custom Filter Dialog,
allowing you to compare a column with one or two values:

Use Advanced Filter Editor Dialog

To invoke an advanced Filter Editor dialog, do one of the following:

Right-click any column's header and select Filter Editor:



Grid 97

© 2014 DevExpress Inc. 97

If the filter panel at the bottom of the grid control is visible, click the Edit Filter button:

The Filter Editor is also invoked when choosing the (Custom) item in a column's filter dropdown list, if the current
filter criteria applied to the column consists of three or more simple filter conditions, or if the filter criteria contain
advanced comparison operators such as "Is between" and "Is any of".

To learn how to work with the Filter Editor, refer to Filter Data via the Filter Editor.

Clear the Filter

To clear the filter applied to a specific column, do one of the following:

Invoke the filter dropdown list (see below) and click (All).

In Grid Views, right-click the column header and select Clear Filter:

To clear all filter criteria, click the Close Filter button within the Filter Panel:
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Disable/Enable the Filter

Click the Enable Filter button within the Filter Panel:

 

All trademarks and registered trademarks are the property of their respective owners.

See Also
Filter Data via the Filter Editor
Examples of Using the Filter Editor
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Filter Grid Data via Find Panel

The Find Panel provides an easy way of searching against visible columns/card fields. Displayed above the grid,
the panel contains a search box where you can type a search string.

Invoke the Find Panel

Ensure that no cell editor is active and press Ctrl+F.

or

In Grid Views, choose the Show Find Panel command from a column menu.

Search

Enter a search string in the search box. In most cases, rows are filtered automatically after a short while.

In some cases (mostly when the grid is bound to a large amount of data), you need to press the Find
button to manually start the search.

The search syntax is described below.
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Clear the Search Box

Press ESC or click the Clear button.

Close the Find Panel

Click the 'x' button to the left of the search box or:

If the search box is empty, press ESC (the shortcut is in effect if the search box has focus);

If the search box is not empty, press ESC twice (the shortcut is in effect if the search box has focus).

Search Syntax

In its simplest form, a search criterion consists of a single word. If you want to search for a string containing a
space character, specify this string in quotation marks. Without quotation marks, words separated by the space
character are treated as individual conditions.

You can search against a specific column by preceding a search string with the column's display name plus a colon
character.

ColumnDisplayName:SearchString

Instead of the complete name, it is possible to partially specify the display name, using the initial characters of a
column's display name. A search will be performed against the first column whose display name starts with the
specified substring. If you want to search against a column whose display caption contains space characters,
specify the column's display caption in quotation marks.

If the search string contains multiple conditions separated by space characters, and at least one condition defines
a search against a specific column, only records that match all of these conditions are shown (i.e., the conditions
are combined by the AND logical operator). If there is no column specification, records that match at least one of
these conditions are shown (i.e., the conditions are combined by the OR logical operator).

Precede a condition with "+" to display only records that match this condition. The "+" specifier allows you to
implement the logical AND operator. There should be no space character between the "+" sign and the condition.

Precede a condition with "-" to exclude records that match this condition from the result set. There should be no
space between the "-" sign and the condition.

Examples

Search Criteria Description

register Selects records that contain the "register" string in
any search column.

check register Dave Selects records that contain either "check" OR
"register" OR "Dave" strings in any search column.

"check register" Selects records that contain "check register" in any
search column.

screen +"Richard Fisher" Selects records that contain both "screen" AND
"Richard Fisher" in search columns.

Product:Tofu Seattle Selects records that contain "Tofu" in the column that
starts with "Product", AND also contain "Seattle" in
any search column.

data +entry -mark Selects records that contain both "data" AND "entry"
in search columns, excluding records that contain
"mark".

menu mask -file Selects records that contain "menu" OR "mask",
excluding records that contain "file".

From:Roller Subj:"currency mask" Selects records that contain "Roller" in the column
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that starts with "From", AND also contain "currency
mask" in the column that starts with "Subj".

import -From:Steve Selects records that contain "import" in any search
column, excluding records that contain "Steve" in the
column that starts with "From".

Note

Searches performed using a Find Panel are case insensitive.
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Show Summaries (Totals) in Grids

To change the type of summary for a specific column or apply a summary, do the following:

1.Right-click a region within a group footer or grid footer under a specific column:

A context menu displaying a list of supported summary types will be displayed:

2.Select the required option from the context menu.
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Layout Customization

Expand and Collapse Rows and Cards in Grids

Expand/Collapse Group Rows in Grid Views

To expand/collapse a group row, do one of the following:

Click the row's expand button:

Double-click the group row.

Double-click the indicator cell corresponding to the group row:

Focus the group row and press PLUS (to expand the row) or MINUS (to collapse the row).

Focus the group row and press RIGHT ARROW (to expand the row) or LEFT ARROW (to collapse the row).

To expand or collapse all group rows, right-click the group panel at the top of the control. This opens the group
panel context menu. Then select Full Expand or Full Collapse respectively:

Expand/Collapse Master Rows in Grid Views

To expand/collapse a master row, do one of the following:

Click the master row's expand button:
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Double-click the indicator cell corresponding to the master row:

Focus the master row and press CTRL+PLUS (to expand the row) or CTRL+MINUS (to collapse the row).

Expand/Collapse Cards in Card and Layout Views

Do one of the following:

Click a card's Expand button:

Click a card's caption and press PLUS (to expand the card) or MINUS (to collapse the card).
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Hide and Display Grid Columns, Bands and Card Fields

Hide Columns/Bands in Grid Views

Do one of the following:

Click a column header/band header and drag it onto the grid control's cell area, until the cursor changes
its image to a big 'X'. Then drop the header.

Drag and drop a column/band header onto the Customization Form if it's open:

Display Hidden Columns/Bands in Grid Views

1.Open the Customization Form by right-clicking a column header and selecting Column Chooser:
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The Customization Form will be displayed listing hidden columns and bands (if any):

2.Drag the required column/band from the Customization Form onto the column/band header panel and
drop it at a specific position.

Note

When a band is hidden together with its child bands and columns, headers of hidden children are not displayed
within the Customization Form.

Change the Visibility of Fields in Card Views

1.Click the Customize button:
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2.To hide specific fields, clear corresponding check boxes in the opened window. To display hidden items,
enable corresponding check boxes:

Change the Visibility of Fields in Layout Views

1.Click the Customization button within the header panel:

2.To hide a field, in the Layout View Customization Window, drag and drop the field from the Template
Card onto the Hidden Items list. To display a hidden field, drag it from the Hidden Items list onto the
Template Card at the required position:
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3.Click OK or Apply.
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Rearrange Grid Columns, Bands and Card Fields

Reorder Columns and Bands in Grid Views

To reorder columns, drag and drop a column header to a new position:

To reorder bands, drag and drop a band header to a new position:

Rearrange Card Fields in Layout Views
Do the following:

1.Click the Customization button displayed within the header panel:
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The LayoutView Customization window will open:

2.Rearrange fields using drag and drop, as required.

3.Close the Customization window to apply the changes.
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Resize Cards in Grids

Resize Cards in Card Views

In Card Views, to resize cards horizontally, drag card separators (if they are visible):

Resize Cards in Layout Views

In Layout Views, to resize cards do the following:

1.Click the Customization button displayed within the header panel:

The LayoutView Customization window will open:
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2.Resize the template card as required.

3.Close the Customization window to apply the changes.
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Resize Grid Columns, Bands and Card Fields

Resize Columns and Bands in Grid Views

To resize columns and bands, drag the right edge of the target column/band header:

To change a column's width so that it displays its contents compactly in their entirety, do one of the following:

Double-click the right edge of the column header.

Right-click the column's header and select Best Fit:

To change the widths of all columns so that they display their contents in the best possible way, right-click the
header of any column and select Best Fit (all columns).

Resize Card Fields in Layout Views

To resize cards or card fields do the following:

1.Click the Customization button displayed within the header panel:
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The LayoutView Customization window will open:

2.Resize the template card and/or fields within the template card as required.

3.Close the Customization window to apply the changes.
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Selection and Navigation

Locate Grid Records

In Grid Views, you can locate a data row by typing the initial characters of the values contained in this row.

To locate the nearest row that contains a specific value in a specific column, do the following:

Focus any cell in the column, against which a search will be performed.

Type the initial character(s) of the value to be located. The nearest row that contains the specified value
in the clicked column will be located.

To proceed with the search in the forward direction, press CTRL+DOWN ARROW.

To proceed with the search in the backward direction, press CTRL+UP ARROW.

To erase the previously typed characters in the search string, press BACKSPACE.
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Navigate Through Grid Records

Move Focus Between Rows and Cards

To move focus between cells and rows use the ARROW, TAB, HOME, END, PAGE UP and PAGE DOWN keys. Note
that the ARROW, HOME and END keys are used for navigation between rows/cards only when the focused cell is
not being edited. Othewise, these keys affect focus movement within the currently edited cell.

To focus the next cell, do one of the following:

Press TAB.

In Grid Views, press RIGHT ARROW. In Card Views and Layout Views, press DOWN ARROW. If a cell editor
is active, pressing RIGHT ARROW moves focus to the next cell if the caret is positioned at the end of the
current cell's text, or if the cell's text is selected in its entirety.

To focus the previous cell, do one of the following:

Press SHIFT+TAB.

In Grid Views, press LEFT ARROW. In Card Views and Layout Views, press UP ARROW. If a cell editor is
active, pressing LEFT ARROW moves focus to the previous cell if the caret is positioned at the beginning of
the current cell's text, or if the cell's text is selected in its entirety.

To focus the first cell within the current row in Grid Views, press HOME.

To focus the last cell within the current row in Grid Views, press END.

To focus the first row/card:

press CTRL+HOME in Grid Views.

press HOME or CTRL+HOME in Card Views and Layout Views.

To focus the last row/card:

press CTRL+END in Grid Views.

press END or CTRL+END in Card Views and Layout Views.

To move focus to the Auto Filter Row displayed at the top of a Grid View, do one of the following:

Click this row.

If a top data row is focused, press CTRL+UP ARROW.

Move Focus Away From the Grid Control

Press CTRL+TAB or CTRL+SHIFT+TAB.
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Select Grid Rows and Cards

Select Individual Rows/Cards

To select a row/card and clear the existing selection, do one of the following:

In Grid Views, click the row's indicator cell or any of its data cells:

In Card and Layout Views, click the card's caption or any of its data cells.

Select the row/card using the ARROW keys.

Select Multiple Rows or Cards

To select a row/card while preserving the current selection, do one of the following:

In Grid Views, click the row's indicator cell or any of its data cells, while holding the CTRL key down.

In Card and Layout Views, click the card's caption or any of its data cells, while holding the CTRL key
down.

To toggle the focused row's/card's selected state, do one of the following:

Press CTRL+SPACE.

Click the row/card while holding the CTRL key down.

To move focus between rows and cards while preserving the current selection, use CTRL+ARROW keyboard
shortcut (supported by Grid and Card Views).

Select a Range of Rows/Cards

To select all rows/cards, press CTRL+A (supported by Grid and Layout Views). Before pressing this shortcut,
ensure that the focused cell is not being edited

To select a continuous range or rows/cards, you can do the following

Use ARROW, PAGE UP, PAGE DOWN keys while holding the SHIFT key down.

To select all rows/cards between the currently focused row/card and another one, click the target row/
card while holding the SHIFT key down.

Note

If the SHIFT key is combined with CTRL, the previously selected rows/cards, if there are any, are not
unselected. If you use the SHIFT key alone, the previously selected rows/cards are unselected.

To select a continuous range of cards in Layout Views, drag with the mouse around cards that are to be
selected (marquee selection).

Copy Selected Records to the Clipboard

Press CTRL+C or SHIFT+INS.
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Layout Manager

This section describes the capabilities provided by the Layout Manager. It maintains a consistent layout of controls
within a form for you, so whenever you resize the form, the controls do not overlap. You can invoke customization
mode to temporarily hide specific editors, and then show them again, resize the controls, save and then restore
the layout, etc.

 

Layout Customization

Start Layout Customization

Finish Layout Customization

Hide and Display Elements using a Layout Manager

Change Element Layout

Resize Interface Elements

Add Empty Regions, Separators, Splitters and Labels

Change Text Label Options

Work with Interface Element Groups

Create and Delete Tabbed Groups

 

Save and Restore Layout

Save and Restore Interface Layout
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Layout Customization

Start Layout Customization

The layout of controls can be modified in customization mode. To invoke customization mode, right-click an empty
space within the Layout Manager and select Customize Layout:

As a result, the Customization Form opens a list of service items and currently hidden elements:

Now, you can modify the current layout using drag-and-drop and resizing operations and commands provided by
context menus. Context menus that can be invoked by right-clicking within the Layout Manager provide various
customization commands. Different commands are available depending upon the type of a layout item which has
been right-clicked (a regular control, a group or tabbed group).
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Finish Layout Customization

To finish customization, do one of the following:

Close the Customization form by clicking on its close button.

Right-click the form and select Hide Customization Form.
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Hide and Display Elements using a Layout Manager

To perform layout customization, first invoke Customization Mode. After customization has been completed, exit
customization mode.

Hide an Element

Do one of the following:

Right-click on the layout item and select Hide Item from the context menu:

Drag the layout item onto the Hidden Items list of the Customization Form.

Display a Hidden Element

Drag the required item from the Customization form's Hidden Items list onto the main form.
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Change Element Layout

To perform layout customization, first invoke Customization Mode. After customization has been completed, exit
customization mode.

Change Element Layout

To rearrange items within the form, use drag-and-drop operations.
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Resize Interface Elements

To perform layout customization, first invoke Customization Mode. After customization has been completed, exit
customization mode.

Resize Layout Items

To resize a layout item, drag the layout item's edge:

Lock Size

To lock a layout item's size, and prevent it from being resized (for instance, when the size of the container
changes), right-click on a layout item and select the Size Constraints | Lock Size menu command:
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Add Empty Regions, Separators, Splitters and Labels

To perform layout customization, first invoke Customization Mode. After customization has been completed, exit
customization mode.

Add Empty Regions

Empty regions enable greater control over element layout. They can be used, for example, if you want elements to
be aligned to the right or bottom edge of a resizeable container. To add an empty region, do one of the following:

Drag the Empty Space Item from the Customization form and drop at the required position on the form.

Right-click the Layout Control and select Create EmptySpace Item from the context menu:

A new empty region will be added at the bottom of the Layout Control. Then, drag this item to the
required position.

Add Splitters

To allow controls to be resized even when no customization is being performed, you can add a splitter between
these controls. To add a splitter, drag the Splitter item from the Customization form onto the main form.

Add Separators

A separator is just a line that allows you visually separate the Layout Control's areas. To add a separator, drag
the Separator item from the Customization form onto the main form.

Add Labels

To add a static text label to the Layout Control, do the following:

1.Drag the Label item from the Customization form onto the main form.

2.To rename the label, right-click the created label and select Rename from the context menu.
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Change Text Label Options

To perform layout customization, first invoke Customization Mode. After customization has been completed, exit
customization mode.

Rename Labels

To rename a layout item's text label, right-click the item and select Rename from the context menu.

To rename a group, right-click the group's caption and select Rename.

Change a Label's Visibility

To hide a layout item's text label or a group's caption, right-click the item/group and select Hide Text from the
context menu.

To display a layout item's hidden text label or a group's hidden caption, right-click the item/group and select Show
Text.

Change a Label's Position

To change the position of an item's label or a group's caption, right-click the item/group to open the context menu.
Then, select Text Position and the required command from this submenu.
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Work with Interface Element Groups

To perform layout customization, first invoke Customization Mode. After customization has been completed, exit
customization mode.

Combine Layout Items into Groups

1.Select a layout item that is to be added to a new group by clicking it.

You can select multiple items simultaneously by clicking them while holding the SHIFT key down.

2.Right-click any of the selected layout items and select Group from the context menu:

Note that only adjacent selected layout items can be combined into a group, and only if the region
occupied by them forms a rectangle. Otherwise, the Group command is not available when right-clicking
the selection.

As a result, a new group is created:

You can subsequently rename the group and customize its contents using drag-and-drop and context menus if
required.

Rename Groups

Do the following:

1.Right-click the group's caption and select Rename:
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2.Type a new name and press ENTER.

Change Group Content

To customize the layout of controls within a group, use drag-and-drop.

Ungroup Elements

To ungroup elements, right-click the group's caption and select Ungroup:
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Create and Delete Tabbed Groups

To perform layout customization, first invoke Customization Mode. After customization has been completed, exit
customization mode.

Combine Layout Items into a Tab Control

1.Select a layout item that is to be added to a tab control by clicking it.

You can select multiple items simultaneously by clicking them while holding the SHIFT key down.

2.Right-click any of the selected layout items and select Group from the context menu:

Note that only adjacent selected layout items can be combined into a group, and only if the region
occupied by them forms a rectangle. Otherwise, the Group command is not available when right-clicking
the selection.

As a result, a new group is created:

3.Right-click the group's caption and select Create Tabbed Group.
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This creates a tab control with one tab displaying the contents of the original group.

You can subsequently rename the created tab and customize the contents of tab pages using drag-and-drop and
context menus, if required.

Combine Groups into a Tab Control

To transform a group into a tab control, right-click the group's caption and select Create Tabbed Group.

To add a group as a tab page to an existing tab control, drag the group's caption onto the tab control's header
area.

Rename Tab Pages
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Do the following:

1.Right-click a tab header and select Rename:

2.Type a new name and press ENTER.

Customize Tabbed Groups

To customize the layout of controls and the order of tab pages within a tab control , use drag-and-drop.

Ungroup Tabbed Groups

To disassemble a tab control into regular groups, right-click the tab control's header area and select Ungroup
Tabbed Group.

As a result, the tab control will be destroyed and all its tab pages will be displayed as regular groups, one below
another.
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Save and Restore Layout

Save and Restore Interface Layout

You can save the current layout of controls to an XML file, and subsequently, restore it.

Save the Layout of Controls

1.Invoke Customization mode.

2.In the Customization form that opens, click the Save Layout button ( ).

3.The Save As dialog will appear. It allows you to specify the XML file to which the layout is to be saved.

Load a Layout of Controls

1.Invoke Customization mode.

2.In the Customization form that opens, click the Load Layout button ( ).

3.The Open File dialog will appear. It allows you to specify the XML file from which the layout is to be
loaded.
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Map

The section describes capabilities provided by the Map control. The following topics are available.

Scrolling

Zooming

Selection

Using the Search Panel
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Scrolling

The following operations can be performed by end-users to scroll a map.

Action Effect

Hold down the
left mouse
button and
drag it.

When an end-user holds down the left mouse button, the mouse pointer changes from  to

. Move the mouse pointer by holding down the left mouse button. The map is scrolled in
the same direction as the mouse pointer is moved.

Use the arrows
in the map
navigation
panel.

An end-user can scroll a map in four directions by clicking the arrows in the map navigation
panel. For example, to move east, use the right arrow in the navigation panel. 

Use the
"Arrow" keys
(LEFT, UP,
RIGHT or
DOWN).

If an end-user presses the LEFT arrow key, the map is moved west.
If an end-user presses the UP arrow key, the map is moved north.
If an end-user presses the RIGHT arrow key, the map is moved east.
If an end-user presses the DOWN arrow key, the map is moved south.

Use flick
gestures on a
touchscreen
device.

An end-user can scroll a map using flick gestures on a touchscreen device.



Map 135

© 2014 DevExpress Inc. 135

Zooming

The following operations can be performed by end-users to zoom in to or out of a map.

Action Effect

Use the 
Plus or
Minus
symbols
in the
map
navigatio
n panel

Click the Plus or Minus symbols in the map navigation panel.

Use the
track bar
slider in
the map
navigatio
n panel

Select the track bar slider in the map navigation panel by hovering the mouse cursor over the
slider. Drag the track bar slider to the right (zoom in) or to the left (zoom out) in the map
navigation panel. To stop zooming, release the left mouse button. Note that a tooltip that displays
the current zoom level appears below the track bar slider.

Drag an
area on
the map
while
holding
the Shift
and Ctrl
keys

Hold the Shift and Ctrl keys, and the left mouse button. Then, drag the mouse pointer. This draws
a rectangle on the map that corresponds to the map zoom region. To zoom into the specified
rectangular area, release the left mouse button.
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Use the "
+" or "-"
keys

If the "+" key is pressed, the map is zoomed in.
If the "-" key is pressed, the map is zoomed out.

Use the
mouse
wheel

Scroll the mouse wheel to zoom in to and out of a map.

Use the
spread or
pinch
gesture
on a
touchscre
en device

Zoom in to or out of a map by performing a spread or pinch gesture on any touchscreen device.
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Selection

To select a map item, do one of the following:

Tap a map item on a touchscreen device;

Hover over a map item with the mouse pointer and click it.

To select multiple map items, do the following:

Hold the Shift key and the left mouse button;

Drag the mouse pointer, to mark an area that includes the desired map items;

Release the left mouse button. All map items within the area will be selected.
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Using the Search Panel

This document explains how to use a search panel in the Map control.

The Search Panel is a UI element that accepts text input and displays the results of a search request returned by
the search service.

The Search Panel allows you to find a location on the map and see the search results for a request in the panel.
To learn how to enable search in the map control, see the Search topic.

To start a search, type a place name ("Texas", for example) in the panel. The result is shown in the image below.

To cancel a request, click the delete ( ) icon on the right side of the panel.

Notice that the map pushpin only shows the "Houston, TX" location on the map. Note, however, that the search
result also displays the Show others item, which means that the Microsoft Bing Search service found alternative
results for this request.

Click the Show others... option to see the other search results.
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Other search results ("Texas, Heard Co., GA", "Texas, QLD, Australia", etc.) will be displayed along with the Show
best result option.

To see only "Houston, TX", click Show best result in the Search panel.
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Mini Map

The Mini Map provides a complete overview of the map, as well as additional information about the current map
viewport, and allows you to navigate to different map regions.

The mini map supports the following behavior modes.

Fixed

When a mini map operates in fixed behavior mode, its center point and zoom level are fixed. The following image
demonstrates fixed behavior mode.

Note that center point of the mini map stays the same when the map's center point changes, as well as the zoom
level.

Dynamic

In a dynamic behavior mode, mini map settings are changed according to the zoom level and center point of the
owner map. The following image demonstrates dynamic behavior mode.

Note that center point of the mini map is changing depending on the map's center point, as well as the zoom
level.
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Navigation Bars

This section describes the capabilities provided by the Navigation Bars.

 

Topics in this section:

Navigation Pane

Navigation Bar
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Navigation Pane

Expand Groups

A Navigation Pane displays only one group at a time. Other groups are collapsed and their buttons are displayed
at the bottom or in the Overflow panel. You can use the horizontal splitter to control the number of group buttons
shown outside of the Overflow panel.

To activate a group, click its caption button.

Minimize the Navigation Pane

To minimize the Navigation Pane, click the Minimize button:

Display the Contents of the Minimized Navigation Pane

To display the contents of a minimized Navigation Pane, you can restore it to its normal state, or display its
contents while it's in the minimized state.

To restore the minimized Navigation Pane to its normal size, click the Maximize button:
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To display the contents of the Navigation Pane when it's in the minimized state, click the current group's button:

To display the contents of the group that is currently hidden, do the following:

1.Click the dropdown button at the bottom of the Navigation Pane:

2.Select the required group in the menu that opens:
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3.Click the current group's button:
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Navigation Bar

Expand Groups in the Navigation Bar That Can Display Multiple Groups at One Time

Windows Explorer Bar style navigation bars can display multiple groups at one time, as in the image below:

To collapse a specific expanded group, click the expand button within the group's header:

To expand a specific collapsed group, click the collapse button:

Expand Groups in the Navigation Bar That Displays One Group at a Time

To expand a specific collapsed group, click the group's button. The previously opened group will be collapsed.
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PDF Viewer

This section describes the capabilities of the PDF Viewer.

The PDF Viewer used to displaying PDF files and supports various document content such as text, images, vector
graphics, etc.

The following sections are available in this guide.

Manage Documents and Files

Print Documents

Navigate through the Document Content

Adjust the Document View

Select and Copy the Document Content
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Manage Documents and Files

This document describes how to open and save PDF files using the PDF Viewer.

This topic consists of the following sections.

Open a PDF File

Save a PDF File

Open a PDF File

To open a document for viewing, click the Open button, or press Ctrl+O.

In the invoked dialog, choose a PDF file and click Open.

Save a PDF File

If you need to save your PDF file to disk, click the Save As button, or press Ctrl+S.
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In the invoked Save As dialog, locate the folder where you want to store your file, enter the document's name
and click Save.

Your document will be saved with the .pdf file extension.
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Print Documents

To print the current document, click the Print command located on the File toolbar button group, or press CTRL+P
.

In the invoked standard Print dialog, choose the printer, specify the printing parameters and click OK.

Alternatively, to invoke the Print dialog, right-click the document area and select the Print...  item in the context
menu.
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Navigate through the Document Content

This document provides information on using the PDF Viewer user interface to navigate through the document
content.

The topic consists of the following sections.

Navigate Between Pages

Use the Hand Tool

Navigate Between Viewes

Search for a Specific Text

Navigate Between Pages

To navigate between pages, use the scrollbars or navigation buttons Previous and Next on the toolbar. These
buttons allow you to switch to the previous or next page of a document.

The main navigation buttons are in the Navigation button group of the PDF Viewer tab.

Use the Hand Tool

The Hand Tool enables you to scroll content by dragging the document instead of using scrollbars.

To activate the Hand Tool, right-click the viewing document and select the Hand Tool  item in the context menu.

Then, after you click a document's page, the mouse pointer is changed from  to . Drag the mouse pointer to
scroll the document.

Navigate Between Views

To switch between viewed pages in the document quickly, right-click this document and select the Previous View

 or Next View  item in the invoked context menu. The pages you viewed are shown in the reverse order in
which you viewed them.
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Alternatively, press Alt+Left or Alt+Right.

Search for a Specific Text

To search for a specific text within a document, click the Find button on the toolbar.

Otherwise, to invoke the Find dialog, right-click the document and select the Find  item in the context menu, or
press Ctrl+F.

In this dialog, you can input the text to find, and specify whether to match case or the whole word during the
search. Click the Previous and Next buttons to set the search direction.
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To start searching or search again, click the Previous or Next button, or press ENTER.
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Adjust the Document View

This topic describes the features that adjust the view in the PDF Viewer.

The document consists of the following sections.

Rotate a Document

Zoom In and Out of a Document

Use a Specific Zoom Factor

Rotate a Document

To rotate a document, use the following commands.

Rotate Clockwise

Rotates the document clockwise through 90 degrees. To perform this command, right-click the viewed
document and choose the Rotate Clockwise  item.

Rotate Counterclockwise

Rotates the document counterclockwise through 90 degrees. To do this, invoke the context menu by
right-clicking the document and choose the Rotate Counterclockwise  item.

Zoom In and Out of a Document

Use buttons from the Zoom button group of the PDF Viewer tab.

To zoom in a document, click the Zoom In button on the toolbar, or press CTRL+PLUS SIGN.

To zoom out of a document, click the Zoom Out button on the toolbar, or press CTRL+MINUS SIGN.

To zoom in or out of a document, you can also hold down CTRL and rotate the mouse wheel.

Use a Specific Zoom Factor

To zoom to a specific zoom factor, ?lick the Zoom dropdown list button. The following list will be invoked.
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Choose the percentage value of the zoom factor or one of the following zoom factor presets.

Actual Size

Sets the document zoom factor value to 100%.

Zoom to Page Level

Sets the document zoom factor value to fit the entire page height.

Fit to Width

Sets the document zoom factor value to fit the entire page width.

Fit to Visible

The document zoom factor is calculated to fit the actual content of a page (if possible).
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Select and Copy the Document Content

The PDF Viewer provides for selecting and copying text from the selectable document to the clipboard. Note that
only plain text copying is supported.

To enable the selection mode, invoke the context menu and choose the Select Tool item. This mode is active by
default.

To copy the viewing document content, select the required text, right-click the selected text and select the Copy
command in the context menu, or press Ctrl+C.

To select all the text in a document for copying, invoke the context menu and choose the Select All  command,
or press Ctrl+A.
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View Document Properties

To view information related to the currently opened document, invoke the context menu by right-clicking this
document and selecting Document properties... item.

The dialog displaying the standard set of the PDF file properties is invoked.
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Pivot Table

This section describes the capabilities provided by the Pivot Table, which represents data in a cross-tabulated
form.

 

Data Editing

Edit Data in Pivot Tables

Describes how to edit cell values and regular expressions used to calculate these values.

 

Data Presentation

Sort Data in Pivot Tables

Describes how you can sort field values alphabetically or by summary values displayed in a particular
column or row.

Filter Data in Pivot Tables

Provides information on how to filter data by hiding specific rows or columns via filter drop-down lists, and
how to provide a more advanced filtering by building a complex filter condition.

Change Summary Type in Pivot Tables

Describes how to specify which calculations Pivot Table should perform against its data.

 

Layout Customization

Expand and Collapse Groups in Pivot Tables

Provides information on how to expand and collapse field values and field headers.

Hide Pivot Table Fields

Guides you through the process of hiding Pivot Table fields.

Display Hidden Pivot Table Fields

Describes how to display fields that have previously been hidden.

Reorder Pivot Table Fields

Provides information on how to reorder Pivot Table fields.
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Selection and Navigation

Select Cells in Pivot Tables

Describes how to select a single or multiple cells and copy their contents to the clipboard.

 

Field List

Field List Overview

Provides basic information about Field Lists.

Invoke a Field List

Describes how to invoke a Field List.

Defer Pivot Table Updates

Describes how to prevent automatic Pivot Table updates and force it to update manually.

Change Field List Layout

Provides information on how to change the layout of an advanced Field List.
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Data Editing

Edit Cell Values

To edit a cell value, click the cell and specify a new value:

Cell values are specified via editors of different types (e.g. text editor, calculator, etc.), depending on the cell data
type and pivot table settings.

Edit Expressions

Specific columns allow you to set a regular or Boolean expression which will be used to calculate their values.
Clicking the column header invokes the Expression Editor used to specify the expression:
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To learn more about using the Expression Editor, see Expression Editor.
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Data Presentation

This section describes how you can customize data presentation in Pivot Tables.

The following sections are available.

Sort Data in Pivot Tables

Describes how you can sort field values alphabetically or by summary values displayed in a particular
column or row.

Filter Data in Pivot Tables

Provides information on how to filter data by hiding specific rows or columns via filter drop-down lists, and
how to provide a more advanced filtering by building a complex filter condition.

Change Summary Type in Pivot Tables

Describes how to specify which calculations Pivot Table should perform against its data.
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Sort Data

This section describes the Pivot Table capabilities used to sort its data by field and summary values.

Topics in this section:

Simple Sorting

Provides information on how to sort data by field values.

Sort Data Using the Context Menu

Describes how to use the context menu to sort data.

Sort Data Using a Field List

Describes how to use a Field List to sort data.

Sort Data by Summaries

Describes how to sort data by column or row values.
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Simple Sorting

Values of dimension fields are always arranged in ascending or descending order. The sort order is indicated by
an Up or Down arrow displayed within a corresponding dimension field's header.

To toggle the sort order for a dimension field, click this field's header.

You can also sort field values using a Field List or context menu. To learn more, see Sort Data Using a Field List
and Sort Data Using the Context Menu.
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Sort Data Using the Context Menu

Depending on the Pivot Table settings made by your application vendor, you may be able to sort data using the
context menu.

If the corresponding functionality is enabled, the context menu invoked when you right-click a field header
contains the Sort A-Z, Sort Z-A and Clear Sorting items.

Select Sort A-Z to set ascending sort order, and Sort Z-A to set descending order.

To reset sort order to the default one, select Clear Sorting.

See Also
Simple Sorting
Sort Data Using a Field List
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Sort Data Using a Field List

You can use an advanced Field List to sort field values (to learn more about Field Lists, see Field List Overview).

First, invoke a Field List. For information on how to do this, see Invoke a Field List.

To toggle the sort order of a field, click its header.
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You can sort data without using a Field List. To learn more, see Simple Sorting and Sort Data Using the Context
Menu.
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Sort Data by Summaries

You can sort values of a particular dimension field by summary values calculated against a specific data field. To do
this, right-click a column or row header, and choose a dimension field whose values should be sorted by column/
row summary values. A specific indicator marks the column/row whose summary values are used to define the sort
order.

You can sort values of multiple dimension fields against a single column/row. To cancel this sorting, click the same
item again, or 'Remove All Sorting' to cancel sorting for all dimension fields.
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Filter Data

By default, the Pivot Table processes all records when calculating its values. Data filtering allows you to process
only those records that meet your requirements.

Topics in this section describe three ways of filtering data in Pivot Tables - filtering by field values, filtering by cell
values and building complex filter criteria.

The following sections and topics are available.

Filter Data by Field Values

Contains topics that describe how to specify simple filter conditions via Filter Windows.

Filter Data by Cell Values

Contains topics that describe how to specify which cell values to display and which to hide.

Build Complex Filter Criteria

Describes the Prefilter feature that allows you to build complex filter criteria.
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Filter Data by Field Values

Filter Popup Windows allow you to configure and apply simple filtering conditions by selecting which values you
wish to view, and which you do not.

Topics in this section describe how to invoke, use and customize Filter Windows.

The following topics are available:

Invoke a Filter Popup Window

Shows how to invoke Filter Windows from the Pivot Table and a Field List.

Using Filter Popup Windows

Describes how to build filter conditions in Filter Popup Windows.

Filtering Options

Acquaints you with filtering options provided by the Pivot Table and describes how you can access these
options via a specially designed toolbar.
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Invoke a Filter Popup Window

You can invoke a Filter Window from the Pivot Table or from a Field List (to learn about Field Lists, see Field List
Overview).

Invoke a Filter Window from the Pivot Table

Field headers display special buttons used to invoke a Filter Window. Follow the steps below:

1.Hover over the header of a field whose data you need to filter. A filter button (the  icon) will be
highlighted.

2.Click this filter button to display a Filter Window.

Invoke a Filter Window from a Field List

You can use an advanced Field List to filter field values.
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First, invoke a Field List. For information on how to do this, see Invoke a Field List.

To open a Filter Window, click the filter button displayed in the field header.
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Using Filter Popup Windows

Depending on the settings made by your application vendor, the Pivot Table can display an individual Filter
Window for each field, or an integrated Filter Window for a group of fields.

This topic describes how to filter data using both types of Filter Windows.

Simple Filter Window

A simple Filter Window allows you to hide visible and show previously hidden values of a particular field.

In the Filter Window, uncheck field values that should be hidden and check values that should be visible. Then,
click OK to close the window and apply the filtering.

Note that you can customize Filter Window settings using the toolbar displayed at the top of the window. To learn
how to do this, see Filtering Options.

Hierarchical Filter Window

A hierarchical Filter Window displays values of several fields, arranged in a tree-like manner.

In the Filter Window, uncheck field values that should be hidden and check values that should be visible.

Use the  buttons to expand field values and access their child values. To collapse an expanded field value and
hide its child values, use the  button.

You can also expand and collapse all values on a particular level. To do this, right-click any field value and select 
Collapse All or Expand All from the context menu.

For instance, to expand all quarters and display months, right-click any quarter value and select Expand All from
the context menu as shown on the image below.
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Click OK to close the window and apply the filtering.

Note that you can customize Filter Window settings using the toolbar displayed at the top of the window. To learn
how to do this, see Filtering Options.

Filtering Indication

You can determine whether a field is filtered by looking at its header. Filter buttons for these fields are visible
even when you are not hovering over their headers.

Removing Filtering

To remove filtering against a specific field, invoke its Filter Window and select (Show All).
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Filtering Options

The Pivot Table allows you to customize its filtering mechanism according to your needs.

If the corresponding functionality is enabled by your application vendor, Filter Windows display toolbars where
you can access various filtering options.

Use the toolbar buttons to enable or disable particular options.

The following table describes the available toolbar buttons.

Show Only Available Items If this button is pressed, values
that cannot be displayed because
of filtering applied to other fields
are hidden from Filter Windows.
This button is not available for 
Hierarchical Filter Windows.

Show New Field Values If this button is pressed, field
values that have appeared in the
database after the field's filtering
was configured are shown by
default.
If this button is released, new field
values are hidden by default. To
view these values, check them
manually in the corresponding Filter
Window.

Incremental Search If this button is pressed, the
Incremental Search feature is
enabled. This feature allows you to
locate a value in the Filter Window
by typing its initial characters.

Multi-Selection If this button is pressed, you can
select multiple values by
sequentially clicking them with the
CTRL key held down (or the SHIFT
key to select a continuous range of
values). In this instance, a field
value is selected when you click its
name, and checked (or unchecked)
when you click a corresponding
check box. When you click a check
box with multiple values selected,
this changes the checked state of
all selected values.
If this button is released, you
cannot select multiple values. In
this instance, a field value is
selected and checked (or
unchecked) when you click either
its name or a corresponding check
box.

Radio Mode If this button is pressed, Filter
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Windows hide check boxes and
display field values in a simple list.
In this instance, you can select and
view only one value from each field
in the Pivot Table.

Invert Filter Inverts the checked state for all
values.
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Filter Data by Cell Values

The Pivot Table allows you to filter data by specifying a range of cell values that should be displayed. Values that
do not fall into this range will be hidden.

Topics in this section describe how to configure filtering by cell values (or summary filtering).

The following topics are available.

Invoke a Summary Filter Window

Describes how to invoke a Summary Filter Window used to enable and configure filtering by cell values.

Select a Range of Values

Shows how to specify a range of cell values that should be displayed.

Move the Selected Range

Demonstrates how to select another range with the same length by moving the selection.

Zoom and Move the Viewport

Describes how to zoom and scroll the range selector.

Specify Target Cells

Shows how to enable filtering by Total and Grand Total cells.

Remove Filtering

Describes how to disable filtering.
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Invoke a Summary Filter Window

To enable and configure filtering by cell values, use the Summary Filter Window.

You can invoke a Summary Filter Window from the Pivot Table or from a Field List (to learn about Field Lists, see 
Field List Overview).

Invoke a Summary Filter Window from the Pivot Table

Field headers located in the Data Area display special buttons used to invoke a Summary Filter Window. Follow
the steps below.

1.Hover over the header of a field whose data you need to filter. A filter button ( ) will be highlighted.

2.Click this filter button to display a Summary Filter Window.

Invoke a Summary Filter Window from a Field List

You can use an advanced Field List to filter field values.
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First, invoke a Field List. For information on how to do this, see Invoke a Field List.

To open a Summary Filter Window, click the filter button displayed in the field header.
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Select a Range of Values

You can select a range of cell values to be displayed in any of the following ways.

Enter the bounds of the range into the appropriate text editors.

Drag selection thumbs in the range selector.

If a range is already selected, you can select a different range with the mouse.
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Move the Selected Range

To move a selection, do one of the following.

Drag the selection by any point within it.

Drag a selection scroll thumb displayed within the Zoom & Scroll Bar.
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Zoom and Move the Viewport

Zoom

You can zoom in or out by shrinking or enlarging a viewport scroll thumb displayed within the Zoom & Scroll Bar.

To zoom in, drag a zoom grip inwards. To zoom out, drag a zoom grip outwards.

Move Viewport

To move the viewport, drag a viewport scroll thumb.
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Specify Target Cells

Filtering by cell values is applied only to regular cells by default. You can change this behavior and apply it to Total
or Grand Total cells. To do this, check the Apply to specific level check box, and select column and row fields that
identify the desired Total or Grand Total cells.
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Remove Filtering

To remove filtering, click the Clear button.
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Build Complex Filter Criteria

To build complex filter criteria consisting of multiple filter clauses using various filter operators, you can use a
Prefilter (Filter Editor):

The Prefilter does not affect filtering via Filter Popup Windows.

To invoke a Prefilter, click an empty space within the Pivot Table header region and select Show Prefilter from the
context menu.

After you have built and applied a filter condition, a prefilter panel appears at the Pivot Table bottom. This panel
displays the filter condition.

To modify a filter condition, open a Prefilter. You can now do it by clicking the Edit Prefilter button.
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To temporarily disable filtering, uncheck the  button.

To remove filtering, click the  button.

For information on the Prefilter filtering capabilities, see Filter Data via the Filter Editor. To learn how to create
filter criteria using a Prefilter, please see Examples of Using the Filter Editor.

See Also
Filter Data via the Filter Editor
Examples of Using the Filter Editor
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Change Summary Type

Pivot Tables can perform different calculations against data (for instance, calculating sums, averages, maximum
and minimum values, etc.).

To specify which calculations Pivot Table should do against its data, left-click a data header and choose the
appropriate function type.
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Layout Customization

This section describes how to customize the Pivot Table layout by expanding and collapsing field values, as well as
hiding, displaying and reordering fields.

The following sections are available.

Resizing Columns

Describes how to resize columns displayed within the Pivot Table.

Expand and Collapse Groups in Pivot Tables

Provides information on how to expand and collapse field values and field headers.

Hide Pivot Table Fields

Guides you through the process of hiding Pivot Table fields.

Display Hidden Pivot Table Fields

Describes how to display fields that have previously been hidden.

Reorder Pivot Table Fields

Provides information on how to reorder Pivot Table fields.
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Resizing Columns

You can resize columns within the Pivot Table by dragging their borders.

Note

Regular, Total and Grand Total columns are resized independently. This means that resizing a regular column
changes the width of all regular columns but does not affect Total and Grand Total columns, and vice versa.

Double-click a column border to automatically resize the column to the minimum width required to completely
display its content.
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Expand and Collapse Groups

Expand/Collapse Groups of Values

To expand/collapse groups of values, do one of the following:

Click a corresponding expand button:

Right-click a value that has nested values, and select the required Expand or Collapse command from the
menu that opens:

Expand/Collapse Fields

To expand/collapse a group of fields, click a corresponding field expand button:
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Hide Fields

This section describes the Pivot Table capabilities to hide fields.

Topics in this section:

Hide Fields Using the Context Menu

Provides information on how to use context menus to hide fields.

Hide Fields Using a Field List

Describes how to hide fields using a Field List.
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Hide Fields Using the Context Menu

To hide a field, right-click its header and choose Hide from the context menu.

You can also use a Field List to hide fields. To learn more, see Hide Fields Using a Field List.
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Hide Fields Using a Field List

You can use a simple or an advanced Field List to hide fields (to learn more about Field Lists, see Field List
Overview).

  

First, invoke a Field List. For information on how to do this, see Invoke a Field List.

Then do one of the following:

Drag a field away from the header panel, until the cursor changes its image to the big 'X'. Then drop the
header.
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Drag and drop a field onto the Field List form.

If you are using an advanced Field List, you can hide a field by dragging its header to the hidden fields area
displayed on the Field List top.

You can also hide fields using the context menu. To learn more, see Hide Fields Using the Context Menu.
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Display Hidden Fields

To display hidden fields, use a simple or advanced Field List (to learn more about Field Lists, see Field List
Overview).

  

First, invoke a Field List. For information on how to do this, see Invoke a Field List.

To display a hidden field, drag-and-drop the field from the Field List onto the required area of Pivot Table. This
works for both simple and advanced Field Lists.

If you are using a simple Field List, you can display the required field as follows.
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1.Click the required field in the Field List.

2.In the drop-down combo box, select a Pivot Table area within which this field should be displayed.

3.Click the Add To button.

If you are using an advanced Field List, you can display a hidden field by dragging its header from the hidden
fields section to the section corresponding to the required Pivot Table area.
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Reorder Fields

This section describes the Pivot Table capabilities to reorder fields.

The following topics are available:

Simple Fields Reordering

Describes how to reorder fields via drag-and-drop and context menus.

Reorder Fields Using a Field List

Provides information on how to use a Field List to reorder fields.
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Simple Fields Reordering

To move a field to another position, use drag-and-drop operations.

To move a field to a different position within the same area, you can also use a field context menu.

Right-click the field header to activate the context menu.

Select the required command from the Order menu.

You can also use a Field List to reorder fields. For more information, see Reorder Fields Using a Field List.
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Reorder Fields Using a Field List

You can use an advanced Field List to reorder fields (to learn more about Field Lists, see Field List Overview).

First, invoke a Field List. For information on how to do this, see Invoke a Field List.

To reorder fields, drag their headers within or between Field List sections that correspond to different Pivot Table
areas.
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You can also reorder fields via simple drag-and-drop operations (without invoking a Field List), or using a context
menu. To learn more, see Simple Fields Reordering.
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Selection and Navigation

Multiple cells can be selected simultaneously, and their contents can then be copied to the clipboard. This topic
shows how.

Select Cells and Clear the Current Selection

To select a single cell, do one of the following:

Click the cell.

Focus the cell using the ARROW keys.

To select a row or column of cells, click the appropriate header:

To select a continuous range of cells, do one of the following:

Use ARROW, PAGE UP, PAGE DOWN keys while holding the SHIFT key down.

Press the mouse button over the starting cell and drag the mouse cursor towards the ending cell. Then
release the mouse button.
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Click the starting cell. Then click the ending cell while holding the SHIFT key down.

To select a continuous range of columns or rows, do one of the following:

Press the mouse button over the starting column/row header and drag the mouse cursor towards to the
ending column or row header. Then release the mouse button.

Click the starting column or row header. Then click the ending column/row header while holding the SHIFT
key down.

To select all the cells, press CTRL+A.

Select Cells While Preserving the Current Selection

Hold the CTRL key down while selecting cells.

Copy Selected Cells to the Clipboard

Press CTRL+C or SHIFT+INS.
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Field List

Pivot Table provides a Field List form used to reorder and hide fields, sort and filter data, etc. For more information
on how to invoke a Field List, see Invoke a Field List.

This topic describes Field List visual elements and layout.

Depending on Pivot Table settings made by your application vendor, Pivot Table can display either a simple or
advanced Field List.

Simple Field List

The following picture shows a simple Field List.

A simple Field List contains the following visual elements:

Hidden Fields Section - contains headers of fields hidden from Pivot Table. Use it to display hidden fields.

Add Button - used to display a selected field in a specified Pivot Table area.

Pivot Table Area Combo Box - used to choose a Pivot Table area where the selected field will be
displayed after you click the Add button.

Use a simple Field List to hide fields from Pivot Table and display hidden fields again.

For more information on operations available in a simple Field List, refer to the following topics:

Hide Fields Using a Field List

Display Hidden Pivot Table Fields

Advanced Field List

The following picture shows an advanced Field List.
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An advanced Field List contains the following visual elements:

Hidden Fields Section - contains headers of fields hidden from Pivot Table. Use it to display hidden fields.

Filter, Column, Row and Data Area Sections - contains headers located in respective Pivot Table areas.

Defer Updates Check Box - used to enable/disable automatic Pivot Table updates (see Defer Pivot Table
Updates).

Update Button - used to force Pivot Table to update (see Defer Pivot Table Updates).

Layout Button - used to invoke the Layou t menu and change the Field List layout (see Change Field List
Layout).

Use an advanced Field List to sort and filter data, reorder and hide visible fields, and show fields that have been
hidden.

For more information on operations available in an advanced Field List, refer to the following topics:

Sort Data Using a Field List

Invoke a Filter Popup Window

Hide Fields Using a Field List

Display Hidden Pivot Table Fields

Reorder Fields Using a Field List
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Invoke a Field List

To invoke a Field List, right-click on an empty space within the Pivot Table header region, and select Show Field
List from the context menu.

A simple or advanced Field List (similar to one of those shown below) will be displayed.

  

To learn more about Field Lists, see Field List Overview.
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Defer Pivot Table Updates

When you perform several sequential operations like hiding, displaying or reordering fields using an advanced
Field List, Pivot Table is updated after each operation.

You can disable automatic Pivot Table updates by checking the Defer Layout Update check box. In this instance,
use the Update button to force Pivot Table to update.

Note that if the Defer Layout Update check box is checked, you cannot sort or filter data in the Field List.

To learn more about Field Lists, see Field List Overview.
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Change Field List Layout

By default, an advanced Field List displays a hidden fields section on the top, and four sections that correspond to
Pivot Table areas at the bottom (see Field List Overview for details).

You can use the Layou t menu to control which sections are displayed and where they are displayed. To do this,

click the  button and select the required layout from the drop-down menu.
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To learn more about Field Lists, see Field List Overview.
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Print Preview

This section describes the capabilities provided by the Print Preview form:

 

File Management

Save a Print Preview to a File

Load a Print Preview from a File

 

Printing and Page Setup

Print a Document via the Print Dialog

Print a Document Using Default Settings

Change Printing Settings via the Page Setup Dialog

Specify Page Margins in Print Preview

 

Headers and Footers

Insert Page Header and Page Footer into Printed Documents

Insert Page Numbers into Printed Documents

Insert Date and Time into Printed Documents

Insert the User Name into Printed Documents
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Insert a Logo into Printed Documents

 

Scaling

Scale Print Preview by Entering a Zoom Factor

Scale Print Preview by Specifying Width in Pages

 

Zooming

Zoom Print Preview In or Out

Zoom Print Preview by Entering a Zoom Factor

Zoom Print Preview to Show Whole Pages or Fit Content

Show Two or More Pages in Print Preview

 

Viewing and Navigating

Navigate Between Pages in Print Preview

Use the Hand Tool in Print Preview

Navigate in Print Preview Using Bookmarks

Search for a Specific Text in Print Preview

Switch Print Preview Display Mode

 

Watermark and Background

Change Watermark and Background Settings in Print Preview

Remove a Watermark in Print Preview

 

Exporting

Exporting from Print Preview

PDF-Specific Export Options

HTML-Specific Export Options

MHT-Specific Export Options

RTF-Specific Export Options

XLS-Specific Export Options

XLSX-Specific Export Options

CSV-Specific Export Options

TXT-Specific Export Options

Image-Specific Export Options

 

Passing Parameters

Passing Parameters in Print Preview

 

Miscellaneous

Customize Printing Settings of Charts

Customize Printing Settings of Grids

Customize Printing Settings of Pivot Tables

Customize Printing Settings of Tree Views
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Warnings and Error Messages

Warnings and Error Messages in Print Preview
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File Management

Save a Print Preview to a File

If you've modified your document, and there's a chance you'll need to print out this document version more than
once, you can save the document to a file on disk. After that, you can simply load your document and print it out,
without having to apply the same changes again.

To save a document to the file, click the Save  button on the toolbar, or press CTRL+S.

On the invoked Save As dialog, locate a folder where you want to store your file, enter the document's name and
click Save.

Your document will be saved with the .prnx file extension. Note that this extension will be added to the file name
even if you enter another one.

Note

If you open a document which was previously saved to the hard drive, it is impossible to change its page settings
(e.g. page size, orientation, margins, etc.). So, the Page Setup and the Scale buttons will be disabled.
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Load a Print Preview from a File

To open a previously saved document, click the Open  button on the toolbar, or press CTRL+O.

On the invoked Open dialog, define the file and click Open.

Note

If you open a document previously saved to the hard drive, it is impossible to change its page settings (e.g. page
size, orientation, margins, etc.). So, the Page Setup and Scale buttons will be disabled.
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Printing and Page Setup

Print a Document via the Print Dialog

To print a document, do one of the following.

Click the Print  button on the toolbar, or press CTRL+P.

On the File menu, click Print....

The Print dialog will be invoked.

Specify the necessary settings and click Print.

To print a document without invoking the Print dialog, see the Print a Document Using Default Settings topic.

Note

If you try to print a document whose margins are outside of the printable area, you'll see a warning message.
Click Yes to print the document anyway, if you are sure that your printer supports the specified page margins.
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Print a Document Using Default Settings

To send a document directly to the default printer without customizing print settings, do one of the following.

Click the Quick Print  button on the toolbar.

On the File menu, click Print.

To learn how to select a printer, number of copies, and other printing options, refer to the Print a Document via
the Print Dialog topic.

Note

If you try to print a document whose margins are outside of the printable area, you'll see a warning message.
Click Yes to print the document anyway, if you're sure that your printer supports the specified page margins.
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Change Printing Settings via the Page Setup Dialog

To start the page setup dialog box, do one of the following.

Click the Page Setup  button on the toolbar.

On the File menu, click Page Setup...

The following dialog will be invoked.

This dialog allows you to do the following:

Change page orientation (choose Portrait or Landscape).

Select paper size.

Change page margins. (This can also be done in the Print Preview dialog)

Note

If you're working with a document that was loaded from file, the Page Setup commands on the toolbar and main
menu will be disabled.
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Specify Page Margins in Print Preview

To set document page margins, do one of the following.

Use the Page Setup dialog

In the Page Setup dialog, enter the required top, left, bottom and right page margins' values into the
appropriate editors.

Then, click OK to save changes.

Use drag-and-drop in the Print Preview window

To use this approach, point to the dotted line indicating the margin's border. When the pointer changes
to , drag the pointer to move the margin.

Note

If you're working with a document that was loaded from file, it is impossible to change its page settings (e.g.
page size, orientation, margins, etc.).
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Print Selection

To print only the selected content of the previewed document, do the following.

1.Select the content of the previewed document by holding the left mouse button and dragging the
mouse pointer to create a selection box. Expand the selection box to fit all of the content you wish to
print. The selected document elements are highlighted.

2.Right-click anywhere within the highlighted area of the document and select Print... in the context
menu.
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3.In the invoked Print dialog, specify the required settings and click Print.
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See Also
Copy to the Clipboard
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Headers and Footers

Insert Page Header and Page Footer into Printed Documents

To insert a page header and page footer into a document, click the Header and Footer  button on the toolbar.
This will invoke the Header and Footer dialog.

Specify header and footer content using the appropriate text boxes, depending on the required alignment.

If needed, you can also adjust vertical alignment and font settings.

Click OK to save changes and close the dialog.
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Insert Page Numbers into Printed Documents

To insert or remove page numbers from a document, first invoke the Header and Footer dialog.

Focus a text box, depending on the required alignment, and do one of the following:

If you need to simply display the current page number, click the Page Number  button.

If you need to display the page number out of the total number of pages, click the Page # of Pages # 
button.

When you click one of these buttons, the dialog adds an alias within square brackets at the current cursor
position. You can surround this alias with any text you like. If you no longer need page numbers in your document,
delete this alias.

Click OK to save changes and close the dialog.
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Insert Date and Time into Printed Documents

If you need to display the date and time when a document is printed, first invoke the Header and Footer dialog.

Then, click on the appropriate text box, depending on the required alignment, and do the following:

To add a date stamp, click the Date Printed  button.

To add a time stamp, click the Time Printed  button.

When you click one of these buttons, the dialog adds an alias within square brackets at the current cursor
position. You can surround this alias with any text you like. If you no longer need to display date and time in your
document, delete this alias.

Click OK to save changes and close the dialog.
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Insert the User Name into Printed Documents

To insert user name into a document's header or footer, first invoke the Header and Footer dialog.

Then, focus an appropriate text box, depending on the required alignment, and click the User Name  button.

When you click this button, the dialog adds an alias within square brackets at the current cursor position. You can
surround this alias with any text you like. If you no longer need to display user name in your document, delete
this alias.

Click OK to save changes and close the dialog.
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Insert a Logo into Printed Documents

To insert a logo into a document's header or footer, first invoke the Header and Footer dialog.

Then, focus an appropriate text box, depending on the required alignment, and click the Image  button.

Select the image from the dropdown list.

Click OK to save changes and close the dialog.

Note

If the Image button is disabled, then logo insertion is not supported by your software vendor.
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Scaling

Scale Print Preview by Entering a Zoom Factor

To scale a document, click the Scale  button on the toolbar. The Scaling dialog will be invoked.

Set the required percentage value in the editor.

Click OK to save changes and close the dialog.

Note

If you're working with a document loaded from file, you cannot use scaling.
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Scale Print Preview by Specifying Width in Pages

To scale a document to fit into X pages, click the Scale  button on the toolbar. The Scaling dialog will be
invoked.

Set the required number of pages in the editor.

Click OK to save changes and close the dialog.

Note

If you're working with a document loaded from file, you cannot use scaling.
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Zooming

Zoom Print Preview In or Out

Zoom In and Out of a Document

To zoom in a document, click the Zoom In  button on the toolbar, or press CTRL+PLUS SIGN.

To zoom out of a document, click the Zoom Out  button on the toolbar, or press CTRL+MINUS SIGN.

To zoom in or out of a document, you can also hold down CTRL and rotate the mouse wheel.

Use the Magnifier Tool

Use the Magnifier Tool  to switch between 100% and "fit whole page" views. Simply click anywhere in the
document, to toggle views.
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Zoom Print Preview by Entering a Zoom Factor

To zoom to a specific zoom factor, do one of the following.

Click the Zooming dropdown list button. The following list will be invoked.

Choose one of the zoom factor presets.

You can manually enter any value into the Zooming box.
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Zoom Print Preview to Show Whole Pages or Fit Content

Zoom Documents to Fit Page Content

To zoom to the page or text width, click the Zooming box. The following list will be invoked.

To zoom to the page width, click Page Width.

To zoom to the text width, click Text Width.

Note

If the preview window will be resized later, the current zoom factor will also be changed, to fit the current page or
text width.

Zoom Documents to Display Whole Pages

First, invoke the zooming dropdown (see above).

To display one whole page at a time, click Whole Page.

To fit two pages into the current view, click Two Pages.

Note

If the preview window will be resized later, the current zoom factor will be also changed in order to fit one or two
pages.

If you want to preview more pages simultaneously, refer to the Show Two or More Pages in Print Preview topic.
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Show Two or More Pages in Print Preview

To preview two or more pages at one time, click the Multiple Pages  button on the toolbar.

Then, in the invoked dialog, hover over the page icons, depending on the required number of pages to preview.

When the required number of pages has been selected, click the popup window to close it and apply changes to
the document view.
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Viewing and Navigating

Navigate Between Pages in Print Preview

To navigate between pages, use the scrollbars or navigation buttons    on the toolbar. These buttons
allow you to switch to the first, previous, next, or last page of a document.
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Use the Hand Tool in Print Preview

The Hand Tool enables you to scroll content by dragging the document instead of using scrollbars.

To activate the Hand Tool, click the Hand Tool  button on the toolbar.

Then, after you click a document's page, the mouse pointer is changed from  to . Drag the mouse pointer to
scroll the document.
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Navigate in Print Preview Using Bookmarks

If a document contains bookmarks, you can use the Document Map feature to quickly navigate to a required
section.

Show or Hide the Document Map

To show or hide the document map, click the Document Map  button on the toolbar.

Go to a Specific Bookmark

To go to the specific bookmark, click it in the Document Map, and the appropriate text will be highlighted in the
document.
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Search for a Specific Text in Print Preview

To search for a specific text within a document, click the Search  button on the toolbar, or press CTRL+F. The
Find dialog will be invoked.

In this dialog, you can input the text to find, and specify whether to match case or the whole word during the
search, or set the search direction.

To start searching, or search again, click Find Next or press ENTER.
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Switch Print Preview Display Mode

Enable the Facing Layout View

To enable the facing layout view, on the View menu, point to Page Layout, and then click Facing.

This allows you to preserve an entire page view, whether you resize the preview window, scroll a document or
choose a multiple page view mode.

Enable the Continuous Layout View

To enable the continuous layout view, on the View menu, point to Page Layout, and then click Continuous.
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This allows you to continuously scroll a page layout view.
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Watermark and Background

Change Watermark and Background Settings in Print Preview

Invoke the Watermark Dialog

To add a watermark to a document, click the Watermark  button on the toolbar, or click Watermark... on the
Background menu. The Watermark dialog will be invoked.

Add a Text Watermark

To add a text watermark, open the Text Watermark tab.

Input the required text, or choose one from the provided options. If required, define other text properties, such as
direction, color, font, size, transparency, etc.

Add an Image Watermark

To add a picture watermark, open the Picture Watermark tab.
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Load the image and customize its properties, such as size mode, horizontal and vertical alignment, tiling,
transparency, etc.

Specify the Pages Where you will Display Your Watermark

Specify the required pages to apply a watermark in the Page Range section of the dialog.

Separate page numbers with commas, or specify page ranges using a dash.

Add a Background Color to a Document

To add a background color to a document, click the Background Color  button on the toolbar, or click Color... on
the Background menu. The Background Color dialog will be invoked.
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Then, choose a color from the Custom, Web or System palettes.

See Also
Remove a Watermark in Print Preview
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Remove a Watermark in Print Preview

To remove a watermark from a document, invoke the Watermark dialog. Click Clear All, then click OK to save
changes and close the dialog.

See Also
Change Watermark and Background Settings in Print Preview
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Exporting

Exporting from Print Preview

There are two options available for a document being exported to.

Export Document to a File on Disk

Send Exported File via E-Mail

Export Document to a File on Disk

To export a document and save the resulting file on your hard drive, do one of the following.

On the toolbar, click the arrow near the Export Document... button .

On the File menu, choose the Export Document... item.

Choose the required format from the invoked list.

Then, you may be prompted to define format-specific options. See corresponding help topics in this documentation
for details, e.g. PDF-Specific Export Options.

Once you've specified exporting options, the Save As dialog appears, allowing you to enter the file name. Then,
the following message will be invoked.

Click Yes, if you want to preview the exported file.

Send Exported File via E-Mail

To send the resulting PDF file via e-mail, do one of the following.

On the toolbar, click the arrow near the Send via E-Mail... button .

On the File menu, choose the Send via E-Mail... item.

Choose the required format in the invoked list.
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Then, you may be prompted to define format-specific options. See corresponding help topics in this documentation
for details, e.g. PDF-Specific Export Options.

Once you've specified exporting options, the Save As dialog appears, allowing you to enter the file name.

Finally, the created document will be attached to a new empty message, created in your default mail program.
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Copy to the Clipboard

Aside from exporting a document to a third-party formatted file, you can copy a portion of the document content to
the clipboard, and paste it into an editor compatible with one of the supported third-party formats.

To copy document content to the clipboard, do the following.

1.Select the content of the previewed document by holding down the left mouse button and dragging the
mouse pointer, to create a selection box. Expand the selection box to fit all of the content you wish to
print. The selected document elements are highlighted.

2.To copy the selected content, press CTRL + C or right-click anywhere within the highlighted area of the
document, and select Copy in the context menu.
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When pasted to a third-party editor from the clipboard, the report content will automatically be converted to the
target format.

See Also
Print Selection
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PDF-Specific Export Options

When exporting a document, you can define PDF-specific exporting options using the following dialog.

General Options

Page range
Define the pages which will be included in the complete file. Separate the pages with a comma, set a
range of pages with a dash.

Don't embed these fonts
Define the fonts that will not be embedded in the complete file, to reduce the file size. Separate the fonts
with a semicolon.

Images quality
Choose the required document's image quality level. The higher the quality, the bigger the file, and vice
versa.

Compressed
Check this to enable compression.

Show print dialog on open
Check this, if desired.

Password Security Options
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These options allow you to adjust the security options of the resulting PDF file (e.g. enable open document,
editing, printing and copying protection, and specify which changes are allowed).

Signature Options

If an X.509 certificate is applied to your report, you can maintain its options via the Signature Options property of
the report PDF Export Options.

Additional Options

You can also fill the Application, Author, Keywords, Subject, and Title fields.

See Also
Exporting from Print Preview
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HTML-Specific Export Options

When exporting a document, you can define HTML-specific exporting options using the following dialog.

Export mode
The following modes are available.

- The Single file mode allows export of a document to a single file, without preserving the page-by-page
breakdown.

- The Single file page-by-page mode allows export of a document to a single file, while preserving page-
by-page breakdown. In this mode, the Page range, Page border color and Page border width options
are available.

- The Different files mode allows export of a document to multiple files, one for each document page. In
this mode, the Page range, Page border color and Page border width options are available.

Page range
Specify the pages which will be included in the resulting file. Separate page numbers with commas; set
page ranges using hyphens.

Page border color
Choose the color for the page border from the available palettes.

Page border width
Define the page border width.

Title
Enter the required document title.

Character set
Define the character set for your HTML document.

Also, using the appropriate check box, you can choose whether to remove carriage returns.

See Also
MHT-Specific Export Options
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MHT-Specific Export Options

When exporting a document, you can define MHT-specific exporting options using the following dialog.

Export mode
Choose one from the available modes to export a document.

- The Single file mode allows export of a document to a single file, without dividing it into pages.

- The Single file page-by-page mode allows export of a document to a single file, divided into pages. In
this mode, the Page range, Page border color and Page border width options are available.

- The Different files mode allows export of a document to multiple files, one for each document page. In
this mode, the Page range, Page border color and Page border width options are available.

Page range
Define the pages which will be included in the result. Separate page numbers with commas; set page
ranges using hyphens.

Page border color
Choose the color for the page borders from the available palettes.

Page border width
Define the width of page borders.

Title
Enter the required document title.

Character set
Define the character set, which will be used in the exported document.

Also, using the appropriate check box, you can choose whether to remove carriage returns.

See Also
HTML-Specific Export Options
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RTF-Specific Export Options

When exporting a document, you can define RTF-specific export options using the following dialog.

Export mode
Choose one from the available modes to export a document.

- The Single file mode allows export of a document to a single file, without dividing it into pages.

- The Single file page-by-page mode allows export of a document to a single file, divided into pages. In
this mode, the Page range, Page border color and Page border width options are available.

- The Different files mode allows export of a document to multiple files, one for each document page. In
this mode, the Page range, Page border color and Page border width options are available.

Page range
Define the pages which will be included in the result. Separate page numbers with commas, set page
ranges using hyphens.

Also, using the appropriate check box, you can choose whether the exported document should include
watermarks (if they exist).
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XLS-Specific Export Options

When exporting a document, you can define XLS-specific export options using the following dialog.

Export mode
Choose one of the available modes to export a document.

- The Single file mode allows export of a document to a single file, without dividing it into pages.

- The Different files mode allows export of a document to multiple files, one for each document page.

Page range
Define the pages which will be included in the result. Separate page numbers with commas; set page
ranges using hyphens.

Sheet name
Define the sheet name.

Text export mode
Choose whether value formatting should be converted to the native XLS format string (if it is possible), or
embedded into cell values as plain text.

Show grid lines
Check if it's required to show grid lines in the resulting XLS file.

Export hyperlinks
Check if it's required to export hyperlinks.

See Also
XLSX-Specific Export Options
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XLSX-Specific Export Options

When exporting a document, you can define XLSX-specific export options using the following dialog.

Export mode
Choose one of the available modes to export a document.

- The Single file mode allows export of a document to a single file, without dividing it into pages.

- The Single file page-by-page mode allows export of a document to a single file, with each shown in a
separate sheet.

- The Different files mode allows export of a document to multiple files, one for each document page.

Page range
Define the pages which will be included in the result. Separate page numbers with commas; set page
ranges using hyphens.

Sheet name
Define the sheet name.

Text export mode
Choose whether value formatting should be converted to the native XLSX format string (if it is possible),
or embedded into cell values as plain text.

Show grid lines
Check if it's required to show grid lines in the resulting XLSX file.

Export hyperlinks
Check if it's required to export hyperlinks.

See Also
XLS-Specific Export Options
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CSV-Specific Export Options

When exporting a document, you can define CSV-specific exporting options using the following dialog.

Encoding
Define the encoding used in the exported document.

Text export mode

Choose whether to use the formatting of the data fields in the bound dataset for the cells in the exported
document. Note that if this property is set to Text, all data fields are exported to the CSV file as strings,
with the corresponding formatting embedded into those strings.

Text separator
Define a text separator (comma by default).

You can also specify whether to quote strings with separators.
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TXT-Specific Export Options

When exporting a document, you can define TXT-specific exporting options using the following dialog.

Encoding
Define the encoding used in the exported document.

Text export mode

Choose whether to use the formatting of the data fields in the bound dataset for the cells in the exported
document. Note that if this property is set to Text, all data fields are exported to the Text file as strings,
with the corresponding formatting embedded into those strings.

Text separator
Define a text separator (TAB by default).

You can also specify whether to quote strings with separators.
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Image-Specific Export Options

When exporting a document, you can define image-specific exporting options using the following dialog.

Image format
Choose one from the available image formats to export a document: BMP, EMF, WMF, GIF, JPEG, PNG or
TIFF.

Resolution (dpi)
Define the required image resolution.

Export mode
Choose one from the available modes to export a document.

The Single file mode allows export of a document to a single file, without dividing the output into
pages.

The Single file page-by-page mode allows export of a document to a single file, divided into pages. In
this mode, the Page range, Page border color and Page border width options are available.

The Different files mode allows export of a document to multiple files, one for each document page. In
this mode, the Page range, Page border color and Page border width options are available.

Page range
Defines the pages which will be included in the result. Separate page numbers with commas; set page
ranges using hyphens.

Page border color
Specifies page border color.

Page border width
Sets page border width.
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Passing Parameters

Some documents or reports allow you to control data display, and what data is to be displayed by specifying
parameter values.

To show the Parameters window, click the Parameters  button on the main toolbar. A window allowing you to
change parameter values will be invoked.

Enter the required values and click Submit. To reset settings, click Reset.
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Miscellaneous

Customize Printing Settings of Charts

If allowed by your application vendor, you can customize additional print settings of a document. For example, if
you are about to print out a chart, you may be able to customize the chart's printing options.

To do this, click the Customize  button on the toolbar. The Print Options dialog will be invoked.

None
A chart is printed in the identical size shown on the form.

Stretch
A chart is stretched or shrunk to fit the page on which it is printed.

Zoom
A chart is resized proportionally (without clipping), so that it best fits the page on which it is printed.
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Customize Printing Settings of Grids

If allowed by your application vendor, you can customize additional print settings of a document. For example, if
you are about to print out a grid, you may be able to customize grid printing options.

To do this, click the Customize  button on the toolbar. The Print Options dialog will be invoked.

Options tab
Allows you to uncheck elements that you don't want to print.

Behavior tab
Allows you to pre-process a grid before printing it. For instance, you can enable automatic column width
calculation, or automatic group row expansion.
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Customize Printing Settings of Pivot Tables

If allowed by your application vendor, you can customize additional print settings of a document. For example, if
you are about to print out a Pivot Table, you may be able to customize its printing options.

To do this, click the Customize  button on the toolbar. The Print Options dialog will be invoked.

Options tab
Allows you to specify which elements are to be printed.

Behavior tab
Allows you to pre-process a Pivot Table before printing it. For instance, you can enable field value
merging.
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Customize Printing Settings of Tree Views

If allowed by your application vendor, you can customize additional print settings of a document. For example, if
you are about to print out a tree view, you may be able to customize its printing options.

To do this, click the Customize  button on the toolbar. The Print Options dialog will be invoked.

Options tab
Allows you to specify which elements are to be printed.

Behavior tab
Allows you to pre-process a tree view before printing it. For instance, you can enable automatic column
width or row height calculation.
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Warnings and Error Messages

Warnings

Warning Text Description

The specified file doesn't have a PRNX extension. This message is invoked if you try to open a file with
an extension different from PRNX.

Click Yes if you are sure that the file contains the
compatible markup. Otherwise, click No.

One or more margins are set outside the printable
area of the page.

This message is invoked when you try to print a
document, whose margins are outside of the printable
area of the page.

Click Yes if you are sure that your printer supports
the specified page margins. Otherwise, click No.

Errors

Error Text Description

The specified file doesn't contain valid XML data in the
PRNX format. Loading is stopped.

This message is invoked if you try to open a file with
an incompatible markup.

This file cannot be loaded in the Print Preview. Try to
open a file with a compatible markup.
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Report Designer

This guide contains information about the basic principles of creating reports with Report Designer.

The Report Designer allows you to create new reports from scratch, bind them to data, and even pass them to
another workstation and load them into another instance of the report designer. In addition to report editing
capabilities, it allows you to display its Print Preview and send its output to a printer or export it to a file on disk.

The following sections are available in this guide.

Report Editing Basics

Create Reports

Report Designer Reference

Report Wizard

Preview, Print and Export Reports

Note

Some features described in this guide may differ from what you see in your application. This depends on your
application vendor.
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Report Editing Basics

This section describes the most basic tasks you may encounter when initiating a report edit in the Report
Designer.

The following documents are available in this section.

Report Editing Basics

Back Up the Current Layout Before Modifying It

Manually Update Report Output

Change the Layout of Report Elements

Change Fonts and Colors of Report Elements

Delete Report Elements

Providing Data

Add or Modify Static Information in Your Report

Displaying Values from a Database (Binding Report Elements to Data)

Use Mail Merge in Report Elements

Add Calculated Fields to a Report

Add Parameters to a Report

Data Representation

Change Value Formatting of Report Elements

Change or Apply Data Sorting to a Report

Change or Apply Data Filtering to a Report

Change or Apply Data Grouping to a Report

Additional Features

Add Totals to a Report

Add Page Numbers and System Information to a Report

Create or Modify Watermarks of a Report
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Back Up the Current Layout Before Modifying It

To guarantee that you will be able to revert your report to its original state, you need to create a backup copy.
Then, you can apply changes without worrying that it will be hard to restore your report, in case something
breaks.

To save a copy of your report, in the Main Menu, select File | Save As.

Then, in the invoked standard Save File dialog, specify the folder and file name.

To save the current layout of your report, in the Main Menu select File | Save, or press CTRL+S. In this
case, the report will be saved in the application's current folder.

After your report is saved, its path is displayed in the Report Designer's title bar.

To load a previously saved report, in the Main Menu, click File | Open, or press CTRL+O. The standard
Open File dialog will allow you to locate and open report files.

See Also
Change the Layout of Report Elements
Delete Report Elements
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Manually Update Report Output

Sometimes you may need to simply update a couple of values in your report before printing it. In these cases, the
simplest way to correct your report is to export it to an editable file (e.g. RTF), then use an appropriate editor tool
to edit values and print your report.

To export a report, switch to the Preview Tab and click the arrow near the Export Document... button .

To learn more about report exporting, see Exporting from Print Preview.
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Change the Layout of Report Elements

To select a control, click it. To select the next control in tab order, press TAB. To select the previous control in tab
order, click SHIFT + TAB.

Individual controls can be moved, using either mouse or keyboard.

They can be precisely aligned to each other using either Snap Gird or Snap L ines. For details on this, refer to
Controls Positioning.

To resize a control using the mouse, select it, and then drag a rectangle drawn on its edge or corner.

To resize a band, drag its header strip.

To resize an element using the keyboard, press SHIFT+ARROW or CTRL+SHIFT+ARROW.

To select multiple elements, do one of the following.

Click elements while holding CTRL or SHIFT.

Click on a blank space and drag the mouse to create a selection frame. When the mouse button is
released, all controls within the selection frame's boundaries will be selected. In this case, the previous
selection is cleared.

You can also easily align multiple controls or make them the same size, by utilizing the Layout Toolbar.

In addition, to copy, paste and delete controls simultaneously, you can place them within the Panel.

For more information, refer to Controls Positioning.

See Also
Change Fonts and Colors of Report Elements
Delete Report Elements
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Change Fonts and Colors of Report Elements

To change fonts and colors (as well as paddings, text alignment and other appearance properties) of a report 
control or band, select this element and do one of the following.

Use the Formatting Toolbar.

Use the Property Grid, where all appearance-related properties are located under the Appearance
category.

Note that the appearance settings of a band are applied to all controls contained within it.

When it's required to apply styles in bulk, we recommend using common s tyle tem plates, which also can be stored
in an external style sheet file, and applied to multiple reports. In addition, this allows you specify separate odd/
even  s tyles, to improve your reports' readability. Another noteworthy option, is the capability to conditionally
change the appearance of report elements based on a certain logical expression (e.g. if a control's value satisfies
some rule). For more information, refer to Styles and Conditional Formatting in Reports.
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Delete Report Elements

To delete a report element (band or control), select it in the Design Panel or Report Explorer (to select multiple
elements, hold down SHIFT while selecting), and then do one of the following.

Press DELETE.

Right-click the report element, and in the invoked Context Menu, choose Delete.

In the Main Menu, select Edit | Delete.

Note

You can cancel the operation by pressing CTRL+Z.

Note that certain elements cannot be deleted (such as the Detail band).

See Also
Change the Layout of Report Elements
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Add or Modify Static Information in Your Report

In a report, s tatic and dynam ic information is displayed using appropriate controls.

Dynamic information changes through a report, such as values from a database (which comprise the main report
data) or service information (such as current user name or page numbers). Approaches to embed dynamic
information to your report are detailed in the following document: Displaying Values from a Database (Binding
Report Elements to Data).

Static information is text or images that aren't obtained from a data source, and therefore don't change through
the report, and don't depend on the current computer. Static information can be printed only once (e.g. in a 
Report Header), can repeat on each page (e.g. in a Page Header) or can repeat with every entry in your report's
data source (a data-bound label, which is placed onto the Detail band).

Static information can be either edited in-place, or loaded from an external file.

Change Static Information

Text elements (e.g. Labels and Rich Text Boxes) allow in-place editing of their content. Simply double-click an
element and activate the editor.

Note

For in-place editing, you also can utilize the Formatting Toolbar.

Another way to change a control's static information, is by clicking its Smart Tag. Then, the invoked actions list will
contain a link (or, a button) allowing you to edit this control's content.
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Load Static Information to Your Report

To load static information to your report from an external file, drop an appropriate control from the Control Toolbox
(e.g. Label, Rich Text Box or Picture Box). After it is properly positioned, edit its content using the Smart Tag.

For instance, the following instructions describe how to display a rich text (a formatted text with embedded
images) into your report.

1.Drop the Rich Text control from the Toolbox onto the Detail band.

2.To load content from an external RTF or TXT file, select the created control and click its Smart Tag. In the
invoked actions list, click the Load File... link.

Then, in the invoked dialog, locate the required file, and click Open.
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See Also
Change Fonts and Colors of Report Elements
Displaying Values from a Database (Binding Report Elements to Data)
Use Mail Merge in Report Elements
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Displaying Values from a Database (Binding Report Elements to Data)

Report controls can either display static information or dynam ic data fetched from the bound database.

Data-bound controls are indicated by a yellow database icon in their top-right corner, both in the Design Panel
and Report Explorer.

To embed dynamic information to a report, if this information is contained in the report's data source, this can
easily be done using one of the following approaches.

Using the Field List

Using the Smart Tag

Using the Property Grid

After a control is bound to data, you may wish to employ additional features, which are listed in the final section of
this document.

Special Capabilities

Using the Field List

To bind an existing report control to a data field, click the required field item in the Field List, and then
drag and drop it onto the control. The yellow database icon inside it will indicate that it's been successfully
bound.
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To add a new data-bound control, simply drag the required data field from the Field List onto a report
band. This will create a Label bound to this data field.

A more flexible way to create data-bound elements is to right-click a Field List item, and then drag and
drop it onto a report. This will invoke the Context Menu, where you can choose which control should
represent your data, and it will be automatically created and bound to the selected data field.

Using the Smart Tag

Click a control's Smart Tag, and in the invoked actions list, expand the Data Binding drop-down list, and select the
required data field.
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Using the Property Grid

Click a control to select it, and in the Property Grid, expand the (Data Bindings) branch that holds the bindable
options. Specify a data field for the required attribute (e.g. Text).

Special Capabilities

After a control is bound, you can apply formatting to its dynamic content (e.g. for it to be treated as currency, or
date-time content). For details on this, refer to Change Value Formatting of Report Elements.
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It is possible to make a control display a result of a summary function calculated across the data field to which it is
bound. For details on this, refer to Add Totals to a Report.

Another noteworthy option is to combine both static and dynamic content within the same control (e.g. to append
some text prefix or postfix to a value obtained from a database), or even bind a control to multiple data fields at
one time. This is detailed in Use Mail Merge in Report Elements.

If it's required to perform some pre-calculations over the data field to which a control is bound, this can be done
by creating a calcu lated field, and binding the control to it. This is detailed at Add Calculated Fields to a Report.

In turn, a calculated field may contain both dynamic and static param eters, which can be requested each time a
report is being previewed. For more information, refer to Add Parameters to a Report.
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Use Mail Merge in Report Elements

The m ail m erge feature allows you to combine both static and dynamic content within the same control (e.g. to
append some text prefix or postfix to a value obtained from a database), or even bind a control to multiple data
fields at one time.

Mail merge is available for the following controls.

Bar Code

Check Box

Label

Rich Text

Table Cell

Zip Code

To embed dynamic data into a control's static content, type in data field names surrounded by [square brackets].

To learn how values  form atting can be applied to the embedded data fields (e.g. for them to be treated as
currency, or date-tim e content), refer to Change Value Formatting of Report Elements.
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Add Calculated Fields to a Report

This document demonstrates how to add a calcu lated field to a report. The main purpose of calculated fields is to
perform pre-calculations (of virtually any level of complexity) over data fields. To learn how to easily perform simple
calculations within a single data field, refer to Add Totals to a Report.

In the Report Designer, a calculated field is similar to an ordinary data field (e.g. you can bind controls to it, and 
group, sort and filter your report against it).

To add a calculated field to your report, follow the instructions below.

1.To create a calculated field, in the Field List, right-click any data member, and on the invoked menu,
choose Add Calculated Field.

2.In the Field List, select the created field to show its properties in the Property Grid. Among these
options, make sure to change the Field Type property to an appropriate value.

3.Now, let's create an expression for the calculated field.

Click the ellipsis button in the Expression section, to invoke the Expression Editor. You can also invoke
this dialog by right-clicking your calculated field within the Field List and selecting Edit Expression...
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Click Fields to see the field list. Double-click field names to add them to the expression string. Use the
toolbar to add operators between field names.

Note

Note that it's also possible to employ parameters in a calculated field's expression.

To close the dialog and save the expression, click OK.

4.Finally, drag the calculated field from the Field List onto the required band, just like an ordinary data
field.

The report with a calculated field is now ready. Switch to the Preview Tab, and view the result.
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See Also
Add Parameters to a Report
Change or Apply Data Filtering to a Report
Change or Apply Data Grouping to a Report
Change or Apply Data Sorting to a Report
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Add Parameters to a Report

For your report, you can employ param eters, which can be requested each time the report is being previewed.
And, based on specified values, the report will then being filtered. It is also possible to employ parameters in
expressions of calculated fields.

In this example, we'll create two date-time parameters, to filter out orders which don't fall in the specified range,
from the report.

To add parameters and filter your report based on their values, follow the steps below.

1.In the Field List window, right-click over the Parameters section and in the invoked menu, click Add
Parameter.

2.In the invoked window for the created parameter, set its Name and Description. And, make sure to set
its Type to an appropriate value.

Note

In Print Preview, the report's document is not generated until you have submitted values of all the
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parameters that have the Show in the parameters panel option switched on via the Parameters UI.

3.Enabling the Supports the collection of standard values option of the parameter allows end-users to
modify its value and also activates the Dynamic values and the Static values tabs of the window:

- On the Dynamic values tab, you can specify a parameter's data source, data adapter and data
member. The value member defines a data field that provides values to the parameter. The display
member defines a data field that provides display names for parameter values (how these values
appear in the user interface available in a Print Preview).

- On the Static values tab, you can manually fill the list of parameter values, with each value having an
individual description (specifying how this value appears in the Parameters panel).

Then, repeat the previous steps to create the second parameter, so that every time your report is
previewed, you will be asked to specify two dates.

The following instructions explain how to use parameters to filter your report's data.

4.Click your report's Smart Tag, and in the invoked actions list, click the ellipsis button for the Filter String
entry. Then, in the invoked Filter String Editor, construct an expression where a data field is compared
with the created parameters. To access parameters, click the icon on the right until it turns into a
question mark.
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The complete filtering expression will then look like this.

The parameterized report is now ready. Switch to the Preview Tab, and in the Parameters section, define the
required values and click Submit.
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See Also
Add Calculated Fields to a Report
Change or Apply Data Filtering to a Report
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Change Value Formatting of Report Elements

To apply value formatting for a data-bound control's content (e.g. for it to be treated as currency, or date-time
content), locate this control, click its Smart Tag, and in the invoked actions list, click the ellipsis button for the
Format String entry.

Then, in the invoked format string editor, choose one of the predefined formatting styles, or specify a custom one.

To quit the dialog and apply the changes, click OK.

Similarly, when the mail-merge is employed for a control's dynamic content, to apply a value formatting to an
embedded data field, select it in the in-place editor, and click the control's smart tag. Then, in the invoked actions
list, specify the required format.

Note that when a sum m ary function is being applied to a control's dynamic content, value formatting is applied
separately, via the Summary Editor, as described at Add Totals to a Report.

Independently from the general (or, summary) value formatting, you can specify a native XLSX format string, which
is to be preserved when the report is being exported to XLSX. This can be done via a control's Xlsx Format String
property.
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Change or Apply Data Sorting to a Report

This document demonstrates how to sort a report's data. Note that as with data grouping, sorting can be
performed only if a report is bound to a data source. In this example, we'll use the report created in the following
tutorial: Change or Apply Data Grouping to a Report.

To sort records in a data-aware report, do the following.

1.Switch to the Group and Sort Panel, and click Add a Sort. In the invoked list, choose a data member
across which the report is to be sorted.

Note that sorting across calculated fields is supported, as well.

2.To manage the sorting order (ascending or descending), use the Sort Order drop-down list.

And, if multiple sorting criteria are specified, you can define the priority for each one, by selecting it in
the Group and Sort Panel, and using the Move Up and Move Down buttons.

The sorting is now applied. Switch to the Preview Tab, and view the result.
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See Also
Change or Apply Data Grouping to a Report
Change or Apply Data Filtering to a Report
Add Calculated Fields to a Report
Sort Groups by a Summary Function Result
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Change or Apply Data Filtering to a Report

For your report, you can specify a filtering expression (of virtually any level of complexity), to exclude excessive or
undesired data.

To filter a report's data, click its Smart Tag, and in the invoked actions list, click the ellipsis button for the Filter
String entry. Then, in the invoked Filter String Editor, construct an expression.

In the Filter String Editor, you can either use the Visual expression builder, or specify the expression in Text.

Note that it is possible to embed parameters into the expression, and also request them each time a report is
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previewed.

To quit the dialog and save the changes, click OK.

See Also
Change or Apply Data Grouping to a Report
Change or Apply Data Sorting to a Report
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Change or Apply Data Grouping to a Report

This document demonstrates how to group a report's data. Note that data grouping can be performed only if a
report is bound to a data source.

To group records in a report, do the following.

1.Create a new report and bind it to a data source. In this tutorial, we'll start with the following report.

2.Now, switch to the Group and Sort Panel, and click Add a Group. In the invoked list, choose a data
member across which the report is to be grouped. Note that grouping across calculated fields is
supported, as well.

If multiple groups are created, you can specify the priority for each group, by selecting it in the Group
and Sort Panel, and using the Move Up and Move Down buttons.

3.After this, a Group Header band is added to the report, with the specified data member being set as its
grouping criterion.

Now, it's only left to drop the corresponding item from the Field List onto this band, so that it's displayed
as a header for each group.

If required, you also can apply mail merge to this label.

4.In addition, you can enable the corresponding Group Footer band, by checking the Show Footer option
in the Group and Sort Panel.
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To manage the sorting order of the group's items (ascending or descending), use the Sort Order drop-
down list.

5.Then, you can calculate a total across the group, by placing a Label onto this band, and specifying its
Summary properties in the following way.

Note also that value form atting is applied to a summary independently of the general formatting, and
has a greater priority.

The report is now ready. Switch to the Preview Tab, and view the result.
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To learn how groups can be sorted against a summary function result, see Sort Groups by a Summary Function
Result.

To learn how page numbers can be added to groups independently from the report's page numbers, refer to Add
Page Numbers for Groups.

See Also
Sort Groups by a Summary Function Result
Count the Number of Records in a Report or a Group
Change or Apply Data Sorting to a Report
Change or Apply Data Filtering to a Report
Add Calculated Fields to a Report
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Add Totals to a Report

With Report Designer, you can force a data-bound control to calculate one of the standard summary functions (
Average, Summary, Count, Running Summary, Percentage, Max or Min).

To calculate summaries (totals) within a report, follow the instructions below.

1.To display the result at the bottom of a report, the Report Footer band should be present. To add it,
right-click anywhere over the report's area and in the invoked Context Menu, select Insert Band |
ReportFooter.

2.Click the field for which a summary will be calculated, to select it. Then, hold down CTRL and drag the
field onto the Report Footer area, to create an exact copy of the Label that will display the summary.

Note

You can also create a new label for your total by simply dragging it from the Control Toolbox.

3.Now, select the newly created Label, click its Smart Tag, and in its actions list, click the ellipsis button for
the Summary item. And, in the invoked Summary Editor, specify the summary options.

The following image shows an example of how you can set up your total. Note that the Summary
Running option is set to Report, to ensure that all values from the specified data field are taken into
account.
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Note

The Ignore NULL values option won't affect the result in this example, since NULL values are treated
like zeros, by default. So, Sum won't change whether these values are taken into account or not. This
option makes sense for functions like Count or Average, because the number of elements counted will
depend on it.

Note also that value form atting is applied to a summary independently of the general formatting, and
has a greater priority.

When calculating totals for groups, you can sort the groups against a summary function result.

To save the settings and close the dialog, click OK.

Switch to the Preview Tab, and view the result.
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See Also
Sort Groups by a Summary Function Result
Calculate an Aggregate Function
Add Calculated Fields to a Report
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Add Page Numbers and System Information to a Report

This document describes how to insert page num bers or other system information (e.g. cu rren t date and tim e, user
nam e, etc.) into a report.

Generally, this information is displayed within the Page Header and Footer or Page Margin bands. To add page
numbers or system information to a report, locate the Control Toolbox and drag and drop the Page Info control.

Then, follow the instructions below for your specific task.

Add Page Numbers

Add System Date and Time

Add the User Name

Add Page Numbers

1.Select the Page Info control, click its Smart Tag, and in the invoked actions list, expand the drop-down
list for the Page Information entry.

Select whether to display only the page number (Latin or Roman - uppercase or lowercase), or the
current page number with total pages.

2.To format the control's text, via its Smart Tag, invoked its actions list, and specify the required format (e.
g. Page {0} of {1}).
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3.Using the control's actions list, you also can specify the s tarting page num ber, and the runn ing band (e.g.
this option is available when there are groups in a report, and it's required to apply independent page
numbering for them). For details on this, refer to Add Page Numbers for Groups.

The result is shown below.

Add System Date and Time

1.Select the Page Info control, click its Smart Tag, and in the invoked actions list, expand the drop-down
list for the Page Information entry, and select Current Date and Time.
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2.To format the control's text, via its Smart Tag, invoked its actions list, and specify the required format.
You can either type it in the Format field, or, click its ellipsis button and use the Format String Editor.

The result is shown below.

Add the User Name

1.Select the Page Info control, click its Smart Tag, and in the invoked actions list, expand the drop-down
list for the Page Information entry, and select User Name.

2.To format the control's text, via its Smart Tag, invoke its actions list, and specify the required format (e.
g. Current User: {0}).
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The result is shown below.

See Also
Create or Modify Watermarks of a Report
Add Page Numbers for Groups
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Create or Modify Watermarks of a Report

This document describes how to add a text waterm ark in a report, or turn a picture into a report's background.
Note that watermarks are visible only in Preview and HTML View modes.

To create a new watermark in a report (or to modify the existing one), do the following.

1.Click the report's Smart Tag, and in its actions list, click the ellipsis button for the Watermark entry.

2.In the Text tab of the invoked Watermark dialog, define the required properties for the text watermark.
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3.Then, switch to the Picture Watermark tab, to load the image to be used as a watermark, and define
its properties, such as Size mode, Alignment (vertical and horizontal), Tiling, Transparency, Page Range,
etc.
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As you can see, it is possible to use both textual and image watermarks simultaneously.

The report with watermark is now ready. Switch to the Preview Tab, and view the result.

See Also
Add Page Numbers and System Information to a Report
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Create Reports

With the help of the Report Designer, you can edit existing reports, as well as create your own reports from
scratch. The following sections contain tutorials providing step-by-step instructions on both basic and advanced
report customization.

Basic Operations

The topics in this section cover the basics of working with reports in the Report Designer.

Report Types

The tutorials in this section provide you detailed instructions on how to create reports of different types
with the Report Designer.

Styles and Conditional Formatting in Reports

The topics of this section cover appearance-related information about the Report Designer.

Report Navigation

The tutorials of this section cover the navigation-related features of the Report Designer.

Miscellaneous Report Management Capabilities

The topics of this section cover the Report Designer features that don't fall into other categories.
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Basic Operations

The topics in this section cover the basics of working with reports in the Report Designer.

This section consists of the following topics.

Create a New Report

Bind a Report to Data

Controls Positioning

Change Measurement Units of a Report

Change Page Settings of a Report
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Create a New Report

This topic explains how to create a new blank report in the Report Designer. Before you start, make sure to back
up the current report.

To create a new report, do one of the following.

Create a New Blank Report

In the Main Menu, click File and then New (or press CTRL+N).

The Main Toolbar contains a button ( ) with the same function.

If there is another report already loaded in the designer, you may be prompted whether it should be saved before
it is replaced with a newly created report.

By default, the created report contains three bands - Page Header and Footer, and the Detail band.

Create a New Report Using the Report Wizard

In the Main Menu, click File and then New with Wizard... (or press CTRL+W).

For more information about this option, refer to Report Wizard.

See Also
Controls Positioning
Change Measurement Units of a Report
Change Page Settings of a Report
Bind a Report to Data
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Bind a Report to Data

The Report Designer is primarily designed to work with data-aware reports, meaning that a report obtains its
general (dynam ic) data from an external data s ource (most types of which are supported). This document
describes how a newly created report can be bound to a data source.

The document consists of the following sections.

Bind a Report to a Database

Bind a Report to an Entity Framework Data Source

Bind a Report to a Database

To bind a report to a database, do the following.

1.Create a new report.

2.Click its Smart Tag, and in the invoked actions list, expand the Data Source drop-down list and click Add
New DataSource.

3.The first wizard page of the invoked Data Source Wizard allows you to specify what type of a data
source you want to use. Select Database and click Next to proceed.
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4.On the next page, specify the database to be used. If it is absent in the drop-down selector containing
existing connections, select No, create a new connection and click Next.

Define a custom connection string, or select from the supported data source types. Depending on the
data provider selected, it may be necessary to specify additional connection options (such as
authentication type and database name) on this page.
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5.If server authentication is required for the selected database type, the next page will prompt you to
specify whether or not you want to save the user credentials along with the connection string.

Select the required option and click Next.

6.On the next page, you can construct an SQL query to obtain data from the database, or select a stored
procedure.

To construct an SQL query, click Run Query Designer...
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7.In the invoked Query Designer window, select an item from the list of available tables on the left and
drop it onto the list of data tables to be used.

It is only possible to select a single table using the Query Designer. When creating a master-detail
report, add the master table first.

8.Enable the check box near the added table to include all of its fields in the data view, and click OK to
exit the Query Designer.
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To assign a custom name to a data field, specify its Alias in the field list displayed below.

To manually customize an SQL string, enable the Allow SQL Editing option. Switching to this mode
disables the visual features of the Query Designer, allowing you to directly edit the text of the SQL
query.

Click OK to exit the Query Designer

Click Finish to exit the Data Source Wizard.

The newly created SQL data source will be displayed in the Components node of the Report Explorer.

Bind a Report to an Entity Framework Data Source

To bind a report to an Entity Framework data source, do the following.

1.Create a new report.

2.Click its Smart Tag, and in the invoked actions list, expand the Data Source drop-down list and click Add
New DataSource.
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3.The first wizard page of the invoked Data Source Wizard allows you to specify what type of a data
source you want to use. Select Entity Framework and click Next to proceed.

4.On the next page, select the required data context from the list of available data contexts and click Next
.
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5.Select a connection string to be used to establish data connection.

Click Next to proceed to the next page.

6.The next page prompts you to specify if you want to bind to a stored procedure.

To bind to a stored procedure, select it in the list of the available stored procedures and click Next
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On the next page, configure the parameters to be passed to the selected stored procedure. Be sure to
specify the correct parameter Type.

The newly created Entity Framework data source will be displayed in the Components node of the
Report Explorer.
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Controls Positioning

This document describes how to easily construct professional looking reports, by precisely aligning their elements
to each other. For this, the two following facilities are introduced in the Report Designer.

Snap Grid

Snap Lines

You can choose which mode to use for controls alignment within your report, by setting its Snapping Mode.

Snap Grid

When a report is being designed in the Design Panel, it is lined up by the Snap Grid. This helps to establish the
distance between report elements, and to precisely align them to each other.

To quickly align a control to the report's Snap Grid, right click the control, and in the invoked Context Menu, click
Align To Grid.
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You can choose whether the Snap Grid should be visible, by selecting your report, and setting the Draw the Grid
option in the Property Grid.

You also can adjust the Snap Grid Size, which is measured in the measurement units set for your report.

The Snap to Grid option specifies whether controls are snapped to the Grid when they are moved as usual (with
no additional keys being hold down). When the Snap to Grid option is enabled, the default move behavior works
in the following way.

For controls to be aligned to the Snap Grid while being moved:

- Using the keyboard: move them using the ARROW keys.

- Using the mouse: move them as usual.

For controls to ignore the Snap Grid while being moved:

- Using the keyboard: move them using ARROW keys while hold down CTRL.

- Using the mouse: move them while hold down ALT.

Disabling the Snap to Grid option swaps the default manipulation to its opposite (you should press CTRL or ALT,
to enable the Grid snapping).

Snap Lines

Instead of the Snap Grid for control positioning and alignment, you can utilize the Snap Lines. These are guide
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lines appearing when a control is being moved, and indicating the distance to other report elements (bands and
controls).

For each report element, you can modify its default Snap Line spacing (paddings for bands and Panel, and m argins
for other controls) using the Property Grid.

To learn how to manage the position of multiple controls at one time, refer to Change the Layout of Report
Elements.

See Also
Change Measurement Units of a Report
Change Page Settings of a Report
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Change Measurement Units of a Report

For your report, you can choose its global Measure Units, which can be either Hundredths of an Inch, or Tenths
of a Millimeter.

This can be specified either using the report's Smart Tag ...

... or via the Property Grid.

This defines the basic measurement unit for all the unit-related options of a report and its bands and controls
(such as location, s ize, border w idth, etc.). And, this determines the measurement unit of the report's Snap Grid.

See Also
Controls Positioning
Change Page Settings of a Report
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Change Page Settings of a Report

In the Report Designer, page settings of a report can be specified in one of two ways. The first approach forces
the default printer settings to be used when the report is printed, while the other one enables you to alter page
settings independently.

Using settings of the default printer

For the orientation, margins and paper size, you can specify a requirement that applies the corresponding
printer settings instead of the report's. In this instance, the page properties in the Property Grid are
disabled and displayed as grayed out. This may be useful when the report is printed in several places
with different printers and printer settings.

Specify the report's page settings

While designing the report, you can specify the page settings via the Property Grid:
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You can set the page orientation and modify the margins. The margin values are expressed in the
report's measurement units. You can select from the predefined paper sizes (Paper Kind property),
choose Custom and create your own paper size, or select one which is already defined for this printer (
Paper Name property).

These settings affect the layout of the report's design surface. After their modification, you may notice red
warning marks, indicating that the controls go beyond the page width. These warnings can be switched
off by setting the Show Printing Warnings property of the report to No.

Modify the settings in Preview Tab

The report's Preview Tab toolbar has a corresponding button that enables you to modify the page
settings. Clicking this button invokes the Page Setup dialog, which allows you to adjust the page layout
before printing or exporting, and select the printer.
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The margins can also be set visually by dragging the dashed lines in the Preview Tab as needed.

To change the measurement units shown in the margins tooltips, customize the report's Measure Units
property.

Measure Units = Hundredths of an Inch

Measure Units = Tenths of a Millimeter
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To learn about other options available for a report, refer to Report Settings.

See Also
Controls Positioning
Change Measurement Units of a Report
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Report Types

The tutorials in this section provide you detailed instructions on how to create reports of different types with the
Report Designer.

Choose a report type from the following table.

Static Report Table Report Label Report

Master-Detail Report
(Detail Bands)

Multi-Column Report Cross-Tab Report

Parameterized Report Chart with Static Series Chart with Dynamic Series
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Static Report

This tutorial describes the steps to create a s tatic report, which means that the report will not be bound to a data
source. In this example, we will create a simple one-page announcement to be repeated 20 times in a report.

To create a static report, do the following.

1.Create a new report.

2.From the Control Toolbox, drop the Rich Text control onto the Detail band.

3.Select the created control and click its Smart Tag. In the invoked actions list, click the Load File...
context link.

In the invoked dialog, define the path to an RTF or TXT file containing a text of the announcement, and
click Open.

Note

Note that you can perform additional text formatting using the Formatting Toolbar.

4.To repeat the created report 20 times, select the Detail band and in the Property Grid set its Repeat
Count when Data Source is Empty property to 20.

And, to make the announcement print on separate pages, set the band's Page Break property to After
the Band.
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The static report is now ready. Switch to the Preview Tab, and view the result.

See Also
Table Report
Label Report
Multi-Column Report
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Table Report

This tutorial describes the steps to create a table report, which means that the report's data is arranged into a
table-like layout. This feature should not be confused with the master-detail report or cross-tab report.

To create a table report, follow the steps below.

1.Create a new report.

2.Bind the report to a data source.

3.To add a Page Header to the report, right-click anywhere on the report's surface, and in the invoked
Context Menu, choose Insert Band | Page Header.

4.Now, add two Table controls to the report's Page Header and Detail band.

To do this, in the Toolbox, click the Table icon. Then, in the Page Header's content area, click and hold
down the left mouse button while dragging the mouse cursor across the Detail band.

As a result, two tables are created. One will be used as a header, and the other one - for the report's
detail information.

5.Type the headers into the upper table's cells, and bind the corresponding cells in the detail section to
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the appropriate data fields. This can be done by simply dropping these fields from the Field List onto the
cells.

6.Finally, you can customize various properties of the tables, to improve their appearance. For example,
using the Property Grid you can define their Borders, as well as Background Color. To customize the
cells' text options, use the Formatting Toolbar.

A noteworthy feature is the capability to specify odd-even styles for the detail table.

The table report is now ready. Switch to the Preview Tab, and view the result.
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See Also
Multi-Column Report
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Label Report

This tutorial describes the steps to create a label report containing employee badges, using the Report Wizard.

To create a label report, do the following.

1.In the Main Menu, select File and click New with Wizard... (or press CTRL+W).

2.Next, the Wizard will guide you through the process of creating a label report. For detailed instructions
on the wizard's steps, refer to Label Report Wizard.

3.Bind the report to a data source containing information about employees.

4.Finally, drop the required fields from the Field List onto the available Detail band's area, and customize
their layout.

Note that you can employ the mail merge, to combine multiple data fields within the same control.

The label report is now ready. Switch to the Preview Tab, and view the result.
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See Also
Static Report
Table Report
Multi-Column Report
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Master-Detail Report (Detail Report Bands)

This tutorial describes the steps to create a m as ter-detail report (or, invoice report) with hierarchically linked data,
using the Detail Report band.

To start with this tutorial, Create a new report and bind the report to a data source. It is only possible to select a
single table when binding to data via Data Source Wizard. For this tutorial, select the table that will be used as
the principal table in the master-detail relation.

The topic consists of the following sections.

Provide an Report Data Source with a Master-Detail Relation

Design a Master-Detail Report

View the Result

Provide a Report Data Source with a Master-Detail Relation

This section of the tutorial describes how to provide an SQL data source with a master-detail relation. If you are
using an Entity Framework data source that contains data members with master-detail relations between them,
the existing relations will be used automatically. In this case, you can skip this section of the tutorial and proceed
to the next section: Design a Master-Detail Report.

To add a master-detail relation to an SQL data source, do the following.

1.First you need to add a detail table to the report data source. To do this, right-click the data source in
the Report Explorer, and select Commands | Add Query... in the invoked context menu.

2.In the invoked Query Editor, click Run Query Designer....

3.Add the detail table to the query and click OK. Next, click Finish to exit the Query Editor.

4.Next, specify the relation between the data source tables. To do this, right-click the data source in the 
Report Explorer, and select Commands | Manage Relations... in the invoked context menu.
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5.In the invoked Master-Detail Relation Editor, click the + button next to the master query to add a new
relation. Specify a relation condition as shown in the following image and click OK to exit the dialog.

6.The Field List will be updated to reflect the added relation.

Design a Master-Detail Report

To create the layout of a master-detail report, do the following.

1.Allocate parts of a master report on the report's Detail Band.

For the master report to be generated properly, the report's Data Member should be set to the master
query. If you added the master query first, this property is set to the required value automatically. To
manually specify the data member, click the report's smart tag and in the invoked actions list, expand
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the drop-down list for the Data Member property and select the master query.

2.Now, to add a detail report band, right-click anywhere on the report's surface, and in the invoked 
Context Menu, point to Insert Detail Report. When the report's data source contains a data
relationship, it is displayed in the Context Menu.

3.Then, drop the required data fields from the Field List onto the detail report band.

Note that you should drop items from the relation  node (in this example it is the CategoriesProducts
section), for the detail report to be generated correctly.

View the Result

The master-detail report is now ready. Switch to the Preview Tab, and view the result.
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See Also
Parameterized Report
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Multi-Column Report

This tutorial describes the steps to create a m u lti-colum n report, meaning that each page of the report document
is laid out in a specified number of columns.

To demonstrate the multi-column feature, we'll use a report with grouping, similar the one created in the following
tutorial: Change or Apply Data Grouping to a Report.

1.Select the Detail band, and in the Property Grid, expand the Multi-Column Options section.

First, set the required Mode. It determines whether the number of columns is manually specified, or it
depends on the fixed column width.

2.Then, if you've chosen to Use Column Count, set the Column Count to 2, and Column Spacing to 10.

The Direction determines the order in which records of the same group are processed.

3.Now, on the Detail band's surface a grey area appears, delimiting the available column's width. Adjust
the controls width, so that they fit within the effective borders.

The multi-column report is now ready. Switch to the Preview Tab, and view the result.
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See Also
Label Report
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Cross-Tab Report

This tutorial describes the steps to create a cros s -tab report using a Pivot Grid control. This feature should not be
confused with the master-detail report or table report.

To create a cross-tab report, do the following.

1.Create a new report.

2.Drop the Pivot Grid control from the Toolbox onto the report's Detail band.

3.To bind the pivot grid to a data source, click its Smart Tag, and in the invoked actions list, expand the
Data Source drop-down selector and click Add New DataSource.

The invoked Report Wizard will guide you through the process of assigning a data source to the grid.
For detailed instructions on the Wizard's steps, refer to Bind a Report to Data, as this process is similar.

Note

Note that after these steps, the report's Data Source property must be set to None.
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Otherwise, the grid will be blank at the preview and repeated as many times as there are records in the
data source.

4.After the dataset is created, it is assigned to the grid's Data Source property. Its Data Member
property defines from which table or view of your dataset the grid obtains its data. And, the Data
Adapter property is auto-defined, as well.

So once again, click the grid's Smart Tag, and in the invoked actions list, click the Run Designer... link.

5.In the invoked Property Editor, click Retrieve Fields.

6.Then, switch to the Layout section in the navigation bar on the left.

Drag and drop the required fields to the Row Fields, Column Fields and Data Items areas.
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Click Apply and close the editor.

7.In the last step, you can set your report's Vertical Content Splitting option to Smart. This will split the
grid's columns precisely by their borders in the Print Preview.

The cross-tab report is now ready. Switch to the Preview Tab, and view the result.
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See Also
Master-Detail Report (Detail Report Bands)
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Parameterized Report

This tutorial describes the steps to create a report with parameters. In this example, we will create two date-time
parameters, to filter out orders which don't fall in the specified range, from the report.

First, create a report and bind it to a data source.

To add parameters and filter your report based on their values, follow the steps below.

1.In the Field List window, right-click over the Parameters section and in the invoked menu, click Add
Parameter.

2.In the invoked window for the created parameter, set its Name and Description. And, make sure to set
its Type to an appropriate value.

Note

In Print Preview, the report's document is not generated until you have submitted values of all the
parameters that have the Show in the parameters panel option switched on via the Parameters UI.

3.Enabling the Supports the collection of standard values option of the parameter allows end-users to
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modify its value and also activates the Dynamic values and the Static values tabs of the window:

- On the Dynamic values tab, you can specify a parameter's data source, data adapter and data
member. The value member defines a data field that provides values to the parameter. The display
member defines a data field that provides display names for parameter values (how these values
appear in the user interface available in a Print Preview).

- On the Static values tab, you can manually fill the list of parameter values, with each value having an
individual description (specifying how this value appears in the Parameters panel).

Then, repeat the previous steps to create the second parameter, so that every time your report is
previewed, you will be asked to specify two dates.

The following instructions explain how to use parameters to filter your report's data.

4.Click your report's Smart Tag, and in the invoked actions list, click the ellipsis button for the Filter String
entry. Then, in the invoked Filter String Editor, construct an expression where a data field is compared
with the created parameters. To access parameters, click the icon on the right until it turns into a
question mark.
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The complete filtering expression will then look like this.

The parameterized report is now ready. Switch to the Preview Tab, and in the Parameters section, define the
required values and click Submit.



Report Designer 348

© 2014 DevExpress Inc. 348



Report Designer 349

© 2014 DevExpress Inc. 349

Chart with Static Series

This document describes how to create a report with a Chart control bound to data, so that a particular s eries has
its own data s ource, and other settings. To simplify the example, both series obtain their data from the same data
source. However, different data sources can be used for different series, if necessary.

This example describes how to construct a chart of products and their prices for a chosen category.

To adjust a Chart by manually creating its series, do the following.

1.Create a new report.

2.Drop the Chart control from the Toolbox onto the report's Detail band.

Note that after you drop the Chart, the Chart Wizard may be invoked (if its "Show wizard every time a
new chart is added" option is enabled). In this example, we don't need to use the Wizard, so click 
Cancel to close its window.

3.To bind the Chart to a data source, click its Smart Tag. In the invoked actions list, expand the Data
Source drop-down selector, and click Add New DataSource.
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The invoked connection Wizard will guide you through the process of assigning a data source to the
Chart. For detailed instructions on the Wizard's steps, refer to Bind a Report to Data, as this process is
similar.

Note

Note that after these steps, the report's Data Source property must be set to None.

Otherwise, the Chart will be blank when previewed, and repeated as many times as there are records
in the data source.

4.After the dataset is created, it is assigned to the Chart's Data Source property. Its Data Member
property defines from which table or view of your dataset the Chart obtains its data. And, the Data
Adapter property is auto-defined, as well.

So once again, click the Chart's Smart Tag, and in the invoked actions list, click the Series... link.
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5.Now, in the invoked Series Collection Editor, create a series of the required view  type (e.g. Bar).

Then, switch to the Properties tab at the right of the editor's window, and assign the existing data set
object to the Data Source property of the series. And, assign the required data fields to the Argument
Data Member and Value Data Member properties, which determine the coordinates for series points.

In addition, you can filter the series data. To do this, click the ellipsis button for its Data Filters property,
and in the invoked dialog, create and adjust the filtering criteria.
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To save the changes and quit the dialog, click Close.

Then, back in the Series Collection Editor, click Copy, to create a similar series, but change its View to
Point.

6.Finally, to improve your Chart's appearance, you can make the following adjustments.

- Remove the Chart's legend, as it shows the same data for both series. To do this, click the Legend,
and in the Property Grid, set its Visible property to No.

- The point labels for Series1 are unnecessary, so select the label and set its Visible property to No.

- Customize the appearance of the Series2 markers (e.g. replace the default circle with the upside-down
triangle by the View.Point Marker Options.Kind property and set its Size to 12).

- Rotate the X-axis labels for better readability. To do this, select the AxisX item in the chart by mouse
click, and adjust properties for its labels (via the Label property). For instance, if the Angle property is
20 and the Antialiasing property is set to Yes, the labels look neat.

If required, it is possible to customize many other properties for the Chart, which are not described
here.

The chart is now ready. Switch to the Preview Tab, and view the result.
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See Also
Chart with Dynamic Series
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Chart with Dynamic Series

This document describes how to create a report with a Chart control bound to data, so that all series are auto-
created based on a common tem plate, which specifies universal options for all series. This is possible when the
data for all series (their names, along with points' arguments and values) are stored in the same data table.

Note that in this scenario, the view  type, and certain other settings, will be the same for all series.

To adjust a Chart with automatically created series, do the following.

1.Create a new report.

2.Drop the Chart control from the Toolbox onto the report's Detail band.

Note that after you drop the Chart, the Chart Wizard may be invoked (if its "Show wizard every time a
new chart is added" option is enabled). In this example, we don't need to use the Wizard, so click 
Cancel to close its window.

3.To bind the Chart to a data source, click its Smart Tag. In the invoked actions list, expand the Data
Source drop-down selector, and click Add New DataSource.
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The invoked connection Wizard will guide you through the process of assigning a data source to the
Chart. For detailed instructions on the Wizard's steps, refer to Bind a Report to Data, as this process is
similar.

Note

Note that after these steps, the report's Data Source property must be set to None.

Otherwise, the Chart will be blank when previewed, and repeated as many times as there are records
in the data source.

4.After the dataset is created, it is assigned to the Chart's Data Source property. Its Data Member
property defines from which table or view of your dataset the Chart obtains its data. And, the Data
Adapter property is auto-defined, as well.

Now, to specify the data field which should provide data for the series names (so that a new series is
created for each record in that data field), set the Series Data Member property value.
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5.Then, adjust the series template which is accessed via the chart's Series Template property. First, set
the Argument Data Member (which specifies from where the data for points' argum ents is obtained).

Make sure that the Argument Scale Type property is set to an appropriate value. Otherwise (e.g. when
your data is of the date-tim e type, but this property is set to Qualitative), the resulting Chart will be
seriously affected, and incorrectly represent its underlying data.

6.And, specify the Value Data Members property, indicating the data field(s) from which the points' values
are obtained.
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As with the argument, make sure to appropriately specify the Value Scale Type.

7.At this point, the chart's data options are completely defined, so in this step some additional
customization capabilities are described.

- Adjust the Series Name Template
By default, the name for every auto-created series is obtained directly from an appropriate data field in
the bound data source. However, you can add some text to the beginning or to the end of every series
name, via the Series Name Template property. For instance, here we set the Begin Text property to
"GSP in ".

- Customize Axis Labels
To avoid overlapping axis labels, select an axis and set its Label.Staggered property to Yes.

If required, it is possible to customize many other properties for the Chart, which are not described
here.

The chart is now ready. Switch to the Preview Tab, and view the result.
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See Also
Chart with Static Series
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Styles and Conditional Formatting

The topics of this section cover appearance-related information about the Report Designer.

This section consists of the following topics.

Understanding Style Concepts

Use Odd and Even Styles

Store and Restore Style Sheets

Conditionally Change a Control's Appearance

Conditionally Hide Bands

Conditionally Change a Label's Text
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Understanding Style Concepts

This document describes how you can provide a professional look to your reports, by effectively adjusting the
appearance of its elements.

This document consists of the following sections.

The Appearance Properties

Styles Priority and Inheritance

The Appearance Properties

In the Report Designer, a report and each of its elements (bands and controls) has a complete set of appearance
options (such as Background Color, Borders, Font, Foreground Color, Text Alignment, etc.). By default, these
properties aren't specified, meaning that their real values are obtained from a control's (or band's) paren t, which is
the report itself. So, the appearance, specified for a report, is distributed to all its child elements. Similarly, the
appearance of a band is translated to the controls it contains.

In turn, a control's appearance can be adjusted independently from its parent.
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When it is required to reset a value assigned to a control's appearance property, you can right-click this property
in the Property Grid, and in the invoked menu, click Reset. So, the control will be restored to the appearance of its
parent.

Styles Priority and Inheritance

To differentiate appearance settings in your report, you can create comprehensive s tyles (which are stored in the
report's s tyle sheet), and then can be assigned to individual elements. There are two ways to store a report's
styles.

to save them to external files (with REPSS extension), and then load them to a report via its Style Sheet
Path property (this is described at Store and Restore Style Sheets);

to store the styles within the report, so that they can be easily accessed via its Style Sheet property.

Note that if styles contained in a style sheet loaded via the Style Sheet Path property have the same names as
styles already contained in a report, the latter ones are overridden.

When both styles and individual appearance settings are assigned to an element, you can control the priority of
their differing options, via an element's Style Priority property.

By default, most of the Style Priority's options (Use Background Color, Use Border Color, etc.) are set to Yes.
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This means that if any style is assigned to a control, its properties will have a higher priority than the appearance
properties of this element or its parent. You can assign a higher priority to an element's appearance property, by
disabling the corresponding Use* property.

The same principles are applied to the odd-even  s tyles feature, which allows you to alternate the appearance of
consecutive data rows in your report. For details on this, refer to Use Odd and Even Styles.

Note

When conditional formatting is applied to an element, its appearance definition has the highest priority.

See Also
Use Odd and Even Styles
Store and Restore Style Sheets
Conditionally Change a Control's Appearance
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Use Odd and Even Styles

This tutorial describes how to apply odd and even  s tyles to report controls, e.g. to alternate the background color
for each record.

To utilize odd and even styles, do the following.

1.Create a table report.

2.Select the detail table, and in the Property Grid, expand its Styles.

Invoke the drop-down list for the Even Style, and click (New).

This will create a style and assign it to the control's Even Style.

3.Now, expand the Even Style property, and adjust the required options, e.g. set the Background Color
to ControlLight.

If required, perform the same steps, to create and assign an odd style, as well.

Switch to the Preview Tab, and view the result.
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See Also
Understanding Style Concepts
Store and Restore Style Sheets
Conditionally Change a Control's Appearance
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Store and Restore Style Sheets

This tutorial describes how you can save a report's style sheet into an external file, and then load it back to the
report.

You can store a report's style sheet (containing all the report's styles) in an external REPSS file. This makes it
possible to easily restore a report's appearance from this file. For general information, refer to Understanding
Style Concepts.

To learn how to store and restore report style sheets, do the following.

1.Create a new report and bind it to a data source.

2.Click the report's Smart Tag, and in the invoked actions list, click the ellipsis button for the Style Sheet
property.

3.In the invoked Styles Editor, use the  button, to create new styles. For them, specify the desired
options (e.g. Background Color), and click the Save button.
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Then, in the invoked Save File dialog, define a name for the style sheet file (.REPSS), and click Save.

4.Then delete the created styles, using the  button, and close the dialog.

5.Select the report, and in the Property Grid, click its ellipsis button for the Style Sheet Path property. In
the invoked Open File dialog, load the created REPSS file.

When you invoke the Styles Editor (via the report's Style Sheet property) again, you'll see that the
styles are read-only, meaning that they are obtained from an external file.
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If the Style Sheet Path property is then set to None, and a style sheet is loaded using the Styles
Editor of the Style Sheet property, all these styles will become editable.

To learn how you can assign styles to report elements, refer to Use Odd and Even Styles.

Note

Note that the styles loaded from a style sheet file have priority over the styles which exist in a report's style
sheet. So, if the styles stored in the report have the same names as the styles loaded from a style sheet file,
then the styles from the file will substitute for their namesakes.

See Also
Understanding Style Concepts
Use Odd and Even Styles
Conditionally Change a Control's Appearance
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Conditionally Change a Control's Appearance

This tutorial describes the steps to conditionally change a control's appearance (e.g. make a Label's text red if its
value exceeds some threshold). Thanks to the form atting ru les feature, to achieve this, no scripts are required, so
you shouldn't write any code.

To conditionally change a control's appearance, do the following.

1.Create a data-aware report.

2.Click the report's Smart Tag, and in the invoked actions list, click the ellipsis button for the Formatting
Rule Sheet option.

And, in the invoked Formatting Rule Sheet Editor, create a new form atting ru le (by using the  button),
and click the ellipsis button for its Condition property.
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3.Then, in the invoked Condition Editor, define the required Boolean condition (which means that its result
is returned as either true or fals e). In this tutorial, we will format fields if the UnitPrice value is greater
than 30.

To save the condition and close the dialog, click OK.

4.Now, back in the Formatting Rule Sheet Editor, define the formatting to be applied (e.g. specify the
desired font color).
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To save the changes and quit the dialog, click Close.

5.Finally, select the band or control to which the formatting rule must be applied (in this example it is the 
Detail band), and via its Smart Tag, access its collection of Formatting Rules.

And, in the invoked Formatting Rules Editor, move the rule from left to right (using the > button), for it
to come into effect for this band.
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If multiple rules are applied, it is possible to customize their precedence, by using the up and down
arrow buttons at the right of the dialog. So, the rules are applied in the same order that they appear in
the list, and the last rule in the list has the highest priority.

The result is shown in the following image.

See Also
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Conditionally Hide Bands
Conditionally Change a Label's Text
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Conditionally Hide Bands

This tutorial describes how to hide bands if a certain logical condition is met. Note that no scripts are required to
accomplish this task.

To demonstrate this feature, we'll use a report with grouping, similar to the one created in the following tutorial: 
Change or Apply Data Grouping to a Report.

To conditionally hide bands in a report, do the following.

1.Select the Group Header, and click its Smart Tag. Then, in the invoked actions list, click the ellipsis button
for the Formatting Rules option.

In the invoked Formatting Rules Editor, click the Edit Rule Sheet... button.

2.Now, in the invoked Formatting Rule Sheet Editor, click the  button, to create a new rule. Then, set
its Visible property to No, and click the ellipsis button for the Condition property.
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3.Construct the required logical expression (e.g. [CategoryID] < 2), and click OK.
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To quit the Formatting Rule Sheet Editor, click Close.

4.Back in the Formatting Rules Editor, move the created rule to the dialog's right section (Applied Rules),
to make it active.

And, do the same for the report's Detail band. That is, click the ellipsis button for its Formatting Rules
property, and in the invoked dialog, apply the same rule to this band, as well.

Switch to the Preview Tab, and view the result. In our example, you can see that the first category isn't shown.
So, the conditional formatting was applied properly.

See Also
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Conditionally Change a Control's Appearance
Conditionally Change a Label's Text
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Conditionally Change a Label's Text

This tutorial demonstrates how to change a label's text if a certain condition is met, without using scripts.

To conditionally change a label's text, do the following.

1.Create a new report and bind it to a data source.

2.To create a calculated field, in the Field List, right-click any item inside the created dataset, and on the
invoked menu, choose Add Calculated Field.

3.Select the calculated field, and in the Property Grid, set its Field Type to String. Then, click the ellipsis
button for its Expression property.

And, in the invoked Expression Editor, define the required logical condition for the calculated field (e.g.
Iif([UnitsOnOrder] == 0, 'None', [UnitsOnOrder]), which means that if the UnitsOnOrder data field's
value is equal to 0, the control's text will be replaced with None).
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To save the changes and close the dialog, click OK.

4.Finally, drop the required data fields (and the created calculated field as well) from the Field List onto
the report's Detail band.

The report is now ready. Switch to the Preview Tab, and view the result.
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See Also
Conditionally Change a Control's Appearance
Conditionally Hide Bands
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Navigation

The tutorials of this section cover the navigation-related features of the Report Designer.

This section consists of the following tutorials.

Add Bookmarks

Create Hyperlinks

Add a Cross-Reference
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Add Bookmarks

This tutorial describes the steps to create a report with bookm arks (a so-called Docum ent Map). This feature allows
you to easily navigate through the report during print preview.

To demonstrate the Document Map feature, we'll use a report with grouping, similar the one created in the
following tutorial: Change or Apply Data Grouping to a Report.

To create a report with bookmarks, do the following.

1.Click the Label in the Report Header band, to select it, and in the Property Grid, set its Bookmark
property to the same value as its text (i.e. Products by Categories).

2.Now, select the Label in the report's Group Header band. As this control is bound to data, we will bind
its Bookmark property to the same data field, using the (Data Bindings) property.

Note that as with other bindable properties, you also can apply value formatting to the Bookmark
property (e.g. Category {0}).

3.Then, for this Label, specify its Bookmark, and set the Parent Bookmark property to the Report
Header's label, to define the document map's hierarchy.
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The report with bookmarks is now ready. Switch to the Preview Tab, and view the result.

See Also
Create Hyperlinks
Add a Cross-Reference
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Create Hyperlinks

This tutorial demonstrates how to embed a hyperlink into your report.

Note that a label will behave as a hyperlink both in a report's Print preview, HTML preview and when the report is
exported to PDF, HTML, MHT, RTF, XLS and XLSX formats.

To insert a hyperlink into your report, do the following.

1.Create a new report.

2.Drop a Label onto the report, and in the Property Grid, change its Text to the one required for the link.

In addition, to make the Label look like a typical link, you can change its appearance appropriately (e.g.
make it blue and underlined).

3.Now, set its Navigation Target to the required value (_blank, _paren t, _search, _self, or _ top), and
define the required Navigation URL.

The hyperlink is now ready. Switch to the Preview Tab (or, HTML View Tab), and view the result.

See Also
Add Bookmarks
Add a Cross-Reference
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Add a Cross-Reference

This tutorial demonstrates how to add a cros s -reference to your report. A cross-reference is simply a link whose
target is located within the current document, which allows you to establish easy navigation through a report. In
this example, we place a link at the bottom of each group, leading to the beginning of the report.

To demonstrate this feature, we'll use a report with grouping, similar the one created in the following tutorial: 
Change or Apply Data Grouping to a Report.

To create a report with cross-references, do the following.

1.Drop a label onto the created ReportHeader band, which will serve as the report's headline. Click the
label, to type the desired contents into it. Then, in the Property Grid, set its Name property to
reportTop.

2.To accompany the existing Group Header with the corresponding Footer, in the Group and Sort Panel,
check the Show Footer option.

Then, drop a label onto it. As it will be the link, change its Text to Top of Report, and apply the desired
formatting to it (e.g. the blue color and underlined text).

Set its Navigation Target property to _self. Then, if you click the drop-down list of the Navigation URL
property, you can see the controls available in your report. Choose the one named reportTop.

The report with cross-references is now ready. Switch to the Preview Tab (or, HTML View Tab), and view the
result.
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See Also
Add Bookmarks
Create Hyperlinks
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Miscellaneous

The topics of this section cover the Report Designer features that don't fall into other categories.

This section consists of the following topics.

Handle Events via Scripts

Show the Current Row Index

Count the Number of Records in a Report or a Group

Add Page Numbers for Groups

Sort Groups by a Summary Function Result

Calculate an Aggregate Function

Cancel Printing If a Report Does Not Contain Any Records

Limit the Number of Records per Page
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Handle Events via Scripts

This document describes the basic principles of s cripting, which can be performed by handling the events of a
report, and its bands and controls.

This documents consists of the following sections.

Scripting Overview

Scripting Specifics

Example: Custom Summary

Scripting Overview

Scripts are program commands, placed within the even t handlers of the required report elements. And, when the
corresponding event occurs (e.g. a mouse click), the script code runs.

You can write s cripts for a report or any of its elements (bands and controls), to be executed when the report is
being previewed, printed or exported.

Although when in the Report Designer, virtually any task can be accomplished without scripting (Conditionally
Change a Control's Appearance, Conditionally Change a Label's Text and Conditionally Hide Bands), scripting is
made available to extend the standard functionality as far as may be required. And, scripting is the only way to
calculate cus tom  sum m aries (this is detailed in the last section of this document).

Every report element has an set of script events, which are individual for each element's type. For example, the
events of the Detail band are shown in the following image.

After you click (New) for an event (e.g. the Before Print, which is the most used), the Scripts Tab is switched on,
where you can manage and edit all the report's scripts.
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In this tab, for a selected event, a script template is auto-added, in the language specified via the Script
Language property of the report.

You can verify that your report's scripts are valid, by clicking Validate. The validation result is then displayed in
the Scripts Errors Panel.

Note that scripts are saved to a file along with the report's layout (for details on this, refer to Back Up the Current
Layout Before Modifying It).

Scripting Specifics

1.Scripting language

The report scripts may be written in one of the following languages that the .NET framework supports - 
C#, Visual Basic and J#. Since J# is not installed with the framework installation, by default, make sure
it is present before writing code in it. The scripting language is specified via the Script Language
property of the Report object. It is set to C#, by default.

2.Scripting scope

Script execution is performed in the following way:

The report engine generates a temporary class in memory. The names of the variables are defined by
the Name properties of the controls and objects they represent. When the script is preprocessed, its
namespace directives are cut from the script code and added to the namespace, where the temporary
class is defined.

After preprocessing, all scripts are placed in the code of the temporary class. Then, the resulting class is
compiled in memory, and its methods are called when events occur.

Scripting offers many advantages: you can declare classes (they will become inner classes), variables,
methods, etc. A variable declared in one script is accessible in another script, because it is, in fact, a
variable of the temporary class.

3.Reference External Assemblies

The Script References property of the Report object specifies the full paths (including the file names) to
the assemblies that are referenced in the scripts used in a report. These paths should be specified for
all the assemblies that are included in scripts via the using (C#), Imports (Visual Basic) or import (J#)
directives.
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Note

Usually, you don't need include any assembles, because most standard assemblies that you may
require in scripts are already referenced by the Report Designer.

Example: Custom Summary

In this example, we will display the total number of product unit packs in a group.

To perform this, execute steps similar to the ones described in Add Totals to a Report, except that for the
summary field, you should set the Function property to Custom.

Then, the additional events are added to the label's Scripts property.

You can handle these events in the following way.

C#

// Declare a summary and a pack.
double totalUnits = 0;
double pack = 15;
private void OnSummaryReset(object sender, System.EventArgs e) {
    // Reset the result each time a group is printed.
    totalUnits = 0;
}
private void OnSummaryRowChanged(object sender, System.EventArgs e) {
    // Calculate a summary.
    totalUnits += Convert.ToDouble(GetCurrentColumnValue("UnitsOnOrder"));
}
private void OnSummaryGetResult(object sender,
DevExpress.XtraReports.UI.SummaryGetResultEventArgs e) {
    // Round the result, so that a pack will be taken into account
    // even if it contains only one unit.
    e.Result = Math.Ceiling(totalUnits / pack);
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    e.Handled = true;
}

Visual Basic

' Declare a summary and a pack.
Private totalUnits As Double = 0
Private pack As Double = 15
Private Sub OnSummaryReset(ByVal sender As Object, ByVal e As System.EventArgs)
    ' Reset the result each time a group is printed.
    totalUnits = 0
End Sub
Private Sub OnSummaryRowChanged(ByVal sender As Object, ByVal e As System.EventArgs)
    ' Calculate a summary.
    totalUnits += Convert.ToDouble(GetCurrentColumnValue("UnitsOnOrder"))
End Sub
Private Sub OnSummaryGetResult(ByVal sender As Object,  _
ByVal e As DevExpress.XtraReports.UI.SummaryGetResultEventArgs)
    ' Round the result, so that a pack will be taken into account
    ' even if it contains only one unit.
    e.Result = Math.Ceiling(totalUnits / pack)
    e.Handled = True
End Sub

Finally, switch to the Preview Tab, and view the result.
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See Also
Show the Current Row Index
Count the Number of Records in a Report or a Group
Add Page Numbers for Groups
Cancel Printing If a Report Does Not Contain Any Records
Limit the Number of Records per Page
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Show the Current Row Index

This document describes how to accompany every record in a data-bound report with its current row index.

To show the current row index in a report, use a Label control bound to a data field, and specify its Summary
options in the following way.

The result is shown in the following image.

See Also
Count the Number of Records in a Report or a Group
Limit the Number of Records per Page
Cancel Printing If a Report Does Not Contain Any Records
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Count the Number of Records in a Report or a Group

This tutorial describes how to count the number of records in a report or a group. To demonstrate this feature,
we'll use a report with grouping, similar the one created in the following tutorial: Change or Apply Data Grouping
to a Report.

This tutorial consists of the following sections.

Count the Number of Records in a Group

Count the Number of Records in a Report

Get the Result

Count the Number of Records in a Group

To count the number of records in a group, do the following.

Select the Label in the Group Footer area, and in the Property Grid, expand its Summary category.

Set the Running option to Group and the Function to Count.

The Ignore NULL values option is useful for functions like Count or Average, because the number of
elements counted will depend on it.

If required, you can specify the Format String (e.g. as Units Count: {0}). Note that value form atting is
applied to a summary independently of the general formatting, and has a greater priority.

Count the Number of Records in a Report

To count the number of records in a report, do the following.

1.To add a Report Footer band to your report, right-click anywhere on it, and in the invoked Context Menu
, choose Insert Band | ReportFooter.
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2.Then, place a Label bound to a data field onto it, and in the Property Grid, expand its Summary
category.

Set the Running option to Report and Function to Count.

The Ignore NULL values option is useful for functions like Count or Average, because the number of
elements counted will depend on it.

If required, you can specify the Format String (e.g. as Total Count: {0}). Note that value form atting is
applied to a summary independently of the general formatting, and has a greater priority.

Get the Result

The report is now ready. Switch to the Preview Tab, and view the result.
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See Also
Show the Current Row Index
Limit the Number of Records per Page
Cancel Printing If a Report Does Not Contain Any Records
Add Page Numbers for Groups
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Add Page Numbers for Groups

This tutorial demonstrates how to display page numbers individually, for each group in your report. To
demonstrate this feature, we'll use a report, similar to the one created in the following tutorial: Change or Apply
Data Grouping to a Report.

To add page numbers for groups, do the following.

1.From the Toolbox, drop the Page Info control onto the Group Footer.

2.Then, select the control, and set its Running Band to GroupHeader1.

If required, you also can specify its Format property (e.g. Page {0} of {1}).

3.Now, you should force each new group to start on a separate page. Otherwise, group page numbers
will be calculated incorrectly.

To do this, select the Group Footer, and set its Page Break to After the Band.

4.Finally, select the Group Footer, and click its Smart Tag. In its actions list, check the Repeat Every Page
option.
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Then, you can do the same for the Group Header, as well.

The report is now ready. Switch to the Preview Tab, and view the result.

See Also
Sort Groups by a Summary Function Result
Show the Current Row Index
Count the Number of Records in a Report or a Group
Cancel Printing If a Report Does Not Contain Any Records
Limit the Number of Records per Page
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Sort Groups by a Summary Function Result

This tutorial demonstrates how to sort groups based on the result of a function summary specified for them. To
demonstrate this feature, we'll use a report similar to the one created in the following tutorial: Change or Apply
Data Grouping to a Report.

To sort groups by a summary function result, do the following.

1.Select the Group Header band and click its Smart Tag. In the invoked actions list, click the ellipsis button
for the Sorting Summary option.

2.Then, in the invoked Group Sorting Summary Editor, check the Enabled option, and specify a field and
summary function against which the group should be sorted.

If required, you also can change the default sorting order (from descending to ascending), and choose
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to ignore null values.

Click OK to apply the changes, and switch to the Preview Tab to view the result.

See Also
Add Totals to a Report
Change or Apply Data Grouping to a Report
Count the Number of Records in a Report or a Group
Add Page Numbers for Groups
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Calculate an Aggregate Function

This tutorial describes the steps required to create a report with an aggregate function. In this example, products
that are not discontinued and have a total unit value greater than $500 will be displayed.

Create a table report with a layout similar to that appearing in the following illustration.

Create a new calculated field and set the field name to "AggregateField".

Click the ellipsis button in the Expression section. The Expression Editor dialog will appear.

In this dialog, double click the [CategoriesProducts] field, then choose Functions | Aggregate. Next,
double click the Count() function. Insert the following text into the empty square brackets.

"Not[Dis con tinued]And[Un itTotal] >= 500".

Click OK to close the dialog and save the expression.

Next, add three Labels to the Detail Band and customize their content, as shown in the following image.
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The report is now ready. Switch to the Preview Tab, and view the result.

You can also set formatting rules for the report. The following image shows the sample report. The data rows that
are not discontinued and have a total unit value greater than $500 are highlighted in red.
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See Also
Add Totals to a Report
Add Calculated Fields to a Report
Sort Groups by a Summary Function Result



Report Designer 403

© 2014 DevExpress Inc. 403

Cancel Printing If a Report Does Not Contain Any Records

To cancel printing when a report does not contain any records, simply set the report's Print when Data Source is
Empty property to No.

You can quickly perform this via the report's Smart Tag.

See Also
Show the Current Row Index
Count the Number of Records in a Report or a Group
Limit the Number of Records per Page
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Limit the Number of Records per Page

This tutorial demonstrates how to define how many records should be displayed at each page in a report's Print
Preview. Note that no scripts are required to accomplish this task.

To demonstrate this feature, we'll use a report, similar to the one created in the following tutorial: Change or
Apply Data Grouping to a Report.

To limit the number of records per page, do the following.

1.To add a parameter to the report, in the Field List, right-click the Parameters section, and in the invoked
menu, choose Add Parameter.

2.Select the parameter, and in the Property Grid, set its Description to Rows per Page:, Parameter Type
to Int32 and (Name) to rowsNumber.

3.From the Toolbox, drop the Page Break control onto the top of the report's Detail band.
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4.Select the Page Break, and set its Visible property to No. Then, click the ellipsis button for its
Formatting Rules property, and in the invoked Formatting Rules Editor, click the Edit Rule Sheet...
button.

5.Now, in the invoked Formatting Rule Sheet Editor, click , to create a new formatting rule. Set its
Visible property to Yes, and click the ellipsis button for its Condition property.

6.In the invoked Condition Editor, define a logical expression for the rule, (e.g. ([DataSource.
CurrentRowIndex] % [Parameters.rowsNumber] == 0) And ([DataSource.CurrentRowIndex] != 0)
).
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To save the changes and close the dialog, click OK.

Then, click Close, to quit the Formatting Rule Sheet Editor, as well.

7.Now, back in the Formatting Rules Editor, move the created rule to the list of applied rules on the right,
using the arrow buttons in the middle of the dialog.

To save the changes and close the editor, click OK.

The report is now ready. Switch to the Preview Tab, and in the Parameters section, define the required value and
click Submit.
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Note that while in this example, the number of rows is specified each time the report is being previewed, you can
make this number secure, by setting the parameter's Value option to the desired value, and then setting the
report's Request Parameters option to No.

See Also
Show the Current Row Index
Count the Number of Records in a Report or a Group
Cancel Printing If a Report Does Not Contain Any Records
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Report Designer Reference

A report is built from controls (text labels, images, zip codes, charts, etc) spread across report sections called
bands (various headers, footers and content sections). The main interface elements helping you manage these
building blocks are Control Toolbox, Field List and Property Grid. These elements allow you add controls to your
report, bind them to data and change their appearance and behavior settings, respectively.

To learn more about these and other elements used in the Report Designer, use the following links.

Report Designer UI

The documents in this section are dedicated to the elements of the Report Designer user interface.

Report Controls

The documents in this section describe options of each report control available in the Report Designer.

Report Bands

The documents in this section details the available kinds of report bands and their settings.

Report Settings

This document details settings that affect the entire report.
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Report Designer UI

The documents in this section are dedicated to the elements of the Report Designer user interface.

The following topics describe the Report Designer interface.

Report Designer Interface

Report Designer Elements

Ribbon Designer Elements

General Elements

Control Toolbox

Design Panel

Main Menu

Quick Access Tools

Context Menu

Smart Tag

Toolbars

Main Toolbar

Formatting Toolbar

Layout Toolbar

Zoom Toolbar

Dock Panels

Field List

Group and Sort Panel

Property Grid

Report Explorer

Scripts Errors Panel

Tabs

Designer Tab

Preview Tab

HTML View Tab

Scripts Tab

Additional Elements

Component Tray

Status Bar
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Report Designer Elements

This document describes elements that comprise the Report Designer that is intended for creating and editing
reports.

The following image illustrates a Report Designer.

The following table lists all main interface elements of the Report Designer.

Element Description

Main Menu Contains a set of items and subitems that allow you
to perform common actions over the report currently
shown in the Design Panel.

It duplicates all the toolbar buttons available on the 
Main, Formatting and Layout toolbars. The Window
menu allows for the disabling of the tabbed multi-
document interface and the tiling of Design Panel
windows vertically or horizontally.

Main Toolbar The main file management toolbar in the Designer. It
contains buttons that allow you to create new
reports, save and load report layouts, cut, copy and
paste controls, and undo and redo actions in the
Designer.
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Layout Toolbar The toolbar for positioning report elements. It
contains buttons that provide the ability to change
the size and location of groups of controls.

Toolbox Contains the available controls that you can add to
your report by dragging and dropping their icons onto
a report's area.

Formatting Toolbar Contains buttons for text formatting. This toolbar can
be also used when a control's text (or its section) is
edited via the In-Place editor.

Zoom Toolbar Provides means for zooming in and out of your report
(both in design and preview modes).

MDI Controller Provides the multi-document interface in the Designer
by containing its Design Panels.

Design Panel A surface where a report is being edited and
previewed. The Designer provides a multi-document
interface, and can have as many Design Panels as
required, each associated with a single report
instance.

Each Design Panel has four tabs (Designer, Preview,
HTML View and Scripts) for report editing, previewing,
and maintaining its scripts.

Component Tray Shows components related to report data binding.
You can click them to display and edit their settings
using the Property Grid.

Report Explorer Displays the structure of a report in a visual-tree form,
which makes the report navigation easier.

Field List Shows the structure of a report's data source and is
used to bind report controls to data.

Property Grid Used to access and modify properties of a report and
all its elements (bands and controls).

Group and Sort Panel Allows you to quickly perform grouping and sorting
operations throughout a report, and visually
represents the report's grouping structure.

Scripts Errors Panel When errors are found in a report's scripts (after
clicking Validate in the Scripts Tab), it lists these
errors. Clicking an error opens the corresponding
script section in the Scripts tab.

Status Bar Provides tips and specific information about the
Designer element being hovered by a cursor or an
action being currently performed.
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Ribbon Designer Elements

This document describes elements that comprise the Ribbon Report Designer.

The following image illustrates a Ribbon Designer.

The following table lists all the main interface elements of the Ribbon Designer.

Element Description

Ribbon The main toolbar in the Designer that contains the 
Main, Formatting, Layout and Zoom toolbars, as well
as the Scripts Tab button.

Toolbox Contains controls that you can add to your report by
dragging and dropping its icons onto a report's area.

Main Tabs Allows you to switch between the Designer, Preview
and HTML View tabs.

MDI Controller Provides the multi-document interface in the Designer
by containing its Design Panels.
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Design Panel A surface where a report is being edited. The
Designer provides a multi-document interface, and
can have as many Design Panels as there are reports
open in it.

Component Tray Shows components related to report data binding.
You can click them to display and edit their settings
using the Property Grid.

Report Explorer Displays the structure of a report in a visual-tree form,
which makes the report navigation easier.

Field List Shows the structure of a report's data source and is
used to bind report controls to data.

Property Grid Used to access and modify properties of a report and
all its elements (bands and controls).

Group and Sort Panel Allows you to quickly perform grouping and sorting
operations throughout a report, and visually
represents the report's grouping structure.

Scripts Errors Panel When errors are found in a report's scripts (after
clicking Validate in the Scripts Tab), it lists these
errors. Clicking an error opens the corresponding
script section in the Scripts tab.

Status Bar Provides tips and specific information about the
Designer element being hovered by a cursor or an
action being currently performed.
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Component Tray

The Component Tray shows components (non-visual report helpers) whose primary purpose is to bind a report to
data. You can click them to display and edit their settings using the Property grid.

Note

Component management and data binding configuration are usually performed by system administrators or your
application vendor, since these areas require advanced knowledge of database connectivity. You will rarely, if
ever, need to access component settings when modifying existing reports.

See Also
Status Bar
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Context Menu

The Context Menu can be invoked by the right-clicking a report...

... or its elements (bands and controls). This menu provides quick access to frequently used commands (e.g.
zooming, clipboard operations, inserting bands, etc.) The available action set varies, depending on the element
where you invoked the Context Menu.

See Also
Smart Tag
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Control Toolbox

The Control Toolbox lists all available controls and allows you to add them to your report.

To add a control from the Toolbox, do one of the following.

Double-click an item in the Toolbox for the appropriate control, which will be created at the Detail band's
top left corner.

Drag and drop an item from the Toolbox onto the required location within a report.

Select an item in the Toolbox, and then click the required location within a report.

Select an item in the Toolbox, and then indicate the bounding rectangle by holding the left mouse button.

Select the  Pointer item when you need to perform selection, re-positioning or resizing operations. It is
automatically selected after you drop a control onto a report.

If the Toolbox is hidden, you can enable it in the Main Menu, by selecting View | Toolbars | Toolbox.

See Also
Design Panel
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Design Panel

The Design Panel is the Report Designer's main area, where a report is being constructed and previewed.

On the Designer Tab, multiple reports can be opened at once (each in its own Design Panel).

The Design Panel provides the following tabs (switched at the bottom).

Designer Tab
Allows you to modify your report.

Preview Tab
Shows a print preview, and enables you to print out your report or export it to a file on disk.

HTML View Tab
Shows the report output in HTML format.

Scripts Tab
Allows you to manage your report's scripts.

See Also
Control Toolbox
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Designer Tab

The Designer Tab allows you to customize a report, manage its bands and controls and define their properties.

See Also
Preview Tab
HTML View Tab
Scripts Tab
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Field List

The Field List window serves the following purposes.

Displays the list of all available data fields (attributes you can show in your report) and allows you to 
create report elements that will show information from these fields.

Allows you to create calculated fields by building expressions based on the values of data fields, report
parameter values, etc.

Shows existing report parameters, and allows you to add parameters to your report.

If the Field List is hidden, you can enable it in the Main Menu, by selecting View | Windows | Field List.

See Also
Group and Sort Panel
Property Grid
Report Explorer
Scripts Errors Panel
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Formatting Toolbar

The Formatting Toolbar allows you to easily customize an element's font, color and alignment settings.

If the Formatting Toolbar is hidden, you can enable it in the Main Menu, by selecting View | Toolbars | Formatting
Toolbar.

See Also
Layout Toolbar
Main Toolbar
Zoom Toolbar
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Group and Sort Panel

The Group and Sort Panel allows you to quickly apply grouping and sorting to your report data.

To create a new grouping or sorting criterion, simply click Add a Group or Add a Sort.

Then, to control whether the corresponding Group Header or Footer band should be seen, use the Show Header
and Show Footer check boxes.

An ascending or descending grouping (sorting) mode is specified via the Sort Order drop-down list.

You can change the order in which multiple grouping and sorting criteria are to be performed, via the Move Up
and Move Down buttons.

To remove a grouping or sorting criterion, select it, and click Delete.

Note

If the Group and Sort Panel is hidden, you can enable it in the Main Menu, by selecting View | Windows | Group
and Sort.

See Also
Change or Apply Data Grouping to a Report
Change or Apply Data Sorting to a Report
Field List
Property Grid
Report Explorer
Scripts Errors Panel
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HTML View Tab

The HTML View Tab allows you to preview the HTML output of a report.

See Also
Designer Tab
Preview Tab
Scripts Tab
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Layout Toolbar

The Layout Toolbar allows you to easily align report elements to one another, change their size to match one
another and customize spacing and z-order.

If the Layout Toolbar is hidden, you can enable it in the Main Menu, by selecting View | Toolbars | Layout Toolbar
.

See Also
Formatting Toolbar
Main Toolbar
Zoom Toolbar
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Main Menu

The Main Menu contains various commands grouped in four sub-menus. These menu items duplicate various
commands available in the Report Designer's Toolbars, and allow you to switch between different Tabs, and hide
or show the available Toolbars and Panels.

To switch focus on the Main Menu, press ALT.
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Main Toolbar

The Main Toolbar contains buttons which provide the capability to create new reports, save and load report
layouts, cut, copy and paste report elements, and undo-redo actions in the Report Designer.

If the Main Toolbar is hidden, you can enable it in the Main Menu, by selecting View | Toolbars | Main Toolbar.

See Also
Formatting Toolbar
Layout Toolbar
Zoom Toolbar
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Preview Tab

The Preview Tab is intended to check the print output of a report and customize its additional options.

To learn more about print preview capabilities, refer to the Print Preview topic.

See Also
Designer Tab
HTML View Tab
Scripts Tab
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Property Grid

The Property Grid allows you to change the settings of the currently selected report element.

To select an element and show its properties within the Property Grid, do one of the following.

Click the required element on the Report Designer surface.

Select an element using the Report Explorer window.

Select an element from the Property Grid's combo box.

To reset a property value, right-click this property, and in the invoked menu, click Reset.

If the Property Grid is hidden, you can enable it in the Main Menu, by selecting View | Windows | Property Grid.

See Also
Field List
Group and Sort Panel
Report Explorer
Scripts Errors Panel
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Report Explorer

The Report Explorer shows a report's structure in tree form, providing easy access to report elements. Once an
element has been selected in the Report Explorer, it's settings can be changed using the Property Grid.

Additionally, the Report Explorer displays non-visual report components (e.g., report data sources) inside its
Components node.

If the Report Explorer is hidden, you can enable it in the Main Menu, by selecting View | Windows | Report
Explorer.

See Also
Field List
Group and Sort Panel
Property Grid
Scripts Errors Panel
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Scripts Errors Panel

The Scripts Errors Panel displays the result of scripts validation after it's forced in the Scripts Tab.

Then, if errors are located, they are listed in this panel. To get to the corresponding line of code, click the
corresponding item in the panel's list.

Or, if all scripts are valid, the panel reports this.

For more information, refer to Handle Events via Scripts.

See Also
Field List
Group and Sort Panel
Property Grid
Report Explorer
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Scripts Tab

The Scripts Tab allows you to manage your report's scripts. It provides centralized access to all the scripts being
written for a report or any of its elements (bands and controls).

The built-in scripts validation capability is provided in this tab. After clicking Validate, the result is displayed in the
Scripts Errors Panel.

For more information, refer to Handle Events via Scripts.

See Also
Designer Tab
Preview Tab
HTML View Tab
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Smart Tag

Most report elements have Smart Tags that provide easy access to the most frequently used settings. Clicking an
element's Smart Tag invokes an actions list with action links and editors, allowing you to customize this element.

Report Smart Tag

A report's Smart Tag icon is located at the top left corner of the Design Panel.

Band Smart Tag

A band's Smart Tag icon is located on the band strip right next to its caption. For instance, the Smart Tag
for the Page Header is shown in the following image.

Control Smart Tag

A control's Smart Tag icon is located at the top right corner of the control. For instance, the Smart Tag for
the Rich Text control is shown in the following image.
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And, this is the Smart Tag for the Picture Box control.

See Also
Context Menu
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Status Bar

The Status Bar is located at the bottom of the Report Designer, and displays hints about currently selected
commands in the Main Menu or toolbars.

See Also
Component Tray
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Zoom Toolbar

The Zoom Toolbar allows you to zoom a report in and out, providing easier control over report's layout.

If the Zoom Toolbar is hidden, you can enable it in the Main Menu, by selecting View | Toolbars | Zoom Toolbar.

See Also
Formatting Toolbar
Layout Toolbar
Main Toolbar
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Report Controls

The documents in this section describe options of each report control available in the Report Designer.

In general, report con trols allow you to represent information of different kinds (e.g. simple or formatted text,
pictures, tables, etc.) in you report both static and dynamic, and to adjust your report's layout (by organizing
controls within panels, and inserting page breaks at the required positions).

In the Report Designer, the available controls are listed in the Control Toolbox from which they are dropped onto
the required bands.

You also can extend the standard functionality of each control by writing scripts for its available events.

This document consists of the following sections.

Available Controls

Add Controls to a Report

Available Controls

The following table lists the available controls (in the same order as in the Control Toolbox). For each control's
options description, refer to the corresponding document.

Label The most basic Label control is
intended to display text in your
report. It can represent static or
dynamic text, or both. In addition,
it can be used to calculate
standard summary functions
across a data field. The Label's
text can only be formatted as a
whole. So, if it's required to
differently format parts of text,
use the Rich Text control.

Check Box The Check Box control is intended
to display True/False or Checked/
Unchecked/Indeterminate states
in a report, by displaying (or not)
a check mark, which can be
accompanied by a text description.

Rich Text The Rich Text control allows you
to display formatted text in your
report. It can represent static or
dynamic text, or both. You can
load content to the Rich Text from
an external TXT or RTF file (which
can also contain images) and then
format any part of it. The
formatting options include font
face, styles and sizes, and color.

Picture Box The Picture Box control is
intended to display images of
numerous formats in a report. An
image can be loaded from an
external file, from a bound data
source, or from a web location
using the specified URL.

Panel The Panel control is a container
that frames separate report
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controls to allow them to be easily
moved, copied and pasted, and
visually unite them in the report's
preview (with borders or a uniform
color background).

Table The Table control is designed to
arrange information in a tabular
layout. It may contain any number
of Rows comprised of individual
Cells. Both Rows and Cells can be
selected and customized
individually. In most aspects, a
Cell is similar to a Label, but can
also contain other controls (e.g. 
Picture Box or Rich Text).

Line The Line control draws a line of a
specified direction, style, width
and color. It can be used for both
decoration and visual separation
of a report's sections. The Line
cannot cross bands, as opposed
to the Cross-band Line control.

Shape The Shape control allows you to
embed simple graphic objects into
your report. You can choose one
of multiple predefined shapes (e.
g. rectangles, ellipses, arrows,
polygons, crosses and brackets of
various kinds).

Bar Code The Bar Code control transforms
its content into a bar code of the
specified type. Multiple standard
bar code symbologies are
supported.

Zip Code The Zip Code control transforms
its content into a zip code. The
width of a zip code's segment is
adjustable.

Chart The Chart is a sophisticated
control used to embed graphs into
your report. It graphically
represents a series of poin ts using
numerous 2D or 3D chart types. A
Chart can be populated with
points both m anually (by
specifying argum ents and values
for each point) and dynam ically (by
connecting it to the report's data
source, or binding it to a separate
one).

Gauge The Gauge control provides you
with the capability to embed
graphical gauges into your report.
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Sparkline The Sparkline control displays a
compact chart that is commonly
used to reflect the flow of data for
every row in a report.

Pivot Grid The Pivot Grid control represents
dynamic data (obtained from an
underlying data source) in a cross-
tabulated form to create cross-tab
reports, similar to Pivot Tables in
Microsoft Excel®. Column headers
display unique values from one
data field, and row headers - from
another field. Each cell displays a
summary for the corresponding
row and column values. By
specifying different data fields,
you can see different totals. This
allows you to get a compact
layout for a complex data analysis.

Page Info The Page Info control is intended
to add page numbers and system
information (the current date and
time or the current user name)
into your report. As with many
other controls, you can format this
control's content.

Page Break The Page Break control's sole
purpose is to insert a page
delimiter at any point within a
report.

Cross-band Line The Cross-band Line control
allows you to draw a line through
several bands. This can be useful
if it is required to visually
emphasize a section consisting of
multiple band areas. In other
aspects, it is similar to a regular 
Line.

Cross-band Box The Cross-band Box control
allows you to draw a rectangle
through several bands. This can
be useful if it is required to visually
encompass a section consisting of
multiple band areas.

Table of Contents The Table of Contents control
generates a table of contents
based on bookmarks specified for
report elements.

Subreport          The Subreport control allows you
to include other reports in your
current report.

Add Controls to a Report

To create a control, drag it from the Toolbox panel onto the report area.
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To automatically create a control bound to data, drag a field from the Field List panel, and drop it onto a report's
surface. When dropping a field onto an existing control, this control will be bound to the data field.

If you drag the field with the right mouse button, when the button is released the context menu is invoked. Use
this menu to specify which control should be created.

To learn more on data binding for report controls, refer to Displaying Values from a Database (Binding Report
Elements to Data).

Note

When controls overlap, the report may be shown incorrectly when exported to some formats. Red markers and a
report tooltip will warn of this situation. You may switch off the red warning marks via the report's Show Export
Warnings property.
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To learn how report controls can be relocated and resized, refer to Change the Layout of Report Elements and
Controls Positioning.
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Label

The most basic Label control is intended to display text in your report. It can represent static or dynamic text, or
both. In addition, it can be used to calculate standard summary functions across a data field. The Label's text can
only be formatted as a whole. So, if it's required to differently format parts of text, use the Rich Text control.

After a Label is added to a report, you can customize its text, appearance and other properties, which can be
accessed in the Property Grid. The most important properties are also available via a control's Smart Tag, which
makes it easy to perform common operations. And, the Formatting Toolbar allows you to easily adjust a Label's
text formatting.

In the Property Grid, the Label control's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the control.

Font

Specifies the font settings for the control. Some of these settings are available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the control. This option is also available in the Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor, allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of a Label.

Style Priority

Specifies the priority of various style elements (such as background color, border color, etc.). For more
information on style inheritance, refer to Understanding Style Concepts.

Styles

Specifies odd and even styles for the control, as well as to assign an existing style to the control (or a
newly created one). For more information on style inheritance, refer to Understanding Style Concepts.

Text Alignment

Specifies the alignment of the control's text. This option is also available in the Formatting Toolbar.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of a Label, so that after page rendering it stays attached to the top
control, bottom control, or both. The property setting is useful for data-bound Labels located between
upper and lower controls, which are allowed to resize depending on their contents.

Note that if the Anchor Vertically property is set to Bottom or Both, the Can Grow and Can Shrink property
(see below) values are ignored, and don't participate in calculating a final height value of this control.

Angle

Specifies the rotation angle of the text. The measurement unit is a degree, and the orientation is counter-
clockwise. Since standard HTML does not support text orientation, this parameter is ignored when a
report is displayed within a web page.
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Auto Width

Specifies whether or not a Label's width should be automatically determined based on its text.

Can Grow

When this property is set to Yes, a Label's height can be automatically increased, if required, to display
the text. If there are other controls below the current Label, they will be pushed down to prevent them
from overlapping. Note that if a control overlaps the growing Label by even one pixel, it will not be pushed
down by the growing Label.

Can Shrink

When this property is set to Yes, and the text does not completely fill a Label, then the Label's height will
be decreased to the height of its text. If there are other controls below the current Label, they will be
moved up to fill the gap. Note that if a control overlaps the shrinking Label by even one pixel, it will not be
pushed up by the shrinking Label.

Keep Together

Specifies whether the contents of a Label can be horizontally split across pages. In other words, if a Label
occupies more space than remains on the page, this property specifies whether this Label should be split
between the current page and the next, or whether it will be printed entirely on the next page. This
property is in effect only when a Label's content does not fit on the current page. If it does not fit on the
next page either, then the Label will be split, irrespective of this property's value.

Multiline

When this property is set to Yes, a Label processes newline characters found in the text to start a new
line. For example, when editing a Label's text, you can insert a new line by pressing ENTER, and in this
case, the Multiline property will be automatically set to Yes.

Process Duplicates

Determines the control's behavior when its data source contains consecutive repeating records. They can
be processed as is (when the property is set to Leave), suppressed except for the first entry (Suppress)
and suppressed with the blank space printed instead of the repeated records (Suppress and Shrink).

When the MergeByValue and MergeByTag settings are selected, the control processes duplicate values by
merging the identical content into a single line of text.

Process Null Values

Determines whether to process Null (blank) values if they appear in the control's data source. They can be
processed as is (when the property is set to Leave), suppressed (Suppress) and suppressed with the
blank space printed instead of the blank records (Suppress and Shrink).

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Text Trimming

Specifies the string trimming mode of the control's text.

Visible

Specifies whether the control should be visible in print preview.

Word Wrap

When this property is set to Yes, text entered into the multiline Label is wrapped to the next line if it
doesn't fit the line or comes across a newline character. If the this property is set to No, text entered into
the multiline Label will be displayed on the same line until a newline character is entered.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of the control's properties
(Bookmark, Navigation URL, Tag and Text) to a data field obtained from the report's data source, and to
apply a format string to it. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Lines

Provides access to the Text property of a Label in the Multiline mode.

Summary

Allows you to perform calculations (summary, max, min, average, etc.) over a data field. For more
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information on calculating summaries, refer to Add Totals to a Report.

Note

Summarization is possible for a single data column only. To perform calculations with several data fields,
use calculated fields.

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.

If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property and in the Tag.Binding drop-down selector,
select the required data field.

Text

Allows you to define a line of static text to be displayed. To type several lines of text, click the control's 
Smart Tag, and in the invoked actions list, click Edit Text, or use the Lines property. Note that when a
Label is selected in the designer, you may simply start typing the text, and it will be automatically entered
into the in-place editor.

If the current report has a data source, the Text property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property and in the Text.Binding drop-down selector,
select the required data field. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Xlsx Format String

Specifies the native XLSX format string for the control's content, which is to be preserved when the report
is being exported to XLSX. This format string is independent from the general value formatting.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field, obtained
from the data source. To do this, expand the (Data Bindings) property, and in the Bookmark.Binding drop-
down selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation, when a user clicks a Label.
The web browser displays a page in a window or a frame as specified by the Navigation Target property.
Note that a URL should have an appropriate prefix (e.g. "http://"). You can create cross-references within
the report by assigning the name of the target control to the Navigation URL property, and setting the
Navigation Target property to "_self". For more information, refer to Create Hyperlinks.
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If the current report has a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property, and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Check Box

The Check Box control is intended to display True/False or Checked/Unchecked/Indeterminate states in a report,
by displaying (or not) a check mark, which can be accompanied by a text description.

In the Property Grid, the Check Box control's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the control.

Font

Specifies the font settings for the control. Some of these settings are available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the control. This option is also available in the Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of a Check Box.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.

Text Alignment

Allows you to change the alignment of the control's text. This option is also available in the Formatting
Toolbar.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that after page rendering it stays attached to the
top control, bottom control, or both. The property setting is useful for data-bound Check Boxes located
between upper and lower controls, which are allowed to resize depending on their contents.

Keep Together

Specifies whether the contents of a Check Box can be horizontally split across pages. In other words, if a
Check Box occupies more space than remains on the page, this property specifies whether this Check Box
should be split between the current page and the next, or whether it will be printed entirely on the next
page. This property is in effect only when a Check Box's content does not fit on the current page. If it
does not fit on the next page either, then the Check Box will be split despite this property's value.

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Text Trimming
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Specifies the string trimming mode of the control's text.

Visible

Specifies whether the control should be visible in print preview.

Word Wrap

When this property is set to Yes, text entered into a Check Box is wrapped to the next line if it doesn't fit
the line.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of the control's properties
(Bookmark, Check State, Navigation URL, Tag and Text) to a data field obtained from the report's data
source, and to apply a format string to it. For more information on this, refer to Displaying Values from a
Database (Binding Report Elements to Data).

Check State

This property allows you to quickly specify the Checked/Unchecked/Indeterminate state of a Check Box
(the Indeterminate state is displayed as a grayed out checked box.) Note that if you only want to use
Checked and Unchecked states, you may use the Checked property, instead.

Checked

This property allows you to define whether a Check Box is checked or not.

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.

If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property and in the Tag.Binding drop-down selector,
select the required data field.

Text

Allows you to define a line of static text to be displayed. Note that when a Check Box is selected in the
designer, you may simply start typing the text, and it will be automatically entered into the in-place editor.

If the current report has a data source, the Text property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property, and in the Text.Binding drop-down selector,
select the required data field. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Xlsx Format String

Specifies the native XLSX format string for the control's content, which is to be preserved when the report
is being exported to XLSX. This format string is independent from the general value formatting.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.
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Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field obtained from
the data source. To do this, expand the (Data Bindings) property and in the Bookmark.Binding drop-down
selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation when a user clicks a Check
Box. The web browser displays a page in a window or a frame as specified by the Navigation Target
property. Note that a URL should have an appropriate prefix (e.g. "http://"). You can create cross-
references within the report by assigning the name of the target control to the Navigation URL property,
and setting the Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report has a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Rich Text

The Rich Text control allows you to display formatted text in your report. It can represent static or dynamic text,
or both. You can load content to the Rich Text from an external TXT or RTF file (which can also contain images) and
then format any part of it. The formatting options include font face, styles and sizes, and color.

A content from an external TXT or RTF file can be loaded to this control via its Smart Tag.

In the Property Grid, the Rich Text control's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the control.

Font

Specifies the font settings for the control. Some of these settings are available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the control. This option is also available in the Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of the control.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.
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Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that after page rendering it stays attached to the
top control, bottom control, or both. The property setting is useful for data-bound controls located
between upper and lower controls, which are allowed to resize depending on their contents.

Note that if the Anchor Vertically property is set to Bottom or Both, the Can Grow and Can Shrink
properties (see below) values are ignored, and don't participate in calculating a final height value of this
control.

Can Grow

When this property is set to Yes, the control's height can be automatically increased, if required, to
display the text. If there are other controls below the current control, they will be pushed down to
prevent them from overlapping. Note that if a control overlaps the growing Rich Text by even one pixel, it
will not be pushed down by the growing Rich Text.

Can Shrink

When this property is set to Yes, and the text does not completely fill a Rich Text, then the control's
height will be decreased to the height of its text. If there are other controls below the current one, they
will be moved up to fill the gap. Note that if a control overlaps the shrinking Rich Text by even one pixel, it
will not be pushed up by the shrinking Rich Text.

Keep Together

Specifies whether the contents of the control can be horizontally split across pages. In other words, if the
control occupies more space than remains on the page, this property specifies whether this control should
be split between the current page and the next, or whether it will be printed entirely on the next page.
This property is in effect only when the control's content does not fit on the current page. If it does not fit
on the next page either, then the control will be split despite this property's value.

Process Duplicates

Determines the control's behavior when its data source contains consecutive repeating records. They can
be processed as is (when the property is set to Leave), suppressed except for the first entry(Suppress)
and suppressed with the blank space printed instead of the repeated records (Suppress and Shrink).

Process Null Values

Determines whether to process Null (blank) values if they appear in the control's data source. They can be
processed as is (when the property is set to Leave), suppressed (Suppress) and suppressed with the
blank space printed instead of the blank records (Suppress and Shrink).

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible

Specifies whether the control should be visible in print preview.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of the control's properties
(Bookmark, Navigation URL, Rtf and Tag) to a data field obtained from the report's data source, and to
apply a format string to it. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Lines

Provides access to the Text property of the control, allowing you to input multiple lines of static text.

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.

If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property, and in the Tag.Binding drop-down selector,
select the required data field.

Text

Allows you to define a line of static text to be displayed. To type several lines of text, use the Lines
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property. Note that when the control is selected in the designer, you may simply start typing the text, and
it will be automatically entered into the in-place editor.

If the current report has a data source, the Rtf property (instead of Text) can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property and in the Rtf.Binding
drop-down selector, select the required data field. For more information on this, refer to Displaying Values
from a Database (Binding Report Elements to Data).

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report, called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field obtained from
the data source. To do this, expand the (Data Bindings) property and in the Bookmark.Binding drop-down
selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation when a user clicks the
control. The web browser displays a page in a window or a frame as specified by the Navigation Target
property. Note that a URL should have an appropriate prefix (e.g. "http://"). You can create cross-
references within the report by assigning the name of the target control to the Navigation URL property,
and setting the Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report has a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property, and in the Navigation
URL.Binding drop-down selector, select the required data field.



Report Designer 450

© 2014 DevExpress Inc. 450

Picture Box

The Picture Box control is intended to display images of numerous formats in a report. An image can be loaded
from an external file, from a bound data source, or from a web location using the specified URL.

The following image formats are supported: BMP, DIB, RLE, JPG, JPEG, JPE, JFIF, GIF, EMF, WMF, TIF, TIFF, PNG and
ICO.

To quickly load an image from an external file, use the control's Smart Tag.

To bind the control to a data field containing images, right-click the corresponding Field List item, and then drag
and drop it onto a report. This will invoke the Context Menu, where you can choose the Picture Box, and it will be
automatically created and bound to the selected data field.

In the Property Grid, the Picture Box control's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control.

Borders, Border Color and Border Width
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Specify border settings for the control.

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of the control.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that after page rendering it stays attached to the
top control, bottom control, or both. The property setting is useful for data-bound controls located
between upper and lower controls, which are allowed to resize depending on their contents.

Keep Together

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Sizing

Defines the sizing mode of a contained image. To quickly adjust the image size and position within the
control, click its Smart Tag, and choose Sizing.

The image sizing settings are briefly described in the following table.

Mode Description

Normal The image is placed in the upper-left corner of the
control. The image is clipped if it is larger than the
Picture Box which contains it.

Stretch Image The image within the control is stretched or shrunk to
fit the size of a Picture Box.
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Auto-Size The Picture Box size is adjusted to that of the image it
contains.

Center Image The image is displayed in the center of the control. If
the image is larger than the Picture Box, the outer
edges are clipped.

Zoom Image The image is sized proportionally (without clipping) for
best fit into the control.

Squeeze If the dimensions of a Picture Box exceed that of the
image it contains, the image is centered and shown
full-size. Otherwise, the image is resized to fit into the
Picture Box's dimensions.

Tile The original image is replicated within the Picture Box
starting from the upper-left corner. The replicated
image is clipped if it doesn't fit in the Picture Box
which contains it.

Visible

Specifies whether the control should be visible in print preview.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of the control's properties
(Bookmark, Image, Image URL, Navigation URL and Tag) to a data field obtained from the report's data
source, and to apply a format string to it. For more information on this, refer to Displaying Values from a
Database (Binding Report Elements to Data).

Image

Specifies an image to display in the Picture Box control.

When you click the ellipsis button, you will see the Open File dialog that enables you to specify the file to
load. Then, this image is embedded into a report and saved within this report, so it is always available.
Note that this increases the size of a saved report definition. If you want to save only the image path,
and not the image itself, use the Image URL property instead.

Image URL

Specifies the URL of the image to display in the Picture Box control. It supports both absolute and relative
paths. A relative path may be related to the Web site or to the current Web page. In the second case, the
path to the image must start with the "~" symbol. Setting a relative path makes it easier to move the
entire application to another directory on the server without having to update the code.

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.

If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property and in the Tag.Binding drop-down selector,
select the required data field.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.
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Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field obtained from
the data source. To do this, expand the (Data Bindings) property and in the Bookmark.Binding drop-down
selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation when a user clicks the
control. The web browser displays a page in a window or a frame as specified by the Navigation Target
property. Note that a URL should have an appropriate prefix (e.g. "http://"). You can create cross-
references within the report by assigning the name of the target control to the Navigation URL property,
and setting the Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report has a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Panel

The Panel control is a container that frames separate report controls to allow them to be easily moved, copied
and pasted, and visually unite them in the report's preview (with borders or a uniform color background).

Currently, there are several limitations on Panel usage. One of them is that Panel cannot shrink, and therefore
cannot suppress the white space that appears when the controls inside are shrunk or collapsed. Also, the Panel
cannot cross bands, as Cross-band Line and Cross-band Box can do.

In the Property Grid, the Panel's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control.

Borders, Border Color and Border Width

Specify border settings for the control.

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of controls contained in a Panel.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that after page rendering it stays attached to the
top control, bottom control, or both.

Note that if the Anchor Vertically property is set to Bottom or Both, the Can Grow property (see below)
values are ignored, and don't participate in calculating a final height value of this control.

Can Grow

When this property is set to Yes, the control's height can be automatically increased, if required, to
display the text. If there are other controls below the current control, they will be pushed down to
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prevent them from overlapping. Note that if a control overlaps the growing Panel by even one pixel, it will
not be pushed down by the growing Panel.

Keep Together

Specifies whether the contents of the control can be horizontally split across pages. In other words, if the
control occupies more space than remains on the page, this property specifies whether this control should
be split between the current page and the next, or whether it will be printed entirely on the next page.
This property is in effect only when the control's content does not fit on the current page. If it does not fit
on the next page either, then the control will be split despite this property's value.

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible

Specifies whether the control should be visible in print preview.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of the control's properties
(Bookmark, Navigation URL and Tag) to a data field obtained from the report's data source, and to apply
a format string to it. For more information on this, refer to Displaying Values from a Database (Binding
Report Elements to Data).

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.

If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property and in the Tag.Binding drop-down selector,
select the required data field.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Snap Line Padding

Specifies the padding (in report measurement units), which is to be preserved within the control when
controls it contains are aligned using Snap Lines.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field obtained from
the data source. To do this, expand the (Data Bindings) property and in the Bookmark.Binding drop-down
selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation when a user clicks the
control. The web browser displays a page in a window or a frame as specified by the Navigation Target
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property. Note that a URL should have an appropriate prefix (e.g. "http://"). You can create cross-
references within the report by assigning the name of the target control to the Navigation URL property,
and setting the Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report has a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Table

The Table control is designed to arrange information in a tabular layout. It may contain any number of Rows
comprised of individual Cells. Both Rows and Cells can be selected and customized individually. In most aspects, a
Cell is similar to a Label, but can also contain other controls (e.g. Picture Box or Rich Text).

When a Table is dropped onto a band from the Toolbox, it has one row and three columns. If you click and drag
over several bands, the resulting table will be split by the bands into several tables. This creates a table header
and the detail table with one mouse move.

When you drag and drop an entire data table from the Field List, a Table with cells bound to the corresponding
data fields is created automatically.

A table's elements are managed by using its Context Menu.
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The whole Table, or its individual Row or Cell can be selected either in the Report Designer, the Report Explorer or
the drop-down selector of the Property Grid.

In the Property Grid, the Table's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the control.

Font

Specifies the font settings for the control. Some of these settings are available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the control. This option is also available in the Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor, allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of a Table's cells.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.

Text Alignment

Allows you to change the alignment of a Table's text. This option is also available in the Formatting
Toolbar.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of a Table, so that after page rendering it stays attached to the top
control, bottom control, or both.

Keep Together

Specifies whether the contents of a Table can be horizontally split across pages. In other words, if a Table
occupies more space than remains on the page, this property specifies whether the Table should be split
between the current page and the next, or whether it will be printed entirely on the next page. This
property is in effect only when a Table's content does not fit on the current page. If it does not fit on the
next page either, then the Table will be split despite this property's value.

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible

Specifies whether the control should be visible in print preview.

Data

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.
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Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field obtained from
the data source. To do this, expand the (Data Bindings) property and in the Bookmark.Binding drop-down
selector, select the required data field.
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Table Row

The Table Row Control represents a single row within a Table.

This control is useful for changing the layout of the entire row. Although in this document, a Row is described as a
separate control, in fact most of its properties are actually applied to the Cells contained within the selected row.

In the Property Grid, the Table Row's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the control.

Font

Specifies the font settings for the control. Some of these settings are available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the control. This option is also available in the Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor, allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of a Row.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.

Text Alignment

Allows you to change the alignment of the control's text. This option is also available in the Formatting
Toolbar.

Behavior

Keep Together

Specifies whether the contents of a Row can be horizontally split across pages. In other words, if a Row
occupies more space than remains on the page, this property specifies whether this Row should be split
between the current page and the next, or whether it will be printed entirely on the next page. This
property is in effect only when a Row's content does not fit on the current page. If it does not fit on the
next page either, then the Row will be split despite this property's value.

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible

Specifies whether the control should be visible in print preview.
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Data

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Height

Specifies the Row's height, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.
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Table Cell

The Table Cell control represents an individual cell within a Table.

In general, the Table Cell control's properties are similar to the properties of the Label control.

In the Property Grid, the Table Cell's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the control.

Font

Specifies the font settings for the control. Some of these settings are available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the control. This option is also available in the Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor, allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of a Label.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.

Text Alignment

Allows you to change the alignment of the control's text. This option is also available in the Formatting
Toolbar.

Behavior

Angle

Specifies the rotation angle of a Cell's text. The measurement unit is a degree, and the orientation is
counter-clockwise. Since standard HTML does not support text orientation, this parameter is ignored
when a report is displayed within a web page.

Can Grow

When this property is set to Yes, a Cell's height can be automatically increased, if required, to display the
text. If there are other controls below the current Cell, they will be pushed down to prevent them from
overlapping. Note that if a control overlaps the growing Cell by even one pixel, it will not be pushed down
by the growing Cell.

Can Shrink

When this property is set to Yes, and the text does not completely fill a Cell, then the Cell's height will be
decreased to the height of its text. If there are other controls below the current Cell, they will be moved
up to fill the gap. Note that if a control overlaps the shrinking Cell by even one pixel, it will not be pushed
up by the shrinking Cell.
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Keep Together

Specifies whether the contents of a Cell can be horizontally split across pages. In other words, if a Cell
occupies more space than remains on the page, this property specifies whether this Cell should be split
between the current page and the next, or whether it will be printed entirely on the next page. This
property is in effect only when a Cell's content does not fit on the current page. If it does not fit on the
next page either, then the Cell will be split despite this property's value.

Multiline

When this property is set to Yes, a Cell processes newline characters found in the text to start a new line.
For example, when editing a Cell's text, you can insert a new line by pressing ENTER, and in this case the
Multiline property will be automatically set to Yes.

Process Duplicates

Determines the control's behavior when its data source contains consecutive repeating records. They can
be processed as is (when the property is set to Leave), suppressed except for the first entry (Suppress)
and suppressed with the blank space printed instead of the repeated records (Suppress and Shrink).

Merging cells with identical dynamic content is performed by setting a cell's Process Duplicates property to
"Merge based on Value" or "Merge based on Tag".

Process Null Values

Determines whether to process Null (blank) values if they appear in the control's data source. They can be
processed as is (when the property is set to Leave), suppressed (Suppress) and suppressed with the
blank space printed instead of the blank records (Suppress and Shrink).

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Text Trimming

Specifies the string trimming mode of the control's text.

Visible

Specifies whether the control should be visible in print preview.

Word Wrap

When this property is set to Yes, text entered into the multiline Cell is wrapped to the next line if it
doesn't fit the line or comes across a newline character. If the this property is set to No, text entered into
the multiline Cell will be displayed on the same line until a newline character is entered.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of a Cell's properties
(Bookmark, Navigation URL, Tag and Text) to a data field obtained from the report's data source, and to
apply a format string to it. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Lines

Provides access to the Text property of a Cell in the Multiline mode.

Summary

Allows you to perform calculations (summary, max, min, average, etc.) over a data field. For more
information on calculating summaries, refer to Add Totals to a Report.

Note

Summarization is possible for a single data column only. To perform calculations with several data fields,
use calculated fields.

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.

If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property and in the Tag.Binding drop-down selector,
select the required data field.

Text
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Allows you to define a line of static text to be displayed. When a Cell is selected in the designer, you may
simply start typing the text, and it will be automatically entered into the in-place editor.

To type several lines of text, use the Lines property.

If the current report has a data source, the Text property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property, and in the Text.Binding drop-down selector,
select the required data field. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Xlsx Format String

Specifies the native XLSX format string for the control's content, which is to be preserved when the report
is being exported to XLSX. This format string is independent from the general value formatting.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Width

Specifies the Cell's width, in report measurement units.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field obtained from
the data source. To do this, expand the (Data Bindings) property and in the Bookmark.Binding drop-down
selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation when a user clicks a Cell.
The web browser displays a page in a window or a frame as specified by the Navigation Target property.
Note that a URL should have an appropriate prefix (e.g. "http://"). You can create cross-references within
the report by assigning the name of the target control to the Navigation URL property, and setting the
Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report has a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Line

The Line control draws a line of a specified direction, style, width and color. It can be used for both decoration and
visual separation of a report's sections. The Line cannot cross bands, as opposed to the Cross-band Line control.

In the Property Grid, the Line's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control.

Borders, Border Color and Border Width

Specify border settings for the control.

Foreground Color

Specifies the Line's color.

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Line Direction

The line can be drawn vertically, horizontally and from one corner of the rectangle, representing the Line
control, to another, across the rectangle. That is, Vertical, Horizontal, Slant and Back Slant types.

Line Style

You can select the solid (by default), dashed, dotted or mixed style for the line.

Line Width

Specifies the Line's width, in report measurement units.

Padding

Specifies indent values which are used to render the contents of the control.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that after page rendering it stays attached to the
top control, bottom control, or both.

Keep Together

Specifies whether the contents of the control can be horizontally split across pages. In other words, if the
control occupies more space than remains on the page, this property specifies whether this control should
be split between the current page and the next, or whether it will be printed entirely on the next page.
This property is in effect only when the control's content does not fit on the current page. If it does not fit
on the next page either, then the control will be split despite this property's value.

Scripts

This property contains events, which you can handle with the required scripts. For more information on
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scripting, refer to Handle Events via Scripts.

Visible

Specifies whether the control should be visible in print preview.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind the control's Tag property.

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.
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Shape

The Shape control allows you to embed simple graphic objects into your report. You can choose one of multiple
predefined shapes (e.g. rectangles, ellipses, arrows, polygons, crosses and brackets of various kinds).

In the Property Grid, the Shape's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the control.

Fill Color

Specifies the color to fill the contour of a Shape, if applicable. It is transparent by default.

Foreground Color

Determines the color of a Shape's contour. This option is also available in the Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Line Width

Here you can set the width of a line used to draw the Shape, expressed in the measure units defined by
the report's Measure Units property. To learn more about this, refer to Change Measurement Units of a
Report.

Padding

Specifies indent values which are used to render the contents of the control.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that after page rendering it stays attached to the
top control, bottom control, or both.

Angle

The value in degrees specifies the rotation angle of a Shape. It indicates counterclockwise rotation.
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You can hold CTRL while pressing the left mouse button to rotate a Shape within the control's borders.

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Shape

Determines which of the various built-in shapes to use within the control.

A certain shape has its own unique set of properties. The following list is intended to give a brief overview
of these special properties specific to a certain shape.

Property Description Supported by Shapes

Fillet This property specifies how much a
Shape's corners are rounded. It
enables display of rounded boxes
and triangles.

Arrows, Polygons, Stars and Cross

Number of Sides This property allows you to set the
number of sides.

Polygons

Count of Star Points This property allows you to set the
number of star points.

Stars

Concavity Defines the level of inward-curve
for the lines connecting the
vertices of a Star. It may be an
integer in the range of 0 - 100.

Stars

Tip's Length This property specifies the length
of the Bracket's ends.

Bracket and Brace

Tail's Length This property specifies the tail
length of a Brace.

Brace

Stretch

If the Shape is rotated to some degree (that is, its Angle property is not zero), you may turn on the
Stretch property. The Shape image will be stretched to cover maximum space within the control's borders.

Visible

Specifies a value indicating whether the current control should be printed (when set to Yes) or hidden
(No) on report generation.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of the control's properties
(Bookmark, Navigation URL and Tag) to a data field obtained from the report's data source, and to apply
a format string to it. For more information on this, refer to Displaying Values from a Database (Binding
Report Elements to Data).

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.
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If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property and in the Tag.Binding drop-down selector,
select the required data field.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field obtained from
the data source. To do this, expand the (Data Bindings) property and in the Bookmark.Binding drop-down
selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation when a user clicks the
control. The web browser displays a page in a window or a frame as specified by the Navigation Target
property. Note that a URL should have an appropriate prefix (e.g. "http://"). You can create cross-
references within the report by assigning the name of the target control to the Navigation URL property,
and setting the Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report has a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Bar Code

The Bar Code control transforms its content into a bar code of the specified type. Multiple standard bar code
symbologies are supported.

Note

The barcode quality can degrade when the report is exported to formats other than PDF. To ensure reliable
barcode recognition, print the report directly from an application using the native printing methods. The Module
and Auto-Module properties of a control should be used with care.

In the Property Grid, the Bar Code's properties are divided into the following groups.

Appearance

Alignment

Determines the alignment of the barcode image within the control. To define the text alignment, use the
Text Alignment property.

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the control.

Font

Specifies the font settings for the control. Some of these settings are available in the Formatting Toolbar.

Foreground Color

Specifies the text and image color for the bar code. This option is also available in the Formatting Toolbar (

).

Formatting Rules

Invokes the Formatting Rules Editor, allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of a Bar Code.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.

Text Alignment

Allows you to change the alignment of the control's text. This option is also available in the Formatting
Toolbar. To define the alignment of the barcode image, use the Alignment property.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that, after page rendering, it stays attached to the
top control, bottom control, or both.

Auto-Module
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When this property is set to Yes, the barcode image is stretched to fit the entire control's width. When
this option is turned off, this behavior is determined by the Module property.

Keep Together

Specifies whether the contents of the control can be horizontally split across pages. In other words, if the
control occupies more space than remains on the page, this property specifies whether this Bar Code
should be split between the current page and the next, or whether it will be printed entirely on the next
page. This property is in effect only when a Bar Code's content does not fit on the current page. If it does
not fit on the next page either, then the Bar Code will be split, despite this property's value.

Module

Specifies the width of the narrowest bar or space in the barcode, in report measurement units. You may
set this property to Yes for automatic adjustment of its value, when the control is resized. Note that if the
Module value is too low, the barcode output may become unreadable by a barcode scanner.

When the Auto-Module property is set to No, there could be a situation when the barcode image
generated with the current setting of Module property is larger than the control itself. In this case, the
control displays a warning, as illustrated below.

So, increase the dimensions of the control, to avoid this.

Orientation

The barcode image within the control can be rotated. If you need this feature, use the Orientation
property to specify one of four possible orientations (Normal, Upside Down, Rotate to the Left and Rotate
to the Right) for an image within the control.

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Show Text

Determines whether to display the numerical value, or only the barcode within the control.

Symbology

The Symbology defines the mapping between barcode text and an image. The symbologies supported by
the Bar Code control are listed in the following table:

Symbology Description

Codabar The Codabar is an old format that uses discrete, self-
checking symbology, capable of encoding 16 different
characters, plus an additional 4 start/stop characters.
You should also specify the Start and Stop Symbols
and Wide Narrow Ratio properties.

Code11 Code 11, also known as USD-8, was developed as a
high-density numerical-only symbology. The
symbology is discrete, and is able to encode the
numbers 0 through to 9, the dash symbol (-), and
start/stop characters.

Code128 Code 128 has been widely implemented. It is a high-
density symbology which permits encoding messages
of arbitrary lengths of any character of the ASCII
character set. The symbology includes a checksum
digit for verification. You should also specify the 
Character Set. The recommended setting is Auto
Charset.
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Code39 Code 39 is also known as "3 of 9 Code" and "USD-3".
It can encode uppercase letters (A through Z), digits
(0 through 9) and several special characters like the $
sign. The Calculate a Checksum and Wide Narrow
Ratio (which should be in a range of 2.2 -3)
properties can also be specified.

Code39Extended This is an extension of Code 39, also known as "Full
ASCII Code 39". It is capable of encoding all 128
ASCII characters. The Calculate a Checksum and
Wide Narrow Ratio (which should be in a range of
2.2 -3) properties can be specified.

Code93 Code 93 was designed to supplement and improve
Code 39. It is an alphanumeric, variable length
symbology, providing higher reliability and density
than Code 39. The Calculate a Checksum property
can be specified.

Code93Extended It enables encoding of all 128 ASCII characters using
Code 93's "Full ASCII Mode". This is accomplished by
using the ($), (/), (%), and (+) symbols as "shift"
characters. The Calculate a Checksum property can
be specified.

CodeMSI MSI symbology, also known as Modified Plessey, is a
low-density, numerical only symbology. To specify the
checksum, use the MSI Checksum property. It can be
set to None, Modulo 10 and Double Modulo 10.

DataMatrix Data Matrix ECC200 code is a two-dimensional matrix
barcode consisting of black and while "cells" arranged
in a square or a rectangular pattern. The encoded
information can be text or raw data.

DataMatrix GS1 GS1 DataMatrix uses a special start combination to
differentiate the GS1 DataMatrix symbol from the
other Data Matrix ECC 200 symbols. The Bar Code
control now supports this symbology.

EAN128 UCC/EAN-128 symbology has the newer name GS1-
128. It is based on the Code128 standard,
additionally specifying the Application Identifiers for
data sections within the code. It includes best before
dates, batch numbers, quantities, weights and other
attributes. The Character Set property can be
specified (Auto Charset is the recommended value).
The FNC1 Functional Character property defines a
symbol that is not included in a bar code when met in
text, but used to generate the application identifiers.
The Human-Readable Text property, when set to
Yes, inserts parentheses into the text below the bar
code for better readability.

EAN13 The EAN-13 barcode contains 13 digits, no letters or
other characters. The first two or three digits
represent the country. The leading zero actually
signifies the USA, and UPC-A coding. The last digit is
the checksum digit. The control calculates it
automatically and it should not be present in the
control's text string. So, make sure that the text for
this symbology contains no more than 12 digits. If
fewer digits are supplied, the string is padded with
zeroes on the left.
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EAN8 EAN-8 is a shortened version of the EAN-13 code. It
includes a 2 or 3 digit country code, 4 of 5 data digits
(depending on the length of the country code), and a
checksum digit. The control calculates the checksum
digit automatically and it should not be present in the
control's text string. So, make sure that the text for
this symbology contains no more than 7 digits. If
fewer digits are supplied, the string is padded with
zeroes on the left.

GS1 Data Bar This bar code is based on a family of symbols often
used in the GS1 DataBar Coupon (coupon codes
commonly used in retail). These bar codes can encode
up to 14 digits, which makes them suitable for GTIN
8, 12, 13 and 14. GS1 DataBar Expanded and GS1
DataBar Expanded Stacked can encode up to 74
numeric or 41 alphanumeric characters, and provide
the capability to utilize all GS1 Application Identifiers
(e.g., expiration date, batch and serial number).
These bar codes are often used in manufacturer
coupons.

Industrial2of5 The Industrial (or non-interleaved) 2 of 5 code is a
numerical, low-density symbology, based on two-out-
of-five code. The Calculate a Checksum and Wide
Narrow Ratio (which should be greater than or equal
to 2.5) properties can be specified.

Intelligent Mail The Intelligent Mail (IM) code is a 65-bar code for use
on mail in the United States. The Intelligent Mail
barcode is a height-modulated barcode that encodes
up to 31 decimal digits of mail-piece data into 65
vertical bars.

Interleaved2of5 The Interleaved 2 of 5 code is a higher-density
numerical symbology, based on two-out-of-five code.
The Calculate a Checksum and Wide Narrow Ratio
(which should be greater than or equal to 2.5)
properties can be specified.

ITF-14 This bar code, also known as "UPC Shipping
Container Symbol", is used to mark packaging
materials that contain products labeled with a UPC or
EAN product identification number. This bar code
provides a GS1 implementation of an Interleaved 2-
of-5 symbology for encoding a Global Trade Item
Number (an identifier for trade items developed by
GS1). This bar code always uses a total of 14 digits.

Matrix2of5 A variant of non-interleaved 2 of 5 code. It is a
numerical only symbology. The Calculate a Checksum
and Wide Narrow Ratio (which should be greater
than or equal to 2.5) properties can be specified.

PDF417 This Portable Data File symbology is used in a variety
of applications, and can also be used to generate
postage accepted by the United States Postal Service.
It consists of a variable number of rows, each of
which is like a small linear bar code. Among other
options, the Error Correction Level specifies the
amount of redundancy, to protect a barcode's
legibility.

PostNet This symbology is used by the United States Postal
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Service to assist in directing mail. The code usually
contains the zip-code and delivery point number.
Unlike most other barcodes, PostNet actually encodes
data in the height of the bars.

QR Code QR (Quick Response) Code is a popular two-
dimensional matrix barcode that consists of black
modules arranged in a square pattern on a white
background.

UPCA The UPC-A barcode contains 12 digits, no letters or
other characters. The first digit is the prefix signifying
the product type. The last digit is the "check digit".
The check digit is calculated using the first eleven
figures when the barcode is constructed. So, for a
correct UPC-A, make sure that the text contains no
more than 11 digits. If there are fewer than 11, the
string is padded with zeroes on the left.

UPCE0 This symbology is a variation of UPC-A which allows
for a more compact barcode by eliminating "extra"
zeros. The first digit is always zero; the last digit is a
checksum digit of the original UPC-A code. Not every
UPC-A code can be transformed into UPC-E0. E.g., the
control's text string "4210000526" is displayed by
UPC-E0 symbology as "04252614" and represents the
"042100005264" UPC-A code (check digit included).

UPCE1 This symbology is a variation of UPC-A, which allows
for a more compact barcode by eliminating "extra"
zeros. The first digit is always 1, and the last digit is a
checksum digit of the original UPC-A code. Not every
UPC-A code can be transformed into UPC-E1. E.g., the
control's text string "4210000526" is displayed by
UPC-E1 symbology as "14252611" and represents the
"142100005261" UPC-A code (check digit included).

UPCSupplemental2 This is a supplemental two-digit barcode. Make sure
that the control's text string contains two digits.

UPCSupplemental5 This is a supplemental five-digit barcode, usually used
to indicate the suggested retail price of a book. Make
sure that the control's text string contains five digits.

Visible

Specifies whether the control should be visible in print preview.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of the control's properties
(Bookmark, Navigation URL, Tag and Text) to a data field obtained from the report's data source, and to
apply a format string to it. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Tag

This property allows you to add additional information to the control; for example its id, by which it can
then be accessible via scripts.

If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property, and in the Tag.Binding drop-down selector,
select the required data field.

Text

Allows you to define a string to be encoded as a barcode. You can define whether to display this value
within the control using the Show Text property. Note that when the control is selected in the designer,
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you may simply start typing the text, and it will be automatically entered into the in-place editor.

If the content does not conform to the rules of a certain symbology (determined by the Symbology
property), the control may display a warning, as in the picture below, or automatically correct the input
string by padding it with zeroes or only allowing an acceptable number of characters to be displayed.

If the current report has a data source, the Text property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property, and in the Text.Binding drop-down selector,
select the required data field. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report, called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field obtained from
the data source. To do this, expand the (Data Bindings) property, and in the Bookmark.Binding drop-down
selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation when a user clicks a Bar
Code. The web browser displays a page in a window or a frame as specified by the Navigation Target
property. Note that a URL should have an appropriate prefix (e.g. "http://"). You can create cross-
references within the report by assigning the name of the target control to the Navigation URL property,
and setting the Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report has a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property, and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Zip Code

The Zip Code control transforms its content into a zip code. The width of a zip code's segment is adjustable.

In the Property Grid, the Zip Code's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the control.

Foreground Color

Specifies the color for the control. This option is also available in the Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of the control.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that after page rendering it stays attached to the
top control, bottom control, or both.

Keep Together

Specifies whether the contents of the control can be horizontally split across pages. In other words, if the
control occupies more space than remains on the page, this property specifies whether this Zip Code
should be split between the current page and the next, or whether it will be printed entirely on the next
page. This property is in effect only when a Zip Code's content does not fit on the current page. If it does
not fit on the next page either, then the Zip Code will be split despite this property's value.

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Segment Width

This property setting specifies the width of the lines (in pixels) used to draw the numbers in the zip boxes
of the control.

Visible

Specifies whether the control should be visible in print preview.
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Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of the control's properties
(Bookmark, Navigation URL, Tag and Text) to a data field obtained from the report's data source, and to
apply a format string to it. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can be then accessible via scripts.

If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property, and in the Tag.Binding drop-down selector,
select the required data field.

Text

The Text box should contain digits or dashes. Other characters are displayed as empty zip boxes.

If the current report has a data source, the Text property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property, and in the Text.Binding drop-down selector,
select the required data field. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field obtained from
the data source. To do this, expand the (Data Bindings) property, and in the Bookmark.Binding drop-down
selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation when a user clicks the
control. The web browser displays a page in a window or a frame as specified by the Navigation Target
property. Note that a URL should have an appropriate prefix (e.g. "http://"). You can create cross-
references within the report by assigning the name of the target control to the Navigation URL property,
and setting the Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report has a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property, and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Chart

The Chart is a sophisticated control used to embed graphs into your report. It graphically represents a series of
poin ts using numerous 2D or 3D chart types. A Chart can be populated with points both m anually (by specifying
argum ents and values for each point) and dynam ically (by connecting it to the report's data source, or binding it to
a separate one).

For more information about this control, refer to Charting.

There are many available Chart types you can choose from. To name a few, these are Bar, Point, Line, Pie and
Doughnut, Area, Radar and Polar, Range Bar, Gantt, Candle Stick and Stock charts.

A Chart control contains multiple elements (diagram, series, series points, axes, legend, titles, labels, strips,
constant lines, etc.). When any of these elements is selected, the Property Grid shows only the properties which
correspond to the selected item. Visual Chart elements which can be highlighted or selected, are described in 
Highlighting and Selection Chart Elements.

The Chart control is data-aware in a different manner than the other report controls. Consider three common
report scenarios:

1.Static data for a Chart's series is provided m anually. It can be done using the Series Collection Editor
invoked by the Chart's Series property. It allows you to manually define values and arguments for each
series point.

2.Chart's series are created au tom atically, getting their data from the Chart's Data Source and dependent
on the rules defined by the Series Template property. This approach is described in Chart with Dynamic
Series.

3.Each series is created and customized manually and has a separate Data Source. This approach is
described in Chart with Static Series.

You can customize a created chart using both the Property Grid and the Chart Wizard. To invoke the Chart Wizard,
click a Chart's Smart Tag, and in the invoked actions list, click the Run Wizard... link.
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Then, the Chart Wizard will guide you through the whole process of customizing the Chart, from defining its view
type to providing its data and customizing its appearance.

In the Property Grid, the Chart's properties are divided into the following groups.

Appearance

Appearance Name

Allows you to choose one of the available appearances, to be used to draw the Chart's elements
(Diagram, Axes, Legend, etc.).

Background Color

Specifies the background color for a Chart.

Background Image

Allows you to load a background image to a Chart (or define its URL), and also define whether it should
be stretched to fit the entire Chart's area, or not.

Borders, Border Color and Border Width

Specify border settings for the control.

Fill Style

Determines the fill style of a Chart's background (Empty, Solid, Gradient or Hatch) and define other fill
options if required.

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Image Type

Determines whether a Chart should be internally rendered as a metafile in a report (in this case the
quality of the rendered image is always good, but in particular cases some details of the control may be
lost), or as a bitmap (in this case the quality of the rendered image is sometimes poor, but it allows a
control to be drawn more precisely).

Indicators Palette Name

Specifies the palette that is used to paint all indicators that exist in a Chart.

Padding

Specifies the internal space between the Chart's content (the diagram and legend) and its edge, in pixels.

Palette Name

Allows you to choose one from the built-in palettes to be used to draw a Chart's series.
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Palette's Base Color Number

Allows you to define an integer index determining the base color for the palette defined by the Chart's
Palette Name property.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that after page rendering it stays attached to the
top control, bottom control, or both.

Automatic Binding Settings Enabled

Specifies whether or not the Chart's data binding is automatically adjusted when its data source is a Pivot
Grid.

Automatic Layout Settings Enabled

Specifies whether or not the Chart's layout is automatically adjusted when its data source is a Pivot Grid.

Empty Chart Text

Specifies the text to be shown in the Chart, when it has no data to display.

Scripts

This property contains events, which you can handle by the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Small Chart Text

Specifies the text to be shown in the Chart, when it's too small to fit the diagram.

Visible

Specifies whether a Chart should be visible in print preview.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of a Chart's properties
(Bookmark, Navigation URL and Tag) to a data field obtained from the report's data source, and to apply
a format string to it. For more information on this, refer to Displaying Values from a Database (Binding
Report Elements to Data).

Data Adapter

Determines a data adapter that will populate a Chart's data source which is assigned via the Data Source
property. It is automatically set to the appropriate value, when the Data Member property is defined. To
learn more on this, refer to Chart with Static Series.

Data Member

Determines the data source member which supplies data to a Chart. To learn more on this, refer to Chart
with Static Series.

Note

Usually, it is not necessary to specify the Data Member property when binding a Chart to data. This
property should only be set directly if the dataset contains more than one table.

Data Source

Determines a Chart's data source. To learn more on this, refer to Chart with Static Series.

Pivot Grid Data Source Options

Determines a Chart's data source. To learn more on this, refer to Chart with Static Series.

Series Data Member
Determines the name of the data field whose values are used to automatically generate and populate a
Chart's series. To learn more on this, refer to Chart with Dynamic Series.

When Chart binding is used to automatically generate series within a chart control based upon the data
obtained from the associated data source (defined by the Data Source property), a rule needs to be
defined that helps the Chart recognize the data records whose values are used to construct individual
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series objects. To do this, the Series Data Member property, which specifies the data field whose values
are taken into account when series objects are automatically created and populated, can be used.

Each automatically generated series gets its name from the data field specified by the Series Data
Member property. For example, this name is used to identify a series within the chart control's legend. The
names of all automatically generated series can be supplemented with the same prefix and postfix
defined by the settings which are available via the Series Name Template property.

The template settings for the dynamically created series are defined by the specific properties which are
available via the SeriesTemplate property of a Chart. In particular, the Argument Data Member and Value
Data Members properties specify the data fields from which the arguments and data values of the series
data points are obtained.

Note

Note that if the Series Data Member property is not set for a Chart, the Chart control can't automatically
generate series even if the Argument Data Member and Value Data Members properties are defined.

Series Name Template

Determines the settings used to name data bound series defining the prefix and postfix texts for the
names of series which are dynamically created as a result of binding a Chart to data (using the Data
Source, Series Data Member, Argument Data Member and Value Data Members properties). The series
names, to which these prefixes and postfixes are added, are taken by each series from the data field
defined by the Series Data Member property. To learn more on this, refer to Chart with Dynamic Series.

Note

Note that the settings available via the Series Name Template property are not applied to the data bound
series which are contained within the Series collection of a Chart.

Series Sorting

Allows you to define the sort mode of a Chart's series (None by default, Descending or Ascending).

Series Template

Allows you to customize a template for series which are created dynamically as a result of binding a Chart
to data (via the Data Source and Series Data Member properties). The settings which are available via the
Series Template property are common to all such data bound series. These settings allow you to provide
centralized customization of all dynamically created data bound series. To learn more on using this
property, refer to Chart with Dynamic Series.

Note that the settings which are customized via the Series Template property don't apply to the series
contained within the Series collection of a Chart.

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.

If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property and in the Tag.Binding drop-down selector,
select the required data field.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Elements

Annotation Repository

Provides centralized access to all annotations that are present in the Chart.

Annotations

Provides access to the annotations collection of the Chart.

Diagram

Allows you to customize a Chart's diagram elements: main and secondary axes and panes.

By default, a Chart is displayed in the Default Pane, but if necessary, you can display each Chart's series
in a separate pane. To do this, click the Pane's ellipsis button, to invoke the Pane Collection Editor,
allowing you to manage and customize panes. Then, select the required series within the Chart and set
its View.Pane property to the required pane.
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Note that the diagram is null until no visible series exists in the Chart's collection. So, to access the
diagram's options, you should create a series first.

Legend

Allows you to customize a Chart's legend, by defining such properties as text alignment and antialiasing,
font style, background color or image, border options, markers' size and visibility, shadow options, etc.

Series

Invokes the Series Collection Editor, which allows you to manage and customize a Chart's series.

Note that series which are bound to data at the level of a chart control (in particular, using the Data
Source, Series Data Member and both the Argument Data Member and Value Data Members properties)
are created dynamically, based upon the data obtained from the specified data source, and they are not
presented within the Series collection. To perform a centralized customization of such series, use the
settings which are available via the Series Template property.

Titles

Invokes the Chart Title Collection Editor, which allows you to manage and customize a Chart's titles.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field obtained from
the data source. To do this, expand the (Data Bindings) property and in the Bookmark.Binding drop-down
selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation when a user clicks the
control. The web browser displays a page in a window or a frame as specified by the Navigation Target
property. Note that a URL should have an appropriate prefix (e.g. "http://"). You can create cross-
references within the report by assigning the name of the target control to the Navigation URL property,
and setting the Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report has a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property, and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Pivot Grid

The Pivot Grid control represents dynamic data (obtained from an underlying data source) in a cross-tabulated
form to create cross-tab reports, similar to Pivot Tables in Microsoft Excel®. Column headers display unique values
from one data field, and row headers - from another field. Each cell displays a summary for the corresponding row
and column values. By specifying different data fields, you can see different totals. This allows you to get a
compact layout for a complex data analysis.

The Pivot Grid has a designer which allows you to easily adjust its layout. It can be invoked using the control's 
Smart Tag.

For more information on using this control, refer to Pivot Table.

In the Property Grid, the Pivot Grid's properties are divided into the following groups.

Appearance

Appearance

Allows you to define the appearance properties (such as Background Color, Foreground Color, Font, etc.)
for the Pivot Grid's elements (Cell, Field Value, Filter Separator, Header Group Line, etc.).

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Styles

Allows you to invoke the Styles Editor, which is intended to manage and customize the control's styles,
which then can be assigned to the Pivot Grid's elements.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the Pivot Grid, so that after page rendering it stays attached to
the top control, bottom control, or both.

Keep Together

Specifies whether the contents of the control can be horizontally split across pages. In other words, if the
control occupies more space than remains on the page, this property specifies whether this Pivot Grid
should be split between the current page and the next, or whether it will be printed entirely on the next
page. This property is in effect only when a Pivot Grid's content does not fit on the current page. If it does
not fit on the next page either, then the Pivot Grid will be split despite this property's value.

Scripts

This property contains events, which you can handle by the required scripts. For more information on
scripting, refer to Handle Events via Scripts.
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Visible

Specifies whether the control should be visible in print preview.

Data

Data Adapter

Determines a data adapter that will populate a Pivot Grid's data source which is assigned via the Data
Source property. It is automatically set to the appropriate value, when the Data Member property is
defined. To learn more on this, refer to Cross-Tab Report.

Data Member

Determines the data source member which supplies data to a Pivot Grid. To learn more on this, refer to 
Cross-Tab Report.

Note

Usually, it is not necessary to specify the Data Member property when binding a Pivot Grid to data. This
property should only be set directly if the dataset contains more than one table.

Data Source

Determines a Pivot Grid's data source. To learn more on this, refer to Cross-Tab Report.

Fields

Invokes the Pivot Grid Field Collection Editor, allowing you to manage and fully customize a Pivot Grid's
fields.

OLAP Connection String

Specifies a connection string to a cube in an Microsoft Analysis Services database. A sample connection
string is shown below:

OLAPConnectionString="Provider=msolap;Data Source=localhost;Initial
Catalog=Adventure Works DW;Cube Name=Adventure Works;Query Timeout=100;"

A connection string can be built via the Connection String Editor. To invoke it, click the ellipsis button for
the OLAP Connection String property.

To represent information from the bound cube, create specific Pivot Grid fields, and bind them to the
required fields in the data source.

If the OLAP Connection String property is set to a valid string, the value of the Data Source property is
cleared. Setting the Data Source property to a valid object clears the OLAP Connection String property.

Prefilter

When this property is expanded in the Property Grid, you can set its Enabled property to Yes, and use the
Criteria property to invoke the Pivot Grid Prefilter dialog.

This dialog allows you to build complex filter criteria with an unlimited number of filter conditions, combined
by logical operators. It provides a set of logical operators that significantly simplify the process of creating
filters for text, numeric and date-time fields.

Note

The Prefilter is not supported in OLAP mode.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.
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Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a
document map. For an explanation and help, refer to Add Bookmarks.

Options

Data Field Options

Allows you to customize the options which control the presentation of the data fields.

Data Options

Allows you to define whether a Pivot Grid's fields must be case sensitive or not.

Options Chart Data Source

Provides access to the options controlling the display of the Pivot Grid's data in a Chart.

Print Options

Allows you to customize the print options of a Pivot Grid.

View Options

Allows you to customize the Pivot Grid's display options.

 

All trademarks and registered trademarks are the property of their respective owners.
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Page Info

The Page Info control is intended to add page numbers and system information (the current date and time or the
current user name) into your report. As with many other controls, you can format this control's content.

In the Property Grid, the Page Info control's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the control.

Font

Specifies the font settings for the control. Some of these settings are available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the control. This option is also available in the Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor, allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of the control.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the control, as well as to assign an existing
style to the control (or a newly created one). For more information on style inheritance, refer to 
Understanding Style Concepts.

Text Alignment

Allows you to change the alignment of the control's text. This option is also available in the Formatting
Toolbar.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that after page rendering it stays attached to the
top control, bottom control, or both.

Format

This property allows you to specify the format string for the text displayed in the control. When you click
the ellipsis button, you will see the Format String Editor window that will select the predefined format or
customize it as needed. For more information about this, refer to Change Value Formatting of Report
Elements.

Page Information

You can select the type of information displayed in the control.

Type Description
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None Displays an empty control.

Page Number The string, specified by the Format property, is
displayed. The {0} combination in the string is
replaced with the current page number.

"Current of Total" Page Numbers The string, specified by the Format property, is
displayed. The {0} combination in the string is
replaced with the current page number, the {1}
combination - with a total number of pages in the
report. To display the typical "Page 1 of 11" text, use
the format string "Page {0} of {1}".

Page Number (Roman, Lowercase) The current page number is displayed using Roman
numerals in lowercase.

Page Number (Roman, Uppercase) The current page number is displayed using Roman
numerals in uppercase.

Current Date and Time The string, specified by the Format property, is
displayed. The {0:[format]} combination is replaced
with the current system date and time formatted
according to the [format] string. Use the Format
String Editor of the Format property (see below) to
select or construct the proper string.

User Name The name of the current user, which was used to log
into the operating system, is displayed.

Running Band

Specifies the name of the band, from which the Page Info gathers information. This allows you to
implement page numbering independently for the report and its groups. For a tutorial on this, refer to Add
Page Numbers for Groups.

By default, this property is not set to any value, meaning that the entire report is being taken into
account.

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Start Page Number

Here you can set the start number for page numbering.

Visible

Specifies whether the control should be visible in print preview.

Word Wrap

When this property is set to Yes, text contained in the control is wrapped to the next line if it doesn't fit
the line or comes across a newline character. If the this property is set to No, the text in this case will be
displayed on the same line until a newline character is entered.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of the control's properties
(Bookmark, Navigation URL and Tag) to a data field obtained from the report's data source, and to apply
a format string to it. For more information on this, refer to Displaying Values from a Database (Binding
Report Elements to Data).

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can be then accessible via scripts.

If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property and in the Tag.Binding drop-down selector,
select the required data field.
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Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a
document map. For an explanation and help, refer to Add Bookmarks.

If the current report has a data source, the Bookmark property can be bound to a data field obtained from
the data source. To do this, expand the (Data Bindings) property and in the Bookmark.Binding drop-down
selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation when a user clicks the
control. The web browser displays a page in a window or a frame as specified by the Navigation Target
property. Note that a URL should have an appropriate prefix (e.g. "http://"). You can create cross-
references within the report by assigning the name of the target control to the Navigation URL property,
and setting the Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report has a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Page Break

The Page Break control's sole purpose is to insert a page delimiter at any point within a report.

This control is visually represented by a short line, attached to the report's left margin, as shown in the following
image.

The Page Break control is useful when you need to insert a page break between controls within a band - for
example, to divide subreports, so that the second subreport starts printing on a new page. Another example of
the Page Break's use can be found in the following tutorial: Limit the Number of Records per Page.

Note

Note that when you need a page break before or after printing a certain band, you may set its Page Break
property to Before the Band or After the Band, instead of using the Page Break control.

In the Property Grid, the Page Break control's properties are divided into the following groups.

Appearance

Formatting Rules

Invokes the Formatting Rules Editor, allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Behavior

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible

Specifies whether the control should be visible in print preview.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.
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Cross-band Line

The Cross-band Line control allows you to draw a line through several bands. This can be useful if it is required to
visually emphasize a section consisting of multiple band areas. In other aspects, it is similar to a regular Line.

Another cross-band control available is the Cross-band Box.

In the Property Grid, the Cross-band Line control's properties are divided into the following groups.

Appearance

Foreground Color

Specifies the color of the control's line. This option is also available in the Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Line Style

You can select a solid (by default), dashed, dotted or mixed style for the line.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that after page rendering it stays attached to the
top control, bottom control, or both.

Visible

Specifies whether the control should be visible in print preview.

Data

Tag

This property allows you to add some additional information to the control; for example its id, by which it
then can be accessible via scripts.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

End Band

Determines a band, in which the control finishes drawing.
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End Point

Determines the end point (from a band's upper left corner) where the control finishes drawing.

Location

Specifies the control's location, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Start Band

Determines a band, in which the control starts drawing.

Start Point

Determines the starting point (from a band's upper left corner) where the control starts drawing.

Width

Specifies the line's width in report measurement units.
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Cross-band Box

The Cross-band Box control allows you to draw a rectangle through several bands. This can be useful if it is
required to visually encompass a section consisting of multiple band areas.

Another cross-band control available is the Cross-band Line.

In the Property Grid, the Cross-band Box control's properties are divided into the following groups.

Appearance

Borders, Border Color and Border Width

Specify border settings for the control.

Formatting Rules

Invokes the Formatting Rules Editor, allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Behavior

Anchor Vertically

Specifies the vertical anchoring style of the control, so that after page rendering it stays attached to the
top control, bottom control, or both.

Visible

Specifies whether the control should be visible in print preview.

Data

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.

Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

End Band

Determines a band, in which the control finishes drawing.

End Point

Determines the end point (from a band's upper left corner) where the control finishes drawing.

Location
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Specifies the control's location, in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.

Start Band

Determines a band, in which the control starts drawing.

Start Point

Determines the starting point (from a band's upper left corner) where the control starts drawing.

Width

Specifies the width of the Box, in report measurement units.
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Subreport

The Subreport control allows you to include other reports in your current report.

There are several reasons for using subreports. The first one is to reuse reports. This can be of help if there is a
particular report structure (tem plate) that has to be included in all reports, and the report must have consistent
appearance and functionality. A good example is a report header that contains the company information, logo,
date, etc. The second reason for using subreports is creation of m as ter-detail reports (or, invoice reports with
hierarchically linked data).

However, for master-detail reports creation, another approach is recommended: using Detail Report bands.

You can click a subreport, to open the report to which it is linked in a new Design Panel.

In the Property Grid, the Subreport's properties are divided into the following groups.

Appearance

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the control
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Behavior

Can Shrink

Determines whether a Subreport's height should be decreased if its contents don't completely fill the
control.

Use this property to specify whether the height of the Subreport control should be taken into account
when generating a report. This may be required, because usually the mutual location of report controls is
considered when generating a report document. But, as the Subreport control actually represents a
report itself, the height of a Subreport normally should not be taken into account in the generated report
document.

Also, note that there is no Can Grow option for the Subreport control, as it always increases its height
depending on its contents.

Scripts

This property contains events, which you can handle by the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible

Specifies a value indicating whether the current control should be printed (when set to Yes) or hidden
(No) on report generation.

Data

Report Source

Determines a report to be included as a subreport.

If report classes of the application that invoked the Report Designer are compiled into one assembly, then
they are available as items in this combo box.

Report Source Url

Defines an URL of a report definition file (*.REPX), to be used as a report source.
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Design

(Name)

Determines a control's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location, in report measurement units.

Size

Specifies the control's size, in report measurement units.

The Subreport isn't limited by the visible size of the control. The size of its actual content is taken into
account when rendering the subreport on the page. Note that depending on its contents, its width is
unlimited and its height is increased.

Snap Line Margin

Specifies the margin (in report measurement units), which is to be preserved around the control when it
is aligned using Snap Lines, or when other controls are aligned next to it.
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Sparkline

The Sparkline control displays a compact chart that is commonly used to reflect the flow of data for every row in a
report.

In the Property Grid, the Sparkline control's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color, Border Width, and Border Dash Style

Specify border settings for the control.

Formatting Rules

Invokes the Formatting Rules Editor, which allows you to choose which rules should be applied to a
control during report generation, and define the precedence of the applied rules. To learn more on this,
refer to Conditionally Change a Control's Appearance.

Padding

Specifies indent values that are used to render the contents of a Label.

Style Priority

Specifies the priority of various style elements (such as background color, border color, etc.). For more
information on style inheritance, refer to Understanding Style Concepts.

Styles

Assigns an existing (or newly created) style to the control, and also specifies odd and even styles.. For
more information on style inheritance, refer to Understanding Style Concepts.

View

Specifies the type of a chart displayed by a Sparkline control. The following table lists the available
Sparkline view types.

View Type Image Description

Line A line chart.

Area An area chart.

Bar A bar chart.

WinLoss A win-loss chart.

Behavior

Anchor Vertically

Specifies the vertical anchor style of the control, so that after a page is rendered it stays attached to the
top control, bottom control, or both.

Scripts

This property contains events that you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible
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Specifies whether the control should be visible in a print preview.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of the control's properties (
Bookmark, Navigation URL, Tag and Text) to a data field obtained from the report's data source, and to
apply a format string to it. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Data Adapter

Determines the data adapter that will populate the Sparkline's data source, which is assigned via the 
Data Source property. It is automatically set to the appropriate value when the Data Member property is
defined.

Data Member

Determines the data source member that supplies data to a Sparkline.

Note

Usually, it is not necessary to specify the Data Member property when binding a Sparkline to data. This
property should only be set directly if the dataset contains more than one table.

Data Source

Determines a Sparkline's data source.

Tag

This property allows you to add some additional information to the control; for example its id, by which it
can then be accessible via scripts.

If the current report has a data source, the Tag property can be bound to a data field obtained from the
data source. To do this, expand the (Data Bindings) property, and in the Tag.Binding drop-down
selector, select the required data field.

Value Member

Specifies the data member field that provides point values for a Sparkline.

Design

(Name)

Determines the control's name by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location in report measurement units.

Size

Specifies the control's size in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units) around the control when it is aligned using Snap Lines
, or when other controls are aligned next to it.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a 
document map. For more information, refer to the Add Bookmarks topic.

If the current report is bound to a data source, the Bookmark property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property, and in the Bookmark.
Binding drop-down selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation when a user clicks a Label.
The web browser displays a page in a window or a frame as specified by the Navigation Target property.
Note that a URL should have an appropriate prefix (e.g., "http://"). You can create cross-references within
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the report by assigning the name of the target control to the Navigation URL property, and setting the
Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report is bound to a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property, and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Table of Contents

The Table of Contents control generates a table of contents based on bookmarks specified for report elements.

When a Table of Contents control is dropped onto a report's body from the Toolbox, it is placed on the Report
Header band of the report. If there is no Report Header in the report, it is created automatically.

A table of contents is generated based on the hierarchy of report bookmarks. To learn how to provide a report
with bookmarks, refer to the Add Bookmarks topic.

In the Property Grid, the properties of the Table of Contents are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color, Border Width and Border Dash Style

Specify border settings for the control.

Formatting Rules

Invokes the Formatting Rules Editor, which allows you to choose which rules should be applied to a
control during report generation, and define the precedence of the applied rules. To learn more on this,
refer to Conditionally Change a Control's Appearance.

Padding

Specifies indent values that are used to render the contents of a Label.

Foreground Color

Specifies the text color for the control. This option is also available in the Formatting Toolbar ( ).

Style Priority

Specifies the priority of various style elements (such as background color, border color, etc.). For more
information on style inheritance, refer to Understanding Style Concepts.

Styles

Assigns an existing (or newly created) style to the control, and also specifies odd and even styles. For
more information on style inheritance, refer to Understanding Style Concepts.

Behavior

Level Default

Specifies the default formatting options for the hierarchical levels of a Table of Contents.

Level Title

Specifies the formatting options for the title of a Table of Contents.

Levels

Invokes the Table of Contents Level Collection Editor, which allows you to edit and customize formatting
options for hierarchical levels of a Table of Contents.

Max Nesting Level

Specifies the maximum number of Table of Contents levels to be displayed. If set to 0, no limitation is
applied.

Visible

Specifies whether the control should be visible in a print preview.

Data
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Tag

This property allows you to add some additional information to the control; for example, its id, by which it
can then be accessible using scripts.

Design

(Name)

Determines the control's name by which it can be accessed in the Report Explorer, Property Grid or using
scripts.

Layout

Location

Specifies the control's location in report measurement units.
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Gauge

The Gauge control provides you with the capability to embed graphical gauges into your report.

In the Property Grid, the Gauge control's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the control. This option is also available in the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the control.

Foreground Color

Specifies the text color for the control. This option is also available in the Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor, which allows you to choose which rules should be applied to a
control during report generation, and define the precedence of the applied rules. To learn more on this,
refer to Conditionally Change a Control's Appearance.

Padding

Specifies the indent values that are used to render the contents of a Label.

Style Priority

Specifies the priority of various style elements (such as background color, border color, etc.). For more
information on style inheritance, refer to Understanding Style Concepts.

Styles

Assigns an existing (or newly created) style to the control, and also specifies odd and even styles. For
more information on style inheritance, refer to Understanding Style Concepts.

View Style

Specifies the style of the displayed gauge.

View Theme

Specifies the color theme of the displayed gauge.

View Type

Specifies the type of the displayed gauge. The following view types are supported.

Circular

Linear
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Behavior

Anchor Vertically

Specifies the vertical anchor style of the control, so that after a page is rendered it stays attached to the
top control, bottom control, or both.

Scripts

This property contains events that you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible

Specifies whether or not the control should be visible in a print preview.

Data

(Data Bindings)

If the current report is bound to data, this property allows you to bind some of the control's properties (
Bookmark, Navigation URL, Tag and Text) to a data field obtained from the report's data source, and to
apply a format string to it. For more information on this, refer to Displaying Values from a Database
(Binding Report Elements to Data).

Actual Value

Specifies the value displayed by a gauge.

Maximum

Specifies the gauges maximum value.

Minimum

Specifies the gauges minimum value.

Tag

This property allows you to add some additional information to the control; for example, its id, by which it
is then accessible via scripts.

Target Value

Specifies the position of the target value marker.

Design

(Name)

Determines the control's name by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Layout

Location

Specifies the control's location in report measurement units.

Size

Specifies the control's size in report measurement units.

Snap Line Margin

Specifies the margin (in report measurement units) around the control when it is aligned using Snap Lines
, or when other controls are aligned next to it.

Navigation

Bookmark and Parent Bookmark

These properties are intended for the creation of a hierarchical structure within a report called a 
document map. For more information, refer to the Add Bookmarks topic.

If the current report is bound to a data source, the Bookmark property can be bound to a data field,
obtained from the data source. To do this, expand the (Data Bindings) property, and in the Bookmark.
Binding drop-down selector, select the required data field.

Navigation URL and Navigation Target

Use the Navigation URL property to specify a URL for web browser navigation, when a user clicks a Label.
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The web browser displays a page in a window or a frame as specified by the Navigation Target property.
Note that a URL should have an appropriate prefix (e.g., "http://"). You can create cross-references within
the report by assigning the name of the target control to the Navigation URL property, and setting the
Navigation Target property to "_self". For more information, refer to Create Hyperlinks.

If the current report is bound to a data source, the Navigation URL property can be bound to a data field
obtained from the data source. To do this, expand the (Data Bindings) property, and in the Navigation
URL.Binding drop-down selector, select the required data field.
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Report Bands

The documents in this section details the available kinds of report bands and their settings.

In the Report Designer, a report is built upon bands - sections of varied type and purpose, where report controls
are contained. Bands are featured in the Designer Tab, solely to represent different sections of a report document
(such as detail, report or page header, or footer). They allow you to select exactly where a control should be
printed, and how many times.

Band Types

The following band types are available.

Detail Band

Groop Header and Footer

Report Header and Footer

Page Header and Footer

Page Margin Bands

Detail Report Band (for Master-Detail Reports)

Manage Bands

To manage bands in a report, click its Smart Tag, and in the invoked actions list, click the Edit and Reorder
Bands... link.

Then, in the invoked Report Editor you can easily add, remove and reorder bands, and adjust their options.

Alternatively, you can invoke the Report Editor via any band's Smart Tag.
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To quickly insert a band of any type (except for the Detail band, since it is required in a report), right-click
anywhere on a report's surface, and in the invoked Context Menu, point to Insert Band, and choose the band
type.

See Also
Detail Band
Grouping Bands
Report Header and Footer
Page Header and Footer
Page Margin Bands
Detail Report Band for Master-Detail Reports
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Detail Band

The Detail band is the central part of a report. Unlike other bands, it cannot be deleted - the present report
structure includes the Detail band in its core. In a data-bound report, the contents of the Detail band are
repeated for every data entry (e.g. if you're building a report listing, say, products, it will be rendered for each
product in the database). And, if static data is also present in the Detail band, in the resulting report, it is
repeated with each new entry.

In the Property Grid, the Detail Band's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color for the controls contained within the band. This option is also available in

the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the controls contained within the band.

Font

Specifies the font settings for the controls contained within the band. Some of these settings are
available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the controls contained within the band. This option is also available in the 

Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the band
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of the controls contained within the band.
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Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the controls contained within the band, as well
as to assign an existing style to them (or a newly created one). For more information on style inheritance,
refer to Understanding Style Concepts.

Text Alignment

Allows you to change the text alignment of the controls contained within the band. This option is also
available in the Formatting Toolbar.

Behavior

Keep Together

As stated above, the detail band is printed repeatedly for every data entry. When the Keep Together
option is on, the report engine tries to keep sequential detail band entries together. This option makes
sense only when data is grouped or you're working with a master-detail report. In this case, the report
engine tries to keep group contents on one page. If a group doesn't fit and it starts somewhere in the
middle of a page, the report moves this group to a new page, thus trying to reduce the number of page
breaks in continuous data.

Multi-Column Options

This property allows you to arrange the printout of the band's content in several columns. For more
information, refer to Multi-Column Report.

Page Break

Use this property if the current report design requires that the detail section should be separated from
previous sections or follow-ups. Specify the Before the Band or After the Band values to insert a page
break before or after the current band. In many cases, this property may be used instead of the Page
Break control.

Scripts

This property contains events, which you can handle by the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible

Specifies whether the band should be visible in print preview.

Data

Sort Fields

Invokes the Group Field Collection Editor, which enables you to specify the fields for sorting the records
within the band, the sorting order (Ascending/Descending) for each field and the order sequence. For
more information, refer to Change or Apply Data Sorting to a Report.

Tag

This property allows you to add some additional information to the band; for example its id, by which it
can then be accessible via scripts.

Design

(Name)

Determines a band's name, by which it can be accessed in the Report Explorer, Property Grid or via scripts
.

Layout

Height

Specifies the band's height, in report measurement units.

Snap Line Padding

Specifies the padding (in report measurement units), which is to be preserved within the band when
controls it contains are aligned using Snap Lines.
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Misc

Keep Together with Detail Reports

When this option is on, the Detail Band will be always printed on the same page together with its child 
Detail Report Band, or multiple bands.
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Grouping Bands

The Group Header and Group Footer bands are shown above and below each group. Usually, you don't need to
manually manage these bands, as they are auto-created via the Group and Sort Panel. For more information, refer
to Change or Apply Data Grouping to a Report and Change or Apply Data Sorting to a Report.

You may use the Group Header bands for grouping by multiple data fields in one of the following ways.

1.Add several Group Header bands. Specify one group field for each of these bands.

This results in nested grouping of the report's data.

2.Specify several group fields for the Group Fields property of the Group Header band. The data will be
grouped by certain combinations of field values.
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The Group Footer band is unnecessary without the corresponding Group Header band, to which its properties are
similar. The Group Footer can be used to display group totals, or group page numbers.

In the Property Grid, the properties of both these bands are divided into the following groups.

Appearance

Background Color

Specifies the background color for the controls contained within the band. This option is also available in

the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the controls contained within the band.

Font

Specifies the font settings for the controls contained within the band. Some of these settings are
available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the controls contained within the band. This option is also available in the 

Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the band
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of the controls contained within the bands.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the controls contained within the bands, as
well as to assign an existing style to them (or a newly created one). For more information on style
inheritance, refer to Understanding Style Concepts.

Text Alignment
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Allows you to change the text alignment of the controls contained within the bands. This option is also
available in the Formatting Toolbar.

Behavior

Group Fields

This property is available for the Group Header band only. It invokes the Group Field Collection Editor,
allowing you to add and remove grouping fields, define data fields to be used as grouping criteria and the
grouping order (ascending or descending).

In most scenarios, it's quick and practical to use the Group and Sort Panel, rather than manually adjust
the band's group fields collection. However, this is the only way to assign multiple group fields to a single
Group Header.

Group Union

Determines whether group rows can be printed on different pages (in this case both Group Union and
Group Footer Band.Group Union are set to None), or the entire group will be printed on a single page (if
the Group Union is set to Whole Page).

Also, if a group can be split across pages, but you don't want a Group Header to be printed on a page if
there is no data row below it (in case a group starts at the bottom of the page and there is enough room
for only a Group Header), you may set the Group Union to With First Detail. In this case, if a Group Header
is alone on a page, it will be moved to the beginning of the next page.

It is the same for the Group Footer. If you don't want it to be printed alone on a page, you may set its
Group Union to With Last Detail, and the last group row from the previous page will be moved to the next
page to be printed together with a Group Footer.

This property is quickly accessible via the band's Smart Tag.

Keep Together

When this option is on, the report tries to fit the band contents entirely on one page, not allowing it to
split across several pages. In general, if the contents are too large to fit on a single page, then the band
is started on a new page, and continues on the following page.

Level

Specifies the nesting level of a group band. The lower the level number, the closer the group band is to
the Detail band. The numeration starts at zero. It is the parameter that identifies the Group Header /
Group Footer band pairs.

This option is auto-defined when using the Group and Sort Panel.

Page Break

Use this property if the current report design requires that the band's section should be separated from
previous sections or follow-ups. Specify the Before the Band or After the Band values to insert a page
break before or after the current band. In many cases, this property may be used instead of the Page
Break control.

Print at Bottom

This property is available for the Group Footer band only. It determines whether the band should be
printed at the bottom of a page, or immediately after the last group's details.

If a report contains several Group Footers with their Print at Bottom properties set to different values,
then the outer Group Footer has the highest priority.

This feature is helpful when the Page Break property of the Group Header band is set to After the Band.
In this instance each group starts a new page, and the Group Footer has two distinct places to reside -
after the last row, or at the bottom of the page.

Repeat Every Page

This property improves the readability of reports with group contents that are several pages long.
Without a repeated group header at the top of the page, the report may be difficult to read.

This property is also accessible via the band's Smart Tag.

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Sorting Summary

This property is available for the Group Header band only. It allows you to sort groups by a summary
function result.
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Visible

Specifies whether the bands should be visible in print preview.

Data

Tag

This property allows you to add some additional information to the band; for example its id, by which it
can then be accessible via scripts.

Design

(Name)

Determines a band's name, by which it can be accessed in the Report Explorer, Property Grid or via scripts
.

Layout

Height

Specifies the band's height, in report units.

Snap Line Padding

Specifies the padding (in report measurement units), which is to be preserved within the band when
controls it contains are aligned using Snap Lines.
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Report Header and Footer

The Report Header and Report Footer are the only types of report bands rendered once per report.

The Report Header is the first band of a report on the first page (not counting margins as they are "out-of-page"
zones). The Report Header also precedes the Page Header, making it the best place to display the report's name,
company logo, date of creation and user name, etc.

And, if you plan to add a Chart that visualizes the report's data, place this control onto this band.

The Report Footer finalizes the informative part of the report. It is placed before the Page Footer and Bottom
Margin on the report's last page. Use the Report Footer for report grand totals or conclusions.

In the Property Grid, the properties of these bands are divided into the following groups.

Appearance

Background Color

Specifies the background color for the controls contained within the band. This option is also available in

the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the controls contained within the band.

Font

Specifies the font settings for the controls contained within the band. Some of these settings are
available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the controls contained within the band. This option is also available in the 

Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the band
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of the controls contained within the bands.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the controls contained within the bands, as
well as to assign an existing style to them (or a newly created one). For more information on style
inheritance, refer to Understanding Style Concepts.

Text Alignment

Allows you to change the text alignment of the controls contained within the bands. This option is also
available in the Formatting Toolbar.

Behavior
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Keep Together

When this option is on, the report tries to fit the band contents entirely on one page, not allowing it to
split across several pages. In general, if the contents are too large to fit on a single page, then the band
is started on a new page, and continues on the following page.

Page Break

Use this property if the current report design requires that the band's section should be separated from
previous sections or follow-ups. Specify the Before the Band or After the Band values to insert a page
break before or after the current band. In many cases, this property may be used instead of the Page
Break control.

Print at Bottom

This property is available for the Report Footer band only, and determines whether this band should be
printed at the bottom of the last page, or immediately after the last report's details. The Report Footer
has priority over the Group Footer's Print at Bottom property, so the Group Footer can never be placed
after the Report Footer.

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible

Specifies whether the band should be visible in print preview.

Data

Tag

This property allows you to add some additional information to the band; for example its id, by which it
can then be accessible via scripts.

Design

(Name)

Determines a band's name, by which it can be accessed in the Report Explorer, Property Grid or via scripts
.

Layout

Height

Specifies the band's height, in report units.

Snap Line Padding

Specifies the padding (in report measurement units), which is to be preserved within the band when
controls it contains are aligned using Snap Lines.
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Page Header and Footer

The Page Header and Page Footer bands are located at the top and bottom of every page in a report.

The Page Header/Footer bands are the best place for information that should be printed on every page. For
example, use them to display the header of a table which is continued from the previous page (an example can be
found at the Table Report tutorial).

Note

If you insert page break right after the Report Header (by setting its Page Break to After the Band), the Page
Footer and Page Header bands will not be printed on the first page.

In the Property Grid, the properties of these bands are divided into the following groups.

Appearance

Background Color

Specifies the background color for the controls contained within the band. This option is also available in

the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the controls contained within the band.

Font

Specifies the font settings for the controls contained within the band. Some of these settings are
available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the controls contained within the band. This option is also available in the 

Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor, allowing you to choose which rules should be applied to the band
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of the controls contained within the bands.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the controls contained within the bands, as
well as to assign an existing style to them (or a newly created one). For more information on style
inheritance, refer to Understanding Style Concepts.

Text Alignment

Allows you to change the text alignment of the controls contained within the bands. This option is also
available in the Formatting Toolbar.

Behavior
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Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible

Specifies whether the band should be visible in print preview.

Data

Tag

This property allows you to add some additional information to the band; for example its id, by which it
can then be accessible via scripts.

Design

(Name)

Determines a band's name, by which it can be accessed in the Report Explorer, Property Grid or via scripts
.

Layout

Height

Specifies the band's height, in report units.

Snap Line Padding

Specifies the padding (in report measurement units), which is to be preserved within the band when
controls it contains are aligned using Snap Lines.

Misc

Print On

This property specifies whether the band should be printed on the same page with Report Header and
Report Footer bands.
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Page Margin Bands

The Top Margin and Bottom Margin bands represent the top and bottom page margins. Unlike other bands, they
are not accompanied by strips displaying their titles in the Design Panel.

They are intended for displaying page numbers, or some sort of supplementary information (e.g. current system
time or the user name).

In the Property Grid, the properties of these bands are divided into the following groups.

Appearance

Background Color

Specifies the background color for the controls contained within the band. This option is also available in

the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the controls contained within the band.

Font

Specifies the font settings for the controls contained within the band. Some of these settings are
available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the controls contained within the band. This option is also available in the 

Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor allowing you to choose which rules should be applied to the band
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of the controls contained within the bands.

Style Priority

Allows you to define the priority of various style elements (such as background color, border color, etc.).
For more information on style inheritance, refer to Understanding Style Concepts.

Styles

This property allows you to define odd and even styles for the controls contained within the bands, as
well as to assign an existing style to them (or a newly created one). For more information on style
inheritance, refer to Understanding Style Concepts.

Text Alignment

Allows you to change the text alignment of the controls contained within the bands. This option is also
available in the Formatting Toolbar.

Behavior

Scripts

This property contains events, which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible
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Specifies whether the band should be visible in print preview.

Data

Tag

This property allows you to add some additional information to the band; for example its id, by which it
can then be accessible via scripts.

Design

(Name)

Determines a band's name, by which it can be accessed in the Report Explorer, Property Grid or via scripts
.

Layout

Height

Specifies the band's height, in report units.

Note

Note that this property is tied to the report's Margins.Top (or Margins.Bottom) property, so that changing
this property's value will cause the appropriate Margin value to be changed, and vice versa.

Snap Line Padding

Specifies the padding (in report measurement units), which is to be preserved within the band when
controls it contains are aligned using Snap Lines.
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Detail Report Band for Master-Detail Reports

The Detail Report band is a type of band used to incorporate one report into another in master-detail reports. It
is quite different from the Detail band, since it holds the whole detail report in a m as ter-detail report layout, and
therefore can contain other types of bands within it.

There can be an unlimited number of Detail Report bands nested inside one another.

To add a Detail Report band, use the Context Menu. If the bound data source contains a data relationsh ip, the
submenu will contain an item with its name. Otherwise, add an unbound detail report and specify its data binding
options later.
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In the Property Grid, the properties of this band are divided into the following groups.

Appearance

Background Color

Specifies the background color for the controls contained within the band. This option is also available in

the Formatting Toolbar ( ).

Borders, Border Color and Border Width

Specify border settings for the controls contained within the band.

Font

Specifies the font settings for the controls contained within the band. Some of these settings are
available in the Formatting Toolbar.

Foreground Color

Specifies the text color for the controls contained within the band. This option is also available in the 

Formatting Toolbar ( ).

Formatting Rules

Invokes the Formatting Rules Editor, allowing you to choose which rules should be applied to the band
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values which are used to render the contents of the controls contained within the band.

Text Alignment

Allows you to change the text alignment of the controls contained within the band. This option is also
available in the Formatting Toolbar.

Behavior

Level

Specifies the order of several Detail Report Band objects in a report. It allows the reordering of different
Detail Report Bands at the same level of master-detail relationships. The lower the level number, the
closer the band is to the Detail band.

Page Break

Use this property if the current report design requires that the band's section should be separated from
previous sections or follow-ups. Specify the Before the Band or After the Band values to insert a page
break before or after the current band. In many cases, this property may be used instead of the Page
Break control.

Print when Data Source is Empty

Specifies whether the band should be printed if its data source is empty.

Scripts

This property contains events which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Visible
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Specifies whether the band should be visible in print preview.

Data

Data Adapter

Determines a Detail Report Band's data adapter that provides the detail data for the report. To learn
more, refer to Master-Detail Report (Detail Report Bands).

Data Member

Determines a name of the data relationship established within the bound data source. To learn more,
refer to Master-Detail Report (Detail Report Bands).

Data Source

Determines the data source that provides the detail data for the report. If this property isn't defined, the
detail report gets data from the master report's data source. To learn more, refer to Master-Detail Report
(Detail Report Bands).

Filter String

Allows you to invoke the Filter String Editor, which is intended to easily define a filtering condition for a
detail report's data. For more information, refer to Change or Apply Data Filtering to a Report.

Tag

This property allows you to add some additional information to the band; for example its id, by which it
can then be accessible via scripts.

XML Data Path

Allows you to define a path to the data contained in an XML file. The data contained in the file will then be
used as the Detail Report Band's data source.

In this case, the Data Member property will specify the bound list in the XML data source.

Note

Note that a detail report uses the XML Data Path property value only when the Data Source property is
set to None. The XML Data Path property has a lower priority than the Data Source property.

Design

(Name)

Determines a band's name, by which it can be accessed in the Report Explorer, Property Grid or via scripts
.

Detail Print Count

Specifies how many times the Detail band should be printed when a data source is defined for the
subreport, and it is not empty.

Detail Print Count when Data Source is Empty

Specifies how many times the Detail band should be printed when no data source is defined for the
subreport.

Structure

Bands

Allows you to invoke the Report Editor intended to manage and customize the report's bands.
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Report Settings

This document details settings that affect the entire report.

A Report is the main object in the Report Designer, as it's the document being edited. A typical report is shown in
the following image (as it looks in the Designer Tab).

While the main report's properties can be accessed via the report's Smart Tag, the complete settings list is
available in the Property Grid, where all the report's properties are divided into the following groups.

Appearance

Background Color

Specifies the background color of report elements. This option is also available in the Formatting Toolbar (

).

Borders, Border Color and Border Width

Specify border settings for report elements.

Font

Specifies the font settings for report elements. Some of these settings are available in the Formatting
Toolbar.

Foreground Color

Specifies the text color for report elements. This option is also available in the Formatting Toolbar ( ).

Formatting Rule Sheet

Invokes the Formatting Rule Sheet Editor, allowing you to manage and customize formatting rules, which
can then be defined for a report's bands and controls. To learn more on this, refer to Conditionally
Change a Control's Appearance.

Formatting Rules

Invokes the Formatting Rules Editor, allowing you to choose which rules should be applied to the report
during report generation, and define the precedence of the applied rules. To learn more on this, refer to 
Conditionally Change a Control's Appearance.

Padding

Specifies indent values used to render the contents of a report's controls.

Page Color

Specifies the fill color for report pages. This color may be changed later in a report's Print Preview.

Style Sheet
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Allows you to invoke the Styles Editor, which is intended to manage and customize a report's style
sheets. To learn more on this, refer to Store and Restore Style Sheets.

Style Sheet's Path

Allows you to define a path to the style sheet contained in a report style sheet file (.REPSS). To learn
more on this, refer to Store and Restore Style Sheets.

Text Alignment

Allows you to change the alignment of a report controls' text. This option is also available in the 
Formatting Toolbar.

Watermark

Allows you to customize a report's watermark options. For more information about this, refer to Create or
Modify Watermarks of a Report.

Behavior

Display Name

Specifies the name of the report, which is displayed in its Design Panel tab.

Export Options

Allows you to set the export options for each file type (PDF, XLS, TXT, etc.). These options vary with the
file type.

Measure Units

Allows you to choose units of measurement for a report (one hundredth of an inch or a tenth of a
millimeter).

Print when Data Source is Empty

Script Language

Allows you to choose the programming language to be used in scripting (C#, Visual Basic or J#).

Script References

Allows you to manage the collection of strings that represent the paths to the assemblies used by the 
scripts in a report.

Scripts

This property contains events which you can handle with the required scripts. For more information on
scripting, refer to Handle Events via Scripts.

Show Margin Lines in Preview

The page margin lines are dotted lines shown on the currently selected page in the report's preview. Use
this property to change the visibility of these lines.

Vertical Content Splitting

Allows you to choose whether report controls outside the right page margin should be split across pages,
or moved in their entirety to the next page. This option is useful for the cross-tab reports creation.

Visible

Specifies whether a report should be created in print preview.

Data

Calculated Fields

Allows you to access a report's calculated fields collection.

Data Adapter

Determines a report's data adapter used to populate the report's data source. It is created automatically
when the Data Member property is defined. To learn more about this, refer to Bind a Report to Data.

Data Member
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Determines a specific list in a report's Data Source, for which the Report Designer objects display data. To
learn more about this, refer to Bind a Report to Data.

Note

Usually, it is not necessary to specify the Data Member property when binding a report to data. This
property should only be set directly if the dataset contains more than one table.

Data Source

Determines a report's data source. To learn more about this, refer to Bind a Report to Data.

Filter String

Allows you to invoke the Filter String Editor, which is intended to easily define a filtering condition for a
report's data. For more information about this, refer to Change or Apply Data Filtering to a Report.

Tag

This property allows you to add some additional information to a report; for example its id, by which it can
then be accessible via scripts.

XML Data Path

Allows you to define a path to data contained in an external XML file. The data contained in the file will
then be used as a report's data source.

Design

(Name)

Determines a report's name, by which it can be accessed in the Report Explorer, Property Grid or via
scripts.

Data Source's Schema

Allows you to load an XML/XSD file, containing the schema of a report's data source.

Designer Options

Contains the following options.

- Show Designer's Hints
The designer hints are intended to provide tooltips, both describing the purpose of certain report
elements for inexperienced users, and describing the reasons and solutions for possible export or printing
warnings. By using this property, these hints can be turned on or off.

- Show Export Warnings
The export warnings appear when report controls are overlapped, indicating that a report layout may be
incorrect when exporting to certain table-based formats (such as XLS, HTML or RTF).

- Show Printing Warnings
The printing warnings are intended to notify you that some of a report's controls are placed outside the
right page margin, so that the report contains unnecessary pages.
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Detail Print Count

Specifies how many times the Detail band should be printed when a data source is defined for the report,
and it is not empty.

Detail Print Count when Data Source is Empty

Specifies how many times the Detail band should be printed when no data source is defined for the
report.

Draw the Grid

Determines whether to draw the Snap Grid when a report is being designed.

Snap Grid Size

Determines the size of the Snap Grid's cells.

Snap to Grid

Specifies whether to snap controls to the Snap Grid when they are located or resized.

Snapping Mode

Specifies the snapping mode for report elements when they are being aligned using the Snap Grid.

Navigation

Bookmark

Allows you to define how a report is named in the document map when the report bookmarks are
implemented. By default, it is synchronized with the report's Name property.

Page Settings

Landscape

Determines whether the page orientation is Landscape (when set to Yes) or Portrait (when set to No).

Margins

Determines the width of a report's margins (measured in report units).

Note

Note that the report's Margins.Top and Margins.Bottom properties are tied to the Height property of the 
Page Margin Bands. So, changing these properties' values will cause changing the appropriate bands'
Height value as well, and vice versa.

Page Height

Specifies page height, in report units. This property can only be set if the Paper Kind property is set to
Custom.

Page Width

Specifies page width, in report units. This property can only be set if the Paper Kind property is set to
Custom.

Paper Kind

Determines the type of paper for a report. Setting this property to any value different from Custom will
prevent the Page Height, Page Width and Paper Name properties from being customized.



Report Designer 526

© 2014 DevExpress Inc. 526

Note

If the Paper Kind property is set to Custom, then the printer paper will be selected according to the Paper
Name property's value. In this case, it's also necessary to set the Page Width and Page Height properties
to the corresponding values of the paper selected.

Paper Name

Determines the name of the custom paper used in the printer that will print the document.

The Paper Name property's value is in effect only when the Paper Kind property is set to Custom. If the
printer on which a document is printed doesn't support the paper type specified by the Paper Name
property's value, then it will default to the Letter paper size. In this case, it's also necessary to set the
Page Width and Page Height properties to the corresponding values of the selected paper.

Printer Name

Determines the name of the printer to use when printing a report. Note that the specified printer should
be installed on the machine.

Using Settings of the Default Printer

Specifies which of the default printer's settings should be used when printing a report.

Parameters

Parameters

Allows you to access a report's parameters collection.

Request Parameters

Allows you to define whether it's required to request the values of a report's parameters when
generating the report.

Printing

Report Print Options

Specifies options that define how a report is printed in various circumstances.

- BlankDetailCount

Specifies how many times the empty Detail band is repeated before printing the regular data.

- Detail Count

Specifies how many times the Detail band should be printed when a datasource is defined for the report,
and it is not empty.

- Detail Count at Design Time

Specifies how many times the Detail band is printed when a report is being previewed at design time.

- Detail Count when Data Source is Empty

Specifies how many times the Detail band should be printed when no datasource is defined for the report.

- Print when Data Source is Empty

Specifies whether or not a report should be printed if its datasource is empty.

Show Print Margin Warnings

Specifies whether an error message is shown when the page margins are set outside the printable area.

Show Print Status Dialog

Specifies whether a print status dialog is shown when a document is being printed.



Report Designer 527

© 2014 DevExpress Inc. 527

Structure

Bands

Allows you to invoke the Report Editor, intended to manage and customize a report's bands.
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Report Wizard

The Report Wizard is a tool that allows you to easily create reports based on built-in templates. Using this tool,
you can do the following.

Create a new report from scratch
In the main menu, select File | New via Wizard... or press CTRL+W.

Edit an existing report
Click the report's Smart Tag and in the invoked actions list, click the Design in Report Wizard... context
link.

Note

In this case, data binding steps are omitted, since a report already has a bound data source. Note that
the initial report layout will be lost after completing the wizard.

The Report Wizard provides three different ways to setup your report.

Empty Report
This option allows you to create a report that is not bound to data and does not contain any report
controls.

Data-bound Report Wizard
Using this wizard, you can easily create a banded report displaying data in a tabular format. While setting
up your report, you'll be able to group data, add totals to your report, apply one of the predefined report
styles, etc.

Label Report Wizard
This wizard is useful if you need to print out labels. In this case, you're likely to purchase label paper that
meets your particular requirements. Depending on paper supplier and label type, your report will need to
generate labels with a specific size and location within paper sheets.

With the Label Report Wizard, you won't have to adjust these settings manually, since we provide a wide
choice of paper suppliers and their products. Simply choose your paper type, and the report is adjusted
automatically. After completing the wizard, you get an empty report that clearly indicates label
boundaries, and of course, properly positions labels within paper sheets.
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Data-bound Report Wizard

The Report Wizard allows you to create reports of three kinds - empty reports, data-bound reports and label
reports. To create a data-bound report, invoke the Report Wizard dialog and select the Data-bound Report option
on the first wizard page.

After completing the Data-bound Report wizard, you will get a tabular banded report. Depending on how many
wizard steps you complete (you don't necessarily have to go through all the pages), you can apply data grouping,
display totals, select one of the predefined style sheets, etc.

The following image shows a sample report created using the Data-bound Report Wizard.
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Use the links below to learn more about every step of the Data-bound Report wizard.

Note

Depending on the method you used to invoke the Wizard, you may be creating an entirely new report or
modifying an existing one. Creating reports from scratch requires database connection knowledge. In these
cases, it's better if you contact your application administrator or vendor for assistance with the first three steps of
the wizard. If you're modifying an existing report, these initial data binding steps will not appear and you will start
with Choose Columns to Display in Your Report.

Select the Data Source Type

Connect to a Database

Select a Data Connection

Specify a Connection String

Save the Connection String

Customize the Query

Connect to an Entity Framework Data Source

Select the Data Context

Select the Connection String

Bind to a Stored Procedure

Choose Columns to Display in Your Report

Add Grouping Levels

Summary Options

Choose Report Layout

Choose Report Style

Enter a Report Title
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Connect to a Database

The topics in this section describe the steps required to connect a report to a database using the Report Wizard.

This task includes the following steps.

Select a Data Connection

Specify a Connection String

Save the Connection String

Customize the Query
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Select a Data Connection

Note

This wizard step appears only if you're creating a new report from scratch. In this instance, familiarity with
database connections is required, so we recommend that you contact your application administrator or vendor for
assistance. If you're modifying an existing report, you will skip this step and start with the Choose Columns to
Display in Your Report wizard page.

Purpose

Connect to a database whose data will be shown in your report.

Page Interface

On this page you can either select one of the currently available data connections from the list, or create a new
one.

Click Next to proceed to the next wizard page, depending on the selected option.

Specify a Connection String

Customize the Query
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Specify a Connection String

Note

This wizard step appears only if you're creating a new report from scratch. In this instance, familiarity with
database connections is required, so we recommend that you contact your application administrator or vendor for
assistance. If you're modifying an existing report, this step will not appear and you will start with the Choose
Columns to Display in Your Report wizard page.

Purpose

On this page, define a custom connection string or select one of the supported data source types.

The following data source types are supported.

Microsoft SQL Server

Microsoft Access 97

Microsoft Access 2007

Oracle server

XML file

SAP Sybase Advantage

SAP Sybase ASE

IBM DB2

Firebird

MySQL

Pervasive PSQL

PostgreSQL

VistaDB

Microsoft SQL Server CE

SQLite

Page Interface

Select the provider type in the Provider drop-down list. Next, specify the connection options required for the
selected provider type (e.g., authentication type and database name).
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Click Next to proceed to the next wizard page, depending on whether or not the created connection uses server
authentication.

Save the Connection String - if server authentication is required, this page allows you to specify whether
or not you want to save the user credentials along with the connection string.

Customize the Query - if server authentication is not required, the page above does not appear, and you
will proceed to constructing the query.
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Save the Connection String

Note

This wizard step appears only if you're creating a new report from scratch. In this instance, familiarity with
database connections is required, so we recommend that you contact your application administrator or vendor for
assistance. If you're modifying an existing report, this step will not appear and you will start with the Choose
Columns to Display in Your Report wizard page.

Purpose

On this page, you can specify whether or not to save the user credentials along with the connection string.

Page Interface

Select the required option in the list.

Click Next to proceed to the next wizard page: Customize the Query.
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Customize the Query

Note

This wizard step appears only if you're creating a new report from scratch. In this instance, familiarity with
database connections is required, so we recommend that you contact your application administrator or vendor for
assistance. If you're modifying an existing report, this step will not appear and you will start with the Choose
Columns to Display in Your Report wizard page.

Purpose

On this page, you can construct an SQL query to obtain data from the database, or select a stored procedure.

Query

Stored Procedure

Query

To construct an SQL query, do the following.

1.Click the Run Query Designer... button.

2.In the invoked Query Designer window, select an item from the list of available tables on the left and
drop it onto the list of data tables to be used.
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It is only possible to select a single table using the Query Designer. When creating a master-detail
report, add the master table first.

3.Enable the check box near the added table to include all of its fields in the data view.

To assign a custom name to a data field, specify its Alias in the field list displayed below.

To manually customize an SQL string, enable the Allow SQL Editing option. Switching to this mode
disables the visual features of the Query Designer allowing you to directly edit the text of the SQL
query.

Click OK to exit the Query Designer

Click Next to proceed to the next wizard page: Choose Columns to Display in Your Report.

Stored Procedure

To use a stored procedure, do the following.

1.Select a stored procedure from the list of the available stored procedures and click Next.
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2.Configure the parameters to be passed to the selected stored procedure. Make sure that the value of
the passed parameter's Type property corresponds to the actual type the stored procedure parameter.

Click Next to proceed to the next wizard page: Choose Columns to Display in Your Report.
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Connect to an Entity Framework Data Source

The topics in this section describe the steps required to connect a report to an Entity Framework data source
using the Report Wizard.

This task includes the following steps.

Select the Data Context

Select the Connection String

Bind to a Stored Procedure
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Select the Data Context

Note

This wizard step appears only if you're creating a new report from scratch. In this instance, familiarity with
database connections is required, so we recommend that you contact your application administrator or vendor for
assistance. If you're modifying an existing report, this step will not appear and you will start with Choose
Columns to Display in Your Report wizard page.

Purpose

Connect to an Entity Framework data context that will provide data to your report.

Page Interface

On this page, select the required data context from the list of available data contexts.

Click Next to proceed to the next wizard page: Select the Connection String.
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Select the Connection String

Note

This wizard step appears only if you're creating a new report from scratch. In this instance, familiarity with
database connections is required, so we recommend that you contact your application administrator or vendor for
assistance. If you're modifying an existing report, this step will not appear and you will start with the Choose
Columns to Display in Your Report wizard page.

Purpose

Select a connection string to be used to establish a data connection.

Page Interface

Select the required connection string from the drop-down list.

Click Next to proceed to the next wizard page: Bind to a Stored Procedure.
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Bind to a Stored Procedure

Note

This wizard step appears only if you're creating a new report from scratch. In this instance, familiarity with
database connections is required, so we recommend that you contact your application administrator or vendor for
assistance. If you're modifying an existing report, this step will not appear and you will start with the Choose
Columns to Display in Your Report wizard page.

Purpose

Bind to a stored procedure provided by an Entity Framework data context.

Page Interface

To bind to a stored procedure, do the following.

1.Select a stored procedure in the list and click Next.

2.Configure the parameters to be passed to the selected stored procedure. Make sure that the value of
the passed parameter's Type property corresponds to the actual type the stored procedure parameter.
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Click Next to proceed to the next wizard page: Choose Columns to Display in Your Report.
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Select the Data Source Type

Note

This wizard step appears only if you're creating a new report from scratch. In this instance, familiarity with
database connections is required, so we recommend that you contact your application administrator or vendor for
assistance. If you're modifying an existing report, this step will not appear and you will start with Choose
Columns to Display in Your Report.

The first page allows you to select the required data source type.

Click Next to proceed to the next wizard page, depending on the selected data source type.

Connect to a Database

Connect to an Entity Framework Data Source
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Choose Columns to Display in Your Report

Purpose

Choose fields (attributes) whose data will be displayed in your report. The selected fields and corresponding
captions will be automatically added to your report, arranged one under another.

Page Interface

The list on the left-hand side shows all available fields (attributes). To select the required fields, double-click them
or drag them to the list box on the right-hand side. Another way to select fields is to use arrow buttons to move
them back and forth.

Note

To continue or finish report creation, you must select at least one field.

Result

You can stop the wizard at this step by clicking Finish. In this case, your report will look similar to the image
below.



Report Designer 546

© 2014 DevExpress Inc. 546

If you want to customize your report further, click Next to proceed to the next wizard page: Add Grouping Levels.
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Add Grouping Levels

Purpose

This page allows you to group data in your report. For instance, if you are displaying car sales information, you
may want to keep records corresponding to the same model together. Each set of records with the same model
will become a "group" with its own header.

Nested grouping and grouping against multiple fields are fully supported. The following image illustrates all basic
grouping types.

Note

If you don't need to group your data, simply click Next on this page to skip this step.

Page Interface

The list on the left-hand side displays data fields that can be used to group data. To apply grouping, do one of the
following.

Select columns and click the right arrow (>) button.

Double-click columns.

Note that grouping fields on the right-hand side can be selected by clicking them. This is useful if you need to
remove them or change their order. To accomplish the latter, use the up arrow ( ) and down arrow ( ) buttons.
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Result

You can stop the wizard on this step by clicking Finish. In this case, your report will look similar to the image
below.
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If you want to customize your report further, click Next. If data grouping has been applied on this page, you'll
proceed to Summary Options page. If you haven't grouped your data, you'll skip the Summaries step and go to
Choose Report Layout page.
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Summary Options

Note

This wizard step is only available if you've applied data grouping in the previous step (Add Grouping Levels). If
you haven't grouped data, this step is skipped.

Purpose

Use this page to specify totals to be displayed for each data group and grand totals for the entire report. For
instance, you may need to display the sum of values in a particular field, the average value, etc. Specified totals
will be displayed after corresponding groups, and in the report footer.

Page Interface

This page displays all available numerical and date-time fields that aren't used to group data. Using the check box
table, you can specify which functions should be calculated for these fields.

Sometimes, data fields can contain empty values (this is different from, say, zero in a numeric field). If you don't
want to take these values into account when calculating totals, check Ignore NULL values. Otherwise, these
values will be treated as zeros for numeric fields and the earliest system date for date-time fields.

Result

You can stop the wizard on this step by clicking Finish. In this case, your report will look similar to the image
below.
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If you want to customize your report further, click Next to proceed to the next wizard page: Choose Report
Layout.
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Choose Report Layout

Purpose

This page sets the layout of elements in your report. If you haven't applied data grouping, you can specify how
data field values are arranged - into a table, one under another, etc. If report data is grouped, you can choose
one of the available indentation styles for nested elements.

Additionally, this page allows you to specify the page orientation for your report.

Page Interface

The following options are available if data grouping has been applied.

If data hasn't been grouped, you will see the following report layout options.

If you want to customize your report further, click Next to proceed to the next page: Choose Report Style.
Otherwise, click Finish to complete report customization.
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Choose Report Style

Purpose

Apply a predefined style sheet to your report.

Page Interface

Select one of the predefined styles from the list box.

If you want to customize your report further, click Next to proceed to the next page: Enter a Report Title.
Otherwise, click Finish to complete report customization.
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Enter a Report Title

Purpose

Specifies the report title.

Page Interface

Enter a title string into the editor and click Finish to complete report creation.
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Label Report Wizard

The Report Wizard allows you to create reports of three kinds - empty reports, databound reports and label
reports. To create a label report, invoke the Report Wizard dialog and choose the Label Report option on the
Welcome page.

After completing the Label Report wizard, you will get a blank report that generates labels of a particular size.
Since the report designer will clearly indicate the label area, you can then populate this area with the required
content and print out your labels.

Use the links below, to learn more about every step in the Label Report wizard.

Select a Label Type

Customize Label Options
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Select a Label Type

Purpose

When you need to print out stickers or, say, water-proof labels, you need to purchase the appropriate paper.
Every supplier will provide it's own specific label size or label position within a paper sheet. To make it easier for
you to produce labels, this wizard step lists several label paper suppliers and their products. Once you've selected
a supplier and a product (paper and label type), the report will change its settings so that your labels will be
printed exactly where they're supposed to, without you having to adjust the label position and size manually.

Page Interface

On this page, choose the supplier from the Label Products combo box and a particular product from the Product
Number list. The box on the left-hand side will be updated to show you label dimensions for the currently selected
product.

If you don't need further customization, click Finish to complete the report adjustment. If manual correction of
label or paper size is required, click Next.
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Customize Label Options

Purpose

On this page, you can manually adjust settings that were automatically specified in the previous step, based on
your supplier and product choice.

Page Interface

Editors on this page allow free customization of all parameters specified on the previous page. The pane on the
left-hand side provides a label dimensions preview based on current values.

Click Finish to complete report setup.
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Preview, Print and Export Reports

Preview and Print a Report

To switch a report to the print preview mode, click the Preview Tab. You will see your report populated with data
and broken down into pages, as specified. When in the Print Preview mode, you can print out your report using
the appropriate menu and toolbar commands.

Note

To learn more about the options available in the print preview mode, refer to the Print Preview section of this
documentation.

Export a Report

In the Preview Tab, you can export your report to files in different formats. The resulting files can either be saved
to the hard drive or sent by e-mail.

The following documents describe the basics of report exporting and format-specific export options.

Exporting from Print Preview

PDF-Specific Export Options

HTML-Specific Export Options

MHT-Specific Export Options

RTF-Specific Export Options

XLS-Specific Export Options

XLSX-Specific Export Options

CSV-Specific Export Options

TXT-Specific Export Options

Image-Specific Export Options
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Ribbon

The Ribbon organizes commands into a tabbed interface, providing quick and intuitive access to these commands.

 

Topics in this section:

Frequently Used Ribbon Commands

Minimize Ribbon

Invoke Ribbon Commands
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Frequently Used Ribbon Commands

Frequently used commands are typically displayed within the Quick Access Toolbar, at the top of the Ribbon:

To add any command to the Quick Access Toolbar, right-click the command and select Add to Quick Access
Toolbar:

To add a group of commands to the Quick Access Toolbar, right-click the group's caption and select Add to Quick
Access Toolbar:

To remove any command from the Quick Access Toolbar, right-click the command and select Remove from Quick
Access Toolbar:
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Minimize Ribbon

To minimize the Ribbon, right-click any command and select Minimize the Ribbon:

To restore the Ribbon, right-click any command or page and uncheck the Minimize the Ribbon option:

You can also minimize and restore the Ribbon by double-clicking any tab page header.
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Invoke Ribbon Commands

To select a specific command, you can click it with the mouse or invoke it via its shortcut. See below for more
information.

Shortcuts are associated with each page and command in the Ribbon. To see the shortcuts, press ALT or F10.
Shortcuts will appear next to the corresponding tab pages and commands:

Shortcuts can be composed of one, two or three symbols. If a shortcut is represented by one symbol, you can
invoke the command by pressing this symbol. If a shortcut is represented by two or three symbols, to invoke the
command, press the symbols one after another.

Initially, when pressing ALT or F10, shortcuts are displayed for commands within the Quick Access Toolbar (at the
top of the Ribbon) and for tab pages. To access shortcuts for commands within a specific tab page, you need to
press the shortcut associated with this page.

For example, to display shortcuts for commands within the Home page (see the image above), press H:
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Rich Text Editor

This section describes the capabilities provided by the Rich Text Editor.

 

Text Editor UI

Editor Elements

Toolbars

Ribbon Interface

 

File Operations

Create a New Document

Load a Document

Save a Document

Print a Document
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Document Layout and Page Setup

Divide a Documents into Sections

Adjust Page Settings

Lay Out Text in Columns

Add Line Numbers

Change Page Background Color

 

Viewing and Navigating

Navigate through a Document

Switch Document Views

Zoom a Document

 

Text Editing

Select Text

Delete Text

Find and Replace Text

Use a Clipboard

Check Text Spelling

Undo and Redo Last Operations

 

Formatting

Format Text

Format Paragraphs

Apply and Modify Styles

 

Pictures and Text Boxes

Insert a Picture

Insert, Select, Copy or Delete a Text Box

Add, Change or Delete a Border for a Picture or Text Box

Add, Change or Delete a Text Box Fill

Rotate a Picture or Text Box

Move a Picture or Text Box

Wrap Text around a Picture or Text Box

Resize a Picture or Text Box

 

Lists

Numbered Lists

Bulleted Lists

Multilevel Lists

 

Tables

Insert a Table

Add and Remove Table Borders
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Customize a Style of Cell Borders

Select a Cell, Row or Column

Insert a Cell, Row or Column

Delete a Cell, Row or Column

Merge or Split Cells

Align Text in Table Cells

Set Background Color of Cells

 

Header and Footer

Header and Footer

 

Embedding Fields (Mail Merge)

Mail Merge

 

Table of Contents

Create a Table of Contents

Create Table of Contents for Special Cases

Update Table of Contents

 

Document Protection

Protect and Unprotect a Document

Edit a Protected Document

 

Miscellaneous

Insert a Bookmark

Insert a Hyperlink

Insert a Page Break

Insert Page Numbers

Insert a Symbol
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Text Editor UI

Editor Elements

The Rich Text Editor consists of visual elements that provide you with the capability to edit and view documents.

Main Elements

The main area of the Rich Text Editor control is the Text Editing Surface that displays a document to be edited.
Here, a document can look as it will appear when you print it (Print Layout View) or with reduced formatting and
pagination (Simple View or Draft View). For more information, see Switch Document Views.

To the top and to the left of the Text Editing Surface, the Rich Text Editor displays horizontal and vertical rulers,
which you can use to align text, graphics, and other elements in a document.

The horizontal ruler controls the width of table columns and the horizontal spacing of paragraph margins,
columns and tabs.

The vertical ruler allows you to set the top and bottom margins of a document, and change the height of table
rows.
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Note

If the ruler is hidden, switch the current view to either the Draft View or Print Layout View.

At the bottom and at the right of the Text Editing Surface there are horizontal and vertical scrollbars, which
allow you to navigate through a document.

Context Menu

The Rich Text Editor supports the Context Menu that appears when you right-click within the Text Editing
Surface. The context menu provides common commands and displays suggested corrections if you right-click a
misspelled word.
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Toolbars

The Rich Text control can be accompanied by a set of toolbars that provide a comprehensive functionality for the
Rich Editor.
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Ribbon Interface

The comprehensive functionality for the Rich Text control can be provided via a set of Ribbon tabbed pages.
Ribbon pages are structurally and visually split into logical groups. Each of these groups includes commands that
have some common features.

Ribbon Tab Name Visual Appearance

File

Home

Insert

Page Layout

References

Mailings

Review
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View

Header & Footer Tools / Design

Table Tools / Design

Table Tools / Layout

Picture Tools / Format
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File Operations

Create a New Document

To create a new empty document, use the New button of the Common toolbar or the CTRL+N keyboard shortcut.
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Load a Document

To load a document, click the Open  button on the Common toolbar or use the CTRL+O keyboard shortcut.

The Open dialog appears, allowing you to select a file.

The Rich Editor enables you to open documents of the following types:

Rich Text Format (*.rtf)

Text Files format (*.txt)

Hyper Text Markup Language format (*.htm, *.html)

web page archive format (*.mht)

Microsoft Word 97-2003 format (*.doc)

WordML (*.xml)

Open Office XML format (aka Office 2007 or *.docx)

Open Document Format (*.odt)

Electronic Publication (*.epub)
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Save a Document

To save a document, click the Save  button on the Common toolbar or use the CTRL+S keyboard shortcut. This
allows you to save a document using the save parameters that were previously set.

If you want to save a document using another file name or to modify other parameters (e.g. file format or

location), click the Save As  button on the Common toolbar or press the F12 key.

After that, the Save As dialog will appear. Note that the same dialog appears if you click the Save  button to
save a document, which has been never saved before.

In this dialog you can specify document name, document format and the location to which the document should be
saved. The Rich Edit control allows you to save documents in the following formats:

Rich Text Format (*.rtf)

Text Files format (*.txt)

Hyper Text Markup Language format (*.htm, *.html)

web page archive format (*.mht)

Microsoft Word 97-2003 format (*.doc)

WordML (*.xml)

Open Office XML format (aka Office 2007 or *.docx)
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Open Document Format (*.odt)

Electronic Publication (*.epub)

Note

When saving a document in HTML format, in-line pictures are saved in the %FileName%_files folder, where %
FileName% is the name of the document file. Image files are named "imageN.png", where N is the picture index
starting from the beginning of the document.
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Print a Document

Preview a Document Before Printing

To display the document as it will look when printed, click the Print Preview button on the Common toolbar.

Print a Document

1.Click the Print button on the Common toolbar...

...or press CTRL+P.

The Print dialog will be invoked.

2.In the Print dialog, specify all required settings and click Print.
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Print a Document Using Default Settings

To send a document directly to the default printer without customizing print settings, click the Quick Print button
on the Common toolbar.
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Document Layout and Page Setup

Divide a Documents into Sections

You can divide your document into sections to specify parts of a document that have different page settings (page
margins, page orientation, paper size), column layouts, line numbering and headers and footers.

Insert Section Breaks

To divide a document into sections, insert section breaks.

1.Click where you want to inset a section break within a document.

2.Click the Breaks button on the Page Setup toolbar and select the required type of the section break.

To show the section break mark, press CTRL+SHIFT+8 or click the Show/Hide button on the Paragraph toolbar.

In a document, section breaks are marked as illustrated below.

Types of Section Breaks

Next Page inserts a section break and starts a new section on the next page.

Even Page inserts a section break and starts a new section on the next even-numbered page.

Odd Page inserts a section break and starts a new section on the next odd-numbered page.

Change Section Break Type
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You can change the type of the section break that has been inserted to start a section. To do this, follow the
instructions below.

1.Click the section following the section break that you wish to change.

2.Invoke the Page Setup dialog and change the Section start property on the Layout tab as required.
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Adjust Page Settings

When changing page layout settings (such as page margins, page orientation, paper size), you can apply them to
the whole document or set specific page layout settings for each individual section if your document is divided into
sections.

Change Page Margins

1.Click within a section whose page margins you wish to set.

2.Click the Margins button on the Page Setup toolbar and select the margin sizes to be set for the
current section from the invoked list...

... or specify page margins for the current section or the whole document via the Page Setup dialog.
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Change Page Orientation

1.Click within a section for which you wish to specify page orientation.

2.Click the Orientation button on the Page Setup toolbar and select Portrait or Landscape from the
invoked list...

... or set the page orientation for the current section or the whole document on the Margins tab of the
Page Setup dialog.

Change Paper Size

1.Click within a section for which you wish to set the paper size.

2.Click the Size button on the Page Setup toolbar and select one of the standard paper sizes from the
invoked list...

... or specify the paper size for the current section or the entire document on the Paper tab of the Page
Setup dialog.
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Lay Out Text in Columns

To split a text into columns, follow the steps below.

1.Click within a section which you wish to lay out in several columns.

2.Click the Columns button on the Page Setup toolbar and select the number of columns into which the
text should be split...

... or click More Columns to invoke the Columns dialog where you can adjust columns layout of the text
in a more flexible way for the current section or the whole document.

To move the text to the next column (if the text in the current section is laid out into multiple columns), insert a
column break.

1.Click within a document where you wish to insert a column break.

2.Click the Breaks button on the Page Setup toolbar and select Column from the invoked list...
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... or press CTRL+SHIFT+ENTER.

To show the column break mark, press CTRL+SHIFT+8 or click the Show/Hide button on the Paragraph toolbar.

In a document, column breaks are marked as illustrated below.
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Add Line Numbers

1.To add line numbers to a whole document, select the entire document if your document is divided into
multiple sections. If your document consists of one section only, simply click anywhere within a
document.

- or -

To add line numbers to a particular section or multiple sections, click a section or select multiple
sections.

2.Click Line Numbers on the Page Setup toolbar and select one of the available line numbering types
from the invoked list...

...or click Line Numbering Options to invoke the Line Numbers dialog that you can use to adjust line
numbering options in a more flexible way (specify the value to be used for the first line - Start at,
increment value for line numbering - Count by, distance between line number and the start of the text
line - From text).
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Change Page Background Color

Click Page Color on the Page Background toolbar and select the required color for the background of the
document pages.
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Viewing and Navigating

Navigate through a Document

You can navigate through a document in the following ways:

Use the mouse device to click anywhere in the document;

Use the mouse device to drag the scroll box to move through the document;

Rotate the wheel button to scroll up and down the document;

Use keyboard shortcuts.

The following table lists the default keyboard shortcuts to navigate through a document.

Keyboard Shortcut Effect

LEFT ARROW Moves the cursor to the previous character.

RIGHT ARROW Moves the cursor to the next character.

UP ARROW Moves the cursor to the previous line.

DOWN ARROW Moves the cursor to the next line.

HOME Moves the cursor to the start of the current line.

END Moves the cursor to the end of line.

PAGE UP Moves the cursor backward by the number of lines in
the current control's window, minus one.

PAGE DOWN Moves the cursor forward by the number of lines in
the current control's window, minus one.

CTRL+LEFT ARROW Moves the cursor to the previous word.

CTRL+RIGHT ARROW Moves the cursor to the next word.

CTRL+UP ARROW Moves the cursor to the beginning of the previous
paragraph.

CTRL+DOWN ARROW Moves the cursor to the beginning of the next
paragraph.

CTRL+HOME Moves the cursor to the start of the document, and
scrolls the document to show the cursor position.

CTRL+END Moves the cursor to the end of the document, and
scrolls the document to show the cursor position.

CTRL+PAGE UP Moves the cursor to the beginning of the previous
page.

CTRL+PAGE DOWN Moves the cursor to the beginning of the next page.
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Switch Document Views

The Rich Edit control provides a number of document views that you can switch depending on what you want to
do.

Simple View

A simple view shows a document without a page layout. This view can be useful when you want to concentrate on
text editing.

To enable this view, click the Simple View button on the Document View toolbar.

Draft View

The draft view is a view without pagination. It does not display complex formatting features that are most
appropriate to the page layout. You can use it for the simplest representation of the document, as well as quick
text editing.

To enable this view, click the Draft View button on the Document View toolbar.
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In draft view the horizontal ruler is available. To show or hide it, click Horizontal Ruler on the Show toolbar.

Print Layout View

The print layout view is intended to display all formatting in the document, including complex formatting, and can
be used to preview the document printout.

To enable this view, click the Print Layout button on the Document View toolbar.
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When the print layout view is active, the horizontal and vertical rulers are available. To show or hide horizontal
and vertical rulers, click the Horizontal Ruler and Vertical Ruler buttons on the Show toolbar, respectively.
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Zoom a Document

You can zoom in and out of a document in the following ways:

Click the Zoom In and Zoom Out buttons on the Zoom toolbar.

 

Hold the CTRL button and rotate your mouse wheel.
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Text Editing

Select Text

To select text in the Rich Editor, use the following mouse actions and keyboard shortcuts.

Selecting one character

To select only one character, click before the character, hold down the Shift key and click the Right Arrow
once.

Selecting one word

To select one word in a document, place the cursor anywhere in the word (or just before it) and double-
click with the left mouse button. Another method is to place your cursor at the beginning of the word,
hold down the Shift and Ctrl keys, and click the Right Arrow.

Selecting one paragraph

Selecting one paragraph is similar to selecting one word. Place the cursor in the paragraph and click three
times with the left mouse button. Another method is to place the cursor in the left margin and click twice
to highlight the whole paragraph.

Selecting entire document

Click three times on the left side of the page in the margin area, and the entire document will be
highlighted. Also, the CTRL+A keyboard shortcut can be used to highlight the entire document.

Selecting one line

The cursor in the margin will highlight one line with one click. Another method is to place the cursor at the
beginning of the line, and use the SHIFT+END keyboard shortcut to extend selection to the end of the
line. Similarly, at the end of the line the SHIFT+HOME keyboard shortcut can be used.

The following table lists the default keyboard shortcuts used for selecting text in the Rich Editor.

SHIFT+LEFT ARROW Extends the selection to the previous character.

SHIFT+RIGHT ARROW Extends the selection to the next character.

SHIFT+UP ARROW Extends the selection to the previous line.

SHIFT+DOWN ARROW Extends the selection one line down.

SHIFT+HOME Extends the selection to the beginning of the line.

SHIFT+END Extends the selection to the end of the current line.

SHIFT+PAGE UP Extends selection to the previous screen.

SHIFT+PAGE DOWN Extends the selection to the next screen.

CTRL+SHIFT+LEFT ARROW Extends the selection to the previous word.

CTRL+SHIFT+RIGHT ARROW Extends the selection to the next word.

CTRL+SHIFT+UP ARROW Extends the selection to the previous paragraph.

CTRL+SHIFT+DOWN ARROW Extends the selection to the next paragraph.

CTRL+SHIFT+HOME Extends the selection to the beginning of the
document.

CTRL+SHIFT+END Extends the selection to the end of the document.

CTRL+SHIFT+PAGE UP Extends the selection to the previous page.

CTRL+SHIFT+PAGE DOWN Extends the selection to the next page.
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CTRL+A Selects the entire document.

CTRL+NUM 5 Selects the entire document.



Rich Text Editor 600

© 2014 DevExpress Inc. 600

Delete Text

The Backspace key deletes one character to the left of the caret. The Delete key deletes one character to the
right of the caret.

To delete more than just a few characters, select text and press the Delete key.

The following table lists the default keyboard shortcuts used for deleting text.

BACKSPACE Moves the cursor backwards and erases the character
in that space.

CTRL+BACKSPACE Deletes the previous word in the text.

DELETE Deletes the selected text.

CTRL+DELETE Deletes the next word in the text.

SHIFT+DELETE Cuts the selected text and places it on the clipboard.

CTRL+X Cuts the selected text and places it on the clipboard.
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Find and Replace Text

Find Text

To search for every occurrence of a specific word or phrase:

1.Click the Find button on the Editing toolbar...

... or press CTRL+F.

The Find and Replace dialog will be invoked.

2.In the Find what box, type the text to search for.

3.Select other search options that you want and click Find Next.

4.To cancel a search, click Cancel or press ESC.

Find and Replace Text

To automatically replace text:

1.Click the Replace button on the Editing toolbar...

... or press CTRL+H.

The Find and Replace dialog will be invoked.
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2.In the Find what box, type the text to replace.

3.In the Replace with box, type the replacement text.

4.Select other search options that you want and click Find Next, Replace or Replace All.

Use Regular Expressions to Find and Replace Text

You can use regular expressions to search for specific text containing a particular pattern:

1.Click Find or Replace on the Editing toolbar...

 

... or press CTRL+F or CTRL+H.

The Find and Replace dialog will be invoked.

2.Select the Regular expression check box.

3.In the Find what box, enter the regular expression pattern using a list of specific characters:
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4.If you want to replace the found text, click the Replace tab and enter the replacement text in the
Replace with box.

Note

You can tag various parts of a regular expression to use them in replacement expression (for example,
to rearrange the parts of the expression). A regular expression may have up to 9 tagged expressions,
numbered according to their order in the regular expression. To enter a tagged expression in the 
Replace with box, enter its index after the symbol $ or select it from the list of tagged expressions:

5.Click Find Next, Replace or Replace All.
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Use a Clipboard

The Rich Text Editor allows you to move and copy text and images using the Clipboard.

To move or copy a text or image, follow the steps below.

1.Select the text or image you wish to move or copy.

2.Depending on what you want, do one of the following.

To move the selection, click the Cut  button on the Clipboard toolbar, or press CTRL+X, or press
SHIFT+DELETE. This cuts the selection from the document and places it on the Clipboard.

To copy the selection, click the Copy  button on the Clipboard toolbar, or press CTRL+C, or press
CTRL+INSERT. This copies the selection and places it on the Clipboard.

3.Point to the position where you want to insert the contents from the Clipboard.

4.Click the Paste  button on the Clipboard toolbar, or press CTRL+V, or press SHIFT+INSERT. This
pastes the contents of the Clipboard into the document.

You can also choose the format for data contained in the Clipboard and paste it into the document as if

that data is imported from the specified format. To do this, click the Paste Special  button on the
Clipboard toolbar, or press CTRL+ALT+V, ...

... and select the required data format from the invoked Paste Special dialog.
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Check Text Spelling

The Rich Text Editor supports spell-check. All misspelled words in your document (words that are not found within
the available dictionaries in the Spell Checker) are underlined. You can work with misspelled words via the
context menu, invoked when right-clicking the underlined word.

In the context menu, you can do one of the following:

Select one of the suggested corrections for the misspelled word to correct it;

Ignore the current occurrence of the word;

Ignore all occurrences of the word;

Add the word to the dictionary in the Spell Checker.

To perform spell check word-by-word, select the Check Spelling item from the context menu, or click the Spelling
button on the Proofing toolbar...

... or press F7.
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The Spelling dialog will be invoked.

In this dialog, select what to do with the misspelled word, click corresponding button, and you will jump to the
next misspelled word.
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Undo and Redo Last Operations

The Rich Editor allows you to undo and redo the last operation using special buttons (Undo and Redo) in the
Common toolbar.

The Undo command reverses the most recent action you have performed. To undo an action, click the Undo
button on the Common toolbar, or press CTRL+Z, or press ALT+BACKSPACE.

You can execute multiple Undo operations. To return the document to its previous state, just keep performing
Undo.

The Redo command enables you to take back the last action you've undone. To redo an action, click the Redo
button, or press CTRL+Y, or press ALT+SHIFT+BACKSPACE.
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Formatting

Format Text

To format text, first select it and then use the Font toolbar to change the font family, size, color, etc.

Also, you can modify the font using the Font dialog. Select the text that you want to format, right-click it and
choose the Font item from the context menu.

The Font dialog appears as illustrated below.
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In this dialog, you can specify all required font parameters, and apply them to the selected text.

In addition, the Rich Editor provides a list of default keyboard shortcuts for text formatting:

CTRL+B Toggles the bold style on the selection.

CTRL+I Toggles the italic style on the selection.

CTRL+U Toggles the underline style on the selection.

CTRL+D Invokes the Font dialog that allows you to change the
font, size and style of the selected text.

CTRL+PLUS Toggles the subscript style on the selection.

CTRL+CLOSEBRACKETS (]) Increases the font size of the selected text by one
point.

CTRL+OPENBRACKETS ([) Decreases the font size of the selection by one point.

CTRL+SHIFT+PERIOD Increases the font size of the selection to the closest
larger predefined value.

CTRL+SHIFT+COMMA Decreases the font size of the selection to the closest
smaller predefined value.

CTRL+SHIFT+D Toggles the double underline style on the selection.

CTRL+SHIFT+PLUS Toggles the superscript style on the selection.

CTRL+SHIFT+H Toggles between the normal and hidden text mode
for the selection. To view the hidden text, press
CTRL+SHIFT+8.

CTRL+SPACE Clears formatting of selected text - resets it to
default.

See Also
Apply and Modify Styles
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Format Paragraphs

To format a paragraph, first click anywhere within it or select the paragraph, and then use the Paragraph toolbar
to change line spacing, indentation, alignment and styles.

Also, you can use the Paragraph dialog to format the paragraph. To invoke this dialog, right-click the paragraph
and select the Paragraph item from the context menu.

The Paragraph dialog appears, as illustrated below.
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In this dialog, you can change different parameters for the paragraph (Indents and Spacing tab) and pagination
(Line and Page Breaks tab).

The Rich Editor provides a list of the default keyboard shortcuts to format paragraphs.

CTRL+1 Formats a current paragraph with single line spacing.

CTRL+2 Formats a current paragraph with double line spacing.

CTRL+5 Formats a current paragraph with one and a half line
spacing.

CTRL+E Toggles centered paragraph alignment on and off.

CTRL+J Toggles justified paragraph alignment on and off.

CTRL+L Toggles left paragraph alignment on and off.

CTRL+R Toggles right paragraph alignment on and off.

See Also
Apply and Modify Styles
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Apply and Modify Styles

To format a text or a paragraph you can apply styles. A style is a group of formatting characteristics. All these
characteristics are applied to a text or a paragraph at once when you apply a style. Thus, styles allow you to
change text and paragraph appearance quicker than setting all formatting characteristics separately (Format Text,
Format Paragraphs).

A character based style includes characteristics to format text within a paragraph (e.g., font type and size, bold
and italic formats, etc.)

A paragraph based style affects paragraph formatting characteristics such as text alignment, line spacing, etc. It
can also include character formatting characteristics.

Apply a Style

To apply a style, do the following.

1.Select text or a paragraph that you want to format.

2.Click or type a required style name in the Quick Styles box on the Styles toolbar.

Modify a Style

You can modify an existing style via the Modify Style dialog.

To invoke the dialog, do the following:

1.Click the Modify Style button on the Styles toolbar:

2.The Modify Style dialog enables you to change the base style for the current style (to specify how the
styles cascade), the style which should be used for the following paragraph, and basic characteristics of
the style, such as Font, Paragraph and Tab Stops.
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Pictures and Text Boxes

Insert, Select, Copy or Delete a Text Box

Insert a Text Box

To insert a text box into your document, position the caret to the desired location and click the Text Box button
on the Text toolbar.

A floating text box enables you to specify fill color, outline width and color and apply formatting to the box content.

Select a Text Box

To select a text box, click a border of the text box.

Note

If the caret is placed inside the text box, you can modify the text box content, but it is impossible to move, copy,
delete the text box or specify such attributes as fill color, outline color and weight, text wrapping, position, etc. In
this case, the text box is not considered as selected, the Shape Styles and Arrange toolbars and corresponding
items of the text box's context menu are unavailable.
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Copy a Text Box

1.Select a text box to be copied.

2.Click Copy  on the Clipboard toolbar or context menu, or press CTRL+C, or press CTRL+INSERT.

3.Position the caret to the location where you want to insert the copy of the selected text box.

4.Click Paste  on the Clipboard toolbar or context menu, or press CTRL+V, or press SHIFT+INSERT.

Delete a Text Box

1.Select a text box that you wish to remove.

2.Press DELETE.
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Insert a Picture

You can insert either inline or floating graphics in the document. Currently it is not possible to convert inline to
floating and vice versa, so you have to choose beforehand how to anchor your picture.

The Rich Text Editor enables you to insert graphics of the following types:

Bitmap (*.bmp, *.dib)

JPEG File Interchange Format (*.jpg, *.jpeg)

Portable Network Graphics (*.png)

Graphics Interchange Format (*.gif)

Tagged Image Format (*.tif, *.tiff)

Microsoft Enhanced Metafile (*.emf)

Windows Metafile (*.wmf)

Inline Picture

To insert inline picture into your document, position the caret to the desired location and click the Inline Picture
button on the Illustrations toolbar.

The Open dialog appears, allowing you to locate a file with graphics.
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Floating Picture

To insert floating picture into your document, position the caret in the paragraph to which the picture should be
anchored, and click the Picture button on the Illustrations toolbar.

The Open dialog appears, allowing you to locate a file with graphics.

The inserted floating picture is centered horizontally and has an In Front of Text wrapping style which you can
change later.



Rich Text Editor 619

© 2014 DevExpress Inc. 619



Rich Text Editor 620

© 2014 DevExpress Inc. 620

Add, Change or Delete a Border for a Picture or Text Box

You can specify the color and weight of the outside border of a floating picture or text box, or fully delete the
border.

Set the Color of a Picture or Text Box Border

1.Select the floating picture or text box whose outline border color you wish to specify.

2.Click Shape Outline on the Shape Styles toolbar and select the required color.

Note

By default, a floating picture is inserted with no border. To specify a colored outline border for a picture, a border
weight must be set.

Set the Weight of a Picture or Text Box Border

1.Select a floating picture or text box whose outline border weight you wish to specify.

2.Select the required border weight from the Shape Outline Weight list accessed on the Shape Styles
toolbar.

Remove a Picture or Text Box Border

1.Select a floating picture or text box whose outline border you wish to remove.

2.Click Shape Outline on the Shape Styles toolbar and select No Outline.



Rich Text Editor 621

© 2014 DevExpress Inc. 621



Rich Text Editor 622

© 2014 DevExpress Inc. 622

Add, Change or Delete a Text Box Fill

Specify a Text Box Fill

1.Select a text box whose background you wish to color.

2.Click Shape Fill on the Shape Styles toolbar and select the required color.

Delete a Text Box Fill

1.Select a text box whose fill you wish to remove.

2.Click Shape Fill on the Shape Styles toolbar and select No Fill.
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Rotate a Picture or Text Box

1.Click the floating picture or text box that you wish to rotate.

2.Do one of the following.

Click the round arrow that appears over the selected floating picture or text box and drag it in the
direction to which you wish to rotate the object.

To rotate an object by 15 degree angles, drag the round arrow at the top of the object while holding
down the SHIFT key.

Right-click a picture or text box to be rotated and select the More Layout Options... item from the
context menu. Switch to the Size tab in the invoked Layout dialog and set the required value of the
angle to rotate the object in the Rotation box.
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Move a Picture or Text Box

Move a Picture or Text Box

1.Select the floating picture or text box that you wish to move.

2.Drag the object to the new location.

Move a Picture or Text Box Forward or Backward

When you add floating objects into a document, they are automatically inserted in particular layers. Objects can
overlap. In this case the top object covers lower objects (in full or in part). You can move particular objects up and
down in a stack one layer at a time, or move them to the top or bottom of a stack in one click.

1.Select the floating picture or text box that you wish to move up or down in the stack.

2.Select the required item from the floating object's context menu ...

... or Arrange toolbar.

To move the selected floating object one layer forward to the front, click Bring to Front -> Bring
Forward.

To move the selected floating object in front of the text layer and any other floating objects, Bring to
Front -> Bring to Front.

To move the selected floating object in front of the text layer, click Bring to Front -> Bring in Front of
Text.

To move the selected floating object one layer forward to the back, click Send to Back -> Send
Backward.
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To move the selected floating object behind the text or any other floating object, click Send to Back -
> Send to Back.

To move the selected floating object behind the text layer, click Send to Back -> Send Behind Text.
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Wrap Text around a Picture or Text Box

Position a Picture or Text Box within a Document

1.Select a floating picture or text box whose location you want to specify.

2.Specify an object location in one of the following ways.

Click Position on the Arrange toolbar and select the required position of the object from the invoked
list.

Right-click the object to be positioned and select the More Layout Options... item from the context
menu. On the Position tag of the invoked Layout dialog, specify the required position for the floating
object.
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Wrap Text around Picture or Text Box

1.Select a floating picture or a text box.

2.To specify a way text wraps around the selected object, do one of the following.

Click Wrap Text on the Arrange toolbar and select the required type of text wrapping around the
selected object from the invoked list.

Rght-click the selected floating object, and select the required type of the text wrapping from the 
Wrap Text sub-menu of the invoked context menu.

Right-click the selected floating object, and select the More Layout Options... item from the context
menu. Switch to the Text Wrapping tab of the invoked Layout dialog and specify the required text
wrapping settings for the floating object.
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Resize a Picture or Text Box

To resize a picture or text box, shrink or stretch an object in the following way.

1.Click a floating picture or text box to be resized.

2.Drag a s izing handle towards or away from the object center until a required size is reached.

To keep object proportions when resizing it, check the Lock aspect ratio option (it is accessed via the Layout
dialog that is invoked when selecting the More Layout Options... item from the context menu of the floating
object). In this case when you change a width of the object by dragging a corner s izing handle, the object's height
will be automatically changed to maintain exact proportions of the object and vice-versa.

To specify an exact height and width of the object, clear the Lock aspect ratio check box.
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Lists

Numbered Lists

Create a Numbered List as You Type

1.Point to the position within a document from which you want to begin your list.

2.Click the Numbering  button on the Paragraph toolbar.

3.Type the text.

4.Press ENTER to create the next item of the list.

5.To finish the list, press ENTER twice.

Make a Numbered List from the Selected Text

You can add numbers to existing lines of text in two ways. The first one is to use the Paragraph toolbar:

1.Select the text lines that you want to transform into a list.

2.Click the Numbering  button on the Paragraph toolbar.

Another way to do the same thing is to use the context menu:

1.Select the text to be transformed into a list.

2.Right-click within the document and select the Bullets and Numbering item from the appeared context
menu.
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3.In the invoked Bullets and Numbering dialog, click the Numbered tab and choose the list style that you
want to apply.

Create Your Own List Style

You can create your own style for a numbered list on the basis of one of the existing list styles, by changing
different list parameters.
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1.Select the numbered list (or text to be transformed into the numbered list) to which you want to apply
your own style.

2.Right-click within the document and select the Bullets and Numbering item from the resulting context
menu. The Bullets and Numbering dialog will be displayed.

3.Click the Numbered tab, choose one of the existing styles and click Customize.... The Customize
Numbered List dialog will be invoked.

Note

The Customize... button is disabled if the None item of the Bullets and Numbering dialog is selected.
This item is selected automatically, when you invoke the Bullets and Numbering dialog for lines of text
rather than for a list.

4.In this dialog, change different list parameters to create your own list style.

For instance, if you specify list parameters in the following way,...
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...you will get the list style as illustrated below.
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Bulleted Lists

Create a Bulleted List as You Type

1.Point to the position in a document from where you want to begin your list.

2.Click the Bullets  button on the Paragraph toolbar.

3.Type the text.

4.Press ENTER to create the next item of the list.

5.To finish the list, press ENTER twice.

Make a Bulleted List from the Selected Text

You can add bullets to existing lines of text in two ways. The first method is to use the Paragraph toolbar:

1.Select the text lines that you want to transform into a list.

2.Click the Bullets  button on the Paragraph toolbar.

Another way to do the same thing is to use the context menu:

1.Select the text to be transformed into a list.

2.Right-click within the document and select the Bullets and Numbering item from the invoked context
menu.

3.In the invoked Bullets and Numbering dialog, click the Bulleted tab and choose the list style that you
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want to apply.

Create Your Own List Style

You can create your own style for a bulleted list on the basis of one of the existing list styles, by changing various
list parameters.

1.Select the bulleted list (or text to be transformed into the bulleted list) to which you want to apply your
own style.

2.Right-click within the document and select the Bullets and Numbering item from the resulting context
menu. The Bullets and Numbering dialog will be displayed.
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3.Click the Bulleted tab, choose one of the existing styles and click Customize.... The Customize Bulleted
List dialog will be invoked.

Note

The Customize... button is disabled if the None item of the Bullets and Numbering dialog is selected.
This item is selected automatically when you invoke the Bullets and Numbering dialog for lines of text,
rather than for a list.

4.In this dialog, change different list parameters to create your own list style.

For instance, if you specify list parameters in the following way,...
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...you will get the list style as illustrated below.
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Multilevel Lists

Create a Multilevel List as You Type

1.Point to the position within a document from which you want to begin your list.

2.Click the Multilevel list  button on the Paragraph toolbar.

3.Type the text.

4.To change levels of the list, press TAB and SHIFT+TAB, or click the Increase Indent  and Decrease

Indent  buttons on the Paragraph toolbar. Press ENTER to create the next item on the current level.

5.To finish the list, press ENTER twice.

Make a Multilevel List from the Selected Text

You can make multilevel list from existing lines of text in two ways. The first one is to use the Paragraph toolbar:

1.Select the text lines that you want to transform into a list.

2.Click the Multilevel list  button on the Paragraph toolbar.

3.Use TAB and SHIFT+TAB, or the Increase Indent  and Decrease Indent  buttons of the
Paragraph toolbar to change levels.

Another way to do the same thing is to use the context menu:

1.Select the text to be transformed into a list.

2.Right-click within the document and select the Bullets and Numbering item from the invoked context
menu.
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3.In the invoked Bullets and Numbering dialog, click the Outline Numbered tab and choose the list style
that you want to apply.

4.Use TAB and SHIFT+TAB, or the Increase Indent  and Decrease Indent  buttons of the
Paragraph toolbar to change levels.

Create Your Own List Style

You can create your own style for a multilevel list on the basis of one of the existing list styles, by changing
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different list parameters.

1.Select the multilevel list (or text to be transformed into the multilevel list) to which you want to apply
your own style.

2.Right-click within the document and select the Bullets and Numbering item from the resulting context
menu. The Bullets and Numbering dialog will be displayed.

3.Click the Outline Numbered tab, choose one of the existing styles and click Customize.... The
Customize Outline Numbered List dialog will be invoked.
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Note

The Customize... button is disabled if the None item of the Bullets and Numbering dialog is selected.
This item is selected automatically, when you invoke the Bullets and Numbering dialog for lines of text,
rather than for a list.

4.In this dialog, change different list parameters to create your own list style.

For instance, if you specify list parameters in the following way,...
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...you will get the list style as illustrated below.

5.Use TAB and SHIFT+TAB, or the Increase Indent  and Decrease Indent  buttons of the
Paragraph toolbar, to change levels.
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Tables

Insert a Table

Insert a Table

1.Click the position within a document where you want to insert a table.

2.Click the Table button on the Tables toolbar.

3.In the invoked Insert Table dialog, select the required number of table rows and columns.

4.Alternatively, you can select the required table size in the drop-down control box:

Insert a Table inside Another Table

Tables that are located inside other tables are called nested tables.

To insert a nested table:

1.Point to the position within a table cell where you want to insert a table.

2.Insert a table.
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Add and Remove Table Borders

Add Borders

Add Borders to the Whole Table

.1.Select a table.

.2.Click the Borders button on the Table Styles toolbar and select one of the available border sets.

Add Borders to Specified Cells Only

.1.Display gridlines to view boundaries of the table cells and select cells to be provided with borders.

.2.Click the Borders button on the Table Styles toolbar and select the border that you want to apply to
cells.

Remove Table Borders

Remove Borders from the Whole Table

.1.Select a table.

.2.Click the Borders button on the Table Styles toolbar and select No Borders from the invoked list.
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Remove Borders from Specified Cells Only

.1.Display gridlines to view boundaries of the table cells and select cells from which you want to remove
borders.

.2.Click the Borders button on the Table Styles toolbar and select No Borders from the invoked list.

Show or Hide Gridlines

Gridlines show boundaries of a table cells when no borders are applied. Unlike borders, gridlines are shown on
screen only and never printed.

To show or hide table gridlines, click the View Gridlines button on the Table toolbar.
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Customize a Style of Cell Borders

Before you add borders to table cells, you can specify a style to be applied to borders.

To set a style for cell borders, do the following:

1.Select a table or specific cells whose borders you want to customize.

2.Change required options (Line Style, Line Weight, Pen Color) on the Draw Borders toolbar.

3.Add borders using the Table Styles toolbar.
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Select a Cell, Row or Column

Select a Cell

You can select a table cell in one of the following ways.

Double-click a cell.

Click the left edge of a cell.

Click a cell to be selected. Then click the Select button on the Table toolbar and choose Select Cell from
the invoked list.

Note

To select multiple cells, click the left edge of a cell and then drag it across other cells.

Select a Row

To select a table row you can do one of the following.

Click to the left of a row.

Click a cell included into a row to be selected. Then click the Select button on the Table toolbar and
choose Select Row from the invoked list.

Select a Column

To select a table column you can do one of the following.

Click the top edge of a column.
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Click a cell included into a column to be selected. Then click the Select button on the Table toolbar and
choose Select Column from the invoked list.

Select a Table

Click any cell of a table. Then click the Select button on the Table toolbar and choose the Select Table item from
the invoked list.
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Insert a Cell, Row or Column

Insert a Cell

1.Click a cell located directly to the right or below where you want to insert a cell, and then click the Insert
Cells button on the Rows & Columns toolbar.

- or -

Right-click a cell relative to which you want to add a new cell, select the Insert item from the context
menu and click Insert Cells.

2.In the invoked Insert Cells dialog choose one of the available options:

Option Descr
iption

Example
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Shift cells right Insert
a new
cell
just
to the
left of
the
select
ed
cell
and
move
the
select
ed
cell
and
all
other
cells
follow
ing
this
cell in
that
row
to the
right.

Shift cells down Insert
a new
cell in
the
select
ed
cell's
place
and
move
other
cells
in
that
colum
n
down
one
row
each.
A new
row
will
be
adde
d at
the
botto
m of
the
table
to
includ
e the
last
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existi
ng
cell.
Remai
ning
cells
in this
new
row
will
be
empty
.

Insert entire row Insert
a new
row
just
above
the
row
contai
ning
the
select
ed
cell.

Insert entire column Insert
a new
colum
n just
to the
left of
the
colum
n
contai
ning
the
select
ed
cell.

Insert a Row

1.Click a cell located directly below or above where you want to insert a new row.

2.Do one of the following:

To add a new row just above the row containing the selected cell, click the Insert Rows Above button
on the Rows & Columns toolbar.

To add a new row just below the row containing the selected cell, click the Insert Rows Below button
on the Rows & Columns toolbar.
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- or -

1.Right-click a cell relative to which you want to insert a row.

2.Click the Insert item in the context menu and select Insert Rows Above or Insert Rows Below.

Insert a Column

1.Click a cell located directly to the right or left of where you want to insert a new column.

2.Do one of the following:

To add a new column just to the left of the column containing the selected cell, click the Insert
Columns to the Left button on the Rows & Columns toolbar.

To add a new column just to the right of the column containing the selected cell, click the Insert
Columns to the Right button on the Rows & Columns toolbar.
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- or -

1.Right-click a cell relative to which you want to insert a column.

2.Click the Insert item in the context menu and select Insert Columns to the Left or Insert Columns to
the Right.



Rich Text Editor 655

© 2014 DevExpress Inc. 655

Delete a Cell, Row or Column

Delete a Cell

1.Click a cell to be deleted and then click the Delete button on the Rows & Columns toolbar and select
Delete Cells from the invoked list.

- or -

Right-click a cell to be deleted and select Delete Cells... from the context menu.

2.In the invoked Delete Cells dialog choose one of the available options:

Option Des
crip
tion

Example
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Shift cells left Del
ete
the
sel
ect
ed
cell
and
mo
ve
all
oth
er
cell
s in
the
row
to
the
left.

Shift cells up Del
ete
the
sel
ect
ed
cell
and
mo
ve
all
oth
er
cell
s in
the
colu
mn
up.

Delete entire row Del
ete
a
row
con
tain
ing
the
sel
ect
ed
cell.
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Delete entire column Del
ete
a
colu
mn
con
tain
ing
the
sel
ect
ed
cell.

Delete a Row

1.Select a row to be deleted or click on one cell included into that row.

2.Click the Delete button on the Rows & Columns toolbar and select Delete Rows from the invoked list.

- or -

1.Select a row to be deleted and right-click it.

2.Select Delete Rows from the invoked context menu.
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Delete a Column

1.Select a column to be deleted or click on one cell included into that column.

2.Click the Delete button on the Rows & Columns toolbar and select Delete Columns from the invoked
list.

- or -

1.Select a column to be deleted and right-click it.

2.Select Delete Columns from the invoked context menu.
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Merge or Split Cells

Merge Cells

1.Select cells that you wish to merge. For example, you can select multiple cells, a whole row or column.

2.Click the Merge Cells button on the Merge toolbar.

You can also:

Right-click cells to be merged and select Merge Cells from the context menu.

Note

The Merge Cells button becomes available, after you have selected the table cells to be merged.

Split Cells

1.Click a cell or select multiple cells that you wish to split.

2.Click the Split Cells button on the Merge toolbar.
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You can also:

If you wish to split a single cell, right-click this cell and select Split Cells from the context menu.

Note

The Split Cells... item of the context menu is available, if you right-click one cell of a table only.

3.In the invoked Split Cells dialog, set the number of columns and rows into which the selected cells
should be split.

If multiple cells are selected, you can first merge these cells and then spit the newly created cell into the
specified number of columns and rows (select the Merge cells before split check box in the dialog) ...
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... or each of the selected cells can be split (clear the Merge cells before split check box).

Split Table

1.Click any cell included into a row relative to which you wish to split a table. This row will be the first row
of the second table.

2.Click the Split Table button on the Merge toolbar.
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Align Text in Table Cells

By default, text is aligned to the top left corner of a table cell. You can change both the vertical and horizontal
alignment of text in a table cells.

1.Click a cell or select multiple cells containing text that you want to align.

2.Click one of the available buttons on the Alignment toolbar.
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Adjust Column Width

Automatically Change Column Width to Fit Entered Data

1.Click within a table.

2.Click AutoFit on the Cell Size toolbar and select AutoFit Contents.

Automatically Change Table Width to Fit Page Margins

1.Click within a table.

2.Click AutoFit on the Cell Size toolbar and select the AutoFit Window.

Fix a Specific Width for Each Column in a Table

1.Specify a width for each column in a table (for example, by using the mouse or via the Table Properties
dialog).

2.Click AutoFit on the Cell Size toolbar and select Fixed Column Width.
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Set Background Color of Cells

1.Select a table or specific cells whose background color you want to set.

2.Click the Shading arrow and select a color to fill-in the background of the selected cells.
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Set Table Properties

To change settings of table rows, columns, particular cells or whole tables, use the Table Properties dialog. To
invoke this dialog, click within a table whose properties you wish to specify and click the Properties button on the
Table toolbar.

You can also:

Right-click within a table to be modified and select Table Properties... form the context menu.

The Table Properties dialog includes several tabs.

On the Table tab you can set table properties, such as the preferred width for an entire table and table
alignment (position of the table relative to the margins of the page).
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The Options... button invokes the Table Options dialog that allows you to set default cell margins
(spacing between cell borders and text within each cell), specify whether the additional space should be
between cells, set the amount of this space, and set whether or not table columns should be
automatically expanded to accommodate cell content.

The Row tab allows you to set the height of the table row, enable or disable the row to break across
pages, and specify whether or not the row should be the first row on each page in case the table is more
than one page.
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On the Column tab, you can set the preferred width for the table column.

Options on the Cell tab allow you to set the preferred width of the table cell and select a vertical
alignment of the text within the cell.
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The Options... button invokes the Cell Options dialog allowing you to customize cell margins (space
between cell borders and cell content) and specify whether or not the text within the cell should be
wrapped and fitted.
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Header and Footer

Headers and footers are the areas at the bottom or the top of each page in a document. You can insert text or
graphics into headers and footers (for example, page numbers, a company logo, the document title or file name,
the author's name).

Insert a Header or Footer

1.Click the Header or Footer button on the Header & Footer toolbar.

2.Type text or insert graphics in the header or footer area.

3.To switch between the header and footer areas, use the Go to Header and Go to Footer buttons of
the Navigation toolbar.

4.If necessary, you can align and format text in the header and footer areas, as required.

5.To finish, double-click anywhere in the document, or click Close on the Close toolbar.

Create a Different Header or Footer for the First Page
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You can skip the header or footer on the first page, or create a unique header or footer for the first page of the
document.

1.Double-click the header or footer area on the first page of the document.

2.Click the Different First Page button on the Options toolbar.

3.If necessary, click the Show Next and Show Previous buttons on the Navigation toolbar to activate
the First Page Header and First Page Footer areas.

4.Change the contents of the header or footer on the first page (or delete the contents of the header or
footer to use no header or footer on the first page of the document).

Create a Different Header or Footer for Odd and Even Pages

1.Click the Header or Footer button on the Header & Footer toolbar.

2.Click the Different Odd & Even Pages button on the Options toolbar.



Rich Text Editor 672

© 2014 DevExpress Inc. 672

3.If necessary, click the Show Next and Show Previous buttons on the Navigation toolbar to move into
the header or footer areas of odd or even pages.

4.Create the header or footer for odd pages in the Odd Page Header or Odd Page Footer areas and
create the header or footer for even pages in the Even Page Header or Even Page Footer areas.

Use Specific Headers and Footers for Each Section

If your document is divided into sections, you can specify different headers and footers for each section.

1.Click the first section from the document beginning whose headers and footers you wish to change.

2.Click the Header or Footer button on the Header & Footer toolbar.

3.Click Link to Previous on the Navigation toolbar to break the connection between the current section
and the previous section.
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4.Modify the existing header or footer as required, or create a new header or footer for the current
section.

5.Repeat the previous two steps for the next sections for which you want to set specific headers and
footers. Use the Show Next button on the Navigation toolbar to navigate to header or footer areas of
the next sections.
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Mail Merge

The Mail Merge feature enables you to use the text retrieved from a data source for filling in the fields in a
document template. This feature is useful for letters, catalogs, mailing labels, and for personalizing any kind of a
document.

Note

If the data source provides formatted text to insert in the merge field, its formatting will not berecognized and
properly processed.

To merge data fields in a Rich Text Editor document, perform the following steps.

Prepare a Data Source

To perform a mail merge, you need a template and a data source. The template is a document containing
fields (placeholders for the information that will be merged). The data source contains data that will be
merged into the fields in the document template to create merged documents.

 

Create a Template for Mail Merge (Insert Fields)

When an application runs with the mail merge data source attached to the Rich Text Editor, you can
create a template for mail merge. To do this, create a new document, type the mail content and insert
merge fields into this document. To insert fields, click the Insert Merge Field button on the Mail Merge
toolbar.

The drop-down list or a dialog window containing field names will be shown.

Choose the required field and click Insert. The field is inserted at the cursor position.

 

Preview Field Values
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The Show All Field Codes button on the Mail Merge toolbar displays field codes for all fields in the
document.

The Show All Field Results button on the Mail Merge toolbar displays field placeholders if the View
Merged Data button is switched off. If this button is switched on, then the current record of the data
source is displayed in place of the field.

The merge field code looks like the following:

{MERGEFIELD " field nam e" [\* MERGEFORMAT]}

The optional \* MERGEFORMAT switch, which you can add manually, retains formatting applied to the field.

 

Perform a Merge

To finalize the process, you should create the resulting document. To do this, click the Merge to New
Document button on the Mail Merge toolbar.
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Table of Contents

Create a Table of Contents

Create a TOC Using Built-In Heading Styles

The easiest way to create a TOC is to use built-in heading styles.

Mark TOC Entries

.1.Select the text (heading) that you want to appear in a TOC.

.2.Click Add Text on the Table of Contents toolbar and then select the required level (for example, if you
want the selected text to be displayed as the main heading in the TOC, click Level 1, etc.). If you
change your mind and decide not to include the selected text in the TOC, click Do Not Show in Table of
Contents.

After you have applied levels in a newly created document once or if you have opened a
document with specified TOC entires by using heading styles, the corresponding heading styles
(Heading 1, Heading 2, etc.) are automatically added to the list of available styles accessed via
the Styles toolbar. In this case you can mark TOC entries by choosing these heading styles.

Build a TOC

After you have specified all required TOC entries, everything is ready to generate a TOC.

.1.Click within the document where you want to insert a TOC.

.2.On the Table of Contents toolbar, click Table of Contents.



Rich Text Editor 677

© 2014 DevExpress Inc. 677

This will automatically generate a TOC that consists of entries marked by using heading styles.

If you click the Show All Field Codes button on the Mail Merge toolbar, you will see the TOC
field code. By default, it is { TOC \h }. The \h switch inserts all TOC entires as hyperlinks.

Create a TOC Using Paragraph Outline Levels

If you wish to include some text in a TOC without changing the text appearance, you can use outline levels.
Unlike heading styles, outline levels applied to text do not affect text formatting characteristics.

Mark TOC Entries

.1.Select the text that you wish to appear in the TOC.

.2.Right-click the selected text and choose Paragraph from the context menu. The Paragraph dialog will
invoked.

.3.In this dialog, use the Outline level combo box to specify the outline level for the selected text. If you
change your mind and decide not to include the selected text to the TOC, click Body Text.

Build a TOC

After you have specified all required TOC entries, everything is ready to generate a TOC.

.1.Click within the document where you want to insert a TOC.

.2.Press CTRL+F9 to create an empty field wherein you can manually enter a field code to insert a TOC.

.3.In this field, write the {  TOC \u  } field code. Use the \u switch to include text marked with outline levels
in the TOC.

.4.To show the result TOC, place the cursor in the TOC field, right-click it and select the Update Field item
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from the context menu, or click the Update Table button on the Table of Contents toolbar.

Create a TOC Using Fields

Along with built-in heading styles and outline levels, there is another way to label text to include it in a TOC - via
TC fields. Sometimes it can be quicker and easier to add TC fields to mark TOC entries, rather than format the
document using heading styles or outline levels. TC fields can be also helpful if you want to capture a portion of a
long heading that should not be entirely included in the TOC and include only that portion in the TOC. In addition,
if your document needs two or more TOCs showing different entries, you can mark entries for a particular TOC
using TC fields with an identifier, which is specific for each TOC.

Mark TOC Entries

.1.Click within a document where you want to add a TC field (for example, right below an abstract
heading).

.2.Press CTRL+F9 to create an empty field wherein you can manually enter a field code (TC in this case)
and set required switches.

.3.Write the following.

{TC "En try Text"  \f A \l 1  }

This will add the "Entry Text" first-level item (the \l switch sets the level of the TC entry) to the
TOC with an \f switch and the A identifier. The \f switch of the TC field is used to include the TC
field in the corresponding TOC. A TC field identifier (A in this case) must exactly match the text in
the argument of the TOC field's \f switch. For example, the {TOC \f A} table of contents will be
created from TC fields like {TC "En try Text"  \f A}.

Note

TC fields display no result in the document. To view field codes, click Show All Field Codes on
the Mail Merge toolbar.

Build a TOC

.1.Click within the document where you want to insert a TOC.

.2.Press CTRL+F9 to create an empty field wherein you can manually enter a field code to insert a TOC.

.3.Write the following:

{TOC \f A}

The \f switch collects the TC field entries in the TOC. This switch's field-argument (A in this case)
specifies which TC fields should be included in the TOC (TC fields with the same identifier - A).

.4.To show the resulting TOC, place the cursor in the TOC field, right-click it and select the Update Field
item from the context menu, or click the Update Table button on the Table of Contents toolbar.
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Create Table of Contents for Special Cases

A table of contents (TOC) in a document is represented by a special TOC field. There is set of TOC field switches
that you can combine to create TOCs of different types. This document describes how to create the following
TOCs.

TOC for the Specified Portion of a Document

TOC Including Paragraphs with Specified Outline Levels

Table of Figures (Tables, Equations)

TOC for the Specified Portion of a Document

To build a TOC consisting of titles (marked with built-in heading styles) from a specified portion of a document
only, follow the steps below.

1.Mark entries to be included in the TOC by using built-in heading styles (Heading 1, Heading 2, etc.).

2.Mark a portion of a document whose headings you want to include in the TOC with the "Chapter1"
bookmark.

3.Insert an empty field (CTRL+F9) and enter a TOC field code with the \b switch and bookmark name:
{TOC \b Chapter1}.

TOC Including Paragraphs with Specified Outline Levels Only

To generate a TOC from Heading 1, Heading 2 and Heading 3 entries only (or paragraphs with outline levels 1
through 3), use the \o switch in the TOC field code.

{TOC} {TOC \o "1-3"}

Table of Figures (Tables, Equations)

The following step-by-step instructions describe how to create a TOC from items numbered by a SEQ field (for
example, table of figures), add sequence numbers (figure numbers) before page numbers in the table of contents,
and specify the separator between sequence and page numbers.

1.Specify captions for figures that you want to include in the table of figures. To do this, click the Insert
Caption button on the Captions toolbar and select Figures Caption...
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... or add the {SEQ Figu re} field code (via CTRL+F9).

2.Click within a document where you wish to insert the table of figures.

3.Click Insert Table of Figures on the Captions toolbar and select Table of Figures.

If you click the Show All Field Codes button on the Mail Merge toolbar, you will see the TOC field code
- {  TOC \h  \c "Figu re"  }. The \c switch is used to build a TOC from items that are numbered by a SEQ
field.

4.To add figure numbers before page numbers in the table of figures and insert the => separator
between figure and page numbers, use the \s and \d switches of the TOC field - {  TOC \h  \c "Figu re"  \s
Figu re \d => }.

5.Resulting table of figures will look like the following.
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In the same way you can sequentially number tables and equations in a document, and built a table of tables or
equations.

Note

If you add, remove or modify captions, you can quickly update the table of figures by using the Update Table
button on the Captions toolbar or by selecting the Update Field from the context menu.
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Update Table of Contents

If you have added, removed or modified TOC entries in your document, you can quickly update the TOC in one of
the following ways.

Place the cursor in the TOC and press F9.

Place the cursor in the TOC and click the Update Table button on the Table of Contents toolbar.

Select Update Field from the context menu.

Note

Note that if the Table of Contents contains hyperlinks (TOC is created using the {TOC \h} field code), you should
position mouse pointer at the upper left corner of the table to have an effect on entire TOC rather than on a
particular hyperlink.
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Document Protection

Protect and Unprotect a Document

Add Protection to a Document

To protect a document by specifying a password, follow the steps below.

1.Click the Protect Document button on the Protect toolbar.

2.In the invoked Start Enforcing Protection dialog, specify a password to restrict people from editing a
document. To do this, type a password in the Enter new password (optional) box and confirm it in the
Reenter password to confirm box.

You can also allow particular users to change certain parts of a document.

Give Users Permission to Edit Certain Parts of a Document

Before adding protection to a document, you can specify certain parts of the document where you want to remove
the restriction and allow a particular user or group of users to modify these parts.

1.Select a part of a document to be unrestricted.

2.Click the Range Editing Permissions button on the Protect toolbar.

3.In the invoked Editing Permissions dialog, select a user or group of users to be allowed to edit the
selected part of a document.
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4.Editable ranges will be highlighted and enclosed in brackets.

5.Continue to select the document regions and give users permission to edit them.

6.After specifying all required unrestricted parts of a document, add protection.

Remove Protection from a Document

You can unprotect a document, if you know the password for removing document protection.

1.Click the Unprotect Document button on the Protect toolbar.

2.In the invoked Unprotect Document dialog, type the password.
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Edit a Protected Document

When a document is protected, it is read-only except for specific unrestricted parts. You can modify a document
part if you have been given permission to make changes to this part. Editable document regions can be easily
recognized - they are highlighted and enclosed in brackets.
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Miscellaneous

Insert a Bookmark

A Bookmark exposes a document range with a name. The range can have a zero length. The name should start
with a letter and can include numbers.

To create a new bookmark, place the caret at the chosen location, or select the text to mark, and click the 
Bookmark button on the Links toolbar...

...or choose the Bookmark... item from the context menu.

In the invoked Bookmark dialog, specify the bookmark name and click Add.
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After you insert a bookmark in a document, you can insert a hyperlink to make a cross-reference to this bookmark.
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Insert a Hyperlink

The Hyperlink marks the document range as a hot spot in the document. It can be activated by clicking or
pressing ENTER, to navigate the specified external URL, file or bookmark within the same document.

To create a new hyperlink, select a range to mark and click the Hyperlink button on the Links toolbar...

...or select the Hyperlink... item from the context menu ...

... or use the CTRL+K keyboard shortcut.

The Edit hyperlink dialog will appear.
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Insert a Page Break

Insert Page Break

You can insert a page break in your document anywhere you want. To do this, follow the steps below.

1.Point to the position within a document where you want to insert a page break.

2.Click the Page button on the Pages toolbar...

... or click the Breaks button on the Page Setup toolbar and select Page from the invoked list...

... or press CTRL+ENTER.

To show the page break mark, press CTRL+SHIFT+8 or click the Show/Hide button on the Paragraph toolbar.

In a document, page breaks are marked as illustrated below.
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Keyboard Shortcuts to Insert Breaks

You can use the following keyboard shortcuts to insert breaks of different types:

CTRL+SHIFT+ENTER Inserts a column break in a document.

CTRL+SHIFT+SPACE Inserts a non-breaking space.

CTRL+ENTER Inserts a page break.

ENTER Inserts a paragraph break.

SHIFT+ENTER Inserts a line break.

TAB Inserts a tab
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Insert Page Numbers

Insert a Page Number

1.Click the Header or Footer button on the Header & Footer toolbar. For more information, see Header
and Footer.

2.Point to anywhere in the header or footer area where you want to insert the page number.

3.To add page numbers, click the Page Number button on the Header & Footer toolbar.

Insert a Page Count

1.Click the Header or Footer button on the Header & Footer toolbar. For more information, see Header
and Footer.

2.Point to anywhere in the header or footer area where you want to insert the number of pages.
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3.To add the number of pages, click the Page Count button on the Header & Footer toolbar.
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Insert a Symbol

The Rich Text Editor allows you to insert symbols that are not on your keyboard, such as copyright symbols,
trademark symbols, paragraph marks.

To insert a symbol, do the following:

1.Point to the position within the document where you want to insert a symbol.

2.Click the Symbol button on the Symbols toolbar.

The Symbol dialog will be invoked.

3.Select the symbol to be inserted and click OK, or double-click the symbol.

In addition, some symbols can be inserted in the document using default keyboard shortcuts:

CTRL+ALT+C Inserts the copyright (©) symbol.

CTRL+ALT+OEMPERIOD Inserts the ellipsis (…) symbol.

CTRL+ALT+R Inserts the registered trademark (®) symbol.

CTRL+ALT+- Inserts the em dash (—) symbol.

CTRL+ALT+T Inserts the trademark sign (™) symbol.

CTRL+- Inserts the en dash (-) symbol.



Scheduler 695

© 2014 DevExpress Inc. 695

Scheduler

This section describes the capabilities provided by the Scheduler, which is used for scheduling/calendar activities.

Scheduler UI

Toolbars

Ribbon Interface

Appointment Management

Create Appointments

Edit Appointments

Manage Reminders

Delete Appointments

Restrictions for Operations with Appointments

Layout Customization

Switch Scheduler Views

Scheduler Grouping

Zoom the Scheduling Area

Selection and Navigation

Navigate Dates in the Scheduler

Navigate Scheduler Resources
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Navigate Scheduler Time Cells

Scheduler Navigation Buttons

Scheduler 'More' Buttons

Printing

Printing
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Scheduler UI

This section describes the Scheduler UI.

Topics in this section:

Toolbars

Lists Command Bar elements.

Ribbon Interface

Lists Ribbon UI elements.



Scheduler 698

© 2014 DevExpress Inc. 698

Toolbars

A scheduler can be accompanied by a set of toolbars that provide you with a comprehensive functionality to
perform basic operations in a scheduler (navigate through dates, change active view, create, edit and delete
appointments, select a type for grouping scheduler data, etc.) via a Bar interface.

Toolbar Name Visual Appearance Provided
Functionality

Common Import and
export data in
the iCalendar
format.

Print Print scheduler
data.

Appointment Create
Appointments

Navigate Navigate
Dates in the
Scheduler

Zoom the
Scheduling
Area

Arrange Switch
Scheduler
Views
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Group By Scheduler
Grouping

Active View Switch
Scheduler
Views

Time Scale Specify time
scales.

Layout Customize the
active view
layout.

Actions Edit
Appointments

Delete
Appointments

Options Edit
Appointments

Manage
Reminders
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Ribbon Interface

A scheduler can be accompanied by a set of of Ribbon tabbed pages that provide you with a comprehensive
functionality to perform basic operations in a scheduler (navigate through dates, change active view, create, edit
and delete appointments, select a type for grouping scheduler data, etc.) via a Ribbon interface. Ribbon pages are
structurally and visually split into logical groups. Each of these groups includes commands that have certain
common features.

Ribbon Tab Name Visual Appearance

File

Home

View

Appointment



Scheduler 701

© 2014 DevExpress Inc. 701

Appointment Management

This section describes how to modify appointments.

Topics in this section:

Create Appointments

Edit Appointments

Manage Reminders

Delete Appointments

Restrictions for Operations with Appointments
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Create Appointments

Context Menu

The following items are available in the context menu, invoked when you right-click any region of the Scheduler
(except for areas covered by appointments).

1.New Appointment

Invokes the Edit Appointment dialog.

The Start time and End time values are initially set to the lower and upper boundaries of the current
date and time selection.

Fill in other fields, if necessary. For example, use the large text box at the bottom of the dialog to enter
text, which will be shown as an appointment's description in a Day or a Work Week views.

You can also select the Reminder check box to enable appointment notifications (see Manage
Reminders).

2.New All Day Event

Invokes the Edit Event dialog, which is used to create a new all-day appointment (also called 'all-day
event'). The dialog is identical to Edit Appointment (shown above), except that in this case, the All day
event option is checked, its time range is measured in days (not hours) and marked as Free. The
appointment can be transformed into an all-day event and vice-versa by checking this box.

3.New Recurring Appointment

All appointments maintained by the scheduler can either be simple (non-recurring - i.e., they happen
only once), or recurring - occurring multiple times within a specified time interval.

Selecting this menu item invokes the Edit Appointment dialog, used to create a new appointment, and
also invokes the Appointment Recurrence dialog, which allows the recurrence pattern to be specified
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for the new appointment.

4.New Recurring Event

Selecting this menu item invokes the Event editor dialog used to create a new all-day appointment, and
also invokes the Appointment Recurrence dialog, which allows the recurrence pattern to be specified
for the new event.

Bar or Ribbon Interface

If a scheduler is provided with the Bar or Ribbon interface, you can create new appointments (simple and
recurring) using the New Appointment and New Recurring Appointment buttons on the Appointment toolbar or
Ribbon page group. These buttons invoke the Edit Appointment and Appointment Recurrence dialogs
respectively.

Create a new appointment via Bar interface Create a new appointment via Ribbon interface

Keyboard Shortcuts and Mouse Operations

Action Description

An alphanumeric key or ENTER Pressing an alphanumeric key or ENTER invokes an in-
place editor where you can type the subject of a new
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appointment occupying the currently selected area.
Once you have typed your appointment's subject, you
can either create and save the appointment by
pressing ENTER or changing the focus, or cancel the
operation by pressing ESC.

The type of the created appointment depends on the
selected time cell(s). When typing is done in Day or
Work-Week view, the appointment is created with
the time interval starting with the earliest time of the
selected cells and ending with the latest, and the time
is marked as Busy. If an all-day area is selected, then
an all-day appointment is created with the time
marked as Free. When the scheduler display mode is
Week or Month view, the appointment is created with
the start time set to 12 AM of the first selected day,
and the end time is set to 12 AM of the day following
the last selected day.

Double-click Double-clicking within a scheduler view's time cell that
does not contain any appointments invokes the Edit
Appointment dialog described above.

CTRL+N Pressing CTRL+N invokes the Edit Appointment
dialog. Then this dialog can be used to create a new
appointment.

Dragging an appointment while holding CTRL This action creates a copy of the selected
appointment and moves it, leaving the original
appointment intact.
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Edit Appointments

You can modify existing appointments in the following ways:

using the appointment context menu

using the built-in dialogs

using the in-place editor

via the Bar or Ribbon interface

via keyboard shortcuts and mouse operations

Note

Access to some operations may be restricted.

Context Menu

After an appointment has been right-clicked, the appointment context menu is invoked. The Show Time As and
Label As items are used to alter an appointment. They allow for the changing of basic visual characteristics of an
appointment - status and label.

Change the appointment status Change the appointment label

Edit Appointment and Appointment Recurrence Dialogs

Edit a Simple Appointment

You can edit properties of a simple (non-recurring) appointment via the Edit Appointment dialog that can
be invoked via the appointment context menu, Bar or Ribbon interface, keyboard shortcuts and mouse
operations.

Context Menu Toolbar Ribbon Page
Group

Keyboard
Shortcuts and

Invoked Edit
Appointment
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Mouse Operations Dialog

Double-click the
appointment to be
edited.

- or -

Select an
appointment, and
then press ENTER
or CTRL-O.

Edit a Particular Occurrence in a Series

The same dialog is used to edit a particular occurrence in the series of recurring appointments (recurring

appointments are marked with a  sign). If you select a recurring appointment, and click Open in the
appointment context menu or the Open Occurrence button on the Action toolbar or Ribbon page group,
the Edit Appointment dialog is invoked to allow for the editing of the current appointment only, but not its
entire series.

Context Menu Toolbar Ribbon Page
Group

Keyboard
Shortcuts and

Mouse Operations

Invoked Edit
Appointment

Dialog

Double-click an
appointment to be
edited.

- or -

Select an
appointment, and
then press ENTER
or CTRL-O.

The appointment with changed properties still belongs to the series, but is marked with an "exception".

The visual indicator of an exception is the crossed recurrence sign . To replace an exceptional
appointment with the regular occurrence in the chain of recurring appointments, click the Restore Default
State item in the appointment's context menu.

Edit a Series of Recurring Appointments

To edit an entire series of recurring appointments (a pattern appointment), it is necessary to select a
recurring appointment, and click Edit Series in the appointment context menu or select the Open Series
item from the Open drop-down list on the Actions toolbar or Ribbon page group. In this instance, the Edit
Appointment dialog is shown with a different window icon. Time fields are inaccessible.

Context Menu Toolbar Ribbon Page Group Invoked Edit
Appointment Dialog

The recurrence pattern can be edited via the Appointment Recurrence dialog. You can invoke it by clicking
the Recurrence button of the Edit Appointment dialog, or using the Recurrence button on the Options
toolbar or Ribbon page group.
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The Edit Appointment
Dialog

Toolbar Ribbon Page Group Invoked Appointment
Recurrence Dialog

In-place Editing

A single mouse click within an appointment, or pressing F2, invokes the in-place editor, which you can use to edit
the selected appointment's Subject. It is illustrated in the following picture.

By default, you can close the editor by pressing Enter (to save modifications) or Escape (to cancel modifications).

Bar or Ribbon Interface

If a scheduler is provided with the Bar or Ribbon interface, you can modify appointment properties (status, label,
recurrence and reminder) using the Options toolbar or Ribbon page group, which is active when an appointment
is selected.

Modify an appointment via the Bar interface Modify an appointment via the Ribbon interface
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Keyboard Shortcuts and Mouse Operations

Action Description

Click an appointment Selects an appointment.

Right-click an appointment Selects an appointment and invokes the context
menu for the selected appointment.

Click appointments while holding the CTRL key
pressed

Enables you to select multiple appointments.

ENTER or CTRL+O Invokes the Edit Appointment dialog for the selected
appointment.

Double-click an appointment Invokes the Edit Appointment dialog.

F2 Invokes the in-place editor to modify the selected
appointment.

Drag appointment edges Resizes the rectangle representing an appointment.
Results in changing its start/end times.

Click and drag an appointment with the left mouse
button

Moves the appointment across time cells, changing
its Start time and End time properties.

Click and drag an appointment with the right mouse
button

Invokes the context menu allowing you to select
between moving the appointment, copying it or
canceling the operation.

Press and hold the CTRL key, click and drag an
appointment(s) with the left mouse button

Creates a copy of the selected appointment(s) when
the mouse button is released.
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Manage Reminders

What is a Reminder?

An appointment can have one or more reminders. They are responsible for sending alerts at specified time periods

before an appointment's start time. If an appointment has a reminder, the bell  image is displayed.

Specifying Reminders

A reminder can be created for a particular appointment with the help of the appointment's editing form,
demonstrated below. Select the Reminder check box and enter the amount of time before the appointment when
you want the reminder to occur. You can select a predefined value in a drop-down list, or just type it in. The
duration editor recognizes digits as the number of minutes if an "h" postfix is added - as hours, "d" - days.

If a scheduler is provided with the Bar or Ribbon interface, you can specify reminders by selecting the required
value from the Reminder drop-down list on the Options toolbar or Ribbon page group, which is active when an
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appointment is selected.

Delete an appointment via Bar interface Delete an appointment via Ribbon interface

How Does It Work?

When the time has come for the reminder alert, it invokes the notification dialog, as illustrated below.

You can switch the reminders off by clicking the Dismiss or Dismiss All buttons.

Another option is to shift the alert time by selecting the time interval in the combo box and clicking the Snooze
button. Then, the notification will be postponed for a specified time frame.
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Delete Appointments

Context Menu

You can delete the selected appointment using the Delete item of the context menu, which is invoked when an
appointment is right-clicked.

Selecting this item removes the current appointment. If the current appointment is recurring, then the Confirm
Delete dialog is invoked.

Edit Appointment Dialog

When the appointment is being edited via the Edit Appointment dialog, in order to delete the corresponding
appointment (or series of recurring appointments) click the Delete button of this dialog.
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Bar or Ribbon Interface

If a scheduler is provided with the Bar or Ribbon interface, you can delete appointments (simple and recurring)
using the Delete button on the Actions toolbar or Ribbon page group. If the appointment to be deleted is
recurring, clicking this button invokes the drop-down list allowing you to decide whether the whole series of
recurring appointments should be deleted or just a particular occurrence.

Delete an appointment via Bar interface Delete an appointment via Ribbon interface

Keyboard Shortcuts

The DELETE key or the CTRL+D keyboard shortcut can be used to delete the selected appointment(s).
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Restrictions for Operations with Appointments

Access to several operations may be restricted. You may find that you're not able to perform the following
operations due to restrictions applied by your application vendor or administrator.

Create new appointments.

Edit appointments.

Invoke the appointment editing form.

Activate an in-place editor for an appointment.

Change the time boundaries of appointments.

Drag and drop appointments to another time slot or date.

Drag and drop appointments between resources.

Copy appointments.

Delete appointments.

Select more than one appointment simultaneously.

Share the scheduled time between two or more appointments.

When you drag an appointment to relocate it, it may conflict with another. This situation is visually
indicated as illustrated below:
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Layout Customization

This section describes how to change the scheduler layout.

Topics in this section:

Switch Scheduler Views

Scheduler Grouping

Zoom the Scheduling Area
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Switch Scheduler Views

Change Active View

The scheduler is intended to display appointment data using one of the standard Views. The currently active view
used by the scheduler can be either selected intentionally or changed according to the scheduler's internal logic.

To change the active view, use the corresponding item of the scheduler's context menu. This menu is
invoked when you right-click any region of the scheduler (not occupied with an appointment).

Note

Depending on the application vendor, some options may be unavailable in your application.

While navigating through dates via the Go To Date dialog, you can specify a view type to display a new
time interval.

The scheduler selects a view mode automatically, according to the date range selected in the date
navigator, combined with a scheduler. To learn more about this capability, refer to the Select Dates topic.

If a scheduler is provided with the Bar or Ribbon interface, you can use the Active View and Arrange
toolbars or Ribbon page groups.

Change the active view via Bar interface Change the active view via Ribbon interface
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- or - - or -

Available View Types

Day View
This view provides the most detailed view of appointments for a certain day(s).

Work-Week View
This view displays appointments for the working days in a particular week.

Week View
This view displays appointments for any given week.

Month (also called Multi-Week) View
The month view is the least detailed of the views, and is designed to allow browsing and long-term plan
analysis. This view positions the days one after another horizontally, so that they form weeks, while
weeks are placed one under the other.

Timeline View
This view plots appointments as horizontal bars along the timescales, and provides a clearer overview for
scheduling purposes.

Gantt View
This view displays appointments as horizontal bars along the timescales, shows the current schedule
status using percent-complete shadings and displays dependency relationships between appointments.

See Also
Select Dates
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Scheduler Grouping

The appointment data displayed within the scheduler can be grouped either by resources or by dates to enhance
visual representation. The following pictures illustrate the appearance of the scheduler in different grouping
modes.

Appointments are grouped by resources Appointments are grouped by dates

If a scheduler is provided with the Bar or Ribbon interface, you can specify the type of grouping appointments
using the Group By toolbar or Ribbon page group.

Group appointments via Bar interface Group appointments via Ribbon interface

See also the Navigate Scheduler Resources topic.
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Zoom the Scheduling Area

You can zoom in the scheduler view to display its content in greater detail, or zoom out for a more general view.
Zooming is implemented by adjusting the time scales (in the Day, Work-Week or Timeline views) or changing the
number of visible weeks (in the Month view).

Zooming in Zooming out

Zooming operations are available for you via the CTRL+PLUS SIGN, CTRL+MINUS SIGN or CTRL+MOUSE
WHEEL key combinations.

If a scheduler is provided with the Bar or Ribbon interface, you can zoom in and zoom out the scheduler area
using the corresponding buttons on the Navigate toolbar or Ribbon page group.

Zoom scheduler via Bar interface Zoom scheduler via Ribbon interface
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Selection and Navigation

This section describes how to navigate the schedule.

Topics in this section:

Navigate Dates in the Scheduler

Navigate Scheduler Time Cells

Zoom the Scheduling Area

Scheduler Navigation Buttons

Scheduler 'More' Buttons
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Navigate Dates in the Scheduler

Context Menu

Right-clicking within the main area of the scheduler opens the context menu, which contains items for navigating
through dates.

Go to This Day
Only available in the Week View and Month View modes. This item is active when only one day is
selected, and when activated, displays the target day in the Day View mode.

Go to Today
Moves focus to the current date, preserving the existing view mode.

Go to Date...
Invokes the Go To Date dialog to select the date and view type. The date can be selected either by using
the calendar or by entering a string with the placeholders. To select the desired view type, use the Show
In drop-down box.

Date Navigator

If the scheduler is accompanied by the date navigator, you can use it to navigate through dates. The common
look of the date navigator is illustrated in the following picture.
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You can select either a particular date, or a range of dates in the date navigator, and the scheduler will display
your selection using a Day View. The table below details how you can select dates in different ways.

Action Effect

Click a date A single date is selected and the scheduler displays it
using the Day View. If the currently active view is of
another type, it is automatically changed to Day View
.

Click and drag across multiple dates
--or--
click a start date, hold down the SHIFT key and click
an end date

The continuous range of dates is selected. The
scheduler displays it using the Day View, irrespective
of the size of the selected range.

Hold down the CTRL key and click several dates A set of dates is selected. The scheduler displays it
using the Day View, irrespective of the size of the
selected range.

Click a week number A corresponding week-long range is selected. The
scheduler displays it using the Day View.

Bar or Ribbon Interface

If a scheduler is provided with the Bar or Ribbon interface, you can navigate through dates within a scheduler
using the Backward, Forward and Go to Today buttons of the Navigate toolbar or Ribbon page group.

Navigate through dates via Bar interface Navigate through dates via Ribbon interface
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Navigate Scheduler Resources

When appointment data is grouped (either by resources or by dates), the number of resources shown on the
screen within the Scheduler at once can make it difficult to see all the scheduled data. To make the Scheduler's
layout more readable, it is possible to limit the number of visible resources, and then scroll between them. There
is an embedded Resource Navigator control, which allows you to scroll between resources.

The Resource Navigator control is composed of a scrollbar and a set of buttons. It may be shown horizontally (on
the bottom line of the Scheduler control, with buttons in the right corner) or vertically (on the right side, buttons at
the bottom). The position of the control is chosen automatically. It is vertical in Day and Week views, if
appointments are grouped by dates, and horizontal in other view modes.

The mode of operation is rather straightforward - you can click the buttons to move back and forth through the list
of resources; one by one, or straight to the first or last one on the list. The buttons with plus and minus signs
increase or decrease the number of displayed resources by one.
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Navigate Scheduler Time Cells

The following table contains the typical navigation operations:

Action Effect

Clicking a cell Moves focus to the clicked cell, selects it.

UP ARROW
DOWN ARROW

Day View, Work Week View - Moves focus to the
previous or next time cell within the current day.

Week View - Moves focus to the previous or next
day.

Month View - Moves focus to the same day of the
week for the previous or next week.

LEFT ARROW
RIGHT ARROW

Day View, Work Week View - Moves focus to the
corresponding time cell of the previous or next
day.

Week View - Moves focus to the left or right of the
corresponding cell of a column. The view is scrolled
to the previous or next week if necessary.

Month View - Moves focus to the previous or next
day.

PAGE DOWN Moves the row focus one page down, preserving the
column focus.

PAGE UP Moves the row focus one page up, preserving the column
focus.

HOME Day View, Work-Week View - Moves focus to the
start of Work Time within the current day.

Week View, Month View - Moves focus to the first
day shown in the current week.

END Day View, Work-Week View - Moves focus to the
end of Work Time within the current day.

Week View, Month View - Moves focus to the last
day shown in the current week.

CTRL+HOME Day View, Work-Week View - Moves focus to the
first cell of the day's visible time span.

Week View, Month View - Moves focus to the first
day shown in the current week.

CTRL+END Day View, Work-Week View - Moves focus to the
last cell of the day's visible time span.

Week View, Month View - Moves focus to the last
day shown in the current week.

TAB Switches to appointments navigation. Focus shifts to the
next time appointment within the time span shown.
Pressing the key repeatedly iterates through the
appointments in the following way - appointments with a
definite duration are followed by all-day appointments.
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SHIFT+TAB Switches to appointments navigation. Focus shifts to the
previous time appointment within the time span shown.
Pressing the key repeatedly iterates through the
appointments in the following way - appointments with a
definite duration are followed by all-day appointments.

ALT+UP ARROW
ALT+DOWN ARROW

Day View, Work-Week View, Month View -
Moves focus one week before or after.

Week View - acts like the LEFT(RIGHT) ARROW
keys

ALT+PAGE UP
ALT+PAGE DOWN

Day View, Week View, Month View - Moves focus
to the start or end of a current month.

ALT+HOME Day View, Work-Week View - Moves focus to the
beginning of a current week.

ALT+END Day View, Work-Week View - Moves focus to the
end of a current week.

Note

When appointments are grouped, only ARROW keys can move focus to another resource group.
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Scheduler Navigation Buttons

The Navigation Buttons are used to scroll to the previous or next appointment. This is helpful when there is a
significant time interval between scheduled appointments.

Navigation buttons are displayed if there are no currently visible appointments within the Scheduler control area.
If there are appointments that refer to a previous or successive date, the Previous Appointment and Next
Appointment navigation buttons provide the capability to navigate to the corresponding date. If there are no
appointments in a specific direction, the corresponding navigation button is disabled.

Note that if the Scheduler control currently displays appointments for multiple resources, navigation buttons are
displayed independently for each resource.
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Scheduler 'More' Buttons

The "More" buttons indicate that more appointments exist on a particular date. Click these buttons to see all
appointments in a more detailed view, or to simply scroll to the next appointment.

Day View:

Month View:
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Printing

If a scheduler includes a Bar or Ribbon interface, you can use the Print toolbar or Ribbon page group.

Print via the Bar interface Print via the Ribbon interface

Page Setup

Click the Page Setup command button to invoke the Page Setup dialog. The Page Setup dialog consists of the
Format, Paper and Resources tab pages, as illustrated in the images below.
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Print Preview

Click the Print Preview button to invoke the Print Preview dialog, which provides a preview of the page to be
printed.
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This dialog allows you to print the page, or save it to a file as a PDF or an image (e.g., BMP, EMF, WMF, GIF, JPEG,
PNG or TIFF).

Print

Click the Quick Print command button to send the scheduler content to the default printer using the current page
and printer settings.
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Snap Reporting Engine

This guide provides information on the basic principles of creating reports with Snap.

Snap is a WYSIWYG reporting engine that provides a user interface that allows for a quick creation of standard
reports with the capabilities of data shaping (grouping, sorting and filtering), hierarchical data representation
(master-detail reports), mail merge and much more.

The following sections are available in this guide.

Graphical User Interface

Connect to Data

Create a Report Layout

Manage Documents and Files
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Graphical User Interface

The topics in this section describe various aspects of the Snap graphical user interface (GUI).

Snap Application Elements

Main Toolbar
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Main Toolbar

The topics in this section describe all ribbon tab and bar commands available in the toolbar of a Snap application.

After executing a command in a Snap application, the corresponding field codes are automatically added to the
document markup.

Main Reporting Commands

The following command categories describe the tools that are essential to create Snap reports.

Data Tools: Field

Data Tools: Group

Data Tools: List

Data Tools: Mail Merge

Data Tools: Appearance

Additional Reporting Commands

The following command categories describe the tools used in various aspects of Snap reporting.

General Tools: File

General Tools: Insert

General Tools: View

General Tools: References

Table Tools: Design

Table Tools: Layout

Word-Processing Commands

The following command categories describe additional tools related to tasks such as word processing and
manipulating embedded objects.

General Tools: Home

General Tools: Page Layout

General Tools: Review

Chart Tools: Design

Header and Footer Tools: Design

Picture Tools: Format
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Data Tools: Field

This toolbar is context sensitive, and becomes active after selecting a Snap field in the document.

The commands available in the Field toolbar of the Data Tools category are divided into the following sections.

Data Shaping

Element

Data Shaping

Command Large Icon Small Icon Description

Group By Field Groups a Snap list by the
selected field.
All groupings added to a
Snap report are
displayed as nodes in
the Report Explorer.

Using this command, you
can apply multiple
grouping criteria. Every
group can have a header
and/or footer.
To customize report
groups, use the tools
provided by the Data
Tools: Group toolbar.

Sort Ascending Sorts a Snap list by the
selected column in
ascending order.

To manage the sort
levels in a mail merge
document, use the Sort
command of the Data
Tools: Mail Merge toolbar.

Sort Descending Sorts a Snap list by the
selected column in
descending order.

To manage the sort
levels in a mail merge
document, use the Sort
command of the Data
Tools: Mail Merge toolbar.

Summary Calculates a summary for
a selected field. Summary
results are shown in the
list footer.

The following summary
functions are available.
- Count;
- Sum;
- Average;
- Max;
- Min.
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Quick Filter Allows you to select
which values of a
selected field to show.
This command is not
applicable to nested lists
of a master-detail report.

To apply complex filtering
criteria to a Snap list, use
the Filter command of
the Data Tools: List or
Data Tools: Mail Merge
toolbar.

Element

Command Large Icon Small Icon Description

Properties Shows the list of
properties for a selected
field.
The set of available
properties depends on
the element type.
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Data Tools: Group

This toolbar is context sensitive, and becomes active after placing the text cursor in a group header or footer.

To create a new group, use the Group By Field command of the Data Tools: Field toolbar.

The following commands are available in the Layout section of the Group toolbar.

Co
m
ma
nd

Larg
e
Icon

Sm
all
Ico
n

Description

He
ad
er

Adds or removes a group header.
Removing both the group header and group footer removes grouping from the Snap List.

Fo
ote
r

Adds or removes the group footer.
Removing both the group header and group footer removes grouping from the Snap List.

Gro
up
Fiel
ds

Invokes a dialog allowing you to add or remove grouping criteria for the selected group.

Arr
an
ge
Gro
up
s

Invokes the Groups Order Editor, which allows you to set the order in which groupings are
applied to a Snap list.
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Se
par
ato
r

Inserts the selected separator between groups in a Snap list.

The following separators are available.
- Page Break;
- Section (Next Page);
- Section (Even Page);
- Section (Odd Page);
- Empty Paragraph;
- Empty Row;
- None.
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Data Tools: List

This toolbar is context sensitive, and becomes active after selecting a Snap list in the document.

The commands available in the List toolbar of the Data Tools category are divided into the following sections.

Layout

Commands

Editor Row Limit

Layout

Command Large Icon Small Icon Description

Header Adds or removes the
header of a selected
Snap list.

Footer Adds or removes the
footer of a selected Snap
list.

Separator Inserts the selected
separator between the
rows of a Snap list.

The following separators
are available.
- Page Break;
- Section (Next Page);
- Section (Even Page);
- Section (Odd Page);
- Empty Paragraph;
- Empty Row;
- None.

Commands

Comman
d

Large Icon Small
Icon

Description

Filter Invokes the FilterString Editor, which allows you to define complex
filtering criteria for a selected Snap list.
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To select which data records to display for a specific field, use the Quick
Filter command from the Data Tools: Field toolbar.

Convert
to
Paragrap
hs

Removes the table layout of a Snap list.
The content of the removed table columns is presented as separate
paragraphs.

There is no reverse action to convert paragraphs back to a tabular
representation.

Delete
List

Removes the selected list from a document.

Editor Row Limit

Command Large Icon Small Icon Description

Editor Row Limit

none none Allows you to define
the maximum number
of rows to be shown in
a selected Snap list.
The Editor Row Limit
setting does not affect
the number of records
shown in the Print
Preview, which shows
the final presentation
of the document with
all Snap fields replaced
with actual data.



Snap Reporting Engine 741

© 2014 DevExpress Inc. 741

Data Tools: Mail Merge

The commands available in the Mail Merge section of the Data Tools toolbar are divided into the following
categories.

Data

Current Record

Publish

Data

Comman
d

Large Icon Small
Icon

Description

Data
Source

Enables mail merge for a connected data source.
After enabling this mode, the data source icon is displayed in green in
the Data Explorer.

There is no functionality for disabling mail merge once it has been
implemented.

Filter Invokes the FilterString Editor to filter data in a mail merge document.
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Sort Invokes the Sort dialog to sort data in a mail merge document.

Current Record

Command Description

Current Record

Allows you to navigate through records in a mail
merge document. You can navigate to the Next
Page, the Previous Page, the First Page or the
Last Page.

Publish
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Command Large Icon Small Icon Description

Finish & Merge Finalizes a mail merge
document by supplying
actual values to data
elements added to a
document template.

This command invokes a
drop-down menu to
select the publishing
format of a document.
The following options are
available.
- Export - exports the
created document to a
selected third-party
format;
- Print - invokes the print
dialog to adjust the page
options of the document
before sending it to a
printer;
- Print Preview -
displays the created
document in a print
preview window that
provides options to
navigate, print and/or
export the document.

After selecting the document's output format, the Export Range dialog is invoked to specify the range of data
records that the document should include.

In this dialog, you can choose from the following separators to isolate different data records.
- None;
- Page Break;
- Section (Next Page);
- Section (Even Page);
- Section (Odd Page);
- Paragraph.
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Data Tools: Appearance

This toolbar is context sensitive, and becomes active after placing the text cursor in a document table.

The commands available in the Layout toolbar of the Table Tools category are divided into the following sections.

Table

Rows & Columns

Merge

Cell Size

Alignment

Table

Comman
d

Large Icon Small
Icon

Description

Select Allows you to select a cell, row, column or table.

View
Gridlines

Shows or hides table gridlines.
This command is useful when working with tables that contain invisible
borders.

These lines are only displayed in the Design Surface - they do not
appear in a published document.

Propertie
s

Invokes the Table Properties dialog for the selected table.

This dialog allows you to adjust the size and alignment properties of
the current table cell, row, column or table.

Rows & Columns

Command Large Icon Small Icon Description
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Delete Deletes the specified cells or the currently selected row,
column or table.

To delete a single table cell, the Delete Cells dialog is
invoked that allows you to select the "shift" mode for
replacing the deleted cell.

To remove individual rows from a Snap List, use the
Quick Filter command of the Data Tools: Field toolbar.

Insert Above Inserts a new row above the selected row.

Insert Below Inserts a new row below the selected row.

Insert Left Inserts a new column to the left of the selected column.

Insert Right Inserts a new column to the right of the selected
column.

Merge

Command Large Icon Small Icon Description

Merge Cells Merges selected cells.
The content of merged
cells is converted to
paragraphs of an output
cell.

Split Cells Splits the selected cell
into a specified number of
rows and columns.
The content of the source
cell is placed in the top-
left output cell.

Split Table Splits the table into two
tables.
The selected row
becomes the first row of
the new table.

Cell Size
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Command Large Icon Small Icon Description

AutoFit Sets the auto fit mode of
the selected table.

The following auto fit
modes are available:
- AutoFit Contents - table
cells occupy the minimum
width possible to fit
content.
- AutoFit Window - the
table occupies the entire
width of the page. Table
cells are resized to fit
their content.
- Fixed Column Width -
column width is fixed and
can only be changed
manually.

Alignment

Command Large Icon Small Icon Description

Alignment

none none Sets the text alignment
for selected cells.

Cell Margins Invokes the Table
Options dialog,
allowing you to set the
default cell margins for
the selected table cells.
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General Tools: File

The File toolbar contains the basic file management and printing commands.

These commands are divided into the following categories.

Common

Data

Common

Command Large Icon Small Icon Description

New Creates a new Snap
document.

Open Opens an existing
document.

A Snap document
template can be created
based on the following
third-party file formats.
- DOC (Microsoft®
Word® 97 2003
document);
- DOCX (Office® Open
XML document);
- EPUB (Electronic
Publication);
- HTML (HyperText
Markup Language);
- MHTML / MHT (Web
archive, single file);
- PDF (Portable
Document Format);
- RTF (Rich Text Format);
- TXT (Plain text);
- ODT (OpenDocument
text document);
- XML (Microsoft®
Word® XML document);
- Image (BMP, EMF, WMF,
GIF, JPEG, PNG or TIFF
format).

The SNX format stores a
Snap report without the 
document field data.
Saving a document in any
other format retrieves
the required data values
and excludes any
information about the
data connections defined
by Snap.

To apply the uniform
layout and style settings
of a specific document to
multiple reports, open
this document as a
template.
In this mode, the Save
command is disabled to



Snap Reporting Engine 748

© 2014 DevExpress Inc. 748

prevent open templates
from being overwritten.

Save Saves a document
template to an SNX file.
When saving a document
for the first time, the 
Save As dialog will
appear.

Save As Saves a document
template to a new SNX
file.
This command invokes
the Save As dialog,
allowing you to specify a
name and location for the
new file.

Export... Exports a document into
one of the supported
third-party formats.

A Snap report can be
exported to one of the
following third-party
formats.
- DOC (Microsoft®
Word® 97 - 2003
document).
- DOCX (Office® Open
XML document);
- EPUB (Electronic
Publication);
- HTML (HyperText
Markup Language);
- MHTML / MHT (Web
archive, single file);
- PDF (Portable
Document Format);
- RTF (Rich Text Format);
- TXT (Plain text);
- ODT (OpenDocument
text format);
- XML (Microsoft®
Word® XML document);

Quick Print Sends a document to the
default printer with
default printing options.

Print Invokes the Print dialog,
allowing you to select a
printer and specify the
printing options.

Print Preview Retrieves all data
required to populate the
report fields to assemble
and preview a document
before publishing,
ignoring the current 
Editor Row Limit setting.
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Calling this command for
a mail-merge document
renders only one page of
the document.
To render a mail-merge
document for a specified
range of data records,
use the Finish & Merge
option in the Data Tools:
Mail Merge tab.

Undo Cancels the last change
made to the document.

Redo Reverses the results of
the last undo.

Data

Command Large Icon Small Icon Description

Add New Data Source Invokes the Create Data
Source wizard, allowing
you to connect the
document to a new data
source and specify its
data connection options
(e.g., data provider, login
information and
connection name).

A data table selected
with the wizard is
included in the data
source. To add more
tables and specify their
data relations, use the 
Query Designer.
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General Tools: Insert

The Insert toolbar contains elements that can be inserted into a document.

These elements are divided into the following categories.

Pages

Tables

Illustrations

Toolbox

Links

Header & Footer

Text

Symbols

Pages

Command Large Icon Small Icon Description

Page Break Inserts a page break at
the carriage position.
A page break cannot
occur within tables, lists,
or document headers
and footers.

Tables

Command Large Icon Small Icon Description

Table Inserts a table with a
specified number of rows
and columns at the
carriage position.
To customize the table
layout, use the
commands available in
the Table Tools: Design
and Table Tools: Layout
tabs.

Illustrations

Command Large Icon Small Icon Description

Inline Picture Inserts an inline picture
at the carriage position.
In a document, the inline
picture behaves like an
ordinary text symbol.

Picture Inserts a picture into a
document. You can
adjust the picture's
outline, wrap text,
position, and order using
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commands from the 
Picture Tools: Format tab.

Toolbox

Command Large Icon Small Icon Description

Bar Code Inserts a bar code at the
carriage position.
After adding a bar code,
specify its symbology,
data binding and other
options using the 
Properties command in
the Data Tools: Field tab.

Check Box Inserts a check box at
the carriage position (e.
g., to display Boolean
values from a data
source).
To customize the check
box state or bind it to
external data, use the 
Properties command in
the Data Tools: Field tab.

Chart Inserts a chart at the
carriage position.

Sparkline Inserts a sparkline at
the carriage position.

Row Index Inserts a row index at
the carriage position.

Links

Comm
and

Large
Icon

Small
Icon

Description

Bookm
ark

Invokes the Bookmark dialog to add a new bookmark at the carriage position, or
navigate to an existing bookmark.
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Hyperli
nk

Invokes the Insert Hyperlink dialog to create a hyperlink and specify its text,
screen tip and destination.
A hyperlink's destination may be a web page, file, or specific position within a
document.

Header & Footer

Command Large Icon Small Icon Description

Header Allows editing the page
header. In a published
document, the content
added to the header will
appear at the top of each
page.

To quickly switch to this
mode, double-click the
page header area.
To quit page header
editing, press ESC,
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double click the
document area, or click 
Close Header and
Footer on the Header &
Footer tab.

To make the first page
header display unique
content, or make odd-
and even-numbered
pages carry different
headers, use the options
available on the Header
and Footer Tools: Design
tab.

Footer Activates the page footer
edit mode. In a published
document, the content
added to the footer will
appear at the bottom of
each page.

To quickly switch to this
mode, double-click the
page footer area.
To quit page footer
editing, press ESC,
double click the
document area, or click 
Close Header and
Footer on the Header &
Footer tab.

To make the first page
footer display unique
content, or make odd-
and even-numbered
pages carry different
footers, use the options
available on the Header
and Footer Tools: Design
tab.

Page Number Inserts the number of
the current page at the
carriage position.
The page statistics can
only be added to a page
header or footer.

Page Count Inserts the total page
count at the carriage
position.
The page statistics can
only be added to a page
header or footer.

Text

Command Large Icon Small Icon Description
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Text Box Inserts a text box into a
document.
A text box is a floating
container that is capable
of displaying virtually any
kind of content (including
the most elaborate lists),
posing no restrictions on
its size and location
within a document.

Symbols

Com
man
d

Large
Icon

Sma
ll
Icon

Description

Sym
bol

Invokes the Symbol dialog, to insert characters that are not available on the keyboard.



Snap Reporting Engine 755

© 2014 DevExpress Inc. 755

General Tools: View

The View toolbar contains commands that control the presentation of document elements on the Design Surface.

These commands are divided into the following categories.

Document Views

Show

Zoom

View

Fields

Document Views

Command Large Icon Small Icon Description

Simple view Shows a document
without the page layout.

Draft View Shows a document in a
draft view that ignores
certain document
elements such as page
breaks, and headers and
footers.

Print Layout Shows a document as it
will appear on the
printed page.

Show

Command Large Icon Small Icon Description

Horizontal Ruler Shows or hides the
horizontal ruler at the
top of the Design Surface
.

Vertical Ruler Shows or hides the
vertical ruler to the left of
the Design Surface.

Zoom

Command Large Icon Small Icon Description

Zoom Out Zooms the document out.

Zoom In Zooms the document in.

View
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Command Large Icon Small Icon Description

Windows Shows or hides the Snap
application windows (i.
e., Data Explorer and
Report Explorer).

Highlight Highlights the boundaries
of a list element after it
receives input focus.
The invoked frame
displays the type of
element that is
highlighted.

Fields

Command Large Icon Small Icon Description

Show All Field Codes Toggles to show the field
codes of all elements
that provide dynamic
content in a document.

Show All Field Results Switches back to the
default mode, which
displays the actual
values fetched by Snap
fields supplying dynamic
content to a document.

To effectively handle
incoming data, only a
portion of data is shown
during real-time editing
of a document. This
restriction does not apply
to a document created
for print preview, and the
report requests all data
after it is set for
publishing.

When a document is
being edited, only the
first 20 rows from each
data column are shown
by default. To modify or
disable this limit, use the 
Editor Row Limit option
in the Data Tools: List
tab.

Highlight Fields Highlights the data fields
that have been added to
a document from an
external data source to
distinguish these fields
from the rest of the
document content.
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General Tools: References

The References toolbar contains commands that provide different kinds of references to a document, such as a
table of contents and table captions.

These commands are divided into the following sections.

Table of Contents

Captions

Table of Contents

Command Large Icon Small Icon Description

Table of Contents Inserts a table of
contents at the carriage
position.

Update Table Updates the table of
contents to ensure that
all entries in it refer to
the correct page
numbers.

Add Text Adds the current
paragraph as an entry to
the specified level of the
table of contents.
If a data field is added to
the table of contents, a
separate table of
contents entry is created
for each data row in the
Snap list.

Captions

Command Large Icon Small Icon Description

Insert Caption Inserts sequentially
numbered captions for
different types of objects
at the carriage position.

The following caption
types are available:
- Figures Caption
(automatically referenced
by the table of figures);
- Tables Caption
(automatically referenced
by the table of captions);
- Equations Caption
(automatically referenced
by the table of
equations).

Insert Table of Figures Creates a table of
figures, table of tables,
or table of equations,
containing page numbers
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for objects of the
corresponding types.

Update Table Updates the table of
figures so that all entries
refer to the correct page
numbers.
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Table Tools: Design

This toolbar is context sensitive, and becomes active after placing the text cursor in a document table.

The commands available in the Design toolbar of the Table Tools category are divided into the following sections.

Table Style Options

Table Styles

Cell Styles

Borders & Shadings

Table Style Options

Commands from this category allow you to activate special formatting options for different table parts.

Special formatting options available for a table are defined in its table style. To create a new table style or modify
an existing one, use the tools provided by the Table Styles section of this category.

The following commands are available in the Table Style Options category.

Command Description

Header Row
Enables formatting of the first row in a table.

First Column
Enables special formatting for the first column in a
table.

Total Row
Enables special formatting for the last row in a table.

Last Column
Enables special formatting for the last column in a
table.

Banded Rows
Enables special formatting for odd and even rows in a
table.

Banded Columns
Enables special formatting for odd and even columns
in a table.

Table Styles

Command Description

Table Styles

Sets a table style for the selected table.

Clicking the arrow button invokes the drop-
down menu containing the following commands
for managing table styles.
- New Table Style...
- Modify Table Style...
- Delete Table Style...

Creating a new table style or modifying an
existing one invokes the Modify Style dialog,
allowing you to specify a style name and adjust
table formatting options (including special
formatting options for different table parts).
You can enable special formatting using
commands from the Table Style Options section
within this toolbar category.
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Cell Styles

Command Description

Cell Styles

Sets a cell style for the selected table cell.

Clicking the arrow button invokes the drop-
down menu, containing the following
commands for managing table cell styles.
- New Cell Style...
- Modify Cell Style...
- Delete Cell Style...

Creating a new table cell style or modifying an
existing one invokes the Modify Style dialog,
allowing you to specify a style name and adjust
cell formatting options.

Borders & Shadings

Command Large Icon Small Icon Description

Line Style

none none Sets the style of a
line that is used to
draw borders.

Line Weight

none none Sets the width of the
line that is used to
draw borders.

Pen Color Sets the color that is
used to draw
borders.

Borders Draws the specified
borders for selected
cells.

Shading Specifies the
background color for
the selected cells.
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Table Tools: Layout

This toolbar is context sensitive, and becomes active after placing the text cursor in a document table.

The commands available in the Layout toolbar of the Table Tools category are divided into the following sections.

Table

Rows & Columns

Merge

Cell Size

Alignment

Table

Comman
d

Large Icon Small
Icon

Description

Select Allows you to select a cell, row, column or table.

View
Gridlines

Shows or hides table gridlines.
This command is useful when working with tables that contain invisible
borders.

These lines are only displayed in the Design Surface - they do not
appear in a published document.

Propertie
s

Invokes the Table Properties dialog for the selected table.

This dialog allows you to adjust the size and alignment properties of
the current table cell, row, column or table.

Rows & Columns

Command Large Icon Small Icon Description
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Delete Deletes the specified cells or the currently selected row,
column or table.

To delete a single table cell, the Delete Cells dialog is
invoked that allows you to select the "shift" mode for
replacing the deleted cell.

To remove individual rows from a Snap List, use the
Quick Filter command of the Data Tools: Field toolbar.

Insert Above Inserts a new row above the selected row.

Insert Below Inserts a new row below the selected row.

Insert Left Inserts a new column to the left of the selected column.

Insert Right Inserts a new column to the right of the selected
column.

Merge

Command Large Icon Small Icon Description

Merge Cells Merges selected cells.
The content of merged
cells is converted to
paragraphs of an output
cell.

Split Cells Splits the selected cell
into a specified number of
rows and columns.
The content of the source
cell is placed in the top-
left output cell.

Split Table Splits the table into two
tables.
The selected row
becomes the first row of
the new table.

Cell Size
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Command Large Icon Small Icon Description

AutoFit Sets the auto fit mode of
the selected table.

The following auto fit
modes are available:
- AutoFit Contents - table
cells occupy the minimum
width possible to fit
content.
- AutoFit Window - the
table occupies the entire
width of the page. Table
cells are resized to fit
their content.
- Fixed Column Width -
column width is fixed and
can only be changed
manually.

Alignment

Command Large Icon Small Icon Description

Alignment

none none Sets the text alignment
for selected cells.

Cell Margins Invokes the Table
Options dialog,
allowing you to set the
default cell margins for
the selected table cells.
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General Tools: Home

The Home toolbar contains text formatting and alignment commands.

These commands are divided into the following categories.

Clipboard

Font

Paragraph

Styles

Editing

Clipboard

Command Large Icon Small Icon Description

Paste Pastes the content of the clipboard into a carriage
position.

Cut Cuts the selected content and places it in the
clipboard.

Copy Copies the selected content and places it in the
clipboard.

Paste Special Invokes the Paste Special dialog, allowing you to
paste the content of the clipboard with a specified
formatting.

Font

Command Large
Icon

Smal
l
Icon

Description

Font

none none Specifies a font for the selected text.

Font Size

none none Specifies a font size for the selected text.

Grow Font Increases the font size of the selected text.
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Shrink Font Decreases the font size of the selected text.

Change Case Changes the case of the selected text to uppercase or lowercase.

Bold Makes the selected text bold.

Italic Italicizes the selected text.

Underline Draws a line under the selected text.

Double Underline Draws a double line under the selected text.

Strikethrough Draws a line through the middle of the selected text.

Double Strikethrough Draws a double line through the middle of the selected text.

Superscript Makes the selected text smaller and places it above the line of the
text.

Subscript Makes the selected text smaller and places it below the line of the
text.

Font Color Specifies a color for the selected text.

Text Highlight Color Specifies a highlight color for the selected text.

Clear Formatting Removes all formatting from the selection, leaving only plain text.

Font
none none Invokes the Font dialog, allowing you to adjust different font options

for the selected text.
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Paragraph

Com
man
d

Large
Icon

Smal
l
Icon

Description

Bulle
ts

Converts the selected paragraphs into a bulleted list, or inserts a new bulleted list at
the carriage position.

Num
berin
g

Converts the selected paragraphs into a numbered list, or inserts a new numbered
list at the carriage position.

Multil
evel
List

Converts the selected paragraphs into a multilevel list, or inserts a new multilevel list
at the carriage position.

Decr
ease
Inde
nt

Decreases the indent level of the paragraph or the hierarchical level of the multilevel
list's items.

Incre
ase
Inde
nt

Increases the indent level of the paragraph or the hierarchical level of the multilevel
list's items.

Sho
w/
Hide
¶

Shows or hides paragraph marks and other non-printable characters.

Align
Text
Left

Aligns the current paragraph to the left.

Cent
er

Centers the selected paragraphs.

Align
Text
Right

Aligns the selected paragraphs to the right.

Justif
y

Aligns the text of the selected paragraphs to both the left and right margins, adding
extra space between words as necessary.

Line
Spaci
ng

Changes the spacing between the lines of the selected paragraphs.
The amount of space added before and after the paragraphs can also be specified.

Shad
ing

Specifies a background color for the selected paragraphs.

Para
grap
h

none none Invokes the Paragraph dialog, allowing you to adjust different layout options for the
selected paragraphs.
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Styles

Command Description

Quick Styles

Applies a style to the selected text.

A style is a group of formatting options. All options are applied to text or a paragraph at
once when you apply a style.
Styles allow you to change text and paragraph appearance quicker than setting each
formatting option individually.

Modify Style
Invokes the Modify Style dialog, allowing you to change the formatting options of the
selected style.
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Editing

Co
mm
and

Large
Icon

Sm
all
Ico
n

Description

Find ' Invokes the Find and Replace dialog that allows you to find the specified text in a
document.
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Repl
ace

Invokes the Find and Replace dialog that allows you to find the specified text in a
document and replace it with other text.



Snap Reporting Engine 770

© 2014 DevExpress Inc. 770

General Tools: Page Layout

The Page Layout toolbar contains page layout options that include paper kind, margins and orientation.

These options are divided into the following categories.

Page Setup

Background

Page Setup

Comma
nd

Large
Icon

Small
Icon

Description

Margins Sets the size of page margins for the current document section.

You can select from a list of predefined margins, or invoke the Page Setup
dialog and adjust the margin size manually.

Orientat
ion

Sets the page orientation for the current document section.

Size Sets the page size for the current document section.

You can select one of the predefined page sizes from the list, or specify a
custom page size in the Page Setup dialog.
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Column
s

Sets the number of columns for all pages in the current document section.

You can also invoke the Columns dialog for more customization options.

Breaks Inserts one of the available breaks (e.g., page break, column break or
section break) at the carriage position.
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Line
Number
s

Displays line numbers in the current document section.

You can select one of the predefined line numbering types from the list, or
invoke the Line Numbers dialog to define custom line numbering.

Background

Command Large Icon Small Icon Description

Page Color Sets a page color for the
entire document.
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General Tools: Review

The Review toolbar contains tools related to proofreading.

The following command is available in the Proofing section of this toolbar.

Comm
and

Large
Icon

Small
Icon

Description

Spellin
g

Checks the spelling of the document text.

On detecting misspelled words, the spell checker invokes the Spelling dialog to
type in the correct version, or select the correctly spelled word from the list of
suggestions.



Snap Reporting Engine 774

© 2014 DevExpress Inc. 774

Chart Tools: Design

This toolbar is context sensitive, and becomes active after selecting a chart in the document.

The commands available in the Design toolbar of the Chart Tools category are divided into the following sections.

Chart Type

Appearance

Wizard

Chart Type

Command Large Icon Small Icon Description

Column Changes the type of the
selected chart to one of
the available column
chart types.
Column charts are used
to compare values across
categories.

Line Changes the type of the
selected chart to one of
the available line chart
types.
Line charts are used to
display trends over time.

Pie Changes the type of the
selected chart to one of
the available pie chart
types.
Pie charts display the
contribution of each
value to a total.

Bar Changes the type of the
selected chart to one of
the available bar chart
types.
Bar charts summarize
and display categories of
data, allowing you to
compare the contribution
of each value to the total
across categories.

Area Changes the type of the
selected chart to one of
the available area chart
types.
Area charts are used to
display trends over time.

Other Charts Changes the type of the
selected chart to a point,
funnel, financial, radar,
polar, range, or Gantt
chart.
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Appearance

Command Large Icon Small Icon Description

Palette Specifies the color
palette for the
selected chart.

Appearance

none none Applies a specified 
appearance to the
selected chart.
The collection of style
presets available for
a chart depends on
the chart's palette.

Wizard

Command Large Icon Small Icon Description

Run Chart Wizard... Invokes the Chart wizard
, which allows you to
adjust the main chart
settings in a single user
interface.
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Header and Footer Tools: Design

This toolbar is context sensitive, and becomes active after double-clicking the page header or footer in a
document.

To add a page header or footer, use the appropriate commands of the General Tools: Insert toolbar.

The commands available in the Design toolbar of the Header & Footer Tools category are divided into the
following sections.

Navigation

Options

Close

Navigation

Command Large Icon Small Icon Description

Go to Header Allows you to switch to
the page header of the
current document section
when editing a page
footer.

Go to Footer Allows you to switch to
the page footer of the
current document section
when editing a page
header.

Show Next Allows you to navigate to
the header or footer of
the next document
section.

Show Previous Allows you to navigate to
the header or footer of
the previous document
section.

Link to Previous Makes the header or
footer display the
content of the header or
footer of the previous
document section.

Options

Command Large Icon Small Icon Description

Different First Page Creates a unique header
and footer for the first
page.

Different Odd & Even
Pages

Allows you to specify
different headers and
footers for odd-
numbered and even-
numbered pages.
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Close

Command Large Icon Small Icon Description

Close Header and Footer Exits the header and
footer edit mode.
You can also do this by
double-clicking the
document area, or by
pressing ESC.
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Picture Tools: Format

This toolbar is context sensitive, and becomes active after selecting a picture in a document.

The commands available in the Format toolbar of the Picture Tools category are divided into the following
sections.

Shape Styles

Arrange

Shape Styles

Command Large Icon Small Icon Description

Shape Fill Fills the selected
shape with a
specified color.

Shape Outline Applies the specified
color to the outline of
the selected shape.

Shape Outline Weight

none none Specifies a width for
the outline of the
selected shape.

Arrange

Command Large Icon Small Icon Description

Wrap Text Specifies the way in
which text wraps around
a selected object.

The text wrap modes are
as follows:
- Square;
- Tight;
- Through;
- Top and Bottom;
- Behind Text;
- In Front of Text.

Position Specifies the position of
the selected object on a
page.

Bring to Front Moves the selected
object forward.

This command invokes a
drop-down menu that
contains the following
actions:
- Bring Forward (moves
the selected object one
layer forward);
- Bring to Front (moves
the selected object to the
front of all other objects
in a document);
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- Bring in Front of Text
(places the selected
object in front of the
text).

Send to Back Moves the selected
object backward.

This command invokes a
drop-down menu that
contains the following
actions:
- Send Backward (moves
the selected object one
layer backward);
- Send to Back (moves
the selected object
behind all other objects
in a document);
- Send Behind Text
(moves the selected
object behind the text).
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Snap Application Elements

The topics in this section describe the main elements that make up the user interface of a Snap application.

This section consists of the following topics.

Snap User Interface Overview

Main Toolbar

Design Surface

Data Explorer

Report Explorer

Print Preview
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Snap User Interface Overview

This document lists the essential elements of the Snap user interface, and provides links to specific topics that
describe these elements in more detail.

The main elements of the Snap user interface are as follows.

Main Toolbar

The Main Toolbar in a Snap application provides quick access to the available document editing tools. The
following toolbar styles are available:.

.1.Ribbon
Tools are organized in various sections, contained in different tabs.

.2.Bars
Tools are organized in separate toolbars.

Design Surface

The body of a report in the designer. In this region, you can design your report layout and immediately
view the result.

Data Explorer

Reflects the structure of available data, allowing you to manage a report's data sources. You can add the
data shown in this pane to your report via drag-and-drop.
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Report Explorer

Reflects the hierarchy of the elements of a Snap document.
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Main Toolbar

The Main Toolbar in a Snap application provides quick access to the available document editing tools. The
following toolbar styles are available:

1.Ribbon
Tools are organized in various sections, contained in different tabs.

2.Bars
Tools are organized in separate toolbars.
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Design Surface

This document describes the design surface of a Snap application.

The design surface is the primary working area of a Snap application, which contains the document and allows you
to modify its layout.

It can display rulers that define the horizontal and vertical alignment of a report's elements, as well as a scroll bar
that allows you to browse different pages of a document.

Right-clicking the design surface invokes the context menu, which displays a specific set of commands based on
the element that is clicked.
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The WYSIWYG nature of Snap allows you to view document content on the design surface in the same way it will
appear on paper. However, the complete document (as it appears in a Print Preview) may differ from the
document layout shown in the design surface. For example, setting the List | Editor Row Limit toolbar option
limits the total number of processed data records while the document layout is being designed.

The View toolbar contains the commands that allow you to switch the document presentation mode (Simple View
, Draft View, Print Layout), as well as maintain the visibility of rulers and the document zoom factor.
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Data Explorer

This topic describes how to use the Data Explorer in Snap.

This topic consists of the following sections.

Overview

Data Type Reference

Overview

The Data Explorer is essential for managing data in Snap applications. It allows you to add new data sources to a
Snap document, access their structure and run the Query Designer to customize a data source.

Using the Data Explorer, you can also manage a report's parameters, as well as the calculated fields supplied to
the data source tables.

You can create a Snap report layout by dropping the data members from the Data Explorer onto a document's 
design surface. The data members correspond to the columns created on the design surface, and the data
member names are displayed in the column headers.
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To display data in a chart, drop data fields from the Data Explorer onto the corresponding chart areas.

When a data field is added to your document, its data type determines what element is created (e.g., text, chart,
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or bar code).

Data Type Reference

In the Data Explorer, different icons are assigned to various data objects. These icons are explained in the
following table.

Icon Description

(regular data source)

(mail merge data source)

Designates an individual data source. When
expanded, shows the hierarchy of its tables and/or
views.

(regular data source)

(mail merge data source)

Designates a data table or view within a data source.
When expanded, shows the hierarchy of its data
fields. You can drag a data table and drop it onto the
document surface, after which the entire table
structure will be presented in the report in a tabular
form.

Parameters. Lists the report parameters. You can
include parameters in a document's filtering
expression or calculated fields, or you can use them
directly in your reports, (e.g., by dropping them onto
the document surface).

For every table or view, the Data Explorer lists the available data fields. Depending on the data type, it will
automatically assign one of the following icons.

Icon Data Type Displayed Contents

(regular data source)

(mail merge data source)

Boolean Check Box, plain text

(regular data source)

(mail merge data source)

Byte Bar Code, Picture

(regular data source)

(mail merge data source)

Date-time Plain text

(regular data source)

(mail merge data source)

Numeric Plain text, Bar Code

(regular data source)

(mail merge data source)

String Plain text, Bar Code

Calculated field Determined by the result of the
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calculation.
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Report Explorer

Report Explorer reflects the hierarchy of fields in a Snap document, to quickly navigate through its data levels. It
displays the order of document lists, and lists their active groups in a tree format.

Clicking a node in the Report Explorer activates the corresponding document element that is closest to the
currently displayed page.
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Print Preview

This document describes the Print Preview window, which displays published documents in a Snap application.

Print Preview Elements

Invoke a Print Preview

Print Preview Elements

The Print Preview displays a report document as it will appear on paper.

The user interface of a Print Preview consists of the following elements.

Main Menu - contains the document management and navigation commands within several menu items (
File, View and Background);
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Toolbar - provides quick access to document management and navigation commands;

Status Bar - indicates the document generation state, displays the selected page number and enables
document zooming.

Invoke a Print Preview

To assemble and preview a tabular report, click Print Preview in the General Tools: File toolbar.

Using the option above to preview a mail merge report will only display the document obtained from the
first data source record.

To assemble and preview a mail merge report, click Finish & Merge in the Data Tools: Mail Merge toolbar
and select Print Preview in the invoked drop-down menu.
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In the invoked Export Range dialog, specify the required range of data records and click OK.
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Connect to Data

The topics in this section describe the various aspects of providing data to a Snap document.

Connect a Document to a Data Source

Create a Master-Detail Data Source

Filter Data

Format Data

Group Data

Sort Data

Pass Parameter Values

Use Calculated Fields

Use the Query Designer
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Connect a Document to a Data Source

This tutorial describes the steps required to connect a Snap document to data by using the ?reate Data Source
wizard and Query Designer.

1.Click Data | Add New Data Source on the Snap application's ribbon toolbar.

Alternatively, right-click anywhere in the Data Explorer and click Add Data Source in the invoked menu.

2.On the first page of the invoked Create Data Source wizard, specify the name for the new data source
and click Next.

3.On the next page, select a data provider, specify the required connection settings and click Next.
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4.Select a data table to include in the data source.

To add more tables and specify their data relations, use the Query Designer that is invoked after
enabling the Open Query Designer after closing the wizard option and clicking Finish on the last
wizard page.
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5.After the data source has been added to the report, the hierarchy of its data members is reflected in
the Data Explorer.

The Snap report is now connected to data. Drag-and-drop the CategoryName and Description data fields from
the Data Explorer onto the document's body to create a simple data-aware report.
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Create a Master-Detail Data Source

This tutorial describes how to add a master-detail relation to the document's data source.

1.Connect a Snap document to data as shown in the Connect a Document to a Data Source tutorial.

2.Right-click the added data source node in the Data Explorer window and select Edit Data Source... in
the invoked context menu.

3.In the invoked Query Designer window, drag the Products item from the list of available tables on the
left and drop it onto the list of data tables to be used.

Enable the check box for the Products table, to include all of its fields in the view.

4.By default, the tables that are added to the query are joined. To create a master-detail relation
between the Categories and Products tables, click the ellipsis for the Join/Relation Condition in the
Products table.
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In the invoked Condition Editor dialog, set the Action type to Master-detail relation and click OK to
exit the dialog.

Next, click OK in the Query Designer to apply all changes to the document data source and exit.

The content of the Data Explorer will be updated to reflect the new structure of the document data
source.
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Filter Data

This document describes how to filter dynamic data within a Snap document.

The document consists of the following sections.

Filter Data on the Design Surface

Filter Data at the Data Source Level

Filter Snap List Data

Filter Mail Merge Document Data

Filter Data on the Design Surface

To improve performance, the Snap Design Surface displays only the first 20 data rows while the document layout
is being designed. To change the number of data rows displayed, specify the Editor Row Limit option, which is
located in the List tab of the main toolbar.

This setting does not affect the final document.

Filter Data at the Data Source Level

Filtering data at the data source level is useful when dealing with large data sources because it reduces data
retrieval time, and thus speeds up document generation.

To filter data at the data source level, use the Query Designer.

Filter Snap List Data

To select which data records to include in the document, click the Quick Filter command in the Field tab of the
contextual Data Tools toolbar category. In the invoked drop-down menu, select the required records and click OK
to apply the filtering.
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To specify the filtering criteria for Snap list data, do the following.

1.Place the text cursor inside the Snap list that you wish to filter and click the Filter command in the List
tab of the contextual Data Tools toolbar category.

2.In the invoked FilterString Editor, construct the required filter expression and click OK to apply the
filtering.
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Filter Mail Merge Document Data

Filtering a mail merge document defines which data entries will appear as pages of the final document.

To filter a mail merge document, do the following.

1.Switch to the Mail Merge tab of the contextual Data Tools toolbar category, and click the Filter
command.

2.In the invoked FilterString Editor, construct the required expression and click OK to apply the filtering.
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3.To view the result, click the Finish & Merge button in the Mail Merge tab of the contextual Data Tools
toolbar category, and select Print Preview... in the drop-down menu. In the invoked Export Range
dialog, select All records and click OK.

The following image illustrates a print preview for a filtered mail merge document.
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Format Data

This document describes how to format dynamic textual data in a Snap document.

To format report data, do the following.

1.Select the Snap field that you wish to format. It must be a field displaying textual information (e.g., a
Text field or a Row Index field). This will activate the Field tab in the contextual Data Tools toolbar
category.

2.In the Field tab, click the Properties button.

3.In the invoked drop-down menu, click the ellipsis button for the Format String property.

4.Specify the required formatting in the invoked FormatString Editor, and click OK to exit the dialog.

Snap supports both standard and custom .NET format strings.

http://msdn.microsoft.com/en-us/library/ee372286.aspx
http://msdn.microsoft.com/en-us/library/ee372287.aspx
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Group Data

This document describes how to group data in a Snap document.

To group dynamic data within a Snap list, select the field that you wish to group. This automatically activates the
contextual Data Tools: Field tab in the main toolbar. In this tab, click the Group By Field button.

The Snap list will be updated to reflect the applied grouping.

A group header and a group footer are automatically created for the new grouping. By default, the group header
displays the value of the field by which to group, and the group footer displays the total count of entries in the
group (evaluated by the Count summary function).

To add or remove group headers and footers, use the corresponding commands in the Group tab of the main
toolbar.

The following image illustrates a Snap list with grouping applied.
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All groupings added to a report are displayed in the Report Explorer as child nodes of the Snap list to which they
are applied.
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Sort Data

This document describes how to sort dynamic data within a Snap document.

The document consists of the following sections.

Sort Snap List Data

Sort Mail Merge Document Data

Sort Snap List Data

To apply sorting to a Snap list, do the following.

1.Select the Snap field that you wish to use as filter criteria. The field must be located inside a Snap list.
This automatically activates the contextual Field tab in the main toolbar.

2.In the Field tab, click the Sort Ascending or Sort Descending button, depending on the required sort
order. The Snap list will automatically be updated to reflect the sorting applied.

Sort commands are also available in the context menu.

You can specify multiple sort criteria for a Snap list. In this case, sort levels are applied in the order that they are
added.

Sort Mail Merge Document Data
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Sorting a mail merge document defines the order in which data entries will appear as pages of the final
document.

To sort a mail merge document, do the following.

1.Switch to the Mail Merge tab of the main toolbar and click the Sort command.

2.Click the Add Level button in the invoked Sort dialog. Specify the sort criteria and sort order for the
additional sort level.

To change the order in which sort levels are applied to the document, use the arrow buttons.
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Click OK to exit the dialog.

3.To view the result, click the Finish & Merge button in the Mail Merge tab of the main toolbar, and
select Print Preview... in the invoked drop-down menu. In the invoked Export Range dialog, select All
records and click OK.

The following image demonstrates a print preview for a sorted mail merge document.
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Pass Parameter Values

This document describes the main concepts for using parameters in Snap, and provides examples of their use in
various tasks.

The document consists of the following sections.

Create Parameters

Pass Parameter Values

Create Parameters

You can manage the report parameters available for a Snap document using the Parameters dialog.

To invoke the Parameters dialog, right-click the Parameters node (or any of its sub-nodes) in the Data Explorer
and select EditParameters in the invoked drop-down menu.

To invoke the Parameters dialog for a data source being edited with the Query Designer, click the Parameters
button.

The Parameters dialog allows you to add and remove parameters using the corresponding buttons. Alternatively,
you can add or remove a parameter by right-clicking the parameter in the Data Explorer and selecting the
required action in the invoked drop-down menu.



Snap Reporting Engine 812

© 2014 DevExpress Inc. 812

Select the newly added parameter and specify its properties in the properties grid. Be sure to specify the proper
parameter type based on the parameter's intended use.

Pass Parameter Values

After a parameter is created, it can be used in different ways during report generation. Below is a list of tasks that
can be accomplished using parameters.

Data Binding

To display a parameter's value in a report, drag the parameter from the Field List and drop it onto the 
Design Surface.

Filtering

You can use a report parameter as part of a filtering expression to filter the Snap document data at either
the report level or the data source level.

To filter the Snap document data at the data source level, do the following.

.1.Invoke the Query Designer for the data source that you wish to filter.

.2.In the Query Designer, click the Filter button to invoke the Filter Editor.
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.3.In the Filter Editor, construct an expression where the parameter's value is used as a filtering
criterion. To access the parameter, click the icon on the right. It will turn into a question mark.

Click OK to exit the dialog.

The SQL query generated by the query designer will be updated to reflect the specified filtering.
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In a similar way, you can use the Filter Editor to filter the Snap document data at the report level. In this
case, to invoke the Filter Editor, click the Filter button that resides on the List tab of the contextual Data
Tools toolbar category.

Calculated Fields

In addition to standard data fields, parameters can be used in expressions for calculated fields. The only
difference is that the data field is inserted into the expression's text using its name in [square brackets],
while a parameter is inserted using the "Parameters." prefix before its name.
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Use Calculated Fields

This document describes how to use calculated fields to evaluate custom expressions based on external data,
and embed the results into a Snap document.

Use calculated fields to perform additional calculations on dynamic data and embed the results into a published
document.

To create a calculated field and access its collection, invoke the context menu in the Data Explorer.

A calculated field's expression can include conditional, date-time, mathematical and other formulas. It can also
evaluate the values of other calculated fields, data source fields and parameters.
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The Expression Editor is invoked by right-clicking a calculated field and choosing the Edit Expression item in the
invoked popup menu.

After a calculated field is inserted into a document, its value is evaluated each time the document is set to be
published.
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Use the Query Designer

This topic describes how to use the Query Designer to manage data tables and their relations in a Snap data
model (e.g., to create master-detail data sources), filter incoming data and specify a custom SQL string.

The Query Designer displays the structure of a connected data source along with its associated Snap data model.
When designing a report, this data model is reflected in the Data Explorer.

This topic includes the following sections.

Run the Query Designer

Manage Data Tables and their Relations

Shape Data

Run the Query Designer

An option to invoke the Query Designer is provided on the last page of the Create Data Source wizard . The
Create Data Source wizard is invoked at connecting a Snap document to a Data Source. Select the "Open Query
Designer after closing the wizard" option before clicking Finish.

Alternatively, you can run the Query Designer by right-clicking a data source in the Data Explorer and clicking Edit
Data Source in the invoked menu.
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Manage Data Tables and their Relations

To modify a relation assigned to a specific table, click its corresponding ellipsis button in the Snap data source
editor.

This invokes the Condition Editor, which allows you to include other tables in the new data relation and select the
relation type (Inner join, Left outer join or Master-detail relation).
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The Condition Editor is automatically invoked after adding a new table to a Snap data model.

The Query Designer highlights the tables of an external data source that is related to the tables of a Snap data
model by one or more primary keys.

To maintain the visibility of data columns in the Data Explorer, use the corresponding check boxes in a specific
table's column list.
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In this list, the primary key columns display a 'plus' button, which invokes a list of related tables. Clicking a table in
this list adds it to the Snap data source.

A Snap data source corresponds to an SQL query that is executed each time external data is supplied from a
database.

To manually customize an SQL string, enable the Allow SQL Editing option. Switching to this mode disables the
visual features of the Query Designer in favor of the specified SQL string value.
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Shape Data

To assign a custom name to the selected data column, specify its Alias in the column list displayed under the Snap
data source editor.

To specify the filter criteria that is applied to incoming data, click the Filter button, which invokes the FilterString
Editor.



Snap Reporting Engine 823

© 2014 DevExpress Inc. 823

Create a Report Layout

Topics in this section provide information on creating reports with different layouts in Snap.

Create a Mail-Merge Report

Create a Master-Detail Report

Create a Table Report

Create a Multi-Column Report

Create a Side-by-Side Report

Create a Parameterized Report

Create a Chart-Based Report

Create a Combined Report Layout
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Create a Mail-Merge Report

This tutorial illustrates the steps required to create and publish a mail merge report with Snap.

The tutorial contains following sections.

Add Dynamic Content

Preview and Publish the Document

Add Dynamic Content

To create a Snap report using a document template, do the following.

1.Add a new Snap document and provide it with a master-detail data connection.

2.Next, specify which data source will be used for mail merge. To do this, click the Data Source button on
the Data Tools: Mail Merge tab and select the required data source in the invoked drop-down list.

Alternatively, right-click the required data source in the Data Explorer and select Use For Mail Merge in
the invoked drop-down menu.

3.To insert data bound fields into the document, drag-and-drop data fields from the Data Explorer onto
the Design Surface.
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Activate the Highlight Fields option from the View tab of the main toolbar to highlight all mail merge
fields in a document. This allows you to easily distinguish between dynamic and static content.
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4.To insert a detail report section, drag-and-drop fields from a subordinate node of the data source. Fields
of a nested level of a mail-merge data source are inserted into a template as columns of a table.

Preview and Publish the Document

The Snap mail merge document is now ready. To view the result, click the Finish & Merge button in the Mail
Merge tab, and select Print Preview... in the invoked drop-down menu. In the invoked Export Range dialog,
select All records and click OK.

The following image illustrates a print preview for the final document.
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Create a Master-Detail Report

This document will guide you through the process of creating a master-detail report. Reports of this type are built
upon hierarchical data sources, so to be able to create a master-detail report, you need to provide a report data
source with a master-detail relation.

To get started with this tutorial, create a new Snap document and add a master-detail relation to it.

Perform the following steps to create a master-detail report.

1.Create a master report. To do this, drag-and-drop data fields of the master data table from the Data
Explorer to the design surface. You can use any type of layout.

2.To create a detail report, drag-and-drop data fields of the detail data table from the Data Explorer onto
the lower border of the master report's data row, as shown in the image below.

3.The master-detail report is now ready. Click the Print Preview button in the General Tools: File tab of
the main toolbar to view the preview.
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Create a Table Report

This tutorial will guide you through the process of creating a Table Report, and printing and saving it to your hard
drive.

The table report is a data-aware Snap report with a tabular master-detail layout.

To get started with this tutorial, create a new Snap document and provide a hierarchical data source for it, as
described in the Create a Master-Detail Data Source topic.

To create a master-detail Snap document layout, do the following.

1.Create a simple tabular report by selecting the data fields that you wish to include in the report in the 
Data Explorer and dragging them to the Design Surface. When you drop data fields onto the empty
space in the document body, they are added as columns of a table. You can select multiple data fields
by pressing CTRL or SHIFT.

To improve performance, Snap shows only the first 20 data rows of a Snap list by default. To change
this setting, use the Editor Row Limit option, which is located on the List tab of the main toolbar.

2.To convert the layout of a Snap list to a paragraph presentation, select the Snap list you wish to convert
and click the Convert to Paragraphs command in the List tab of the contextual Data Tools toolbar
category. Note that there is no reverse action allowing you to convert a Snap list back to the tabbed
form.

The report should now appear as shown in the following image.
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To remove a list header, select the Snap list, click the Header command in the List tab of the main
toolbar, and select Remove Header in the invoked drop-down menu.

3.To create a detail report, drag data fields from the child data table in the Data Explorer onto the lower
border of the master report's data row, as shown in the image below.

The added detail part will have a tabular form by default.
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4.To preview your Snap document click the Print Preview button in the General Tools: File tab of the main
toolbar.
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Create a Multi-Column Report

This tutorial guides you through the creation of a Multi-Column Report. A multi-column report is a report which
represents its data in multiple columns or rows (depending upon the current multi-column settings).

To create a multi-column report, do the following.

1.In a new Snap document, create a simple table report, as described in the Create a Table Report topic.

2.In the main toolbar, switch to the General Tools: Page Layout tab, click Columns, and select the
required number of columns in the drop-down menu.

To define more than three columns, click More Columns. In the invoked Columns dialog, customize the
report layout to meet your requirements.

The following image illustrates the result.
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Create a Side-by-Side Report

This tutorial describes the steps used to create a side-by-side report to compare different items within the report.

Follow these steps to create a side-by-side report.

1.Create a new Snap document and bind it to the required table as described in the Connect a Document
to a Data Source topic.

2.To add a new table to the report, switch to the Insert tab in the main toolbar and click Table. Then,
move the cursor over the grid to select the required number of rows and columns.

You can set table borders by clicking the Borders button on the Design tab.

3.Then, drop the fields that will be compared from the Data Explorer on the table's corresponding
columns.
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4.To filter each table column so that it shows only a single record, select a field on the left column and in
the activated Field tab in the main toolbar, click Quick Filter. In the invoked menu, select the required
field and click OK.

Finally, repeat the same procedure for the right column, so that it displays a different field to compare it
with.
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Create a Parameterized Report

This tutorial illustrates the steps required to create a parameterized report. In this tutorial, we will create a
parameter and pass it to the report's filtering expression. You are not limited by the number of parameters you
can create, or the data type (e.g., s tring, date-tim e, Boolean, in teger and double). Parameters can be used in other
ways such as data binding and calculated fields. Tasks that can be solved using parameters are described in the
Pass Parameter Values topic.

Follow these steps to create a report with parameters.

1.Create a new Snap document and bind it to the required table.

2.To create a layout for your report, drop the required data fields from the Data Explorer to the Design
Surface.

3.To create a parameter, switch to the Data Explorer window, right-click the Parameters section and
choose Add Parameter.
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Alternatively, you can create report parameters when editing a data source using the Query Designer.

4.Right-click the created parameter and select the Edit Parameters... action in the invoked popup menu.

5.In the invoked editor, define the parameter name and assign an appropriate type to it. This type
corresponds to the value that a parameter can receive (e.g., you cannot assign a string value to a
numeric parameter).

Next, assign a default static value to the parameter.

If required, you can easily modify the parameter value in the same way described in steps 4 and 5.

6.Now, switch to the List tab in the main toolbar and click the Filter button.

In the invoked FilterString editor, define a filtering expression (e.g., UnitPrice data field is greater than
or equal to the Starting Price parameter).

To access the parameter, click the icon on the right until it turns into a question mark, and then select
your parameter from the drop-down list.
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The parameterized report is now ready, and its data is filtered based on the specified expression that uses the
parameter value to shape the report's data.

To view how your report will look on paper, switch to the File tab in the main toolbar and click the Print Preview
button.
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Create a Chart-Based Report

This tutorial describes the steps used to add a chart to your Snap report. Snap supports many chart types, as well
as multiple visual appearance settings and chart palettes.

Snap also provides the Chart Wizard, which allows you to quickly create and customize complex charts. However,
when advanced charting functionality is not required, Snap provides an even easier way to create and customize
your charts.

Do the following steps to create a chart-based report.

1.Create a new Snap document and bind it to the required table.

2.Click the Chart command in the Insert tab of the main toolbar.

3.In the created chart, the blue circles correspond to the values and arguments of the chart. Drop one
field from the Data Explorer onto the "values" region in the chart...

...and the other onto the "arguments" region.
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4.You can change the default chart type to one that best meets your requirements by selecting the chart
and switching to the Design tab of the main toolbar.

In the same tab, you can also run Chart Wizard and select the chart's palette and visual appearance.

5.The Snap report with a chart is now ready. To view the result, switch to the File menu of the main
toolbar and click the Print Preview button.
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Create a Combined Report Layout

Snap allows you to create a single combined report, incorporating features of different report layout types. There
is no limits on how many reports you can combine.

In this tutorial, we will create a combined report that uses the features of mail-merge and chart-based reports.

The tutorial consists of the following sections.

Add Mail-Merge Report Functionality

Add Chart-Based Report Functionality

View the Result

Add Mail-Merge Report Functionality

In this section, we will create a simple Mail-Merge Report.

1.Create a new Snap document and provide it with a master-detail data connection.

2.Specify which data source will be used for mail merge by right-clicking the required data source in the 
Data Explorer and select Use For Mail Merge in the invoked drop-down menu.

3.Insert a master report part. To do this, drag-and-drop data fields from the Data Explorer onto the
Design Surface.

4.To insert a detail report part, drag-and-drop fields from a subordinate node of the data source.
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The added detail part will have a tabular form by default.

For more information on the creation mail-merge report, see the tutorial Create a Mail-Merge Report.

Add Chart-Based Report Functionality

In this section we will add a Chart to the Snap document.

1.Click the Chart command in the Insert tab of the main toolbar.

2.In the created chart, the blue circles correspond to the values and arguments of the chart. Drop one



Snap Reporting Engine 848

© 2014 DevExpress Inc. 848

field from a subordinate node of the data source onto the "values" region in the chart...

...and the other onto the "arguments" region.

For more information on the creation of a chart-based report, see the tutorial Create a Chart-Based Report.

View the Result

The Snap mail merge document is now ready. To view the result, click the Finish & Merge button in the Mail Merge
tab, and select Print Preview... in the invoked drop-down menu. In the invoked Export Range dialog, select All
records and click OK.
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The following image illustrates a print preview for the final document.
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Manage Documents and Files

The tutorials in this section will assist you in solving the most elementary and essential tasks that relate to
managing and storing Snap documents.

This section includes the following tutorials.

Create a New Report

Save a Report

Open an Existing Report

Third-Party Document Compatibility

Export a Report
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Create a New Report

To create a new Snap report, click the New button in the File tab of the Snap application's ribbon toolbar.

A new Snap report will be created and opened in the editor.
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Save a Report

To save a report to a file, click the Save button in the File tab of the Snap application's ribbon toolbar.

If you are saving a new report, the Save As dialog will be invoked. In the invoked dialog, specify the name and
directory for the new report file and click Save.

To save a changed copy of an existing report to a separate file, click the Save As button in the File tab of the
ribbon toolbar.
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Storing Reports

This document explains the basic principles of storing report documents.

Snap provides the capability to store a report to a file and restore it. You can store the report in the following
formats (.epub, .snx, .doc, .docx, .xml, .odt, .mht, .htm, .html, .txt, .rtf, .pdf). For more information about the
methods that you can use for saving, loading, and exporting reports, see How to: Save, Load, or Export a Report.
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Open an Existing Report

To open an existing report, click the Open button in the File tab of the Snap application's ribbon toolbar.

In the invoked Open dialog, select a file and click Open.
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Export a Report

In addition to native .snx file format, Snap allows you to export reports into the one of the wide variety of third-
party formats, (e.g., PDF, HTML or DOCX).

To export a Snap report in a third-party format, do the following.

1.Click the Export Document button in the File tab of the Snap application's ribbon toolbar.

2.In the invoked Save As dialog, select a directory in which you want to save, specify the name and
format of the exported file, and click Save to export the report and exit the dialog.
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Spreadsheet

This section describes the capabilities provided by the Spreadsheet.

Spreadsheet UI

Ribbon Interface

Spreadsheet Elements

File Operations

Create a Workbook

Load a Workbook

Create a Worksheet

Rename a Worksheet

Delete a Worksheet

Save a Workbook

Import and Export Text Files

Print a Workbook

Adjust Page Settings

Undo and Redo Last Actions
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Viewing and Navigating

Hide and Display Worksheets

Zoom a Worksheet

Hide Gridlines and Headings

Freeze Columns and Rows

Editing Cells

Select Cells or Cell Content

Copy and Paste Cell Content

Fill Data Automatically

Find and Replace

Insert a Comment

Insert a Symbol

Cell Formatting

Format Cells

Format Cell Content

Wrap Text and Merge Cells

Number Formatting

Conditional Formatting

Clear Cell Formatting

Columns and Rows

Insert and Delete Columns and Rows

Show and Hide Columns and Rows

Specify Column Width and Row Height

Tables

Create a Table

Data Presentation

Outline Data

Subtotal Data

Sort Data

Filter Data

Formulas

Create a Simple Formula

Using Cell References and Defined Names in Formulas

Using Functions in Formulas

Supported Functions

Create an Array Formula

Error Types in Formulas

Charting

Charting Overview

Creating a Chart

Changing a Chart Type

Applying a Predefined Chart Layout and Style

Modifying a Chart Manually
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Mail Merge

Mail Merge Overview

Data Source Wizard

Query Designer

Parameters Panel

Pictures and Hyperlinks

Insert a Picture

Move, Rotate and Resize a Picture

Insert and Delete Hyperlinks

Shortcuts to Work with Pictures

Keyboard Shortcuts

File Operations

Navigation through Worksheets

Work with Selections

Copy, Paste and Edit the Cell Content

Cell Formatting

Work with Columns and Rows

Work with Formulas
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Spreadsheet UI

Ribbon Interface

The comprehensive functionality of the Spreadsheet is provided by a set of Ribbon pages. Ribbon pages are
divided into logical groups that include commands with common features. Use the Ribbon interface to perform
basic operations in the Spreadsheet (to create a workbook, create or delete worksheets, select data in a
worksheet, navigate through a worksheet, etc.).

Ribbon Tab Name Visual Appearance Functionality

File Create a Workbook

Load a Workbook

Save a Workbook

Print a Workbook

Undo and Redo Last Actions

Home Copy and Paste Cell Content

Format Cells

Format Cell Content

Wrap Text and Merge Cells

Number Formatting

Conditional Formatting

Clear Cell Formatting

Insert and Delete Columns and
Rows

Show and Hide Columns and Rows

Specify Column Width and Row
Height

Fill Data Automatically

Find and Replace

Insert Create a Table

Insert a Picture

Move, Rotate and Resize a Picture

Insert and Delete Hyperlinks

Charting Overview

Creating a Chart

Changing a Chart Type

Applying a Predefined Chart Layout
and Style

Modifying a Chart Manually

Insert a Symbol

Page Layout Adjust Page Settings

Formulas Create a Simple Formula

Using Cell References and Defined
Names in Formulas

Using Functions in Formulas

Supported Functions
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Create an Array Formula

Error Types in Formulas

Data Sort Data

Filter Data

Outline Data

Subtotal Data

Review Insert a Comment

Protect a Workbook

Protect a Worksheet

Protect Worksheet Ranges

View Zoom a Worksheet

Hide Gridlines and Headings

Freeze Columns and Rows

Mail Merge Mail Merge Overview

Data Source Wizard

Query Designer

Parameters Panel
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Spreadsheet Elements

The Spreadsheet consists of visual elements that provide the capability to create, edit and view spreadsheet
documents, which are called workbooks. A workbook includes one or more worksheets used to store data. You
can add, delete and rename worksheets in a workbook. All existing worksheets are displayed on the Sheet tab
bar at the bottom of the control. Click one of the sheet tabs to switch between existing worksheets. To navigate
through the current worksheet, use the horizontal and vertical scrollbars.

A worksheet consists of cells that are organized into 1,048,576 rows and 16,384 columns. Each row is numbered
(1, 2, 3, ...) and each column is lettered (A, B, C, ...) if the A1 reference style is used, or numbered (1, 2, 3, ...) if
the R1C1 reference style is specified. Row and column headings are displayed at the left and at the top of a
worksheet, respectively.

An individual cell is a box at the intersection of a column and a row. Each cell is indicated by a cell reference, (the
column letter and row number where the column and row intersect). For example, B2 refers to a cell at the
intersection of column B and row 2. The cell reference is displayed in the Name Box, located at the top-left corner
of a worksheet. The current cell that is selected and used to enter data is called the active cell. The active cell is
identified by a blue border around the cell.

Each cell contains a single piece of data, the cell value. You can enter different types of values such as text,
numbers or dates. The Spreadsheet also provides the capability to create and edit formulas that perform
calculations on the data on a worksheet. To enter a formula, you can use the Formula Bar at the top of a
worksheet. If a cell does not contain a formula, the cell content is displayed in the Formula Bar.

Context Menu

The Spreadsheet supports a Context Menu, which appears when you right-click a worksheet. The context menu
provides common commands for working with cell content.
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File Operations

Create a Workbook

To create a blank workbook, select the File tab, and click the New button in the Common group (or press
CTRL+N).
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Load a Workbook

To load a workbook, select the File tab, and click the Open button in the Common group (or press CTRL+O).

In the invoked Open dialog box, select the file you wish to open.

The Spreadsheet supports the following file formats.

Excel Workbook (*.xlsx)

Excel Macro-Enabled Workbook (*.xlsm)

Excel 97-2003 Workbook (*.xls)

Tab-delimited Text File format (*.txt)

Comma-separated Values File format (*.csv)
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Create a Worksheet

To create a new worksheet within the current workbook, do one of the following.

Click the New Sheet button (which looks like a plus sign) at the right edge of the Sheet tab bar.

To insert a worksheet in front of the existing worksheet, got to the Home tab, and then in the Cells
group, click the Insert button and select the Insert Sheet item from the drop-down list or press
SHIFT+F11.

On the Sheet tab bar, right-click the sheet tab of the existing worksheet and select the Insert item from
the invoked menu.
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Rename a Worksheet

When a new worksheet is created, the Spreadsheet assigns it a generic name, such as Sheet1, Sheet2, etc.

To rename a worksheet, double-click its sheet tab on the Sheet tab bar to invoke the Rename Sheet dialog box,
or ...

... right-click the sheet tab of the worksheet and select the Rename item from the invoked menu. Rename the
worksheet and click OK.

The Spreadsheet sets the following rules for a valid worksheet name.

The maximum length of a worksheet name is 31 characters.

A worksheet name must not be an empty string.

A worksheet name must not include the following characters: \ , /, ?, :, *, [, ].

A worksheet name must not start or end with a single quote.

A worksheet name must not be equal to a name of another existing worksheet.
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Delete a Worksheet

To delete an existing worksheet, follow the instructions below.

1.Switch to the worksheet you want to delete.

2.Do one of the following.

On the Home tab, in the Cells group, click the Delete button and select the Delete Sheet item from
the drop-down list.

Right-click the sheet tab of the worksheet, and then click the Delete item from the context menu.
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Save a Workbook

To save a workbook, go to the File tab, and then click the Save as button in the Common group, or press F12
instead of these steps.

After that, the Save as dialog box is invoked.

Specify the location and the file format in which to save the workbook.

The available file formats in the Save as dialog box are the following.

Excel Workbook (*.xlsx)

Excel Macro-Enabled Workbook (*.xlsm)

Excel 97-2003 Workbook (*.xls)

Tab-delimited Text File format (*.txt)

Comma-separated Values File format (*.csv)

To save the active workbook with its current file format and location, go to the File tab, and then click the Save
button in the Common group, or press CTRL+S instead. If you click the Save button to save a newly created
workbook, the Save as dialog is invoked.
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Import and Export Text Files

The Spreadsheet provides the capability to save a workbook as a text file (.txt or .csv) or load data from text files.

Save a Workbook as a Text File

1.To save a workbook as a text file, go to the File tab, and in the Common group, click the Save As
button.

2.In the Save As dialog box that is invoked, select the Text (Tab-delimited) or CSV (Comma-delimited)
item from the Save as type drop-down list.

The main features of the tab-delimited and comma-delimited file formats are described below.

Tab-delimited text files

This file format uses the TAB character to separate each field of text. Note that the Spreadsheet only
saves the active worksheet as a text (.txt) file. The columns are separated by the tab characters and
each row ends with a carriage return character. The values and text in cells are saved as they are
displayed in a worksheet. If a cell contains a comma, the cell contents are enclosed in double quotation
marks. All formatting options applied to the cell, pictures and objects (such as hyperlinks) are lost.

Comma-delimited text files

This file format uses the com m a character to separate each field of text. Note that the Spreadsheet only
saves the active worksheet as a CSV (.csv) file. Columns are separated by commas, and each row ends
with a carriage return character. Cell text and values are saved as they are displayed in a worksheet. If a
cell contains a comma, cell contents are enclosed in double quotation marks. All formatting options applied
to the cell, pictures and objects (such as hyperlinks) are lost.
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Load Data from Text Files

1.To load data from text files (.txt or .csv), go to the File tab, and in the Common group, click the Open
button.

2.In the Open dialog box that is invoked, locate the text file you wish to open and click Open.
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Print a Workbook

Preview a Workbook Before Printing

To view your workbook as it will be printed, select the File tab and click the Print Preview button in the Common
group.

At the bottom of the Preview window, the Spreadsheet indicates how many pages the workbook will require
when printed, and the number of the page you are currently viewing.
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Print a Workbook

To print a document, click the Print button in the Common group or press CTRL+P.
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In the invoked Print dialog box, specify the required settings and click Print.

Print a Workbook Using the Default Settings

To send a workbook directly to the default printer without setting print options, click the Quick Print button in the
Common group.
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Adjust Page Settings

Before you print a worksheet, you can change page layout settings such as page margins, page orientation and
paper size.

Set Page Margins

1.Click a worksheet for which you wish to set the page margins.

2.In the Page Setup group within the Page Layout tab, click the Margins button and select the margin
sizes to be set for the current worksheet.

Set Page Orientation

1.Click a worksheet for which you wish to specify page orientation.

2.In the Page Setup group within the Page Layout tab, click the Orientation button and select Portrait or
Landscape from the invoked drop-down list.

Change Paper Size

1.Click a worksheet for which you wish to set the paper size.

2.In the Page Setup group within the Page Layout tab, click the Size button and select one of the
predefined paper sizes from the invoked drop-down list.



Spreadsheet 876

© 2014 DevExpress Inc. 876



Spreadsheet 877

© 2014 DevExpress Inc. 877

Undo and Redo Last Actions

The Spreadsheet allows you to undo or redo your last performed action.

To undo an action, select the File tab, and click the Undo button in the Common group (or press CTRL+Z or
ALT+BACKSPACE).

To redo an action that you undid, click the Redo button in the Common group (or press CTRL+Y or
ALT+SHIFT+BACKSPACE).
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Viewing and Navigating

Hide and Display Worksheets

The Spreadsheet provides the capability to hide worksheets in a workbook. It can be useful if you want to remove
a worksheet from the Sheet tab bar without deleting it. By default, all worksheets are displayed on the Sheet tab
bar.

Hide Worksheets

1.Switch to a worksheet you want to hide. To hide multiple worksheets, hold down CTRL and then click
the sheet tabs of the worksheets you wish to hide on the Sheet tab bar.

2.Do one of the following:

On the Home tab, in the Cells group, click the Format button and select Hide & Unhide | Hide Sheet.
Note that this command is disabled when a workbook includes only one worksheet;

Right-click the selected sheet tabs and select the Hide item from the context menu.

Display Hidden Worksheets

1.Do one of the following:

On the Home tab, in the Cells group, click the Format button and select Hide & Unhide | Unhide
Sheet...;

Right-click any visible sheet tab, and select the Unhide item from the context menu.



Spreadsheet 879

© 2014 DevExpress Inc. 879

2.In the Unhide dialog box that is invoked, select the name of the worksheet you want to display and
click OK. Note that you can hide multiple worksheets at once, but you can display only one worksheet at
a time.



Spreadsheet 880

© 2014 DevExpress Inc. 880

Zoom a Worksheet

To zoom in or out of a worksheet, do one of the following:

In the Zoom group within the View tab, click the Zoom In or the Zoom Out button. Click the Zoom 100%
button to restore the worksheet to normal size;

Hold the CTRL button and rotate your mouse wheel.
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Hide Gridlines and Headings

The Spreadsheet allows you to hide gridlines and headings that are displayed on a worksheet by default.

In the Show group within the View tab, uncheck the Gridlines check box to hide gridlines on a worksheet.

To hide the column and row headers, uncheck the Headings check box.

To display gridlines and headers, select the Gridlines and Headings check boxes, respectively.
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Freeze Columns and Rows

To keep specific columns and rows of the worksheet visible while scrolling through the rest of the worksheet, lock
them in place using the Freeze Panes options of the Spreadsheet.

To freeze specific row(s) or column(s), follow the instructions below.

1.Depending on what you wish to freeze, do one of the following.

To lock a row(s), select the row below the row(s) you wish to freeze.

To lock a column(s), select the column to the right of the column(s) you wish to freeze.

To lock a row(s) and column(s) simultaneously, click the cell below the row(s) and to the right of the
column(s) you wish to freeze.

2.In the Window group within the View tab, click the Freeze Panes button's drop-down.

Select one of the following.

Freeze Panes - lock multiple columns and/or multiple rows simultaneously.

Freeze Top Row - lock the first row only.

Freeze First Column - lock the left column only.

A black border appears beneath the frozen row(s) and to the right of the frozen column(s).

3.To unfreeze a row(s) or column(s), click the Unfreeze Panes item from the Freeze Panes button's drop-
down list. This unlocks all frozen rows and columns in the worksheet.
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Editing Cells

Select Cells or Cell Content

Selecting Cells

To select cells in the Spreadsheet, use the following mouse actions and keyboard shortcuts.

1.To select a single cell, click the cell or press the arrow keys to move to the required cell.

2.To select a range of cells, do one of the following.

Click the first cell in the range and drag it to the last cell.

Hold down the SHIFT key, and then press the arrow keys to extend the selection.

Click the first cell in the range, hold down the SHIFT key, and then click the last cell in the range.

3.To select the entire worksheet, click the Select All button at the intersection of the column and row
headings, or press CTRL+A.

4.To select nonadjacent cells, hold down the CTRL key, and then select other cells.

5.To select an entire row or column, click the row or column heading.

6.To select multiple columns or rows, drag across the row or column headings.

7.To select several nonadjacent rows or columns, click the heading of the first row or column in the
selection, hold down CTRL, and then click the headings of other rows or columns you wish to select.

The following table lists the default keyboard shortcuts used for selecting cells in the Spreadsheet.

CTRL+RIGHT ARROW Selects the last cell in a row.

CTRL+LEFT ARROW Selects the first cell in a row.

CTRL+DOWN ARROW Selects the last cell in a column.

CTRL+UP ARROW Selects the first cell in a column.

CTRL+HOME Selects the first cell on a worksheet.
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CTRL+END Selects the last cell that contains data or formatting
on a worksheet.

CTRL+A Selects the entire worksheet.

CTRL+SHIFT+END Extends the selection to the last used cell on a
worksheet.

CTRL+SHIFT+HOME Extends the selection to the beginning of the
document.

Selecting Cell Content

To select the cell content, do one of the following:

Double-click the cell, and then drag across the cell content you wish to select.

Press F2, and then drag across the contents of the cell you wish to select, or press SHIFT+LEFT ARROW
to select the cell content.

Click the cell, and then drag across the cell content you wish to select in the Formula Bar.
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Copy and Paste Cell Content

The Spreadsheet allows you to copy and paste entire cells, or only their contents, using the Clipboard.

To move or copy cell content, follow the steps below.

1.Select the cells that you wish to move or copy.

2.In the Clipboard group within the Home tab, do one of the following.

To move the selected cells, click the Cut button (or press CTRL+X or SHIFT+DELETE).

To copy the selected cells, click the Copy button (or press CTRL+C or CTRL+INSERT).

3.Click the upper-left cell in the area where you wish to paste the copied cells.

4.In the Clipboard group within the Home tab , click the Paste button (or press CTRL+V or
SHIFT+INSERT).

To choose special options when you paste cells, in the Clipboard group within the Home tab, click the
Paste Special button (or press CTRL+ALT+V).
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In the invoked Paste Special dialog box, select one of the following options.

All - paste all cell content and formatting.

Formulas - only paste formulas, as entered in the Formula Bar.

Values - only paste cell values.

Formats - only paste cell formatting.

Comments - only paste the comments added to the cells.

All except borders - paste cell content and formatting without cell borders.

Column widths - paste the column widths of the copied cells to another range of columns.

Formulas and number formats - only paste formulas and number formatting options from the copied
cells.

Values and number formats - only paste values and number formatting options from the copied cells.

Skip blanks - avoid replacing values in the paste area when the copy area includes blank cells.



Spreadsheet 887

© 2014 DevExpress Inc. 887

Fill Data Automatically

The Spreadsheet provides the capability to fill adjacent cells with data automatically.

To fill a selected cell or a range of cells with the data contained in adjacent cells, do the following.

1.Select the cell (or range of cells) adjacent to the cell (or range of cells) of the data you wish to repeat.

2.In the Editing group within the Home tab, click the Fill button and select one of the following items from
the drop-down list.

Fill Down (or press CTRL+D) - pastes the contents of the cell that is above the selected cell, or
pastes the contents of the topmost cell in the selected range to the cells below.

Fill Up - pastes the contents of the cell below the selected cell, or pastes the contents of the
lowermost cell in the selected range to the cells above.

Fill Right (or press CTRL+R) - pastes the contents of the cell or cell range to the left of the selected
cell(s).

Fill Left - pastes the contents of the cell or cell range to the right of the selected cell(s).
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Find and Replace

The Spreadsheet allows you to search for specific data in the current worksheet. To perform a search, on the
Home tab, in the Editing group, click the Find & Select button. The button's drop-down menu will be displayed.

Next, do one of the following.

Click Find in the Find & Select drop-down menu (or press CTRL+F) to perform a search in the active
worksheet. The Find and Replace dialog (with the Find tab activated) will be invoked.

In the Find what field, enter the text or number you wish to find, and click the Find Next button to start
the search. To define the direction of the search, in the Search field, select the By Rows or By Columns
drop-down item. In the Look in field, select Values (to search cell values only) or Formulas (to search cell
values and formula expressions, excluding the calculated results). To perform a case-sensitive search,
select the Match Case check box. To restrict the search to the entire cell content, select the Match entire
cell contents check box.

Click Replace in the Find & Select drop-down menu (or press CTRL+H) to search for a text string and
optionally replace it with another value. The Find and Replace dialog (with the Replace tab activated) will
be invoked.
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To replace a value, enter the search term in the Find what field and the replacement text for this search
term in the Replace with field, and then click the Find Next button to find the first occurrence of the
search term. Next, click the Replace button to replace only the value of the selected matching cell, or
Replace All to replace all occurrences of the search term. Note that the Replace tab provides the same
search options as the Find tab, with one exception: you can only select the Formulas drop-down item in
the Look in box, so only the underlying formulas (not the calculated results) will be examined when
searching for matches to your search term.
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Insert a Comment

The Spreadsheet allows you to attach notes to individual cells by using comments. Comments are extremely
useful when you need to provide additional information, such as reminders, notifications, or feedback in a
document without modifying cell content.

Comments are displayed in a yellow box anchored to a cell. A cell containing a comment has a red triangular
indicator in the corner.

You can add new comments, edit existing comments, copy comments to other cells, move and resize the comment
box, hide or delete comments if they are no longer needed.

Add a Comment

To insert a new comment, select the cell where you wish to place the comment, and do one of the following.

On the Review tab, in the Comments group, click the New Comment button.

Right-click the cell and select the Insert Comment item in the context menu.
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Press SHIFT+F2.

The new comment will be anchored to the cell. Type the desired text within the comment box. By default, the
comment is accompanied by the user name of the person who created the comment. If you wish to change the
default name, delete it and type a new name.

Edit a Comment

1.Select the cell that contains the comment you wish to edit.

2.Do one of the following.

On the Review tab, in the Comments group, click the Edit Comment button...

... or right-click the cell and select the Edit Comment item in the context menu.

The comment will be activated and the cursor will be positioned within the comment box.
Change the comment text as needed.

Click inside the comment box, and start editing the comment text.

Tip

If the comment is hidden, click the Show/Hide Comment button to display the comment.

Copy Comments Only

1.Select the cell(s) containing the comment(s) you wish to copy.

2.On the Home tab, in the Clipboard group, click Copy, or press CTRL+C.

3.Select the top-left cell of the destination area where you wish to insert the copied comment(s).

4.On the Home tab, in the Clipboard group, click the Paste Special button, or press CTRL+ALT+V.

5.In the invoked Paste Special dialog, click Comments, and then click OK.
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Move and Resize a Comment

1.Select the cell that contains the comment you wish to move or resize.

Tip

If the comment is hidden, click the Show/Hide Comment button to display the comment.

2.Click the comment box border to display the sizing handles (small rectangles at the corners and sides of
the comment box).

3.Do one of the following.

To move a comment, hover the mouse over the comment border so that the four-way resize arrow
appears, and drag the comment to a new location.

To resize a comment, click one of the sizing handles and drag the edge of the comment box.

Display or Hide a Comment

1.Select the cell that contains the comment you wish to display or hide.

2.Do one of the following.

On the Review tab, in the Comments group, click the Show/Hide Comment button.
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Right-click the cell and select the Show/Hide Comment item in the context menu.

Remove a Comment

To delete the existing comment, do the following.

1.Select the cell that contains the comment you wish to delete.

2.Do one of the following.

On the Review tab, in the Comments group, click the Delete button.

Right-click the cell and select the Delete Comment item in the context menu.
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Insert a Symbol

The Spreadsheet allows you to insert symbols and special characters that are not on your keyboard, such as
ASCII characters, copyright symbols, trademark symbols, paragraph marks, etc.

To insert a symbol, follow the instructions below.

1.Move to the cell where you wish to insert a symbol.

2.On the Insert tab, in the Symbols group, click the Symbol button.

The Symbol dialog will be invoked.

3.Select the symbol you wish to insert and click Insert, or double-click the symbol.
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Cell Formatting

Format Cells

The Spreadsheet provides the capability to format cells and the data they contain. It includes many predefined
styles that you can use.

To format a cell or a range of cells, follow the instructions below.

Using Predefined Styles

1.Select the cells you wish to format.

2.In the Styles group within the Home tab, select the style that you wish to apply to the selected cells.

Applying Specific Formatting

If you are not satisfied with the predefined styles, specify your own formatting options.

1.Select the cells you wish to format.

2.To add borders to the selected cells, do one of the following.

In the Font group within the Home tab, click the Borders button's drop-down menu and select the
border type. This menu also allows you to select the line style and line color of borders.
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Click the Font dialog box launcher to invoke the Format Cells dialog box. Click the Border tab and
specify all required parameters. Then click OK.
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3.To set the background color of the selected cells, do one of the following.

In the Font group within the Home tab, click the Fill Color button's drop-down menu and select the
desired color.

Click the Font dialog box launcher, and in the invoked Format Cells dialog box, open the Fill tab.
Specify all required parameters and click OK.
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Format Cell Content

The Spreadsheet provides the capability to set font style, size, color and text alignment in a cell.

To format cell content, follow the steps below.

1.Select a cell or a cell range that you wish to format.

2.To change the font, use the Font group within the Home tab to specify the font family, size, style, color,
etc.

You can also modify cell font using the Font tab of the Format Cells dialog box. To invoke this dialog,
click the arrow in the bottom right corner of the Font group. In the Font tab, you can specify the
required font characteristics and apply them to the selected cells.

3.To position text within a cell so that it is centered, aligned to the left or aligned to the right, select the
appropriate alignment options in the Alignment group within the Home tab.
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To specify additional alignment options, click the arrow in the bottom right corner of the Alignment
group. The dialog box launcher invokes the Format Cells dialog. In the Alignment tab, specify all
required parameters and click OK to apply them to the selected cells.

4.To undo the formatting options you applied before, select the text. In the Editing group within the
Home tab, click the Clear drop-down and select the Clear Formats item.
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Wrap Text and Merge Cells

If text is too long to be displayed in a single cell, the Spreadsheet allows you to wrap the text to make it display
on multiple lines in the cell, or merge cells to combine two or more adjacent cells into a single larger/longer cell.

Merging Cells

To merge cells, follow the instructions below.

1.Select the cells that you wish to merge.

Note

Make sure that the data you wish to display in the merged cell is contained in the upper-left cell of the
selected range, because only the contents of this cell will remain in the merged cell. The data in the
other cells will be deleted.

2.In the Alignment group within the Home tab, click the Merge Cells button's drop-down arrow and
select one of the following items.

Merge & Center - merge the selected cells and center the text in a merged cell.

Merge Across - merge each row of the selected cell range into larger cells.

Merge Cells - merge the selected cells into a single cell.

3.If you change your mind and wish to split a merged cell, select this cell and click the Unmerge Cells item
in the Merge Cells button's drop-down menu. The data of the merged cell appears in the upper-left cell
of the range of split cells.

Wrapping Text in a Cell

To wrap text in a cell, do the following.

1.Select a cell or a range of cells containing the text you wish to wrap.

2.In the Alignment group within the Home tab, click the Wrap Text button. The text is displayed on
multiple lines within the cell.

3.To unwrap the text, click the Wrap Text button again. The text is displayed in the same way as it was
before the wrap option was applied.
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Number Formatting

The Spreadsheet allows you to format numbers in cells to make them easier to read and understand. For
example, you can display numbers as monetary values or dates. The default format for cell content is the General
style. Notice that number formatting does not change the value you enter, it only influences the way the number
is displayed in a cell. Number formatting options are available in the Number group within the Home tab.

Depending on the format you wish to apply, click one of the buttons in the Number group, such as Accounting
Number Format, Percent Style or Comma Style.

If you wish to set more formatting parameters, click the Number dialog box launcher to invoke the Format Cells
dialog box. Select the desired number format, and then specify formatting options in the right pane of the dialog
box.

You can use the following shortcuts to quickly apply the specified number format.

CTRL+SHIFT+1 Applies the Number format with two decimal places.
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CTRL+SHIFT+2 Applies the Time number format.

CTRL+SHIFT+3 Applies the Date format.

CTRL+SHIFT+4 Applies the Currency format.

CTRL+SHIFT+5 Applies the Percentage format.

CTRL+SHIFT+6 Applies the Scientific number format.
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Conditional Formatting

The Spreadsheet allows you to apply conditional formatting to a range of cells. Conditional formatting changes
the appearance of individual cells based on specific conditions. It helps to highlight critical information, or describe
trends within cells by using data bars, color scales and built-in icon sets. To create a conditional format, select the
cell range to which you wish to apply a conditional formatting rule. On the Home tab, in the Styles group, click
the Conditional Formatting button to display a drop-down list of available conditional formats. You can do one of
the following.

Format Cells that are Less than, Greater than or Equal to a Value

Format Cells that Contain Text or a Date

Format Unique or Duplicate Cells

Format Top or Bottom Ranked Values

Format Cells whose Values are Above or Below the Average

Format Cells Using Data Bars

Format Cells using Color Scales

Format Cells using Icon Sets

Clear Conditional Formatting Rules

Format Cells that are Less than, Greater than or Equal to a Value

To highlight cells whose values meet the criterion represented by a relational operator (=, <, >), do the following.

Select the cell range to which you wish to apply a conditional format.

On the Home tab, in the Styles group, select Conditional Formatting | Highlight Cells Rules, and then
select one of the following items: Greater Than..., Less Than..., Between... or Equal To...

In the invoked dialog, specify the threshold value, and select formatting options to be applied to cells that
meet the condition. Note that you can also use a formula to specify the threshold value. If you enter a
formula, start it with an equal sign (=). If a formula returns an error, formatting options will not be
applied.
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Format Cells that Contain Text or a Date

To highlight cells that contain the specified text string or time period, do the following:

Select the cell range to which you wish to apply a conditional format.

On the Home tab, in the Styles group, select Conditional Formatting | Highlight Cells Rules, and then
click Text that Contains... or A Date Occurring....

In the invoked dialog, specify the text string (if you selected Text that Contains...) or time period (if you
selected A Date Occurring...) to be highlighted, and select the formatting options to be applied to cells
that meet the condition.

Note that for the Text that Contains... rule you can also specify a formula that returns text. If you enter a
formula, start it with an equal sign (=). If a formula returns an error, formatting options will not be
applied.
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Format Unique or Duplicate Cells

To find unique or duplicate values in a range of cells, do the following:

Select the cell range to which you wish to apply a conditional format.

On the Home tab, in the Styles group, select Conditional Formatting | Highlight Cells Rules | Duplicate
Values...

In the invoked dialog, specify whether you wish to highlight unique or duplicate values, and select the
formatting options to be applied to cells that meet the condition.

Format Top or Bottom Ranked Values

To highlight only the top or bottom ranked values in a range of cells, do the following:

Select the cell range to which you wish to apply a conditional format.

On the Home tab, in the Styles group, select Conditional Formatting | Top/Bottom Rules, and then
select one of the following items: Top 10 Items..., Top 10%..., Bottom 10 Items... or Bottom 10%...
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In the invoked dialog, specify the number or percentage of the rank value (depending on the selected
rule), and select the formatting options to be applied to cells that meet the condition.

Format the Cells whose Values are Above or Below the Average

To highlight values that are above or below the average in a range of cells, do the following:

Select the cell range to which you wish to apply a conditional format.

On the Home tab, in the Styles group, select Conditional Formatting | Top/Bottom Rules, and then click
Above Average... or Below Average...
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In the invoked dialog, select the formatting options to be applied to cells that meet the condition.

Format Cells using Data Bars

The data bar conditional formatting rule draws a shaded bar in the background of each cell in the range to which
the rule is applied. The length of the data bar represents the cell value. A longer bar represents a higher value,
and a shorter bar represents a lower value. For example, the image below shows markup magnitude using solid
light-green data bars.

To apply a data bar conditional formatting rule, do the following:

On the Home tab, in the Styles group, choose Conditional Formatting | Data Bars, and then select the
desired color for a gradient or solid data bar.
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Format Cells using Color Scales

Color scales compare values using a gradation of two or three colors. The shade of the color represents higher,
middle and lower values in the cell range to which the rule is applied. For example, the image below shows a price
distribution using a gradation of three colors. Red represents the lower values, yellow represents the medium
values and sky blue represents the higher values.

To create a color scale, do the following:

On the Home tab, in the Styles group, choose Conditional Formatting | Color Scales, and then select
one of the predefined color combinations.
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Format Cells using Icon Sets

An icon set conditional format classifies data in a range into three to five categories. The Spreadsheet divides the
range into equal parts based on the number of icons in the selected set and applies an icon to each cell
depending on its value. For example, the image below shows the value ranking. A filled star represents values
that are greater than or equal to 67 percent, a half-filled star represents values that are less than 67 percent and
greater than or equal to 33 percent, and an empty star shows values that are less than 33 percent.

To apply an icon set conditional formatting rule, do the following:

On the Home tab, in the Styles group, choose Conditional Formatting | Icon Sets, and then select the
desired icon set from the gallery.
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Clear Conditional Formatting Rules

To delete a conditional formatting rule, do one of the following:

Select the range that contains the conditional formatting rules you wish to clear. On the Home tab, in the
Styles group, select Condtional Formatting | Clear Rules | Clear Rules from Selected Cells to delete the
rules applied to the selected range.

To clear all conditional formatting rules on a worksheet, select Condtional Formatting | Clear Rules |
Clear Rules from Entire Sheet.
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Clear Cell Formatting

To remove all formatting from cells, do one of the following.

1.In the Editing group within the Home tab, click the Clear button, and select Clear Formats from the
drop-down menu.

2.In the Styles group within the Home tab, select the Norm al style, to restore the default settings.
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Columns and Rows

Insert and Delete Columns and Rows

The Spreadsheet provides the capability to insert and delete columns and rows in a worksheet.

Insert Rows

1.To insert a single row, select the entire row by clicking the row heading, or click a cell in the row above
the position in which you wish to insert a new row. To insert multiple rows, select the number of rows
you wish to insert. For example, if you wish to insert three rows, select three rows by clicking the row
headings.

2.Do one of the following.

In the Cells group within the Home tab, click the Insert button and select the Insert Sheet Rows
item from the drop-down list.

Right-click a cell within the selected row(s) and click the Insert item in the invoked menu. The new row
(s) will be inserted above the selected row(s).

Insert Columns

1.To insert a single column, select the entire column by clicking the column heading, or by clicking a cell in
the column to the left of where the new column will be inserted. To insert multiple columns, select the
number of columns you wish to insert. For example, to insert three columns, select three columns by
clicking column headings.

2.Do one of the following:

In the Cells group within the Home tab, click the Insert button and select the Insert Sheet Columns
item from the drop-down list.
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Right-click a cell within the selected column(s) and click the Insert item in the invoked menu. The new
column(s) will be inserted to the left of the selected column(s).

Delete Rows and Columns

1.Select the column(s) or row(s) you wish to delete by clicking its heading.

2.Do one of the following.

In the Cells group within the Home tab, click the Delete button and select the Delete Sheet Rows or
Delete Sheet Columns item from the drop-down list.

Right-click a cell within the selected column(s) or row(s), and then click the Delete item in the invoked
menu. The specified column(s) or row(s) will be deleted.
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Show and Hide Columns and Rows

The Spreadsheet provides the capability to display and hide columns and rows in a worksheet.

Hide and Unhide Columns

1.Select the column to be hidden.

2.Do one of the following:

Set the column width to zero. To do this, drag the boundary of the column heading until the column is
hidden;

On the Home tab, in the Cells group, click the Format button and select Hide & Unhide | Hide
Columns;

Right-click the selected column and select the Hide item from the context menu.

3.To show the column you hid, select the columns adjoining to either side of the hidden column, and then
do one of the following:

On the Home tab, in the Cells group, click the Format button, and then select Hide & Unhide |
Unhide Columns;

Right-click the selected columns and select the Unhide item from the context menu.

Hide and Unhide Rows
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1.Select the row to be hidden.

2.Do one of the following:

Set the row height to zero. To do this, drag the boundary of the row heading until the row is not
displayed;

On the Home tab, in the Cells group, click the Format button and select Hide & Unhide | Hide Rows;

Right-click the selected row and select the Hide item from the context menu.

3.To display the row you hid, select the rows that are above and below the hidden row, and then do one
of the following:

On the Home tab, in the Cells group, click the Format button, and then select Hide & Unhide |
Unhide Rows;

Right-click the selected rows and select the Unhide item from the context menu;

Display all hidden columns and rows

1.Click the Select all button at the intersection of the column and row headings, or press CTRL+A.

2.Do one of the following:

On the Home tab, in the Cells group, click the Format button, and then select Hide & Unhide |
Unhide Rows or Unhide Columns;

Right-click the selection and select the Unhide item from the context menu.
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Specify Column Width and Row Height

Setting the column width

In the Spreadsheet, the column width can vary from zero to 255 characters of the default font specified by the
predefined Norm al style. If you set the column width to zero, the column will be hidden.

To change the column width, do one of the following.

1.Drag the right boundary of the column heading to resize the column width. To set the width of multiple
columns, select these columns, and then drag the right boundary of any selected column.

2.To change the column width to automatically fit the contents, select the column and do one of the
following.

On the Home tab, in the Cells group, click the Format button and select the AutoFit Column Width
item from the drop-down list.

Double-click the right boundary of the selected column.

3.To match the column width to another column, do the following.

Select the column, the width of which you want to copy.

On the Home tab, in the Clipboard group, click the Copy button, or press CTRL+C.

Click a cell in the column to be resized, and then click the Paste Special button in the Clipboard
group. In the Paste Special dialog box that is invoked, select the Column widths item.

Set the row height

In the Spreadsheet the row height should be between zero and 409 points. If you set the row height to zero, the
row is hidden.



Spreadsheet 918

© 2014 DevExpress Inc. 918

To change the row height, do one of the following.

1.Drag the lower boundary of the row heading until the row is the height you want. To set the height of
multiple rows, select them, and then drag the lower boundary of any selected row.

2.To change the row height to automatically fit the contents, select the row and do one of the following.

On the Home tab, in the Cells group, click the Format button and select the AutoFit Row Height item
from the drop-down list.

Double-click the lower boundary of the selected rows.
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Tables

Create a Table

The Spreadsheet allows you to insert a new table in a worksheet, or convert an existing range to a table.

Create a Table

Convert a Table to a Data Range

Delete a Table

Create a Table

To insert a table, select the cell range to be included in the table.

Then, do one of the following.

To create a table with the default style, on the Insert tab, in the Tables group, click the Insert Table
button.

To create a table with one of the predefined styles, on the Home tab, in the Styles group, click the
Format As Table button and select the desired style from the gallery.

In the invoked Create Table dialog, verify that the range in the Where is the data for your table? field reflects
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your selection, and then specify whether or not the table has headers.

Note that after you create a table, the Table Tools contextual tab becomes available. Use this tab to provide
some extra settings for the created table.

Convert a Table to a Data Range

To convert an existing table to a normal range of cells, do the following.

Click the table to display the Table Tools contextual tab.

On the Design tab, in the Tools group, click the Convert To Range button.

Note that after you delete a table, the table formatting persists. However, the Table Tools contextual tab is no
longer available, and table features are lost. For example, you cannot use structured references (references that
use table names) in formulas.

Delete a Table

To delete an existing table, select it and do one of the following.

On the Home tab, in the Editing group, click Clear | Clear All.
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Press DELETE.
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Data Presentation

Outline Data

The Spreadsheet provides you with the capability to split a large amount of data into separate groups and display
summary rows and columns for each group. Data grouping is useful when you wish to temporally hide
unnecessary rows or columns to display only significant information.

Select the action you wish to perform.

Group Rows and Columns

Outline Data Automatically

Expand or Collapse Groups

Specify Group Settings

Group Rows and Columns

To group data in a worksheet, do the following.

.1.Select the rows or columns you wish to group.

.2.On the Data tab, in the Outline group, click the Group button, and select the Group item in the
button's drop-down menu...

... or press SHIFT+ALT+RIGHT ARROW KEY to create an outline of the selected rows or columns.

Note

You can also place one group of rows or columns inside another. To do this, repeat the steps above until
you create the required number of groups. Note that the number of nested groups is limited: you can
create a maximum of seven levels of grouping.

To ungroup data in a worksheet, do the following.

.1.Select the rows or columns you wish to ungroup.

.2.On the Data tab, in the Outline group, click the Ungroup button, and select the Ungroup item in the
button's drop-down menu...

... or press SHIFT+ALT+LEFT ARROW KEY to remove an outline of the selected rows or columns.

Outline Data Automatically
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The Spreadsheet allows you to create an automatic outline of rows and columns based on subtotal and summary
formulas contained in a worksheet.

To create an automatic outline, do the following.

.1.Specify the summary rows or columns containing formulas that reference cells to be outlined. If you do
not specify any summary formulas, the data will not be grouped.

.2.On the Data tab, in the Outline group, click the Group button, and select the Auto Outline item in the
button's drop-down menu.

To remove an automatic outline, do the following.

On the Data tab, in the Outline group, click the Ungroup button, and select the Clear Outline item in the
button's drop-down menu.

Expand or Collapse Groups

Using the outline symbols

Since the group is created, it is marked by the grouping bar displayed along the grouped rows to the left
side of a worksheet and along the grouped columns at the top of a worksheet. Each grouping bar is

accompanied by a plus  or minus  outline symbol (depending on the group state). To collapse the
required group, click the minus sign, which automatically changes into a plus sign after the group is
collapsed, or just click the grouping bar itself. To expand the collapsed group, click the plus sign.

You can also use the Hide Detail and Show Detail buttons in the Outline group to hide or display the
detail rows and columns for a specific group.

Using the outline buttons
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If your data is divided into different grouping levels , you can collapse or expand multiple groups at once

using the outline buttons . The outline buttons for row grouping are displayed above the row
headers, while the outline buttons for column grouping are shown to the left of the column headers. Each
outline button has a number that indicates a grouping level. For example, if you have two levels of
grouping, the Spreadsheet displays three outline buttons. Clicking outline button 1 collapses all the
specified groups of rows or columns. Clicking number 2 collapses all the groups in the second grouping
level and lower, except the first level. Clicking the last outline button displays the entire worksheet by
expanding all the specified groups.

Thus, to hide all detail data, click outline button 1. To display all detail data, click the outline button with
the largest number.

The number of outline buttons changes depending on the levels of grouping created in a worksheet. The
largest number is 8, because you can create a maximum of seven levels of grouping.

Specify Group Settings

You can specify the grouping direction using the Settings dialog. To invoke this dialog, on the Data tab, click the
Outline dialog box launcher.

Select the required check boxes depending on where your summary rows or columns are located. For example, if
you inserted summary rows above detail rows in each group, clear the Summary rows below detail check box.

In this case, the grouping bar changes direction, so that the minus outline symbol is displayed opposite the
summary row at the top of the group.

Summary rows below detail Summary rows above detail
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Subtotal Data

The Spreadsheet allows you to automatically group related data in a worksheet and add summary rows to each
group using the SUBTOTAL function.

Important

Before subtotaling, it is necessary to ensure that the range to be subtotaled contains similar data in each column,
has column headings in the first row and does not include blank rows or columns.

To insert subtotals for the selected range, follow the steps below.

On the Data tab, in the Outline group, click the Subtotal button.

In the invoked Subtotal dialog, specify the required subtotal options.

In the At each change in drop-down list, select the heading of the column by which the data should be
grouped. Each time a value in this column changes, a new subtotal row is inserted. So sorting your data
by this column is recommended to ensure that the same column values will be in one group.

In the Use function drop-down list, select one of the eleven functions available for calculating
subtotals: Sum, Count, Average, Max, Min, etc.

In the Add subtotals to box, select the check boxes corresponding to the columns for which the
SUBTOTAL function should be calculated.

http://office.microsoft.com/en-us/excel-help/subtotal-function-HP010062463.aspx
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Select the Replace current subtotals check box to replace the existing subtotals with the recently
specified subtotals. If you wish to create more than one level of subtotals (for example, to insert
subtotals for the inner groups using different summary functions), clear this check box.

Select the Page break between groups check box to locate each group on a new page. It can be useful
if your groups contain many detail rows and you wish to separate them while printing.

Select the Summary below data check box to display a summary row below detail rows in each group.
Otherwise, the summary row will be displayed at the top of the group.

Since subtotals are specified, you can change the SUBTOTAL function directly in the cell or formula bar to ignore
values in the collapsed groups. To do this, add 100 to the first numeric function's argument, which specifies the
code of the function used in calculating subtotals. In this case, the hidden values in the collapsed group will not be
taken into account during calculations.

To remove subtotals, select a cell in the subtotaled range, invoke the Subtotal dialog and click the Remove All
button.
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Sort Data

The Spreadsheet provides the capability to sort data by text (A to Z or Z to A), numbers (smallest to largest or
largest to smallest), dates and times (oldest to newest or newest to oldest) in one column.

To perform sorting, do the following.

1.Select a range in the column you wish to sort.

Note

If multiple columns are selected, the range will be sorted by the first column.

2.On the Data tab, in the Sort & Filter group, click Sort A to Z to select ascending order, or click Sort Z to
A for descending order.

Sort a Table

To sort data in a table, follow the steps below.

1.Click the arrow  in the header of the column by which data will be sorted.

2.In the drop-down menu, select the Sort A to Z item to select ascending order, or select the Sort Z to A
item to select descending order.

All the records in the table will be reordered accordingly. The tiny arrow  appears in the column header to
indicate that data in the table are sorted by this column.

Note

You cannot sort a table by more than one column at a time. When you apply a new sort order, it replaces the
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previous one.
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Filter Data

The Spreadsheet allows you to use the AutoFilter to arrange large amounts of data by displaying only rows that
meet the filtering criteria.

To enable the filtering functionality, select the required data, and on the Data tab, in the Sort & Filter group, click
the Filter button.

Once filtering is activated, a drop-down arrow  appears on the right side of each column header in the range.
Depending on the data in the column you wish to filter, you can apply one of the following filters: Filter by Values,
Text Filter, Number Filter or Date Filter.

Note

You can filter your data by multiple columns. Filters are additive: each new filter is applied in addition to the
existing filters and further reduces your data.

Filter by Values

Text Filter

Number Filter

Date and Time Filter

Reapply a Filter

Clear a Filter

Filter by Values

To filter your data by a list of values, do the following.

1.Click the arrow  in the header of the column containing the values you wish to filter.

2.In the drop-down menu, select the Filter by Values item to invoke the AutoFilter dialog.
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3.The AutoFilter dialog displays a list of all values in the selected column. Click the Uncheck All button to
deselect the values. Then, select the check boxes for the items you wish to display, and click OK.

Text Filter

To apply the text filter, do the following.

1.Click the arrow  in the header of the column containing text values you wish to filter.

2.Point to Text Filters and select one of the built-in comparison operators, or select Custom Filter to
construct your own filter expression.
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3.In the invoked Custom AutoFilter dialog specify the filter criterion.

You can also specify the additional filter criterion using the AND or OR logical operator to combine the
conditions.

To make your filter criterion more flexible, use the wildcard characters. The asterisk * matches any
number of characters, while the question mark ? represents a single character. For example, to display
all the values that start with the letter "C", you can either use the Begins With operator as shown in
the image above, or select the Equals operator and type "C*" in the box on the right.

Tip

To filter values containing a specific character, such as the asterisk, question mark or tilde, put the tilde
(~) before it.

Number Filter

To apply the number filter, do the following.

1.Click the arrow  in the header of the column containing numeric values you wish to filter.

2.Point to Number Filters and select one of the built-in comparison operators (Equals, Greater Than,
Less Than, Between, Top 10, Above or Below Average, etc.), or select Custom Filter to construct your
own filter expression.
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3.In the invoked Custom AutoFilter dialog specify the filter criterion.

You can also specify the additional filter criterion using the AND or OR logical operator to combine the
conditions.

Date and Time Filter

To apply the date filter, do the following.

1.Click the arrow  in the header of the column containing dates you wish to filter.

2.Point to Date Filters and select one of the built-in dynamic filter types to display dates that fall within a
specified time period (next, this or last week, month, year, etc.)...
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... or select the Before, After, Equals or Between item to invoke the Custom AutoFilter dialog and find
dates that are before, after or equal to the specified date, or between two dates.

Reapply a Filter

To reapply a filter after you change your data, click a cell in the range or table to which the filter is applied, and
then on the Data tab, in the Sort & Filter group, click the Reapply button.
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Clear a Filter

To remove a filter, do the following.

To remove a filter from a specific column, click the Filter button  in the column header, and then select
the Clear Filter From 'Column Name' item in the drop-down menu.

To clear all the specified filters and display the hidden rows, on the Data tab, in the Sort & Filter group,
click the Clear button.

To disable the filtering functionality, click a cell in the range or table, and then on the Data tab, in the Sort & Filter
group, click the Filter button. The drop-down arrows will disappear from the column headers and all the specified
filters will be removed.
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Formulas

Create a Simple Formula

The Spreadsheet allows you to perform calculations on data in cells using formulas. A formula is a string
expression that starts with the equal sign ("="). Formulas can contain constants, math operators, functions, cell
references, etc.

The Spreadsheet provides the capability to use the Formula Bar, which is the bar at the top of a worksheet, to
enter and edit formulas.

For example, if you wish to add 1 to the product of 2 and 5, type the following formula in the cell in which you wish
to insert the formula or in the Formula Bar.

=2*5+1

Press ENTER. The result appears in the cell in which you inserted the formula.
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Using Cell References and Defined Names in Formulas

The A1 Reference Style

If you want to change data in a worksheet without changing formulas that use this data for evaluation, you can
use cell references. A cell reference defines cell location in a worksheet. It is a combination of column letters (A,
B, C, etc.) and row numbers (1, 2, 3, etc.). For example, A1 refers to a cell at the intersection of column A and row
1.

To add values in cells A1 and A2, and divide the result by the value in cell A3, type the following formula (use
parentheses to determine the order of operations):

=(A1+A2)/A3

You can also use a reference to a cell located in another worksheet. For example, to multiply a value in cell B1 by
the value in cell B1 in Sheet 2, enter the following formula:

=B1*Sheet2!B1

To prevent data from changing when the formula is copied, use the absolute reference. Absolute references have
a dollar sign ($) before column and/or row references.

The following example demonstrates how to use a constant value in cell B1 in calculations:

=A1*$B$1

The R1C1 Reference Style

The Spreadsheet supports the R1C1 reference style where both rows and columns are labeled with numbers.
Cell location is indicated by an "R" letter followed by a row number and a "C" letter followed by a column number.

You can use absolute and relative R1C1 references. An absolute R1C1 reference always refers to a cell in a
specific location.

The example below demonstrates how to create a formula that adds values in cells A1 through A5 using the
absolute R1C1 reference style:

=SUM(R1C1:R5C1)

A relative R1C1 reference refers to a cell location in relation to an active cell.

The image below illustrates a relative reference to a cell one row above and one column to the left of the active
cell.

The following example demonstrates how to create a formula that adds values in cell range A1:A5 using the
relative R1C1 reference style in cell B1:

=SUM(RC[-1]:R[4]C[-1])
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Defined Names

To make formulas easier to understand, you can use defined names that represent cells, cell ranges, functions, or
constant values.

To define a name for a cell or cell range, follow the instruction below.

1.Select a cell or a range of cells for which you wish to define a name.

2.Type the name you want to use to refer to the selection in the Name Box at the left end of the Formula
Bar. Press ENTER.

To add values in cell range B3:B7 that is named Amount, enter the following formula:

=SUM(Amount)
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Using Functions in Formulas

The Spreadsheet provides the capability to use functions in formulas.

To insert a formula containing functions, follow the instructions below.

1.Click the cell in which you want to insert the formula.

2.Type the equal sign "=" that is required to interpret cell content as a formula. Skip this action if you
insert the function in the cell which already contains a formula.

3.Type the function's name.

4.Enter the arguments into the function's parentheses.

5.Press ENTER. The result appears in the cell in which you inserted the formula.

If you do not remember the name of the function you want to use, select it on the Formulas tab in the Function
Library group.

For example, if you want to add all numbers in the range E4:E8, in the Function Library group, select the SUM
function from the AutoSum or Math & Trig button's drop-down list. Type "E4:E8" in the function's parentheses
and press ENTER. Note that the Spreadsheet automatically adds the equal sign to the formula when you insert
the function from the Function Library group.

Nested functions

You can create a formula with a function that uses another function as one of the arguments. A function that is
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used as an argument is called a nested function.

Examples of formulas with nested functions are detailed in the table below.

Formula Description

=ROUND(SUM(A1:A5),2) Round the sum of the values contained in the cell
range A1:A5 to two decimal places.

=SQRT(AVERAGE(A1:A5)) Square the root of the average value of the numbers
in the cell range A1:A5.

=IF(A5&LT;1000, POWER(A5,2)) Square the value in cell A5 if it is less than 1000.
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Supported Functions

The Spreadsheet supports the following functions to be used in formulas.

Mathematical Functions - used to perform common mathematical operations: addition (SUM),
multiplication (PRODUCT), exponentiation (POWER), extraction of the square root (SQRT), evaluation of
trigonometric functions (e.g., SIN, COS or TAN), etc.

Financial Functions - used to perform various types of financial operations: calculation of interest rates
(RATE), calculation of interest payments (IPMT), etc.

Logical Functions - used to perform logical operations such as AND, OR, NOT, etc.

Text Functions - used to provide operations with text data in cells, such as string concatenation
(CONCATENATE), replacement of part of a string with another string (REPLACE), etc.

Date and Time Functions - used to work with dates: to calculate the number of days, months, or years
between two dates (e.g., DATEIF or DAYS360), or to add various components of a specified time to a
worksheet (e.g., SECOND, MINUTE or HOUR).

Lookup and Reference Functions - used for searching specific data in a worksheet: to look up values in
vectors, arrays or references (e.g., LOOKUP or MATCH)

Statistical Functions - used for data analysis: to find the average of a list of values (AVERAGE), to
evaluate the covariance between two data sets (COVAR), to find the smallest or the largest value in a list
of arguments (MAX, MIN), etc.

Engineering Functions - used to work with special functions (e.g., BESSELI or BESSELJ), complex numbers
(e.g., COMPLEX or IMAGINARY) and various numeral systems (e.g., DEC2BIN or BIN2DEC).

Information Functions - used to provide information about the formatting, location or content of cells (e.
g., CELL, INFO or ISTEXT).

Compatibility Functions - replaced by new functions in Microsoft® Excel® versions 2010 and higher.
These functions can be used to provide compatibility with earlier versions of Microsoft® Excel®.

Web Functions - used to return a URL-encoded string (ENCODEURL).

All of the functions described above are available in the Function Library group within the Formulas tab.
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Create an Array Formula

An array formula is a formula that performs calculations on sets of cell ranges, so that you do not need to re-
enter formulas for each calculation. Create an array formula and specify the columns or rows that the array
formula must fill. Array formulas are used to perform actions on two or more sets of values, which are called
arguments. Each array argument must have the same number of rows and columns. The result of an array formula
can either be a single value or multiple values.

To create an array formula, do the following.

1.Select the cell in which you wish to insert the array formula. If the formula calculates multiple results,
select the cell range for which you wish to create the array formula.

2.Enter the array formula in the Formula Bar.

3.Press CTRL+SHIFT+ENTER. The Spreadsheet automatically adds a pair of curly braces to the formula
to indicate that it is an array formula.

Note

Any time you edit the array formula, you must press CTRL+SHIFT+ENTER to save changes and convert the
formula into an array formula.

The example below demonstrates how to create a formula that multiplies three arrays of values (quantity, price
and discount) to get an array of amount values for each product item without entering a separate formula for
each row.

=C4:C8*D4:D8*(1-E4:E8)
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Error Types in Formulas

If a formula in a cell cannot be calculated correctly, it means that the cell contains an error. The error appears
because the formula's syntax is incorrect, or the formula uses unexpected arguments or data types.

Errors that occur in formulas are detailed in the following table:

Error Description Example

##### The column is not wide enough to
display the cell content.

#DIV/0! Division by zero. =A1/B1 (where the value in cell
B1 is equal to zero, or cell B1 is
blank).

#NAME? The formula refers to a name that
doesn't exist or is spelled
incorrectly.

=SUM(Values) (the cell range
named "Values" does not exist).

#N/A The referenced value is not
available to the formula.

=SUM(A1:A5*B1:B3) (the array
formula has arguments consisting
of different numbers of elements).

#NULL! An incorrect range operator is used
in the formula, or the specified
intersection includes two ranges
that do not intersect.

=SUM(A1 A3) (a colon is missing
in the cell range reference).

#NUM! There are invalid numeric values in
the formula.

=SQRT(-4) (the square root of a
negative number cannot be
calculated).

#REF! The cell reference is not valid. =SUM(A1, B1) (column B has
been deleted).

#VALUE! The formula uses values of the
wrong data type.

=SUM(5, "Text") (the SUM
function requires numeric
arguments).
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Charting

Charting Overview

The Spreadsheet provides the capability to summarize worksheet data visually using a variety of charts. Charts
display data series visually to make data interpretation easier, and show the relationship between different data
series. To create a chart, click the chart type you wish to insert in the Charts group within the Insert tab.

Below is a list of all charts currently available in the Spreadsheet.

Column Charts

Line Charts

Pie Charts

Bar Charts

Area Charts

Scatter Charts

Stock Charts

Radar Charts

Chart Type Chart Subtypes Description

Column Charts 2-D Colum n Charts :

Clustered Column

Stacked Column

100% Stacked Column

3-D Colum n Charts :

3-D Clustered Column

Stacked Column in 3-D

100% Stacked Column in 3-
D

3-D Column

Cylinder Charts :

Clustered Cylinder

Stacked Cylinder

100% Stacked Cylinder

3-D Cylinder

Cone Charts :

Clustered Cone

Stacked Cone

Column charts are used to display
series as sets of vertical bars (or
columns) that are grouped by
category. The bar lengths are
proportional to the values that they
represent. Column charts are
typically used to compare values in
different categories. Some column
graphs display series as individual
columns, grouped by category, and
others show columns divided into
subparts to show a cumulative
effect (stacked column graphs). You
can select column charts of different
shapes, such as cylinder, cone or
pyramid.
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100% Stacked Cone

3-D Cone

Pyram id Charts :

Clustered Pyramid

Stacked Pyramid

100% Stacked Pyramid

3-D Pyramid

Line Charts 2-D L ine Charts :

Line

Stacked Line

100% Stacked Line

Line with Markers

Stacked Line with Markers

100% Stacked Line with
Markers

3-D L ine Charts :

3-D Line

Line charts display information as a
series of data points connected by
line segments. This chart type is
useful when you need to show
trends for several series on the
same diagram, and to compare
values of several series for the
same point argument.

Pie Charts 2-D Pie Charts :

Pie

Exploded Pie

3-D Pie Charts :

Pie in 3-D

Exploded Pie in 3-D

Doughnut Charts :

Doughnut

Exploded Doughnut

Pie and doughnut charts are used
to compare the percentage values
of different point arguments in the
same series. These charts may be
useful to determine which point
value is the most significant, or
which values in the point series are
the most significant. A doughnut
chart is functionally identical to a
pie chart. The main difference is the
shape of the doughnut chart, and
that it can contain more than one
data series.

Bar Charts 2-D Bar Charts :

Clustered Bar

Bar charts are identical to column
charts with one exception: bar
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Stacked Bar

100% Stacked Bar

3-D Bar Charts :

Clustered Bar in 3-D

Stacked Bar in 3-D

100% Stacked Bar in 3-D

Cylinder Charts :

Clustered Horizontal
Cylinder

Stacked Horizontal Cylinder

100% Stacked Horizontal
Cylinder

Cone Charts :

Clustered Horizontal Cone

Stacked Horizontal Cone

100% Stacked Horizontal
Cone

Pyram id Charts :

Clustered Horizontal
Pyramid

Stacked Horizontal Pyramid

100% Stacked Horizontal
Pyramid

charts use horizontal bars instead
of vertical bars to compare values
across categories. Some bar graphs
display series as individual bars
grouped by category, and others
show bars divided into subparts to
show a cumulative effect (stacked
bar graphs). You can select bar
charts of different shapes, such as
cylinder, cone or pyramid.

Area Charts 2-D Area Charts :

Area

Stacked Area

100% Stacked Area

3-D Area Charts :

3-D Area

Stacked Area in 3-D

100% Stacked Area in 3-D

Area charts display series as filled
areas in a diagram, with each data
point displayed as a peak or valley
in the area. This chart type is useful
when you need to show trends for
several series on the same
diagram, and also show the
relationship of the parts to the
whole. The area chart is based on
the line chart, with the area below
the plotted line filled with color.

Scatter Charts Scatter Charts :

Scatter with only Markers

Scatter with Smooth Lines
and Markers

Scatter with Smooth Lines

Scatter with Straight Lines
and Markers

Scatter charts are used to plot data
points on the horizontal and
vertical axis to show the
relationship between two sets of
data. This chart type combines data
values into single data points and
displays them in uneven intervals
(or clusters).
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Scatter with Straight Lines

Bubble Charts :

Bubble

Bubble with a 3-D Effect

Bubble charts allow you to visually
represent data that has a third
dimension, expressed in the
bubble's size. You map two
dimensions along the horizontal
and vertical axes, and then the
third dimension is displayed as a
filled circle at the data point.

Stock Charts Stock Charts :

High-Low-Close

Open-High-Low-Close

Stock charts are used to show
variation in stock prices over the
course of a day. In the High-Low-
Close chart type, the High and Low
prices are represented by the top
and bottom values of the vertical
line that is shown at each point,
and the Close prices are
represented by the right tick marks.
In the Open-High-Low-Close chart
type, the High and Low prices are
shown in the same way as in the 
High-Low-Close charts, but the
Open and Close prices are
represented by the bottom and top
borders of a rectangle. If the stock
closes higher than its opening
price, the rectangle is hollow. And if
the stock closes lower than its
opening price, the rectangle is
filled.

Radar Charts Radar Charts :

Radar

Radar with Markers

Filled Radar

Radar charts are used when it is
necessary to display series as an
area on a circular grid that has
multiple axes along which data can
be plotted, so values are shown
relative to a center point.
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Creating a Chart

The Spreadsheet allows you to create charts quickly using the Charts group of the Insert tab.

To create a chart, select the table that contains the data you wish to use for the chart. Note that the 
Spreadsheet only allows you to create charts for data series representing a contiguous cell range.

In the Charts group within the Insert tab, select the required chart type. In the example below, a line chart is
created. To insert a line chart, click the Line button, and then select the Line with Markers chart subtype.

The chart is added to the worksheet. You can move the chart to the desired location and resize it for a better fit.
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Changing a Chart Type

The Spreadsheet allows you to change the type of the existing chart. To do this, click the chart to display the
Chart Tools contextual tab.

Click the Change Chart Type button in the Type group within the Design tab...

... or right-click the chart and select the Change Chart Type... item in the context menu.

In the invoked Change Chart Type dialog, select a new chart type and click OK.
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The following image illustrates the chart with the Radar with Markers chart type applied.
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Applying a Predefined Chart Layout and Style

The Spreadsheet allows you to change the appearance of the existing chart by applying one of the predefined
layouts and styles.

To change a chart style or layout, click the chart you wish to format, to display the Chart Tools contextual tab.

Apply a Predefined Chart Layout

In the Chart Layouts group within the Design tab, select the required chart layout. For example, select Layout 10
, which positions the chart legend to the right of the chart area, and adds the chart and axis titles.

To enter the chart title, right-click the chart and select the Change Chart Title... item in the context menu.

In the invoked Change Chart Title dialog box, enter a title and click OK.
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To provide horizontal or vertical axis titles, right-click the chart and select the Change Horizontal Axis Title... or
Change Vertical Axis Title... item in the context menu. Type a new title in the invoked dialog box.

The image below shows the result.

Apply a Predefined Style

In the Chart Styles group of the Design tab, click the chart style you wish to apply.

The image below shows a chart with Style 22 applied.
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Modifying a Chart Manually

After you create a chart, you can choose whether to apply one of the predefined chart layouts or specify your own
layout. The Spreadsheet provides the capability to add axis titles and chart titles, show the chart legend, display
gridlines and data labels, etc.

To modify a chart, click it to display the Chart Tools contextual tab.

Add a Chart Title

To add a title to your chart, click the Chart Title button in the Labels group within the Layout tab, and then select
where to position the chart title. For example, click the Above Chart button to display the title at the top of the
chart.

The image below illustrates the result.

To change the default text in the title, right-click the chart and select the Change Chart Title... item in the context
menu. Specify a new chart title in the invoked Change Chart Title dialog box.
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Add Axis Titles

To display horizontal and vertical axis titles, click the Axis Titles button in the Labels group within the Layout tab
and do the following.

To add a horizontal axis title, select the Primary Horizontal Axis Title item, and then click the Title Below
Axis button.

To add a vertical axis title, select the Primary Vertical Axis Title item, and then select the type of axis
title (rotated, vertical or horizontal) you wish to display.

To change the default text in the axis title, right-click the chart and select the Change Horizontal Axis Title... or
Change Vertical Axis Title... item in the context menu. Type a new title in the invoked dialog box.

Add a Chart Legend

To add a legend to the chart, click the Legend button in the Labels group within the Layout tab, and then select
where to position the legend.
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For example, click the Show Legend at Top button to display the legend above the plot area.

Display Data Labels

To display data values on the chart, click the Data Labels button in the Labels group within the Layout tab, and
then select where to position the data labels.
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Add Gridlines

To display chart gridlines, click the Gridlines button in the Axes group within the Layout tab and do one of the
following:

To add horizontal gridlines, select the Primary Horizontal Gridlines item, and then select the type of
gridlines you wish to display.

To add vertical gridlines, select the Primary Vertical Gridlines item, and then select the type of gridlines
you wish to display.
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A chart with horizontal and vertical gridlines is shown below.
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Mail Merge

Mail Merge Overview

The Spreadsheet supports the Mail Merge functionality, which allows you to automatically generate a set of
documents based on a common template, and include unique data values retrieved from a data source in each
document. Use mail merge to generate personalized letters and a variety of professional reports.

Add a Data Source

Create a Template

Generate a Merged Document

Add a Data Source

To perform a mail merge, you need a template and a data source from which the data is retrieved. You can specify
a data source at runtime using the Data Source Wizard. Once created, the data source configuration will be
stored in the XLS/XLSX spreadsheet file, so there is no need to re-configure the data source again.

To invoke the wizard, click Add Data Source in the External Data Sources group of the Mail Merge tab.

The wizard allows you to select the data source type. You can choose between an external database, the Entity
Framework and an object data binding.
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For more information on data source configuration review the following documents:

Data Source Wizard

Query Designer

Parameters Panel

Create a Template

A template is a workbook with one worksheet containing mail merge fields that will be filled with unique data
values from a bound data source.

As a rule, a template includes detail, header and footer ranges that reflect the structure of a merged document.
To highlight template ranges, on the Mail Merge tab, in the Design group, click the Mail Merge Design View
button.



Spreadsheet 962

© 2014 DevExpress Inc. 962

A detail range contains information from a data source. To create a detail range, select the range of the required
size and do one of the following:

On the Mail Merge tab, in the Template Ranges group, click the Detail button.

Assign the "DETAILRANGE" defined name to the selected range.

A detail range includes mail merge fields. Real data values retrieved from a data source will be displayed in a
merged document instead of these fields. To create a mail merge field, use the FIELD function.

Function Syntax Description

FIELD FIELD("data_field_name") Retrieves a data value from the
corresponding field of a data
source.

A mail merge field is displayed as the name of the specified data field enclosed in square brackets. If a mail merge
field is used in a cell formula as one of its elements, the entire formula is displayed in the cell.
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You can also create a multi-level report by adding nested levels within a detail range. To create the next data
level, select a range within an existing detail range, and then click Master-Detail | Detail Level in the Template
Ranges group. Click Master-Detail | Data Member to invoke the Data Member dialog and bind the specified detail
level to a data member from a data source.

Header and footer ranges are displayed above and below all detail ranges in the resulting worksheet if all data
records are merged into a single worksheet. In other mail merge modes, the header and footer are repeated for
each detail range. To create a header or footer range, select the range you wish to use as a header or footer,
and do one of the following:

On the Mail Merge tab, in the Template Ranges group, click the Header or Footer button.
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Assign the "HEADERRANGE" or "FOOTERRANGE" defined name to the selected range.

Note that you can create a header or footer range only if the template already contains a detail range. If you do
not set a detail range, the entire template will be copied for each record of the data source.

At the template creation stage, you can access the range into which the specified cell in a template will be
expanded after a mail merge is performed. To do this, use the RANGE function.

Function Syntax Description

RANGE RANGE(abs_cell_reference)
The abs_cell_reference argument
is an absolute reference to a
template cell that will be copied for
each data source record in a
resulting worksheet.

Obtains the specified range of a
merged document.

If you no longer wish to use the specified range as a detail range, header or footer, you can reset it by clicking
the Reset button.
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Generate a Merged Document

A mail merge supports three modes for generating a resulting document, as listed in the table below:

Mode Description

Multiple Docum ents Inserts the merged range for each record of the data
source into a separate workbook.

Mu ltiple Sheets Inserts the merged range for each record of the data
source into a separate worksheet of a single
document.

Single Sheet Inserts all merged ranges into a single worksheet,
retaining the structure of the template document.

Docum ent Orien tation Specifies the direction in which the detail range will be
repeated.

To select the desired mode, on the Mail Merge tab, in the Mode group, click Multiple Documents, Multiple Sheets
or Single Sheet. Document Orientation option can be useful for the Single Sheet mode only.
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Data Source Wizard

The Data Source Wizard allows the user to create a new data source, configure it, and if there is more than one
data source available, to select the one that is required for a particular task. Once created, the data source
configuration will be stored in the XLS/XLSX spreadsheet file, so the user does not have to re-configure the data
source again.

To invoke the wizard, click Add Data Source in the External Data Sources group of the Mail Merge tab.

Next, proceed with the following steps in the wizard.

1.On the first page, select the data source type and click Next. The following steps assume that a
Database is selected.

2.If a data connection has already been specified in the application, the next wizard page allows you to
select whether to use one of the existing connections, or create a new one.
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3.When creating a new connection, you can specify the connection parameters on the next page.



Spreadsheet 968

© 2014 DevExpress Inc. 968

On this page, you can define a custom connection string, or select from the following supported data
source types.

Microsoft SQL Server

Microsoft Access 97

Microsoft Access 2007

Oracle

XML File

SAP Sybase Advantage

SAP Sybase ASE

IBM DB2

Firebird

MySQL

Pervasive PSQL

PostgreSQL

VistaDB

Microsoft SQL Server CE

SQLite

Depending on the selected data provider, it may be necessary to specify additional connection options
(such as authentication type and database name) on this page.

To proceed to the next wizard page, click Next.

4.On this page, you are prompted whether to save the user name and password in a connection string.

Click Next to proceed to the next page.

5.This page allows you to select a query or a stored procedure.
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Click Run Query Builder... to invoke a Query Designer dialog.

6.The Query Designer window allows you to select tables and columns to include in the result. The joins
are created automatically, however you can modify them using the Condition Editor.



Spreadsheet 970

© 2014 DevExpress Inc. 970

Click OK to close the Query Designer dialog and return to the Data Source Wizard.

7.The data source is created and configured.
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Now you can click Finish to quit the Data Source Wizard.

If the Spreadsheet is accompanied with the Field List Panel, the fields from the bound data source are
immediately displayed within that panel. It allows you to drag and drop the required data field onto a
worksheet used as a mail merge template.

To modify the query used in the data source, click Manage Relations -> Man?ge Queries in the
External Data Sources group to invoke the Query Designer.

Tip

The data source configuration is stored in .xls or .xlsx file. You can save the workbook after creating the data
source. Subsequently, you can start a mail merge immediately after the XLSX/XLS file is loaded into the
Spreadsheet control.
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Query Designer

When the data source is configured, you can use the built-in Query Designer to select required data.

To invoke the Query Designer window, select Manage Queries from the Manage Relations drop-down.

In the Manage Queries dialog, click the ellipsis button in the query list to edit the selected query.

The Query Editor window appears. You can modify the SQL string directly...
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...or click Run Query Builder... to invoke the Query Designer window.
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Double-click a table or view in the Item s column on the left to add it to the query. Check the box near the field to
include that field in the query. A green  plus symbol near the field indicates that you can join the tables using that
field.

Click the Allow SQL Editing check box to edit SQL statements directly. However, note that unchecking this box will
cancel all your changes.

Click Preview Results to invoke a dialog displaying the first 1000 records of the resulting table.
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Click Filter... to invoke a Filter Editor to specify criteria or create a parametrized query.

The Filter Editor window allows you to specify a criteria operator:

Click the symbol in the Filter Editor to switch between a value, another field and a parameter.
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For more information on parameters, review the Parameters Panel document.

When all the necessary changes are made, click OK to close the window and save the query in the document.

Tip

All queries are stored in an .xls or .xlsx file. You can save the workbook after creating the data source.
Subsequently, you can start performing a mail merge immediately after the XLSX/XLS file is loaded into the
Spreadsheet control.
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Parameters Panel

The Spreadsheet can be accompanied with the Parameters panel. It displays parameters used in the query to
retrieve data and allows you to modify them. The following picture illustrates how to specify the order ID for data
used in the mail merge template.

The resulting report for order ID 10300 is shown below.

To add parameter to a query, invoke the Query Designer and click Filter... to display a Filter Editor.

The Filter Editor window allows you to specify a criteria operator.
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Click the symbol in the Filter Editor to switch between a value, another field and a parameter.
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Click OK to close the Filter Editor dialog and click Next in the Query Editor window to navigate to a second page
that allows you to specify the parameter's input source. This page is shown in the image below.
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Click in the Expression column to select the parameter type. If you choose New Spreadsheet Parameter..., the
Spreadsheet Parameter window is displayed.

The Spreadsheet Parameter window allows you to type in the parameter's name and specify its initial value.
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After closing the Query Designer window, you will see the newly created parameter in the Parameters Panel as
shown in the picture at the beginning of this document.
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Pictures and Hyperlinks

Insert a Picture

The Spreadsheet allows you to insert pictures in a worksheet.

You can insert graphics of the following type.

Bitmap (*.bmp, *.dib)

JPEG File Interchange Format (*.jpg, *.jpeg)

Portable Network Graphics (*.png)

Graphics Interchange Format (*.gif)

Tagged Image Format (*.tif, *.tiff)

Microsoft Enhanced Metafile (*.emf)

Windows Metafile (*.wmf)

To insert a picture, follow the instructions below.

1.On the Insert tab, in the Illustrations group, click the Picture button.

2.In the Open dialog box that is invoked, locate the folder that contains the picture you want to insert.
Click Open. The picture will be inserted into the worksheet.
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Move, Rotate and Resize a Picture

Move a Picture

1.Click the picture you wish to move.

2.Drag the picture to a new location.

Rotate a Picture

1.Click the picture you wish to rotate.

2.Click the rotation  handle (the round arrow that appears over the selected picture) and drag it in the
direction in which you wish to rotate the object.

3.To rotate a picture in 15-degree increments, drag the rotation handle while holding down the SHIFT
key.

Resize a Picture

1.Click the picture to be resized.

2.Drag the s izing handle away from the center (or towards the center) of the picture, and release it once
the desired size is reached.

When you change the width of the object by dragging a corner s izing handle, the object's height will automatically
be changed to maintain the aspect ratio of the object, and vice-versa.
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Insert and Delete Hyperlinks

The Spreadsheet allows you to insert, edit and delete hyperlinks. A hyperlink is a link from a worksheet to
another file or Web page that can be opened when you click the hyperlink text or image.

Insert a Hyperlink

1.Click the cell in which you wish to insert a hyperlink.

2.Do one of the following.

In the Links group within the Insert tab, click the Hyperlink button.

Right-click the cell and select Hyperlink... from the context menu.

Press CTRL+K.

3.In the invoked Edit Hyperlink dialog box, select whether you wish to insert a hyperlink to an existing
file, a Web page, a location within the current workbook, or an email address. Depending on your
choice, provide all required options in the right pane of the dialog box.
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Delete a Hyperlink

1.To delete a hyperlink along with its text, do one of the following.

In the Editing group within the Home tab, click the Clear button, and select Clear Contents from the
drop-down list.

Right-click the cell that contains the hyperlink and select Clear Contents from the invoked context
menu.

2.To delete a hyperlink while maintaining its text with hyperlink formatting, in the Editing group within the
Home tab, click Clear, and select Clear Hyperlinks from the drop-down list.
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3.To delete a hyperlink while maintaining its text with default formatting, do one of the following.

In the Editing group within the Home tab, click the Clear button, and select Remove Hyperlinks from
the drop-down list.

Right-click the cell that contains the hyperlink and select Remove Hyperlinks from the invoked context
menu.
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Shortcuts to Work with Pictures

The Spreadsheet allows you to move, resize or rotate pictures quickly using keyboard shortcuts.

To work with pictures, use the default shortcuts listed in the table below.

Shortcut Description

DELETE Deletes the selected picture.

BACKSPACE Deletes the selected picture.

ARROW KEYS Move the selected picture in a worksheet.

ALT+LEFT ARROW KEY Rotates the selected picture counterclockwise by 15
degrees.

CTRL+ALT+LEFT ARROW KEY Rotates the selected picture counterclockwise by 1
degree.

ALT+RIGHT ARROW KEY Rotates the selected picture clockwise by 15 degrees.

CTRL+ALT+RIGHT ARROW KEY Rotates the selected picture clockwise by 1 degree.

SHIFT+RIGHT ARROW KEY Increases the width and height of the selected picture
by 10%.

SHIFT+UP ARROW KEY Increases the width and height of the selected picture
by 10%.

CTRL+SHIFT+RIGHT ARROW KEY Increases the width and height of the selected picture
by 1%.

CTRL+SHIFT+UP ARROW KEY Increases the width and height of the selected picture
by 1%.

SHIFT+LEFT ARROW KEY Decreases the width and height of the selected
picture by 10%.

SHIFT+DOWN ARROW KEY Decreases the width and height of the selected
picture by 10%.

CTRL+SHIFT+LEFT ARROW KEY Decreases the width and height of the selected
picture by 1%.

CTRL+SHIFT+DOWN ARROW KEY Decreases the width and height of the selected
picture by 1%.

CTRL+A Selects all pictures in a worksheet.

TAB Selects the next picture in a worksheet.

TAB+SHIFT Selects the previous picture in a worksheet.
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Protection

Protect a Workbook

WinForms Controls > Spreadsheet > Protect a Workbook

Workbook protection prevents users from changing a workbooks structure (by moving, deleting, adding, hiding or
displaying a hidden worksheet) or window position (by freezing or unfreezing panes).

You can protect a worksheet by using the following dialog:

To invoke this dialog, on the Review tab, in the Changes group, click Protect Workbook.

In a protected workbook, this button displays the "Unprotect Workbook" caption, which invokes a simple dialog
that prompts for a password or unlocks the workbook if an empty password was set.
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Protect a Worksheet

Worksheet protection locks the cells so that you can only perform a specific (restricted) set of actions.

By default, all cells in the worksheet are locked. When protection is applied to the worksheet, these cells become
read-only. However, you can specify certain actions which can be performed with the locked cells in a protected
worksheet.

To protect a worksheet, use the following dialog:

To invoke this dialog, on the Review tab, in the Changes group, click Protect Sheet.

In a protected sheet, this button displays the "Unprotect Sheet" caption, which invokes a simple dialog that
prompts for a password or unlocks the sheet if an empty password was set.
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Protect Worksheet Ranges

In a protected worksheet, all locked cells are read-only. However, you can unlock certain ranges for users who
provide the correct password. You can also specify user accounts and groups who can edit specific ranges without
a password.

To accomplish this, invoke the Allow Users to Edit Ranges dialog. On the Review tab, in the Changes group, click
Allow Users to Edit Ranges.

The Allow Users to Edit Ranges dialog is shown in the picture below.

Click the New... button to display a dialog to specify the worksheet range and password, as illustrated below.
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The Permissions... button allows you to specify Active Directory users and groups.

After all required permissions and password-protected ranges are specified, apply protection to the worksheet to
activate permissions as described in the Protect a Worksheet document.

When attempting to edit a cell content in a protected range for which a permission is specified, you will be
prompted for a password if your user account is not listed in the Permissions dialog for that range or if the
account does not belong to the user group listed in that dialog.
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Keyboard Shortcuts

The Spreadsheet provides the capability to perform common commands quickly using keyboard shortcuts.

All supported shortcuts are divided into the following groups:

File Operations

Navigation through Worksheets

Work with Selections

Copy, Paste and Edit the Cell Content

Cell Formatting

Work with Columns and Rows

Work with Formulas
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File Operations

The key combinations used to perform file operations are listed in the table below.

Shortcut Description

CTRL+N Creates a blank workbook.

SHIFT+F11 Inserts a new worksheet in front of the existing
worksheet within the current workbook.

CTRL+O Invokes the Open dialog box to open a new file.

F12 Invokes the Save as dialog box to save the current
workbook.

CTRL+P Invokes the Print dialog box.
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Navigation through Worksheets

The key combinations that allow you to navigate through a worksheet are listed in the table below.

Shortcut Description

LEFT ARROW KEY Moves the active cell one cell to the left in a
worksheet.

RIGHT ARROW KEY Moves the active cell one cell to the right in a
worksheet.

UP ARROW KEY Moves the active cell one cell up in a worksheet.

DOWN ARROW KEY Moves the active cell one cell down in a worksheet.

CTRL+ARROW KEYS Move the active cell to the edge of the current data
region in a worksheet.

HOME Moves the active cell to the beginning of a row in a
worksheet.

CTRL+HOME Moves the active cell to the beginning of a worksheet.

CTRL+END Moves the active cell to the last cell in a worksheet
(the last edited row of the rightmost edited column).

PAGE DOWN Moves the active cell one screen down in a
worksheet.

PAGE UP Moves the active cell one screen up in a worksheet.

TAB Moves the active cell one cell to the right in a
worksheet.

SHIFT+TAB Moves the active cell one cell to the left in a
worksheet.

CTRL+PAGE DOWN Moves to the next worksheet in the current
workbook.

CTRL+PAGE UP Moves to the previous worksheet in the current
workbook.
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Work with Selections

The key combinations that allow you to work with selections are listed in the table below.

Shortcut Description

CTRL+PERIOD (.) Moves the active cell clockwise to the next corner of
the selection.

CTRL+ALT+LEFT/RIGHT ARROW KEY Switches between multiple selected ranges of cells.

SHIFT+BACKSPACE Selects only the active cell in the selected cell range.

CTRL+SPACEBAR Selects an entire column in a worksheet.

SHIFT+SPACEBAR Selects an entire row in a worksheet.

CTRL+A Selects the entire worksheet or the data region to
which the active cell belongs.

CTRL+SHIFT+SPACEBAR Selects the entire worksheet or the data region to
which the active cell belongs.

SHIFT+ARROW KEYS Extend the selection by one cell.

CTRL+SHIFT+ARROW KEYS Extend the selection to the last nonblank cell in a row
or column.

SHIFT+HOME Extends the selection to the first column.

CTRL+SHIFT+HOME Extends the selection to the beginning of the
document.

CTRL+SHIFT+END Extends the selection to the previously used cell in a
worksheet.

SHIFT+PAGE DOWN Extends the selection one screen down in a
worksheet.

SHIFT+PAGE UP Extends the selection one screen up in a worksheet.
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Copy, Paste and Edit the Cell Content

The key combinations used to work with cell content are listed below.

Shortcut Description

CTRL+Z or ALT+BACKSPACE Performs the Undo command to reverse the last
action or to delete the last entry you typed.

CTRL+Y or ALT+SHIFT+BACKSPACE Repeats the last action.

F2 Turns on the edit mode for the active cell and
positions the cursor at the end of the cell content.

ENTER Completes a cell entry and selects the cell below.

SHIFT+ENTER Completes a cell entry and selects the cell above.

ESC Cancels an entry in a cell or Formula bar.

DELETE Removes the cell content without affecting the cell
formatting.

CTRL+C or CTRL+INSERT Copies the selected cell in the Clipboard.

CTRL+V or SHIFT+INSERT Inserts the contents of the Clipboard in the specified
cell and replaces any selection.

ALT+CTRL+V Invokes the Paste Special dialog box to specify the
paste options.

CTRL+X or SHIFT+DELETE Cuts the selected cells.

CTRL+D Performs the Fill Down command to copy the
contents of the topmost cell to the cells below.

CTRL+R Performs the Fill Right command to copy the contents
of the leftmost cell to the cell to the right.

CTRL+K Invokes the Insert Hyperlink dialog box to create a
new hyperlink.
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Cell Formatting

The key combinations that allow you to apply formatting options quickly are listed in the following table.

Shortcut Description

CTRL+B or CTRL+2 Applies or removes bold formatting.

CTRL+I or CTRL+3 Applies or removes italic formatting.

CTRL+U or CTRL+4 Applies or removes underlining.

CTRL+5 Applies or removes strikethrough.

CTRL+SHIFT+7 Applies the outline border to the selected cell or cell
range.

CTRL+SHIFT+MINUS (-) Removes the outline border from the selected cell or
cell range.

CTRL+SHIFT+1 Applies the Number format with two decimal places.

CTRL+SHIFT+2 Applies the Time format.

CTRL+SHIFT+3 Applies the Date format.

CTRL+SHIFT+4 Applies the Currency format.

CTRL+SHIFT+5 Applies the Percentage format.

CTRL+SHIFT+6 Applies the Scientific number format.
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Work with Columns and Rows

The key combinations that allow you to display, hide or group columns and rows in a worksheet are listed in the
following table.

Shortcut Description

CTRL+9 Hides the selected rows.

CTRL+SHIFT+9 Displays the hidden rows.

CTRL+0 Hides the selected columns.

CTRL+SHIFT+0 Displays the hidden columns.

ALT+SHIFT+RIGHT ARROW KEY Groups the selected rows or columns.

ALT+SHIFT+LEFT ARROW KEY Unroups the selected rows or columns.
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Work with Formulas

The key combinations used to create formulas quickly are listed in the table below.

Shortcut Description

CTRL+SHIFT+ENTER Creates an array formula.

ALT+PLUS (+) Inserts the SUM function in the active cell.

CTRL+ ` Toggles between displaying cell values and formulas
on a worksheet.

CTRL+SHIFT+U Toggles between expanding and collapsing the 
Formula Bar.

F9 Calculates the entire workbook.

SHIFT+F9 Calculates the active worksheet.

CTRL+F3 Defines a name.

CTRL+SHIFT+F3 Creates names from row and column labels.
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Toolbars and Menus

This section describes the capabilities provided by toolbars and menus.

 

Layout Customization

Open Toolbar Customization Window

Finish Toolbar Customization

Hide and Display Toolbars

Hide and Display Bar Commands

Rearrange Toolbars and Menus

Rearrange Bar Commands

Restore the Default Layout of Bar Commands

 

Navigation

Keyboard Navigation in Menus and Toolbars

 

Select Commands

Invoke Toolbar and Menu Commands
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Layout Customization

Open Toolbar Customization Window

Opening the Customization window activates the customization mode where you can:

Rearrange, hide and display bar commands.

Change display options of bar commands.

Hide bars, etc

To open the Customization window, do one of the following:

Right-click any bar or the empty space, and select Customize...

Click the dropdown button displayed at the right edge of any bar. Then select Add or Remove Buttons
and then Customize...

Double-click the empty space, not occupied by any bar.

The Customization window will be opened, containing three tabs:
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The Toolbars tab allows you to hide specific bars and display hidden ones.

The Commands tab allows you to access bar commands and add them to bars.

The Options tab allows you to control options affecting the display of menus and bar commands.
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Finish Toolbar Customization

To finish customization, click the Customization window's Close button:
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Hide and Display Toolbars

Use the Quick Customization Menu

Right-click any bar, and check or uncheck the required toolbars.

Use the Customization Window

Open the Customization window. Under the Toolbars tab, check or uncheck the required toolbars.
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Hide and Display Bar Commands

Temporarily Hide and Display Bar Commands

You can temporarily hide bar commands, and then restore hidden commands within a specific bar as follows:

1.Click the dropdown button displayed at the right edge of the bar:

2.Select Add or Remove Buttons, and then select the name of the clicked bar displayed at the top of the
submenu. A check list of bar commands displayed within the bar will be displayed:

3.To hide specific commands, uncheck corresponding items via mouse click. To display hidden commands,
check the corresponding items.

If a specific command is not available in a bar's command list, you can still access this command in customization
mode, and add this command to the bar. See below, to learn more.

Hide and Display Bar Commands in Customization Mode

First, open the Customization window.

To add a specific bar command to a bar, do the following:

1.Switch to the Commands tab page and locate the required command in the Commands list. Typically,
commands are grouped into categories, so you can first select a category to quickly locate the
command.
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2.Drag the bar command from the Commands list onto a bar or menu. Note that you can put bar
commands into nested menus. Menus will automatically open when you drag a bar command over their
parent menu items.

To remove a bar command from a bar, drag the bar command away from the bar, and drop it when the mouse
cursor changes its image to 'x':

Note

You can cancel drag and drop while dragging an item by pressing ESC.
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Rearrange Toolbars and Menus

To move a bar docked to a form to a new position, drag it via its drag widget.

To move a floating bar, drag it by its caption.

To dock a bar to any of the four edges of the form, drag the bar to this edge.

To make a docked bar floating, drag the bar away from the form's edges.
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Rearrange Bar Commands

To rearrange bar commands, do the following:

1.Open the Customization window.

2.Drag a bar command to a new position:

To copy a bar command, press CTRL while dragging.

Note

You can move commands even when the customization window is closed. For this purpose, hold down the ALT key
when dragging a bar command.
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Restore the Default Layout of Bar Commands

You can customize the layout of bar commands within a bar by hiding and rearranging them. Subsequently, you
can revert to the default layout of bar commands. This topic describes two ways to do this.

Restore the Default Layout Using Quick Customization

1.Click the dropdown button displayed at the right edge of any bar:

2.Select Add or Remove Buttons, and then select the name of the clicked bar displayed at the top of the
submenu. Then, select Reset Toolbar.

Restore the Default Layout in Customization Mode

1.Open the Customization window.

2.Select a bar in the list whose layout is to be restored.

3.Click Reset.
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Navigation

Keyboard Navigation in Menus and Toolbars

Navigate between Toolbar and Menu Items

To switch focus to the main menu, press ALT or F10. The following shortcuts allow you to navigate through bars
and bar items. They are in effect when a bar/menu is focused.

Action Description

CTRL+TAB Moves focus to another bar.

ARROW keys Moves focus to the next command in the
corresponding direction.

TAB
SHIFT+TAB

Moves focus to the next/previous command.

ESC Moves focus away from the currently focused bar.

Open and Close Menus

To open a sub-menu displayed within a bar, do one of the following:

Focus the sub-menu (using one of the methods described above) and press the ENTER or DOWN ARROW.

If the sub-menu's name contains an underscored letter, then:

- if the bar is focused, press the underscored letter.

- if the bar is not focused, hold the ALT key down and then press the underscored letter.

To open a menu displayed within another menu, do one of the following:

Focus the sub-menu and press the RIGHT ARROW.

If the menu's name contains an underscored letter, press the underscored letter.

To close the currently opened menu, press ESC.

See Also
Invoke Toolbar and Menu Commands
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Select Commands

Invoke Toolbar and Menu Commands

To invoke a specific bar or menu command, do one of the following:

Click the command with the mouse

Focus the command and then press ENTER.

If a command is visible and it contains an underscored letter in its name, then:

- if the bar or menu that contains this command is focused, then press this underscored letter.

- if the bar or menu that contains this command is not focused, hold the ALT key down and then press this
underscored letter.

Press the shortcut assigned to the command.

If a command is displayed within a menu, its shortcut is displayed next to the command's name (if
assigned).

Shortcuts for toolbar buttons are typically displayed in hints.
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Tree List

This section describes the capabilities provided by a multi-column tree view, which displays hierarchical data,
supports data editing, sorting, summary calculation and many other features:

 

Data Editing

Edit Cells in a Tree List

 

Data Presentation

Show Summaries (Totals) in a Tree List

Sort Tree List Nodes

 

Layout Customization

Expand and Collapse Nodes in a Tree List

Hide and Display Tree List Columns

Reorder Tree List Columns

Resize Tree List Columns

 

Selection and Navigation

Navigation in a Tree List

Select Tree List Nodes
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Data Editing

Activate Cell Editor

Do one of the following:

Click a cell.

Focus a cell (for instance, via the keyboard), and press ENTER or F2.

Focus a cell and press any alpha-numeric key. The editor will be invoked and its contents will be replaced
with the pressed character.

Select and Deselect Cell Text

Press F2 or CTRL+A.

Close Cell Editor and Accept Changes Made

Do one of the following:

Press ENTER.

Click any other grid cell.

Focus any other control.

Discard Changes

To discard changes made in a cell, press ESC.

To discard changes made in all cells within a node, press ESC twice.

Open Cell Editor's Dropdown

Do one of the following:

Activate a cell editor and press ALT+DOWN ARROW or F4.

Click the editor's dropdown button:

Close Cell Editor's Dropdown

For all editors providing a dropdown, you can close the dropdown by pressing ALT+DOWN ARROW.

If the calculator is displayed in the dropdown, it can be closed via CTRL+ENTER.

Dropdowns displaying lists of items can be closed by clicking an item with the mouse, or by selecting an item with
the keyboard and pressing ENTER.

Change Values

Change Date/Time Values

You can edit these cell values without opening the dropdown calendar. Position the caret at the portion of a date/
time value that needs to be changed. To increment the value, press CTRL+UP ARROW. To decrement the value,
press CTRL+DOWN ARROW.

Change Numeric Values

To increment the value, press CTRL+UP ARROW. To decrement the value, press CTRL+DOWN ARROW.

Change Values of Cells That Provide Dropdown Items

To select the previous value, press CTRL+UP ARROW. To select the next value, press CTRL+DOWN ARROW.

Note: this feature is not applicable to all editors.

Edit Images
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To copy, cut, paste, load and save images in image editors, right click the image and select the required command
via the context menu:
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Data Presentation

Show Summaries (Totals) in a Tree List

To change the type of summary for a specific column or apply a summary, do the following:

1.Right-click a region within a group footer or grid footer under a specific column. A context menu
displaying a list of supported summary types will be displayed.

2.Select the required option from the context menu.

To calculate summaries against all nodes, ensure that the All Nodes menu check item is checked. To calculate
summaries against root nodes only, uncheck the All Nodes check item.
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Sort Tree List Nodes

To sort nodes by a column's values and replace existing sort conditions that are applied to the current or other
columns, click the target column's header, until an Up or Down Arrow icon is displayed within the header. The Up
and Down Arrows indicate ascending and descending sort orders respectively.

To sort nodes by a column's values while preserving existing sort conditions, do one of the following:

Click a column header while holding the SHIFT key down, until an UP or Down Arrow icon is displayed
within the header.

Right-click a column header and select Sort Ascending or Sort Descending from the context menu that
will appear.

To remove sorting by a column, click a column header while holding the CTRL key down.
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Layout Customization

Expand and Collapse Nodes in a Tree List

Expand and Collapse Nodes

Do one of the following:

Focus the node and then press PLUS on the keyboard to expand the node, and MINUS to collapse the
node:

Click the node's expand button.

Double-click the indicator cell corresponding to the node.

Expand Nodes Recursively

To expand a node and all its child nodes that have nested nodes, focus the node and press MULTIPLY on the
keyboard.
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Hide and Display Tree List Columns

Hide Columns

Do one of the following:

Click a column header and drag it outside the header panel, until the cursor changes its image to the big
'X'. Then drop the header.

Drag and drop a column header onto the Customization Form if it's open (see below).

Display Hidden Columns

1.Open the Customization Form by right-clicking a column header and selecting Column Chooser.

The Customization Form will be displayed listing hidden columns (if any).
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2.Drag the required column from the Customization Form onto the column header panel and drop it at the
required position.
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Reorder Tree List Columns

To reorder columns, drag and drop a column header to a new position.
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Resize Tree List Columns

To resize columns, drag the right edge of the target column header:

To change a column's width so that it displays its contents compactly in their entirety, do one of the following:

Double-click the right edge of the column header.

Right-click the column's header and select Best Fit.

To change the widths of all columns so that they display their contents in the best possible way, right-click the
header of any column and select Best Fit (all columns).
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Selection and Navigation

Navigation in a Tree List

Action Description

Clicking a data cell Moves focus to the clicked cell.

ARROW keys Moves focus to the next cell in the corresponding
direction.

HOME
END

Moves focus to the first/last cell within the focused
node.

PAGE UP
PAGE DOWN

Moves focus one page up or down.

CTRL+HOME Moves focus to the first cell within the first node.

CTRL+END Moves focus to the last cell within the last node.

TAB
CTRL+TAB

Moves focus away from the TreeList to the next
control, in tab order.

SHIFT+TAB Moves focus away from the TreeList to the previous
control, in tab order.

CTRL+RIGHT ARROW Expands the focused node.

CTRL+LEFT ARROW Collapses the focused node.

You can also click node indicator cells to move focus to the corresponding row while preserving column focus.
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Select Tree List Nodes

Change Focused Node

To focus a node and clear the existing selection, do one of the following.

Click the node's indicator cell or any of its data cells.

Select the node using the ARROW keys.

Select Multiple Nodes

To select a node while preserving the current selection, click the node's indicator cell or any of its data cells, while
holding the CTRL key down.

To toggle the focused node's selected state, do one of the following.

Press CTRL+SPACE.

Click the node while holding the CTRL key down.

To move focus between nodes while preserving the current selection, use CTRL+ARROW keyboard shortcut.
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Vertical Grid

This section describes the capabilities provided by Vertical Grids (Property Grids).

 

Data Editing

Edit Cells in Vertical Grids

 

Layout Customization

Expand and Collapse Rows in Vertical Grids

Resize Rows and Columns in Vertical Grids

 

Navigation

Navigation in Vertical Grids
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Data Editing

Activate Cell Editor

Do one of the following:

Click a cell.

Focus a cell (for instance, via the keyboard), and press ENTER or F2.

Focus a cell and press any alpha-numeric key. The editor will be invoked and its contents will be replaced
with the pressed character.

Select and Deselect Cell Text

Press F2 or CTRL+A.

Close Cell Editor and Accept Changes Made

Do one of the following:

Press ENTER.

Click any other grid cell.

Focus any other control.

Discard Changes

To discard changes made in a cell, press ESC.

Open Cell Editor's Dropdown

Do one of the following:

Activate a cell editor and press ALT+DOWN ARROW or F4.

Click the editor's dropdown button:

Close Cell Editor's Dropdown

For all editors providing a dropdown, you can close the dropdown by pressing ALT+DOWN ARROW.

If the calculator is displayed in the dropdown, it can be closed via CTRL+ENTER.

Dropdowns displaying lists of items can be closed by clicking an item with the mouse, or by selecting an item with
the keyboard and pressing ENTER.

Change Values

Change Date/Time Values

You can edit these cell values without opening the dropdown calendar. Position the caret at the portion of a date/
time value that needs to be changed. To increment the value, press CTRL+UP ARROW. To decrement the value,
press CTRL+DOWN ARROW.

Change Numeric Values

To increment the value, press CTRL+UP ARROW. To decrement the value, press CTRL+DOWN ARROW.

Change Values of Cells That Provide Dropdown Items

To select the previous value, press CTRL+UP ARROW. To select the next value, press CTRL+DOWN ARROW.

Note

This feature is not applicable to all editors.
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Edit Images

To copy, cut, paste, load and save images in image editors, right click the image and select the required command
via the context menu:
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Layout Customization

Expand and Collapse Rows in Vertical Grids

Expand and Collapse Data Rows

Do one of the following:

Focus the row and then press PLUS on the keyboard to expand the row, and MINUS to collapse the row:

Double-click the row's header.

Click the row's expand button.

Expand and Collapse Category Rows

Do one of the following:

Focus the row and press PLUS on the keyboard to expand the row, and MINUS to collapse the row.

Double-click the row.

Click the row's expand button.

Expand Rows Recursively

To expand a row and all its child rows that have nested rows, focus the row and press MULTIPLY on the keyboard.
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Resize Rows and Columns in Vertical Grids

Resize Rows

To resize a row, drag the row header's bottom edge vertically.

Resize Columns

To resize data columns, drag a separator between data columns horizontally.

To resize the header column, do one of the following.

Drag the header column's right edge.

Press CTRL+LEFT ARROW to decrease the header column's width. Press CTRL+RIGHT ARROW to increase
the header column's width.

To resize headers to the minimum width while making sure all content is visible, double-click a header's
right edge.
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Navigation

Action Description

Clicking a data cell Moves focus to the clicked cell.

Clicking a row header Moves focus to the corresponding row while
preserving column focus.

ARROW keys Moves focus to the next cell in the corresponding
direction.

TAB
SHIFT+TAB

Moves focus to the next/previous cell.

HOME
END

Moves focus to the first/last cell within the current
row.

PAGE UP
PAGE DOWN

Moves focus one page up or down.

CTRL+HOME Moves focus to the first cell of the grid control.

CTRL+END Moves focus to the last cell of the grid control.

CTRL+TAB Moves focus away from the control to the next
control, in tab order.
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